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关于本指南

• 文档目的，第 xv 页

• 相关文档，第 xv 页

• 约定，第 xvi 页

• 获取文档和提交服务请求，第 xvi 页

文档目的
本指南旨在帮助您使用自适应安全设备管理器 (ASDM) 配置思科 ASA 系列的防火墙功能。本指南
仅介绍最常见的一些配置场景，并未涵盖所有功能。

本指南中，术语 “ASA”一般适用于所支持的型号，除非另有说明。

注 ASDM 支持许多 ASA 版本。ASDM 文档和联机帮助涵盖 ASA 支持的所有最新功能。如果您在运行
较早版本的 ASA 软件，文档可能包含您版本中不支持的功能。同样，如果在较早主要版本或次要
版本的维护版本中添加了一个功能，则 ASDM 文档包括该新功能，即使该功能在所有后续 ASA 版
本中都不提供。请参阅每章的功能历史记录表确定功能的添加时间。有关每个 ASA 版本所支持 
ASDM 的最低版本，请参阅 《思科 ASA 系列兼容性》。

相关文档
有关详细信息，请参阅 《思科 ASA 系列文档导航》，网址为 http://www.cisco.com/go/asadocs。
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  获取文档和提交服务请求
约定
本文档使用下列约定：

注 表示读者需要注意的地方。

提示 表示以下信息有助于您解决问题。

注意事项 表示读者应当小心。在这种情况下，操作可能会导致设备损坏或数据丢失。

获取文档和提交服务请求
有关获取文档、使用 Cisco Bug 搜索工具 (BST)、提交服务请求和收集更多信息的详细信息，请参阅
思科产品文档更新，网址为：http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html。

通过 RSS 源的方式订阅思科产品文档更新（其中包括所有新的和修改过的思科技术文档），并将相
关内容通过阅读器应用直接发送至您的桌面。 RSS 源是一种免费服务。

约定 说明

粗体 命令和关键字及用户输入的文本以粗体显示。

斜体 文档标题、新增或强调的术语以及要为其提供值的参数以斜体表示。

[   ] 方括号中的元素是可选项。

{x | y | z } 必选的备选关键字括在大括号中，以竖线分隔。

[ x | y | z ] 可选的备选关键字括在方括号中，以竖线分隔。

字符串 不加引号的字符集。请勿将字符串用引号引起来，否则会将字符串和引号
视为一个整体。

courier 字体 系统显示的终端会话和信息以 courier 字体显示。

courier 粗体 命令和关键字及用户输入的文本以 courier 粗体显示。

courier 斜体 要提供值的参数以 courier 斜体显示。

<   > 非打印字符 （如密码）括在尖括号中。

[   ] 系统提示的默认回复括在方括号中。

!， # 代码行开头的感叹号 (!) 或井号 (#) 表示注释行。
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章第 1第 章
服务策略

发布日期：2014 年 7 月 24 日
更新日期：2014 年 9 月 16 日

服务策略给 ASA 功能配置提供了一致并灵活的方法。例如，您可以使用服务策略创建特定于某项 
TCP 应用而非应用于所有 TCP 应用的超时配置。服务策略由多个应用于某个接口或全局应用的操
作或规则组成。

• 第 1-1 页的关于服务策略

• 第 1-7 页的服务策略准则

• 第 1-8 页的服务策略的默认设置

• 第 1-9 页的配置服务策略

• 第 1-14 页的服务策略历史

关于服务策略
以下主题介绍服务策略的工作原理。

• 第 1-2 页的服务策略的组成部分

• 第 1-4 页的使用服务策略配置的功能

• 第 1-4 页的功能方向性

• 第 1-5 页的服务策略内的功能匹配

• 第 1-6 页的应用多项功能操作的顺序

• 第 1-6 页的某些功能操作的不兼容性

• 第 1-7 页的多项服务策略的功能匹配
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  关于服务策略
服务策略的组成部分

服务策略的关键在于将高级服务应用于您允许的流量。任何被访问规则允许的流量都可以应用服务
策略，从而接受特殊处理，例如被重定向到服务模块，或者运用应用检测。

提供以下类型的服务策略：

• 一项应用到所有接口的全局策略。

• 一项应用到单个接口的服务策略。策略可以是一个类组合，适用于流经设备的流量以及在 ASA 
接口定向但不流经该设备的管理流量。

每项服务策略都由以下要素组成：

1. 服务策略映射，这是一组按顺序排列的规则集，根据 service-policy 命令命名。在 ASDM 中，
策略映射表示为 Service Policy Rules 页面上的一个文件夹。

2. 规则，每条规则都是服务策略映射中的 class 命令，以及与 class 命令相关联的命令。在 ASDM 
中，每条规则都显示于不同的行，规则名称为类名称。

a. class 命令定义匹配规则条件的流量。

b. 与类相关联的命令，例如 inspect 和 set connection timeout，定义应用于匹配流量的服务和
限制。请注意，检测命令可以指向检测策略映射，通过这种方式定义应用于被检测流量的
操作。请记住，检测策略映射不同于服务策略映射。

以下示例将服务策略在 CLI 中的显示方式与在 ASDM 中的显示方式进行了对比。请注意，图中编
号和 CLI 中的行之间没有一对一映射关系。

以下 CLI 由上图中显示的规则生成。

: Access lists used in class maps. 
: In ASDM, these map to call-out 3, from the Match to the Time fields. 
access-list inside_mpc line 1 extended permit tcp 10.100.10.0 255.255.255.0 any eq sip 
access-list inside_mpc_1 line 1 extended deny udp host 10.1.1.15 any eq snmp 
access-list inside_mpc_1 line 2 extended permit udp 10.1.1.0 255.255.255.0 any eq snmp 
access-list inside_mpc_2 line 1 extended permit icmp any any 
: SNMP map for SNMP inspection.Denies all by v3. 
: In ASDM, this maps to call-out 4, rule actions, for the class-inside policy. 
snmp-map snmp-v3only
  deny version 1
  deny version 2
  deny version 2c
: Inspection policy map to define SIP behavior. 
: The sip-high inspection policy map must be referred to by an inspect sip command 
: in the service policy map. 
: In ASDM, this maps to call-out 4, rule actions, for the sip-class-inside policy. 
policy-map type inspect sip sip-high
  parameters
1-2
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    rtp-conformance enforce-payloadtype
    no traffic-non-sip
    software-version action mask log
    uri-non-sip action mask log
    state-checking action drop-connection log
    max-forwards-validation action drop log
    strict-header-validation action drop log
: Class map to define traffic matching for the inside-class rule. 
: In ASDM, this maps to call-out 3, from the Match to the Time fields. 
class-map inside-class
  match access-list inside_mpc_1
: Class map to define traffic matching for the sip-class-inside rule. 
: In ASDM, this maps to call-out 3, from the Match to the Time fields. 
class-map sip-class-inside
  match access-list inside_mpc
: Class map to define traffic matching for the inside-class1 rule. 
: In ASDM, this maps to call-out 3, from the Match to the Time fields. 
class-map inside-class1
  match access-list inside_mpc_2
: Policy map that actually defines the service policy rule set named test-inside-policy. 
: In ASDM, this corresponds to the folder at call-out 1. 
policy-map test-inside-policy
: First rule in test-inside-policy, named sip-class-inside.Inspects SIP traffic. 
: The sip-class-inside rule applies the sip-high inspection policy map to SIP inspection.
: In ASDM, each rule corresponds to call-out 2. 
  class sip-class-inside
    inspect sip sip-high
: Second rule, inside-class.Applies SNMP inspection using an SNMP map. 
  class inside-class
    inspect snmp snmp-v3only
: Third rule, inside-class1.Applies ICMP inspection. 
  class inside-class1
    inspect icmp 
: Fourth rule, class-default.Applies connection settings and enables user statistics. 
  class class-default
    set connection timeout embryonic 0:00:30 half-closed 0:10:00 idle 1:00:00 
reset dcd 0:15:00 5
    user-statistics accounting
: The service-policy command applies the policy map rule set to the inside interface. 
: This command activates the policies. 
service-policy test-inside-policy interface inside
1-3
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  关于服务策略
使用服务策略配置的功能

下表列出了您使用服务策略配置的功能。

功能方向性

可以将操作双向或单向应用到流量，具体情况视功能而定。对于双向应用的功能，如果流量在两个
方向上都匹配类映射，所有进入或退出应用了策略映射的接口的流量都会受到影响。

注 当您使用全局策略时，所有功能都是单向的；通常在应用到单一接口时为双向的功能，在全局应用
时仅应用到每个接口的入口。因为策略应用到所有接口，所以策略将在两个方向上应用，因此，在
这种情况下，双向性是冗余的。

对于单向应用的功能，例如 QoS 优先级队列，仅进入 （或退出，具体取决于功能）应用了策略映
射的接口的流量会受到影响。请参见下表，了解每项功能的方向性。

表 1-1 使用服务策略配置的功能

功能 适用于直通流量？ 适用于管理流量？ 请参阅：

应用类型 （多种类型） 全部，除 RADIUS 
记账以外

仅 RADIUS 记账 • 第 8 章，“应用层协议检测入门”

• 第 9 章，“基本互联网协议检测”

• 第 10 章，“语音和视频协议的检测”

• 第 11 章，“数据库和目录协议的检测”

• 第 12 章，“管理应用协议检测”

• 第 16 章，“ASA 和思科云网络安全”

ASA IPS 是 否 第 20 章，“ASA IPS 模块”

ASA CX 是 否 第 19 章，“ASA CX 模块”

ASA FirePOWER (ASA SFR) 是 否 第 18 章，“ASA FirePOWER (SFR) 模块”

NetFlow 安全事件记录过滤 是 是 请参阅一般操作配置指南。

QoS 输入和输出策略管制 是 否 第 14 章，“服务质量”

QoS 标准优先级队列 是 否 第 14 章，“服务质量”

TCP 和 UDP 连接限制与超时，
以及 TCP 序列号随机化

是 是 第 13 章，“连接设置”

TCP 规范化 是 否 第 13 章，“连接设置”

TCP 状态旁路 是 否 第 13 章，“连接设置”

身份防火墙用户统计信息 是 是 请参阅命令参考中的 user-statistics 命令

表 1-2 功能方向性

功能 单一接口方向 全局方向

应用类型 （多种类型） 双向 入口

ASA CSC 双向 入口

ASA CX 双向 入口
1-4
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服务策略内的功能匹配

数据包根据以下规则，匹配策略中适用于既定接口的规则：

1. 对于每种功能类型，数据包仅可以匹配适用于某个接口的策略映射中的一个类映射。

2. 当数据包匹配某种功能类型的某条规则时，ASA 不会尝试将其与该功能类型的任何后续规则进
行匹配。

3. 然而，如果数据包匹配另一种功能类型的某条后续规则，在支持的情况下， ASA 还将为该后续
规则应用操作。请参阅第 1-6 页的某些功能操作的不兼容性，了解有关不受支持的组合的详细
信息。

注 应用检测包括多种检测类型，大部分类型都相互排斥。对于可以组合在一起的检测，每
项检测都被视为一项独立功能。

数据包匹配示例 

例如：

• 如果数据包不仅匹配连接限制的规则，还匹配应用检测规则，则两项操作均会被应用。

• 如果数据包不仅匹配 HTTP 检测的规则，还匹配另一条包含 HTTP 检测的规则，则第二条规则
的操作不会被应用。

• 如果数据包不仅匹配 HTTP 检测规则，还匹配另一条包含 FTP 检测的规则，则第二条规则的操
作不会被应用，因为 HTTP 检测和 FTP 检测不能整合在一起。

• 如果数据包不仅匹配 HTTP 检测规则，还匹配另一条包含 IPv6 检测的规则，则两项操作均会被
应用，因为 IPv6 检测可以与任何其他类型的检测整合在一起。

ASA CX 身份验证代理 入口 入口

ASA FirePOWER (ASA SFR) 双向 入口

ASA IPS 双向 入口

NetFlow 安全事件记录过滤 不适用 入口

QoS 输入策略管制 入口 入口

QoS 输出策略管制 出口 出口

QoS 标准优先级队列 出口 出口

TCP 和 UDP 连接限制与超时，以及 TCP 序
列号随机化

双向 入口

TCP 规范化 双向 入口

TCP 状态旁路 双向 入口

身份防火墙用户统计信息 双向 入口

表 1-2 功能方向性 （续）

功能 单一接口方向 全局方向
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  关于服务策略
应用多项功能操作的顺序

不同类型的操作在服务策略中的执行顺序独立于这些操作在表中显示的顺序。

按以下顺序执行操作：

1. QoS 输入策略管制

2. TCP 规范化、 TCP and UDP 连接限制与超时、 TCP 序列号随机化和 TCP 状态旁路。

注 当 ASA 执行代理服务 （例如， AAA 或 CSC）或者修改 TCP 负载 （例如， FTP 检测）
时， TCP 规化器在双模式下运行，在代理或负载修改服务之前和之后应用。

3. ASA CSC

4. 可以与其他检测整合在一起的应用检测：

a. IPv6

b. IP 选项

c. WAAS

5. 无法与其他检测组合在一起的应用检测。有关详细信息，请参阅第 1-6 页的某些功能操作的不
兼容性。

6. ASA IPS

7. ASA CX

8. ASA FirePOWER (ASA SFR)

9. QoS 输出策略管制

10. QoS 标准优先级队列

注 NetFlow 安全事件记录过滤和身份防火墙用户统计信息不受顺序约束。

某些功能操作的不兼容性

某些功能对于同一流量互不兼容。下表可能不包含所有不兼容性；有关每项功能兼容性的详细信
息，请参阅功能对应的章节：

• 您无法为同一组流量配置 QoS 优先级队列和 QoS 策略管制。

• 大部分检测不应与另一项检测整合在一起，因此，如果您为同一流量配置多项检测， ASA 仅应
用一项检测。HTTP 检测可以与云网络安全检测整合在一起。其他例外已在第 1-6 页的应用多项
功能操作的顺序中列出。

• 您无法配置即将发送到多个模块 （例如 ASA CX 和 ASA IPS）的流量。

• HTTP 检测不兼容 ASA CX 或 ASA FirePOWER。

• 云网络安全不兼容 ASA CX 或 ASA FirePOWER。
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注 在默认全局策略中使用的 Default Inspection Traffic 流量类是一个特殊的 CLI 快捷方式，用以匹配所
有检测的默认端口。在策略映射中使用时，该类映射可以根据流量的目标端口确保应用到每个数据
包的检测都正确。例如，当端口 69 的 UDP 流量到达 ASA 时，ASA 将应用 TFTP 检测；当端口 21 
的 TCP 流量到达时， ASA 将应用 FTP 检测。因此，只有在这种情况下，您才能为同一类映射配置
多项检测。通常， ASA 不使用端口号确定应用哪项检测，因此，您可以将检测应用到非标准端口
（例如）。

该流量类不包含云网络安全检测的默认端口 （80 和 443）。

多项服务策略的功能匹配

对于 TCP 和 UDP 流量（以及启用状态性 ICMP 检测时的 ICMP），服务策略不仅在单个数据包上运
行，还在流量上运行。如果流量为现有连接的一部分且该现有连接匹配一个接口上的策略中的某项
功能，那么该流量无法匹配另一个接口上的策略中的同一项功能；仅使用第一项策略。

例如，如果 HTTP 流量匹配内部接口上的检查 HTTP 流量的策略，而且您在 HTTP 检测的外部接口
上有独立策略，该流量也不会在外部接口的出口被检测。同样，该连接的返回流量不会被外部接口
的入口策略检测，也不会被内部接口的出口策略检测。

对于未被当作流量处理的流量，例如，不启用状态性 ICMP 检测时的 ICMP，返回流量可以匹配返
回接口上的另一个策略映射。例如，如果在内部和外部接口上配置 IPS，但内部策略使用虚拟传感
器 1，同时外部策略使用虚拟传感器 2，则非状态性 Ping 将匹配出站虚拟传感器 1，以及匹配入站
虚拟传感器 2。

服务策略准则

IPv6 准则

支持在以下功能中使用 IPv6：

• DNS、 FTP、 HTTP、 ICMP、 ScanSafe、 SIP、 SMTP、 IPsec-pass-thru 和 IPv6 的应用检测

• ASA IPS

• ASA CX

• ASA FirePOWER

• NetFlow 安全事件记录过滤

• TCP and UDP 连接限制与超时， TCP 系列号随机化

• TCP 规范化

• TCP 状态旁路

• 身份防火墙用户统计信息
1-7
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 1 章      服务策略

  服务策略的默认设置
类映射（流量类）准则

所有类型的最大类映射 （流量类）数量在单一模式下为 255，在多模式下视情景而定。类映射包括
以下类型：

• 第 3/4 层类映射 （对于直通流量和管理流量）

• 检测类映射

• 正则表达式类映射

• 直接在检测策略映射下使用的 match 命令

该限制还包括所有类型的默认类映射，将用户配置的类映射限制为大约 235 个。请参阅第 1-9 页的
默认类映射 （流量类）。

服务策略准则

• 对于某个既定功能来说，接口服务策略优先于全局服务策略。例如，如果有 FTP 检测全局策略
和 TCP 规范化接口策略，则 FTP 检测和 TCP 规范化都会被应用到接口。然而，如果有 FTP 检
测全局策略和 FTP 检测接口策略，则仅接口策略 FTP 检测会被应用到接口。

• 您只能应用一项全局策略。例如，您无法创建一个包含功能集 1 的全局策略和另一个包含功能
集 2 的全局策略。所有功能都必须包含在单一策略中。

• 对配置进行服务策略更改时，所有新的连接都使用新的服务策略。现有连接继续使用在建立连
接时配置的策略。 show 命令输出不包含有关旧连接的数据。

例如，如果从某接口移除 QoS 服务策略，然后添加经修改的版本， show service-policy 命令仅
显示与匹配新服务策略的新连接相关联的 QoS 计数器；旧策略上的现有连接不再在命令输出中
显示。

为确保所有连接都使用新策略，您需要断开当前连接，使其能够使用新策略重新连接。使用 
clear conn 或 clear local-host 命令。

服务策略的默认设置
以下主题介绍服务策略和模块化策略框架的默认设置：

• 第 1-8 页的服务策略默认配置

• 第 1-9 页的默认类映射 （流量类）

服务策略默认配置

默认情况下，配置包含一项策略 （全局策略），该策略匹配所有默认应用检测流量并将某些检测应
用到所有接口上的流量。默认情况下，并非所有检测都被启用。您只能应用一项全局策略，因此，
如果想要调整全局策略，您需要编辑默认策略，或者将其禁用来应用新策略。（对于某项特定功
能，接口策略覆盖全局策略。）

默认策略包括以下应用检测：

• DNS

• FTP

• H323 (H225)

• H323 (RAS)

• RSH
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• RTSP

• ESMTP

• SQLnet

• Skinny (SCCP)

• SunRPC

• XDMCP

• SIP

• NetBios

• TFTP 

• IP 选项

默认类映射 （流量类）

该配置包含一个默认的第 3/4 层类映射（流量类），ASA 在叫作  Default Inspection Traffic 的默认全
局策略中使用该类映射；它匹配默认检测流量。该类在默认全局策略中使用，是一个用来匹配所有
检测的默认端口的特殊快捷方式。

在策略中使用时，该类可以根据流量的目标端口，确保应用到每个数据包的检测都正确。例如，当
端口 69 的 UDP 流量到达 ASA 时，ASA 将应用 TFTP 检测；当端口 21 的 TCP 流量到达时，ASA 将
应用 FTP 检测。因此，只有在这种情况下，您才能为同一类映射配置多项检测。通常， ASA 不使
用端口号确定应用哪项检测，因此，您可以将检测应用到非标准端口 （例如）。

默认配置中的另一个类映射叫作 class-default，该类映射匹配所有流量。如果需要，您可以使用 
class-default 类，而非类映射。事实上，有些功能仅对 class-default 可用。

配置服务策略
配置服务策略包括为每个接口或全局策略添加一项或多项服务策略。ASDM 使用一个向导指导您完
成创建服务策略的流程。对于每条规则，您可以识别以下要素：

1. 要应用规则的接口或全局策略。

2. 要应用操作的流量。您可以识别第 3 层和第 4 层流量。

3. 应用到流量类的操作。您可以为每个流量类应用多项互不冲突的操作。

创建策略后，您可以添加规则，移动、编辑或删除规则或策略。以下主题描述如何配置服务策略。

• 第 1-10 页的为直通流量添加服务策略规则

• 第 1-12 页的为管理流量添加服务策略规则

• 第 1-13 页的管理服务策略规则的顺序
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为直通流量添加服务策略规则

要为直通流量添加服务策略规则，请使用 Add Service Policy Rule 向导。系统将要求您选择策略范
围，为某个特定接口或全局：

• 对于某个既定功能来说，接口服务策略优先于全局服务策略。例如，如果有 FTP 检测全局策略
和 TCP 连接限制接口策略，则 FTP 检测和 TCP 连接限制均会被应用到接口。然而，如果有 
FTP 检测全局策略和 FTP 检测接口策略，则仅接口策略 FTP 检测会被应用到接口。

• 全局服务策略可以为所有接口提供默认服务。除非被接口特定策略覆盖，否则将应用全局服
务。默认情况下，存在一项全局策略，包括适用于默认应用检测的服务策略规则。有关详细信
息，请参阅第 1-8 页的服务策略的默认设置。您可以使用向导向全局策略添加规则。

有关可以使用服务策略配置的功能，请参阅第 1-4 页的使用服务策略配置的功能。

步骤 1 选择 Configuration > Firewall > Service Policy Rules，并点击 Add 或 Add > Add Service Policy Rule。

步骤 2 在 Create a Service Policy and Apply To 区域：

a. 选择 Interface 将策略应用到某个特定接口，或者选择 Global 应用到所有接口。

b. 如果选择 Interface，请选择接口名称。如果接口已有策略，您可以向现有策略添加规则。

c. 如果接口没有服务策略，请输入新策略的名称。

d. （可选）输入策略说明。

e. （可选）选中 Drop and log unsupported IPv6 to IPv6 traffic 选项，为不支持 IPv6 流量的应用检
测丢弃的 IPv6 流量生成系统日志 (767001)。默认情况下，不生成系统日志。有关支持 IPv6 的检
测列表的详细信息，请参阅第 1-7 页的 IPv6 准则。

f. 点击 Next。
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步骤 3 在 Traffic Classification Criteria 页面，选择以下某个选项，指定要应用策略操作的流量，然后点击 Next。

• Create a new traffic class。输入流量类名称和可选说明。

使用以下某个条件识别流量：

– Default Inspection Traffic - 该类匹配 ASA 能够检测的所有应用使用的默认 TCP 和 UDP 端
口。当您点击 Next 时，系统将显示该类定义的服务和端口。

该选项在默认全局策略中使用，在规则中使用时，是一个特殊的快捷方式，可以根据流量
的目标端口确保应用到每个数据包的检测都正确。有关详细信息，请参阅第 1-9 页的默认
类映射 （流量类）。

请参阅第 8-5 页的默认检测和 NAT 限制，查看默认端口列表。 ASA 包括一项默认全局策
略，该策略匹配默认检测流量且将通用检测应用到所有接口上的流量。并非所有其端口包
含在 Default Inspection Traffic 类中的应用都在策略映射中被默认启用。

您可以指定 Source and Destination IP Address 类（使用 ACL）以及 Default Inspection Traffic 
类，缩小被匹配的流量的范围。因为 Default Inspection Traffic 类指定了要匹配的端口和协
议，所以 ACL 中的任意端口和协议都将被忽略。

– Source and Destination IP Address (uses ACL) - 该类匹配扩展 ACL 指定的流量。如果 ASA 
正在透明防火墙模式下运行，您可以使用以太网类型 ACL。点击 Next 时，系统将提示您设
置访问控制条目的属性。向导将创建 ACL，您无法选择现有的 ACL。

定义 ACE 时， Match 选项创建一条规则，使操作应用于匹配这些地址的流量。 Do Not 
Match 选项可以使流量免于被应用指定的操作。例如，您想匹配 10.1.1.0/24 中的所有流量，
并应用连接限制，但 10.1.1.25 除外。在这种情况下，创建两条规则，使用 Match 选项为 
10.1.1.0/24 创建一条，使用 Do Not Match 为 10.1.1.25 创建一条。请务必安排这些规则，使 
Do Not Match 规则优先于 Match 规则，否则， 10.1.1.25 将首先匹配 Match 规则。

注 创建这一类型的新流量类时，您最初只能指定一个访问控制条目 (ACE)。完成添加
规则之后，您可以通过向同一接口或全局策略添加一条新规则，然后指定 Add rule 
to existing traffic class （见下文），添加其他 ACE。

– Tunnel Group - 该类匹配想要应用 QoS 的隧道组流量 （连接配置文件）。您还可以指定另
一个流量匹配选项，以优化流量匹配， Any Traffic、 Source and Destination IP Address (uses 
ACL) 或 Default Inspection Traffic 除外。

点击 Next 时，系统将提示您选择隧道组 （如果需要，您可以创建一个新隧道组）。要对每
个流进行策略管制，请选中 Match flow destination IP address。所有流向某唯一 IP 目标地
址的流量都被视为流。

– TCP or UDP Destination Port - 该类匹配单一端口或连续的端口范围。点击 Next 时，系统将
提示您选择 TCP 或 UDP，并输入端口号；点击 ...，选择已在 ASDM 中定义的某个端口号。

提示 对于使用多个非连续端口的应用，请使用 Source and Destination IP Address (uses ACL) 匹配
每个端口。

– RTP Range - 该类映射匹配 RTP 流量。点击 Next 时，系统将提示您输入一个 RTP 端口范
围，介于 2000 和 65534 之间。此范围中的最大端口数量为 16383 个。

– IP DiffServ CodePoints (DSCP) - 该类最多匹配 IP 标头中的 8 个 DSCP 值。点击 Next 时，
系统将提示您选择或输入所需要的值 （将这些值移至 Match on DSCP 列表）。

– IP Precedence - 该类映射最多匹配 4 个优先级值，用 IP 标头中的 TOS 字节表示。点击 Next 
时，系统将提示您设置数值。

– Any Traffic - 匹配所有流量。
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• Add rule to existing traffic class。如果已在同一接口上有服务策略规则，或者正在向全局服务策
略添加规则，您可以通过此选项向现有 ACL 添加 ACE。您可以将 ACE 添加到您之前在为该接
口上的服务策略规则选择 Source and Destination IP Address (uses ACL) 选项时创建的任意 ACL。
对于该流量类，即使您添加多个 ACE，也只能有一组规则操作。您可以重复这一完整操作步
骤，将多个 ACE 添加到同一流量类。请参阅第 1-13 页的管理服务策略规则的顺序，了解有关
更改 ACE 顺序的详细信息。点击 Next 时，系统将提示您设置访问控制条目的属性。

• Use an existing traffic class。如果您创建了被不同接口上的规则使用的流量类，您可以重用该规
则的流量类定义。请注意，如果您更改某条规则的流量类，该更改将被所有使用该流量类的规
则继承。如果配置包含您在 CLI 上输入的任何 class-map 命令，则那些流量类名称也可用 （尽
管您需要创建规则，以查看流量类的定义）。

• Use class default as the traffic class。该选项使用 class-default 类，该类匹配所有流量。
class-default 类由 ASA 自动创建，并放置在策略末尾。如果不对该类应用任何操作，该类依然
由 ASA 创建，但仅用于内部目的。如果需要，您可以对该类应用操作，这可能比创建一个匹配
所有流量的新流量类更方便。您只能使用 class-default 类为该服务策略创建一条规则，因为每
个流量类只能与一项策略的单一规则相关联。

步骤 4 如果您选择了要求附加配置的流量匹配条件，请输入所需的参数并点击 Next。

步骤 5 在 Rule Actions 页面，配置一项或多项规则操作。请参阅第 1-4 页的使用服务策略配置的功能，了
解您可以应用的功能和操作列表，以及到其他详细信息的指针。

步骤 6 点击 Finish。

为管理流量添加服务策略规则

要出于管理的目的为定向到 ASA 的流量添加服务策略规则，请使用 Add Service Policy Rule 向导。
您将被要求选择策略范围，为某个特定接口或全局：

• 对于某个既定功能来说，接口服务策略优先于全局服务策略。例如，如果有 RADIUS 记帐检测
全局策略和连接限制接口策略，则 RADIUS 记帐和连接限制均会被应用到接口。然而，如果有 
RADIUS 记帐全局策略和 RADIUS 记帐接口策略，则仅接口策略 RADIUS 记帐会被应用到接口。

• 全局服务策略可以为所有接口提供默认服务。除非被接口特定策略覆盖，否则将应用全局服
务。默认情况下，存在一项全局策略，包括适用于默认应用检测的服务策略规则。有关详细信
息，请参阅第 1-8 页的服务策略的默认设置。您可以使用向导向全局策略添加规则。

有关可以使用服务策略配置的功能，请参阅第 1-4 页的使用服务策略配置的功能。

步骤 1 选择 Configuration > Firewall > Service Policy Rules，并点击 Add 或 Add > Add Management 
Service Policy Rule。

步骤 2 在 Create a Service Policy and Apply To 区域：

a. 选择 Interface 将策略应用到某个特定接口，或者选择 Global 应用到所有接口。

b. 如果选择 Interface，请选择接口名称。如果接口已有策略，您可以向现有策略添加规则。

c. 如果接口没有服务策略，请输入新策略的名称。

d. （可选）输入策略说明。

e. 点击 Next。
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步骤 3 在 Traffic Classification Criteria 页面，选择以下某个选项，指定要应用策略操作的流量，然后点击 Next。

• Create a new traffic class。输入流量类名称和可选说明。

使用以下某个条件识别流量：

– Source and Destination IP Address (uses ACL) - 该类匹配扩展 ACL 指定的流量。如果 ASA 
正在透明防火墙模式下运行，您可以使用以太网类型 ACL。点击 Next 时，系统将提示您设
置访问控制条目的属性。向导将创建 ACL，您无法选择现有的 ACL。

定义 ACE 时， Match 选项创建一条规则，使操作应用于匹配这些地址的流量。 Do Not 
Match 选项可以使流量免于被应用指定的操作。例如，您想匹配 10.1.1.0/24 中的所有流量，
并应用连接限制，但 10.1.1.25 除外。在这种情况下，创建两条规则，使用 Match 选项为 
10.1.1.0/24 创建一条，使用 Do Not Match 为 10.1.1.25 创建一条。请务必安排这些规则，使 
Do Not Match 规则优先于 Match 规则，否则， 10.1.1.25 将首先匹配 Match 规则。

– TCP or UDP Destination Port - 该类匹配单一端口或连续的端口范围。点击 Next 时，系统将
提示您选择 TCP 或 UDP，并输入端口号；点击 ...，选择已在 ASDM 中定义的某个端口号。

提示 对于使用多个非连续端口的应用，请使用 Source and Destination IP Address (uses ACL) 匹配
每个端口。

• Add rule to existing traffic class。如果已在同一接口上有服务策略规则，或者正在向全局服务策
略添加规则，您可以通过此选项向现有 ACL 添加 ACE。您可以将 ACE 添加到您之前在为该接
口上的服务策略规则选择 Source and Destination IP Address (uses ACL) 选项时创建的任意 ACL。
对于该流量类，即使您添加多个 ACE，也只能有一组规则操作。您可以重复这一完整操作步
骤，将多个 ACE 添加到同一流量类。请参阅第 1-13 页的管理服务策略规则的顺序，了解有关
更改 ACE 顺序的详细信息。点击 Next 时，系统将提示您设置访问控制条目的属性。

• Use an existing traffic class。如果您创建了被不同接口上的规则使用的流量类，您可以重用该规
则的流量类定义。请注意，如果您更改某条规则的流量类，该更改将被所有使用该流量类的规
则继承。如果配置包含您在 CLI 上输入的任何 class-map 命令，则那些流量类名称也可用 （尽
管您需要创建规则，以查看流量类的定义）。

步骤 4 如果您选择了要求附加配置的流量匹配条件，请输入所需的参数并点击 Next。

步骤 5 在 Rule Actions 页面，配置一项或多项规则操作。

• 要配置 RADIUS 记账检测，请从 RADIUS Accounting Map 下拉列表选择检测映射，或者点击 
Configure 添加映射。有关详细信息，请参阅第 1-4 页的使用服务策略配置的功能。

• 要配置连接设置，请参阅第 13-7 页的配置连接设置。

步骤 6 点击 Finish。

管理服务策略规则的顺序

接口上或全局策略中的服务策略规则的顺序会影响将操作应用到流量的方式。请参阅以下准则，了
解数据包如何匹配服务策略中的规则：

• 数据包只能匹配每个功能类型的服务策略中的一条规则。

• 当数据包匹配一条包含某个功能类型的操作的规则时，ASA 不会尝试将其与任何包含该功能类
别的后续规则进行匹配。

• 然而，如果数据包匹配不同功能类型的后续规则， ASA 也会应用此后续规则的操作。

例如，如果数据包既匹配连接限制规则，也匹配应用检查规则，则两项规则的操作均会被应用。
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  服务策略历史
如果数据包匹配应用检测规则，但也匹配另一条包含应用检测的规则，则第二条规则的操作不会被
应用。

如果规则包含一个带多个 ACE 的 ACL， ACE 的顺序也会影响数据包流。 ASA 按照条目的列出顺
序，针对每个 ACE 测试数据包。发现某个匹配后，不再检查更多的 ACE。例如，如果您在明确允
许所有流量的 ACL 的开头创建 ACE，不再检查更多语句。

要更改规则顺序或规则中 ACE 的顺序，请执行以下步骤：

步骤 1 在 Configuration > Firewall > Service Policy Rules 窗格，选择想向上或向下移动的规则或 ACE。

步骤 2 点击 Move Up 或 Move Down 按钮。

图 1-1 移动 ACE

注 如果在多个服务策略中使用的 ACL 中重新排列 ACE，该更改将在所有服务策略中被继承。

步骤 3 重新排列规则或 ACE 后，点击 Apply。

服务策略历史

功能名称 版本 说明

模块化策略框架 7.0(1) 引入了模块化策略框架。

与 RADIUS 记账流量一起使用的管理类映射 7.2(1) 引入了管理类映射，与 RADIUS 记账流量一起使用。引入了以下
命令：class-map type management 和 inspect radius-accounting。

检测策略映射 7.2(1) 引入了检测策略映射。引入了以下命令：class-map type inspect。

正则表达式和策略映射 7.2(1) 引入了正则表达式和策略映射，在检测策略映射下使用。引入
了以下命令：class-map type regex、 regex、 match regex。

检测策略映射的 match any 命令 8.0(2) 引入了关键字 match any，与检测策略映射一起使用：流量可
以匹配一个或多个条件以匹配类映射。过去，仅 match all 命
令可用。
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2第 章
应用检测的特殊操作 （检测策略映射）

您可以使用模块化策略框架为许多应用检测配置特殊操作。当您在服务策略中启用检测引擎时，或
者还可以启用在检测策略映射中定义的操作。当检测策略映射与服务策略中定义了检测操作的流量
匹配时，将根据指定的操作处理该流量的子集 （例如，丢弃或限制速率）。

• 第 2-1 页的检测策略映射有关信息

• 第 2-2 页的准则和限制

• 第 2-2 页的默认检测策略映射

• 第 2-3 页的在检测策略映射中定义操作

• 第 2-3 页的在检测类映射中识别流量

• 第 2-3 页的更多信息指南

• 第 2-4 页的检测策略映射的功能历史

检测策略映射有关信息
有关支持检测策略映射的应用列表，请参阅第 8-8 页的配置应用层协议检测。

检测策略映射由下列一个或多个要素组成：检测策略映射的确切可用选项视应用而定。

• 流量匹配选项 - 您可以直接在检测策略映射中定义流量匹配选项，将应用流量与应用的特定条
件相匹配，例如 URL 字符串，然后为流量启用操作。

– 某些流量匹配选项可以指定正则表达式，以匹配数据包中的文本。请务必在配置策略映射
之前，在正则表达式类映射中单独或集中创建和测试正则表达式。

• 检测类映射 - 检测类映射包括多个流量匹配选项。然后，在策略映射中识别类映射，并针对整
个类映射启用操作。创建类映射和直接在检测策略映射中定义流量匹配的差别在于，您可以创
建更复杂的匹配条件和重用类映射。然而，您无法为不同的匹配设置不同操作。请注意，并非
所有检测都支持检测类映射。

• 参数 - 参数会影响检测引擎的行为。
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  准则和限制
准则和限制
• HTTP 检测策略映射 - 如果修改正在使用的 HTTP 检测策略映射，您必须移除并重新应用检测策

略映射操作，才能使更改生效。例如，如果修改 “http-map”检测策略映射，您必须移除、应
用修改，将检测策略映射从第 3/4 层策略重新添加到服务策略

• 所有检测策略映射 - 如果想用正在使用的检测策略映射交换不同的映射名称，必须删除、应用
更改，将新检测策略映射重新添加到服务策略

• 您可以在检测策略映射中指定多个检测类映射或直接匹配。

如果数据包匹配多个不同的 matches，ASA 应用操作的顺序将由内部 ASA 规则决定，而不是由
向检测策略映射添加的顺序决定。内部规则由应用类型和分解数据包的逻辑进展确定，并且不
可由用户配置。例如，对于 HTTP 流量，解析 Request Method 字段优先于解析 Header Host 
Length 字段；Request Method 字段的操作早于 Header Host Length 字段的操作。

如果操作丢弃数据包，在检测策略映射中将不会执行进一步操作。例如，如果第一个操作是重
置连接，它绝不会匹配任何更多匹配条件。如果第一个操作是记录数据包，则会发生第二个操
作，例如，重置连接。

如果数据包匹配多个相同的 match criteria，它们将会按照在策略映射中出现的顺序进行匹配。

会根据类映射中的最低优先级 match option （优先级基于内部规则）来确定某类映射是与另一
类映射同类型还是直接匹配。如果某个类映射与另一个类映射有同一类型的最低优先级匹配选
项，类映射将根据被添加到策略映射中采用的顺序被匹配。如果每个类映射的最低优先级匹配
不同，将会首先匹配具有较高优先级 match option 的类映射。

默认检测策略映射
默认情况下，启用 DNS 检测，使用 preset_dns_map 检测类映射：

• 最大 DNS 消息长度为 512 字节。

• 最大客户端 DNS 消息长度是自动设置的，以匹配资源记录。

• DNS 保护已启用，这样，一旦 ASA 转发 DNS 应答，ASA 就会断开与 DNS 查询相关的 DNS 会
话。另外， ASA 还监控消息交换，确保 DNS 回复 ID 匹配 DNS 查询 ID。

• 根据 NAT 配置的 DNS 记录转换已启用。

• 协议执行已启用，使得可以进行 DNS 消息格式检查 （具体检查内容包括：域名长度不得超过 
255 个字符，标签长度不得超过 63 个字符，压缩检查和循环指针检查）。

注 还存在其他默认检测策略映射，例如 _default_esmtp_map。例如， ESMTP 检测规则隐式地使用策
略映射 “_default_esmtp_map”。
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  在检测策略映射中定义操作
在检测策略映射中定义操作
当您在服务策略中启用检测引擎时，或者还可以启用在检测策略映射中定义的操作。

详细步骤

步骤 1 （可选）创建检测类映射。或者，您可以直接在策略映射中识别流量。请参阅第 2-3 页的在检测类
映射中识别流量。

步骤 2 （可选）对于支持正则表达式的策略映射类型，创建一个正则表达式。请参阅一般操作配置指南。

步骤 3 选择 Configuration > Firewall > Objects > Inspect Maps。

步骤 4 选择您想配置的检测类型。

步骤 5 点击 Add，添加新的检测策略映射。

步骤 6 按照检测章节中所选检测类型相关的说明操作。

在检测类映射中识别流量
此类型的类映射可以让您匹配某个应用特定的条件。例如，对于 DNS 流量，您可以匹配 DNS 查询
中的域名。

类映射可以将多个流量匹配聚集在一起（在 match-all 类映射中），或者让您匹配在匹配列表中的任
何一个 （在 match-any 类映射中）。创建类映射和直接在检测策略映射中定义流量的差别在于，类
映射可以让您将多个匹配命令聚集在一起并重用类映射。对于您在类映射中识别的流量，您可以指
定操作，例如丢弃、重置和/或在检测策略映射中记录连接。如果您想对不同类型的流量执行不同
操作，应当直接在策略映射中识别流量。

限制

并非所有应用都支持检测类映射。

详细步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps。

步骤 2 选择您想配置的检测类型。

步骤 3 点击 Add，添加新的检测类映射。

步骤 4 按照检测章节中所选检测类型相关的说明操作。

更多信息指南
要使用检测策略，请参阅第 1 章，“服务策略”。
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第 2 章      应用检测的特殊操作 （检测策略映射）

  检测策略映射的功能历史
检测策略映射的功能历史
表 2-1 列出了此功能的版本历史。

表 2-1 服务策略的功能历史

功能名称 版本 功能信息

检测策略映射 7.2(1) 引入了检测策略映射。引入了以下命令：class-map type 
inspect。

正则表达式和策略映射 7.2(1) 引入了正则表达式和策略映射，在检测策略映射下使用。
引入了以下命令：class-map type regex、 regex、 match 
regex。

检测策略映射的 Match any 命令 8.0(2) 引入了关键字 match any，与检测策略映射一起使用：流
量可以匹配一个或多个条件以匹配类映射。过去，仅 
match all 命令可用。
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3第 章
访问规则

本章描述如何使用访问规则，控制经由或至 ASA 的网络访问。在路由和透明防火墙模式下均可使
用访问规则控制网络访问。在透明模式下，可同时使用访问规则（适用于第 3 层流量）和以太网类
型规则 （适用于第 2 层流量）。

注 要访问用于管理访问的 ASA 接口，也不需要允许主机 IP 地址的访问规则。只需按照一般操作配置
指南配置管理访问。

• 第 3-1 页的控制网络访问

• 第 3-6 页的访问控制准则

• 第 3-6 页的配置访问控制

• 第 3-12 页的监控访问规则

• 第 3-13 页的访问规则历史记录

控制网络访问
访问规则确定允许哪些流量通过 ASA。有多个不同的规则层，这些规则层共同实施访问控制策略：

• 分配至接口的扩展访问规则 （第 3+ 层流量） - 可于入站和出站方向应用单独的规则集 (ACL)。
扩展访问规则根据源和目标流量条件允许或拒绝流量。

• 全局分配的扩展访问规则 - 可创建用作默认访问控制的单个全局规则集。全局规则在接口规则
之后应用。

• 管理访问规则（第 3+ 层流量） - 可应用单个规则集以覆盖接口处定向的流量，这通常是管理流
量。在 CLI 中，这些是 “控制平面”访问组。对于在设备处定向的 ICMP 流量，也可配置 
ICMP 规则。

• 分配至接口 （仅透明防火墙模式）的以太网类型规则 （第 2 层流量） - 可在入站和出站方向应
用单独的规则集。以太网类型规则控制针对非 IP 流量的网络访问。以太网类型规则根据以太网
类型允许或拒绝流量。

在透明防火墙模式下，可在相同的接口上整合使用扩展访问规则、管理访问规则和以太网类型规则。

• 第 3-2 页的有关规则的一般信息

• 第 3-4 页的扩展访问规则

• 第 3-5 页的以太网类型规则
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  控制网络访问
有关规则的一般信息

本节介绍有关访问规则和以太网类型规则的信息，包含以下主题：

• 第 3-2 页的接口访问规则和全局访问规则

• 第 3-2 页的入站和出站规则

• 第 3-3 页的规则顺序

• 第 3-3 页的隐式允许

• 第 3-4 页的隐式拒绝

• 第 3-4 页的 NAT 和访问规则

接口访问规则和全局访问规则 

可将访问规则应用于特定接口，也可将访问规则全局应用于所有接口。可结合接口访问规则配置全
局访问规则，在此情况下，特定入站接口访问规则始终在通用全局访问规则之前得以处理。全局访
问规则仅适用于入站流量。

入站和出站规则

可根据流量的方向配置访问规则：

• 入站 - 入站访问规则在流量进入接口时应用于流量。全局访问规则和管理访问规则始终为入站
规则。

• 出站 - 出站规则在流量离开接口时应用于流量。

注 “入站”和 “出站”是指 ACL 在接口上的应用，针对进入接口上 ASA 上的流量，或者离开接口上
的 ASA 的流量。这些术语不是指流量从较低安全性接口至较高安全性接口的移动 （通常称为入
站），或者流量从较高安全性接口至较低安全性接口的移动 （通常称为出站）。

出站 ACL 非常有用，例如，如果您想要仅允许内部网络上的某些主机访问外部网络上的某个网络
服务器。可创建仅允许指定主机的单个出站 ACL，而不是创建多个入站 ACL 以限制访问。（请参
阅下图。）出站 ACL 防止任何其他主机访问外部网络。
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第 3 章      访问规则

  控制网络访问
图 3-1 出站 ACL

规则顺序

规则顺序非常重要。在 ASA 决定是否转发或丢弃数据包时，ASA 将按规则在已应用 ACL 中列出的
顺序针对每条规则测试数据包。发现某个匹配后，不再检查其他规则。例如，如果在起始处创建的
访问规则显式允许某接口的所有流量，则将不检查更多的规则。

隐式允许

对于路由模式，将默认允许以下类型的流量通过：

• 从较高安全性接口流向较低安全性接口的单播 IPv4 和 IPv6 流量。

对于透明模式，将默认允许以下类型的流量通过：

• 从较高安全性接口流向较低安全性接口的单播 IPv4 和 IPv6 流量。

• 两个方向上的 ARP 流量。（可使用 ARP 检测控制 ARP 流量，但不能通过访问规则控制该流量。）

• 两个方向上的 BPDU 流量。

对于其他流量，需要使用扩展访问规则 （IPv4 和 IPv6）或以太网类型规则 （非 IP）。

Web Server:
209.165.200.225

Inside HR Eng

Outside

Static NAT
209.165.201.410.1.1.14

Static NAT
209.165.201.610.1.2.67 Static NAT

209.165.201.810.1.3.34

ACL Outbound
Permit HTTP from 10.1.1.14, 10.1.2.67,

and 10.1.3.34 to 209.165.200.225
Deny all others

ACL Inbound
Permit from any to any

ACL Inbound
Permit from any to any

ACL Inbound
Permit from any to any

ASA

33
38

23
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隐式拒绝

ACL 列表的末尾有隐式拒绝，因此，除非您显式允许流量，否则流量无法通过。例如，如果除特定
地址外，您想要允许所有用户通过 ASA 访问某个网络，则需要拒绝这些特定地址，然后允许所有
其他地址。

对于以太网类型 ACL，ACL 末尾处的隐式拒绝不会影响 IP 流量或 ARP 流量；例如，如果您允许以
太网类型 8037，则 ACL 末尾处的隐式拒绝此时将不阻止您先前使用扩展 ACL 允许的任何 IP 流量
（或者隐式允许的从较高安全性接口流向较低安全性接口的 IP 流量）。然而，如果您使用以太网类
型规则显式拒绝所有流量，则将拒绝 IP 和 ARP 流量，仅物理协议流量 （如自动协商流量）仍得以
允许。

如果配置全局访问规则，则全局规则之后的隐式拒绝得以处理。请参阅以下操作顺序：

1. 接口访问规则。

2. 全局访问规则。

3. 隐式拒绝。

NAT 和访问规则

在确定访问规则匹配时，访问规则始终将使用真实 IP 地址，即使您已配置 NAT。例如，如果已为
内部服务器 (10.1.1.5) 配置 NAT，以使该服务器在外部拥有公共可路由的 IP 地址 209.165.201.5，则
用于允许外部流量访问内部服务器的访问规则需要引用该服务器的真实 IP 地址 (10.1.1.5)，而非映
射地址 (209.165.201.5)。

扩展访问规则

本节介绍有关扩展访问规则的信息。

• 第 3-4 页的用于返回流量的扩展访问规则

• 第 3-4 页的使用访问规则允许通过透明防火墙的广播和组播流量

• 第 3-5 页的管理访问规则

用于返回流量的扩展访问规则

对于路由和透明模式的 TCP 和 UDP 连接，不需要访问规则即可允许返回流量，因为 ASA 允许已建
立的双向连接的所有返回流量。

然而，对于诸如 ICMP 的无连接协议，ASA 将建立单向会话，因此，您需要在两个方向访问规则以
允许 ICMP （通过将 ACL 应用于源和目标接口），或需要启用 ICMP 检测引擎。 ICMP 检测引擎将 
ICMP 会话视为双向连接。

使用访问规则允许通过透明防火墙的广播和组播流量

在路由防火墙模式下，包括不受支持的动态路由协议和 DHCP 在内的广播和组播流量均将被阻止，
即使已在访问规则中允许该流量 （除非配置 DHCP 中继）。透明防火墙模式可允许任何 IP 流量
通过。

注 由于这些特定类型的流量是无连接的，因此，您需要将访问规则应用于两个接口，以便允许返回流
量通过。
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下表列出了允许通过透明防火墙的常见流量类型。

管理访问规则

可配置控制以 ASA 为目标的管理流量的访问规则。入站管理流量（如通向接口的 HTTP、Telnet 和 
SSH 连接）的访问控制规则拥有的优先级高于使用管理访问规则。因此，将允许此类管理流量进
入，即使其被入站 ACL 显式拒绝。

或者，可使用 ICMP 规则控制流向设备的 ICMP 流量。使用正则扩展访问规则可控制通过设备的 
ICMP 流量。

以太网类型规则

本节介绍以太网类型规则。

• 第 3-5 页的受支持的以太网类型流量和其他流量

• 第 3-5 页的返回流量的以太网类型规则

• 第 3-6 页的允许 MPLS

受支持的以太网类型流量和其他流量

以太网类型规则控制以下内容：

• 通过 16 位十六进制数标识的以太网类型，包括常见类型的 IPX 和 MPLS 单播或组播。

• 以太网 V2 帧。

• 默认允许的 BPDU。 BPDU 为 SNAP 封装式， ASA 专用于处理 BPDU。

• Trunk 端口 （思科专有） BPDU。 Trunk BPDU 在负载内拥有 VLAN 信息，因此，如果允许 
BPDU，则 ASA 将使用出站 VLAN 修改负载。

• 中间系统至中间系统 (IS-IS)。

以下类型的流量不受支持：

• 802.3 格式化帧 - 规则将不处理这些帧，因为它们使用长度字段而不是类型字段。

返回流量的以太网类型规则

因为以太网类型是无连接的，所以，如果想要在两个方向上允许流量通过，则需要在两个接口上应
用规则。

表 3-1 透明防火墙的特定流量

流量类型 协议或端口 备注

DHCP UDP 端口 67 和 68 如果启用 DHCP 服务器，则 ASA 将不允许 
DHCP 数据包通过。

EIGRP 协议 88 -

OSPF 协议 89 -

组播流 UDP 端口因应用而异。 组播流始终以 D 类地址为目标 （224.0.0.0 至 
239.x.x.x）。

RIP （v1 或 v2） UDP 端口 520 -
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允许 MPLS

如果允许 MPLS，请将连接至 ASA 的两个 MPLS 路由器配置为将 ASA 接口上的 IP 地址用作 LDP 或 
TDP 会话的路由器 ID，从而确保标签分发协议和标记分发协议 TCP 连接通过 ASA 建立。（LDP 和 
TDP 允许 MPLS 路由器协商用于转发数据包的标签 （地址）。

在 Cisco IOS 路由器上，输入适合您的协议 LDP 或 TDP 的命令。 interface 为连接至 ASA 的接口。

hostname(config)# mpls ldp router-id interface force

或

hostname(config)# tag-switching tdp router-id interface force

访问控制准则

IPv6 准则

支持 IPv6。（9.0 及更高版本）源和目标地址可能包括 IPv4 和 IPv6 地址的任意混合。对于 9.0 之前
的版本，必须创建单独的 IPv6 访问规则。

每用户 ACL 准则

• 每用户 ACL 使用 timeout uauth 命令中的值，但该值可由 AAA 每用户会话超时值覆盖。

• 如果由于每用户 ACL 而拒绝流量，则将记录系统日志消息 109025。如果允许流量，则将不生
成系统日志消息。每用户 ACL 中的 log 选项将不产生影响。

附加准则和限制

• 通过启用对象组搜索，可减少搜索访问规则所需的内存，但这将以降低规则查找性能为代价。
已启用的对象组搜索将不展开网络对象，而是根据这些组定义搜索匹配的访问规则。可设置此
选项，只需点击访问规则表下方的 Advanced 按钮。

• 可使用访问组的事务提交模型，从而提高系统性能和可靠性。请参阅一般操作配置指南中的基
本设置章节，了解详细信息。该选项位于 Configurations > Device Management > Advanced > 
Rule Engine 下方。

• 在 ASDM 中，规则描述基于出现在 ACL 中规则之前的访问列表注释，对于在 ASDM 中创建的
新规则，任何描述均将配置为相关规则之前的注释。然而， ASDM 中的数据包跟踪器匹配在 
CLI 中在匹配规则之后配置的注释。

配置访问控制
以下主题解释如何配置访问控制。

• 第 3-7 页的配置访问规则

• 第 3-10 页的配置管理访问规则

• 第 3-10 页的配置以太网类型规则 （仅透明模式）

• 第 3-11 页的配置 ICMP 访问规则
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配置访问规则

要应用访问规则，请执行以下步骤。

操作步骤

步骤 1 选择 Configuration > Firewall > Access Rules。

规则按接口和方向排列，全局规则另行分组。如果配置管理访问规则，则它们将在此页面上重复出
现。这些分组等同于已创建并分配至接口或作为访问组全局性分配的扩展 ACL。这些 ACL 也显示
在 ACL Manager 页面上。

步骤 2 执行以下任意操作：

• 要添加新规则，选择 Add > Add Access Rule。

• 要在容器内的特定位置插入规则，请选择现有规则，并选择 Add > Insert 以便在该规则上方添
加规则，或选择 Add > Insert After。

• 要编辑规则，请选择并点击 Edit。

步骤 3 填写规则属性。要选择的主要选项为：

• Interface - 要将规则应用至的接口。选择 Any 以创建全局规则。

• Action: Permit/Deny - 您是允许所述流量还是拒绝 （丢弃）它。

• Source/Destination criteria - 源 （源地址）和目标 （流量的目标地址）的定义。您通常配置主
机或子网的 IPv4 或 IPv6 地址，这些地址可用网络或网络对象组表示。还可指定源地址的用户
或用户组名称。此外，如果您想要规则更严格，而不是作用于所有 IP 流量，则可使用 Service 
字段来确定特定流量类型。如果实施 Trustsec，则可使用安全组定义源和目标地址。

有关所有可用选项的详细信息，请参阅第 3-7 页的访问规则属性。

定义规则完毕，请点击 OK 以将规则添加至表。

步骤 4 点击 Apply，以将访问规则保存至您的配置。

访问规则属性

添加或编辑访问规则时，可配置以下属性。在许多字段中，可点击编辑框右侧的 “...”按钮，以选
择、创建或编辑可用于该字段的对象。

• Interface - 要将规则应用至的接口。选择 Any 以创建全局规则。

• Action: Permit/Deny - 您是允许所述流量还是拒绝 （丢弃）它。

• Source Criteria - 您尝试匹配的流量发起方的特性。您必须配置 Source，但其他属性为可选属性。

– Source - 源地址的 IPv4 或 IPv6 地址。默认值为 any，该值匹配所有 IPv4 或 IPv6 地址；可
使用 any4 以仅将 IPv4 作为目标地址，也可使用 any6 以仅将 IPv6 地址作为目标地址。可指
定单个主机地址 （如 10.100.10.5 或 2001:DB8::0DB8:800:200C:417A）、子网 （以 
10.100.10.0/24 或 10.100.10.0/255.255.255.0 格式，或者对于 IPv6，以 2001:DB8:0:CD30::/60 
格式）、网络对象或网络对象组的名称，或者接口的名称。

– User - 如果启用标识防火墙，则可将用户或用户组指定为流量源。用户目前正在使用的 IP 
地址将与规则匹配。可指定用户名 (DOMAIN\user)、用户组 （DOMAIN\\group，请注意指
示组名称的两个 \）或用户对象组。对于该字段，点击 “...”从 AAA 服务器组选择名称比
键入名称容易得多。
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– Security Group - 如果启用 Cisco Trustsec，则可指定安全组名称或标记 (1-65533)，或安全组
对象。

– More Options > Source Service - 如果将 TCP 或 UDP 指定为目标服务，或者可以为 TCP、
UDP 或 TCP-UDP 指定预定义服务对象，或使用您自己的对象。通常，可仅定义目标服务，
不定义源服务。请注意，如果定义源服务，则目标服务协议必须与其匹配 （例如，都为 
TCP，带或不带端口定义）。

• Destination Criteria - 您尝试匹配的流量目标的特性。必须配置 Destination，但其他属性为可选
属性。

– Destination - 目标的 IPv4 或 IPv6 地址。默认值为 any，该值匹配所有 IPv4 或 IPv6 地址；可
使用 any4 以仅将 IPv4 作为目标地址，也可使用 any6 以仅将 IPv6 地址作为目标地址。可指
定单个主机地址 （如 10.100.10.5 或 2001:DB8::0DB8:800:200C:417A）、子网 （以 
10.100.10.0/24 或 10.100.10.0/255.255.255.0 格式，或者对于 IPv6，以 2001:DB8:0:CD30::/60 
格式）、网络对象或网络对象组的名称，或者接口的名称。

– Security Group - 如果启用 Cisco Trustsec，则可指定安全组名称或标记 (1-65533)，或安全组
对象。

– Service - 流量的协议（如 IP、TCP、UDP），或者指 TCP 和 UDP 端口。默认值为 IP，但可
选择更具体的协议以将更精细的流量作为目标。通常，您将选择一些类型的服务对象。对
于 TCP 和 UDP，您可指定端口，例如 tcp/80、 tcp/http、 tcp/10-20 （用于一系列的端口）、
tcp-udp/80 （匹配端口 80 上的任何 TCP 或 UDP 流量）等。

• Description - 规则用途的解释，每行最多 100 个字符。可输入多行；每行均在 CLI 中作为注释
添加，注释将放置在规则之前。

注 如果在一个平台 （如 Windows）上使用非英文字符添加注释，然后在另一平台 （如 
Linux）中尝试将其移除，则可能无法对其进行编辑或删除，因为原始字符可能无法得
以正确识别。由于基础平台依赖性将以不同的方式对不同的语言字符进行编码，于是便
有了该限制。

• Enable Logging; Logging Level; More Options > Logging Interval - 日志记录选项定义如何为规
则生成系统日志消息。可实施以下日志记录选项：

– Deselect Enable Logging - 这将禁用规则的日志记录。对于匹配该规则的流量，将不会发布
任何类型的系统日志消息。

– Select Enable Logging with Logging Level = Default - 这将为规则提供默认的日志记录。将为
每个被拒绝的数据包发布系统日志消息 106023。如果设备受到攻击，发布此消息的频率将
影响服务。

– Select Enable Logging with Non-Default Logging Level - 这将提供汇总的系统日志消息 
106100，而不是 106023。消息 106100 在规则首次命中时发布，然后按在 More Options > 
Logging Interval 中配置的每个间隔 （默认值为每 300 秒，可指定 1-600 之间的值）再次发
布，显示该间隔期间的命中次数。建议的日志记录级别为 Informational。

汇总拒绝消息可降低攻击之影响，且可能使分析消息变更更容易。如果您确实遭受拒绝服
务攻击，则可能看到消息 106101，该消息指示，用于为消息 106100 生成命中计数的缓存拒
绝流的数量已超过间隔的最大数量。此时，设备将停止收集统计信息，直至下一间隔，以
便缓解攻击。

• More Options > Traffic Direction - 规则是用于 In 方向还是用于 Out 方向。 In 是默认值，对于
全局和管理访问规则，它是唯一选项。
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• More Options > Enable Rule - 规则在设备上是否处于活动状态。已禁用的规则在规则表中显示
为带删除线的文本。禁用规则后，即可停止将其应用于流量，而无需将其删除，因此，如果您
决定需要它，则可以以后再次启用它。

• More Options > Time Range - 时间范围对象的名称，该对象定义在一周的哪些天、一天的哪些
时间该规则应处于活动状态。如未指定时间范围，则规则始终处于活动状态。

为访问规则配置高级选项

高级访问规则选项可供您自定义规则行为的某些方面，但这些选项拥有适用于大多数情况的默认值。

步骤 1 选择 Configuration > Firewall > Access Rules。

步骤 2 点击规则表下方的 Advanced 按钮。

步骤 3 根据需要配置以下选项：

• Advanced Logging Settings - 如果配置非默认日志记录，则系统将缓存拒绝流，以便生成消息 
106100 的统计信息，如第 3-12 页的评估访问规则的系统日志消息中所述。为防止无限制地消耗
内存和 CPU 资源， ASA 将限制并发拒绝流的数量，因为它们可能是潜在的攻击。到达该限制
时，将会发布消息 106101。可控制与消息 106101 相关的以下方面。

– Maximum Deny-flows - ASA 停止缓存流之前允许的拒绝流的最大数量，介于 1 至 4094 之
间。默认值为 4096。

– Alert Interval - 发布系统日志消息 106101 的间隔时长（1-3600 秒），该消息指示已达到拒绝
流的最大数量。默认值为 300 秒。

• Per User Override table - 对于从 RADIUS 服务器下载用于用户授权的动态用户 ACL，是否允许
其覆盖已分配至接口的 ACL。例如，如果接口 ACL 拒绝来自 10.0.0.0 的所有流量，但动态 ACL 
允许来自 10.0.0.0 的所有流量，则动态 ACL 将覆盖该用户的接口 ACL。对于应允许用户覆盖的
每个接口 （仅入站方向），请选择 Per User Override 复选框。如已禁用每用户覆盖功能，则 
RADIUS 服务器提供的访问规则将与在该接口上配置的访问规则相组合。

默认情况下，将不针对接口 ACL 匹配 VPN 远程访问流量。然而，如果您在 Configuration > 
Remote Access VPN > Network (Client) Access > AnyConnect Connection Profiles 窗格上取消选择 
Enable inbound VPN sessions to bypass interface access lists 设置，则该行为将取决于是否在组
策略中应用了 VPN 过滤器 （请参阅 Configuration > Remote Access VPN > Network (Client) 
Access > Group Policies > Add/Edit > General > More Options > Filter 字段），以及您是否设置了 
Per User Override 选项：

– No Per User Override, no VPN filter - 针对接口 ACL 匹配流量。

– No Per User Override, VPN filter - 依次针对接口 ACL 和 VPN 过滤器匹配流量。

– Per User Override, VPN filter - 仅针对 VPN 过滤器匹配流量。

• Object Group Search Setting - 通过选择 Enable Object Group Search Algorithm，您可减少搜索
使用了对象组的访问规则所需的内存，但这将以降低规则查找性能为代价。已启用的对象组搜
索将不展开网络对象，而是根据这些组定义搜索匹配的访问规则。

步骤 4 点击 OK。
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配置管理访问规则

可配置一个接口 ACL，该 ACL 控制从特定对等设备（或对等设备集）流向 ASA 的入站管理流量。
在一种情况下，此类型 ACL 非常有用，即当您想要阻止 IKE 拒绝服务攻击时。

要配置允许或拒绝入站流量数据包的扩展 ACL，请执行以下步骤。

步骤 1 选择 Configuration > Device Management > Management Access > Management Access Rules。

规则将按接口进行排列。每个分组等同于作为控制平面 ACL 创建并分配至接口的扩展 ACL。这些 
ACL 也将显示在 Access Rules 和 ACL Manager 页面上。

步骤 2 执行以下任意操作：

• 要添加新规则，请选择 Add > Add Management Access Rule。

• 要在容器内的特定位置插入规则，请选择现有规则，并选择 Add > Insert 以便在该规则上方添
加规则，或选择 Add > Insert After。

• 要编辑规则，请选择并点击 Edit。

步骤 3 填写规则属性。要选择的主要选项为：

• Interface - 要将规则应用至的接口。

• Action: Permit/Deny - 您是允许所述流量还是拒绝 （丢弃）它。

• Source/Destination criteria - 源 （源地址）和目标 （流量的目标地址）的定义。您通常配置主
机或子网的 IPv4 或 IPv6 地址，这些地址可用网络或网络对象组表示。还可指定源地址的用户
或用户组名称。此外，如果您想要规则更严格，而不是作用于所有 IP 流量，则可使用 Service 
字段来确定特定流量类型。如果实施 Trustsec，则可使用安全组定义源和目标地址。

有关所有可用选项的详细信息，请参阅第 3-7 页的访问规则属性。

定义规则完毕，请点击 OK 以将规则添加至表。

步骤 4 点击 Apply，以将规则保存至您的配置。

配置以太网类型规则 （仅透明模式）

以太网类型规则将在透明防火墙模式下应用于非 IP 的第 2 层流量。可使用这些规则根据第 2 层数据
包中的以太网类型值允许或丢弃流量。借助于以太网类型规则，可控制流经 ASA 的非 IP 流量。

在透明模式下，可同时将扩展和以太网类型访问规则应用于接口。以太网类型规则优先于扩展访问
规则。

要添加以太网类型规则，请执行以下步骤。

步骤 1 选择 Configuration > Firewall > EtherType Rules。

规则按接口和方向排列。每个分组等同于已创建并分配至接口的以太网类型 ACL。

步骤 2 执行以下任意操作：

• 要添加新规则，请选择 Add > Add EtherType Rule。

• 要在容器内的特定位置插入规则，请选择现有规则，并选择 Add > Insert 以便在该规则上方添
加规则，或选择 Add > Insert After。

• 要编辑规则，请选择并点击 Edit。
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步骤 3 填写规则属性。要选择的主要选项为：

• Interface - 要将规则应用至的接口。

• Action: Permit/Deny - 您是允许所述流量还是拒绝 （丢弃）它。

• EtherType - 可使用以下选项来匹配流量：

– ipx - 互联网数据包交换 (IPX)。

– bpdu - 默认允许的网桥协议数据单元。

– mpls-multicast - MPLS 组播。

– mpls-unicast - MPLS 单播。

– isis - 中间系统至中间系统 (IS-IS)。

– any - 匹配所有流量。

– hex_number - 可通过 16 位十六进制数 0x600 至 0xffff 标识的任何以太网类型。请参阅 
http://www.ietf.org/rfc/rfc1700.txt 中 RFC 1700，“分配的编号”，了解以太网类型列表。

• Description - 规则用途的解释，每行最多 100 个字符。可输入多行；每行均在 CLI 中作为注释
添加，注释将放置在规则之前。

• More Options > Direction - 规则是用于 In 方向还是用于 Out 方向。 In 为默认值。

定义规则完毕，请点击 OK 以将规则添加至表。

步骤 4 点击 Apply，以将规则保存至您的配置。

配置 ICMP 访问规则

默认情况下，可使用 IPv4 或 IPv6 向任何 ASA 接口发送 ICMP 数据包，以下情况例外：

• ASA 不响应定向至广播地址的 ICMP 回显请求。

• ASA 仅响应发送至流量进入的接口的 ICMP 流量；不能通过某个接口将 ICMP 流量发送至远端
接口。

要保护设备免受攻击，可使用 ICMP 规则将对 ASA 接口的 ICMP 访问限制为特定主机、网络或 
ICMP 类型。 ICMP 规则的工作原理与访问规则类似，将对规则进行排序，与数据包匹配的第一条
规则将定义操作。

如为某个接口配置任何 ICMP 规则，则将隐式拒绝 ICMP 规则添加至 ICMP 规则列表的末尾，从而
更改默认行为。因此，如果想要仅拒绝几种消息类型，则须在 ICMP 规则列表的末尾纳入一条允许
任何消息类型的规则，以便允许剩余的消息类型。

我们建议，始终为 ICMP 不可到达消息类型 （类型 3）授予权限。拒绝 ICMP 不可到达消息将禁用 
ICMP 路径 MTU 发现，这可能停止 IPsec 和 PPTP 流量。此外，IPv6 中的 ICMP 数据包用于 IPv6 邻
居发现进程。请参阅 RFC 1195 和 RFC 1435，了解有关路径 MTU 发现的详细信息。

操作步骤

步骤 1 选择 Configuration > Device Management > Management Access > ICMP。

步骤 2 配置 ICMP 规则：

a. 添加规则 （Add > Rule、 Add > IPv6 Rule 或 Add > Insert），或者选择并编辑一条规则。

b. 选择要控制的 ICMP 类型，或选择 any 以应用于所有类型。
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c. 选择要将规则应用至的接口。必须为每个接口创建单独的规则。

d. 选择是允许还是拒绝匹配流量的访问。

e. 选择 Any Address，以将规则应用于所有流量。或者，输入您正尝试控制的主机或网络的地址
与掩码 （适用于 IPv4），或地址与前缀长度 （适用于 IPv6）。

f. 点击 OK。

步骤 3 （可选）要设置 ICMP 不可到达消息限制，请设置以下选项。要允许将 ASA 显示为跃点之一的跟踪
路由通过 ASA，需要在服务策略中提高速率限制，并启用 Decrement time to live for a connection 选
项（在 Configuration > Firewall > Service Policy Rules > Rule Actions > Connection Settings 对话框上）。

• Rate Limit - 设置不可到达消息的速率限制，该限制介于每秒 1 至 100 条消息之间。默认值为每
秒 1 条消息。

• Burst Size - 设置突发速率，该速率介于 1 至 10 之间。系统目前未使用该关键字，因此，可选
择任何值。

步骤 4 点击 Apply。

监控访问规则
Access Rules 页面包含每条规则的命中计数。将鼠标指针悬停在命中计数之上，即可查看计数的更
新时间和间隔。要重置命中计数，右键单击规则，然后选择 Clear Hit Count，但请注意，这将清除
应用至相同接口相同方向的所有规则的计数。

评估访问规则的系统日志消息

使用系统日志事件查看器，如 ASDM 中的查看器，查看与访问规则相关的消息。

如果使用默认日志记录，则只会看到与显式拒绝的流对应的系统日志消息 106023。将不记录与规则
列表末尾的 “隐式拒绝”条目匹配的流量。

如果 ASA 受到攻击，则表明已拒绝数据包的系统日志消息数量可能十分庞大。我们建议您转而启
用使用系统日志消息 106100 的日志记录，该记录提供每条规则 （包括允许规则）的统计信息，且
可使您限制所生成的系统日志消息的数量。或者，您可禁用给定规则的所有日志记录。

为消息 106100 启用日志记录时，如果数据包与 ACE 匹配，则 ASA 将创建流条目以跟踪特定间隔内
收到的数据包的数量。ASA 将在首次命中以及在每个间隔结束时生成系统日志消息，从而确定间隔
期间总命中数量和最后一个命中的时间戳。在每个间隔结束时， ASA 将命中计数重置为 0。如在间
隔期间没有与 ACE 匹配的数据包，则 ASA 将删除流条目。为规则配置日志记录时，可控制间隔，
甚至可控制每条规则的日志消息的严重性级别。

流是按源与目标 IP 地址、协议和端口定义的。由于对于相同两台主机之间的新连接而言源端口可
能不同，且为该连接创建了新的流，因此，可能看不到相同的流递增。

不需要针对 ACL 检查属于已建立连接的已允许数据包；仅初始数据包将得以记录并纳入命中计数
中。对于无连接的协议 （如 ICMP），所有数据包均得以记录，即使它们是被允许的数据包，且所
有已拒绝数据包均得以记录。

有关这些消息的详细信息，请参阅系统日志消息指南。
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提示 为消息 106100 启用日志记录时，如果数据包与 ACE 匹配，则 ASA 将创建流条目以跟踪特定间隔内
收到的数据包的数量。对于 ACE， ASA 拥有最大为 32 K 的日志记录流。在任何时间点，都可能有
大量的流同时存在。为防止无限制地消耗内存和 CPU 资源， ASA 将限制并发拒绝流的数量，仅对
拒绝流施加该限制（不施加于允许流），因为它们可能是潜在攻击。达到限制时，ASA 将不为日志
记录创建新的拒绝流，直至现有流到期，并且发布消息 106101。可在高级设置中控制该消息的频率
和缓存的拒绝流的最大数量；请参阅第 3-9 页的为访问规则配置高级选项。

访问规则历史记录

功能名称 平台版本 说明

接口访问规则 7.0(1) 使用 ACL 控制经由 ASA 的网络访问。

我们引入了以下屏幕：Configuration > Firewall > Access Rules。

全局访问规则 8.3(1) 引入了全局访问规则。

我们修改了以下屏幕：Configuration > Firewall > Access Rules。

标识防火墙的支持 8.4(2) 现可将标识防火墙用户和组用于源和目标。可将标识防火墙 ACL 
与访问规则、 AAA 规则组合使用，及用于 VPN 身份验证。

IS-IS 流量的以太网类型 ACL 支持 8.4(5)、
9.1(2)

在透明防火墙模式下，ASA 现可使用以太网类型 ACL 允许 IS-IS 
流量通过。

我们修改了以下屏幕：Configuration > Device Management > 
Management Access > EtherType Rules。

对 TrustSec 的支持 9.0(1) 现可将 TrustSec 安全组用于源和目标。可将标识防火墙 ACL 与访
问规则组合使用。

适用于 IPv4 和 IPv6 的统一 ACL 9.0(1) ACL 现支持 IPv4 和 IPv6 地址。甚至可为源和目标指定 IPv4 和 
IPv6 地址的混合。已将 any 关键字更改为代表 IPv4 和 IPv6 流量。
已添加 any4 和 any6 关键字，分别用于代表纯 IPv4 和纯 IPv6 流
量。 IPv6 特定 ACL 已弃用。现有 IPv6 ACL 已迁移至扩展 ACL。
有关迁移的详细信息，请参阅版本说明。

我们修改了以下屏幕：

Configuration > Firewall > Access Rules
Configuration > Remote Access VPN > Network (Client) Access > 
Group Policies > General > More Options 

用于按 ICMP 代码过滤 ICMP 流量的扩
展 ACL 和对象增强

9.0(1) 现可根据 ICMP 代码允许/拒绝 ICMP 流量。

我们引入或修改了以下屏幕：

Configuration > Firewall > Objects > Service Objects/Groups
Configuration > Firewall > Access Rule 

基于访问组规则引擎的事务提交模型 9.1(5) 启用时，规则更新将在规则编译完成后应用，而不影响规则匹配
性能。

我们引入了以下屏幕：Configuration > Device Management > 
Advanced > Rule Engine。
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4第 章
公共服务器

本节描述如何配置公共服务器。

• 第 4-1 页的有关公共服务器的信息

• 第 4-1 页的公共服务器许可要求

• 第 4-2 页的准则和限制

• 第 4-2 页的添加可启用静态 NAT 的公共服务器

• 第 4-2 页的添加可启用带有 PAT 功能的静态 NAT 的公共服务器

• 第 4-3 页的编辑公共服务器的设置

• 第 4-4 页的公共服务器的功能历史

有关公共服务器的信息
管理员可通过 Public Servers 窗格允许内部用户和外部用户访问各种应用服务器。该窗格显示了一个
公共服务器的列表，内部和外部地址、内部或外部地址适用的接口，转换地址的功能和所显示的服
务。您可以添加、编辑、删除或修改现有公共服务器的设置。

公共服务器许可要求

型号 许可证要求

ASAv 标准或高级许可证。

所有其他型号 基础许可证。
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准则和限制
此节包括该功能的指导原则和限制。

情景模式准则

在单一和多情景模式下受支持。

防火墙模式准则

在路由和透明防火墙模式下受支持。

添加可启用静态 NAT 的公共服务器
要添加可启用静态 NAT 的公共服务器并创建从实际地址到映射地址的固定转换，请执行以下步骤：

步骤 1 在 Configuration > Firewall > Public Servers 窗格中，点击 Add，添加新服务器。

系统将显示 Add Public Server 对话框。

步骤 2 从 Private Interface 下拉菜单中，选择与真实服务器连接的专用接口的名称。

步骤 3 在 Private IP address 字段中，输入服务器的真实 IP 地址 （仅限 IPv4）。

步骤 4 在 Private Service 字段中，点击 Browse 显示 Browse Service 对话框，选择在外部可见的实际服务并
点击 OK。

或者，可以从 Browse Service 对话框中，点击 Add，创建新的服务或服务组。可对外开放来自各个
端口的多种服务。有关服务对象和服务组的详细信息，请参阅一般操作配置指南。

步骤 5 从 Public Interface 下拉菜单中，输入用户可从外部访问真实服务器的接口。

步骤 6 在 Public Address 字段中，输入外部用户所看到的服务器的映射 IP 地址。

步骤 7 （可选）要启用静态 PAT，请选中 Specify if Public Service is different from private service 复选框。

步骤 8 点击 OK。系统在主窗格中显示配置。

步骤 9 点击 Apply，生成静态 NAT 和流量的相应访问规则并保存此配置。

有关静态 NAT 的详细信息，请参阅第 5-3 页的关于静态 NAT。

添加可启用带有 PAT 功能的静态 NAT 的公共服务器
要添加可用于指定端口的实际协议和映射协议 （TCP 或 UDP ）的公共服务器，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > Public Servers，然后点击 Add。

系统将显示 Add Public Server 对话框。

步骤 2 从 Private Interface 下拉菜单中，选择与真实服务器连接的专用接口的名称。

步骤 3 在 Private IP address 字段中，输入服务器的真实 IP 地址 （仅支持 IPv4）。

步骤 4 在 Private Service 字段中，点击 Browse，显示浏览服务对话框。
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步骤 5 选择在外部可见的实际服务并点击 OK。

或者，可以从 Browse Service 对话框中，点击 Add，创建新的服务或服务组。可对外开放来自各个
端口的多种服务。有关服务对象和服务组的详细信息，请参阅一般操作配置指南。

步骤 6 从 Public Interface 下拉菜单中，输入用户可从外部访问真实服务器的接口。

步骤 7 在 Public Address 字段中，输入外部用户所看到的服务器的映射 IP 地址。

步骤 8 选中 Specify Public Service if different from Private Service 复选框，启用静态 PAT。

步骤 9 在 Public Service 字段中，输入映射的协议（仅限 TCP 或 UDP ），或点击 Browse，从列表中选择一
个协议。

步骤 10 点击 OK。

步骤 11 点击 Apply，生成带有 PAT 功能的静态 NAT 和相应的流量访问规则，并保存此配置。

有关带有端口地址转换功能的静态 NAT 的详细信息，请参阅第 5-4 页的带端口转换的静态 NAT。

编辑公共服务器的设置
要编辑公共服务器的设置，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > Public Servers，选择一个现有公共服务器，然后点击 Edit。

系统将显示 Edit Public Server 对话框。

步骤 2 对以下设置进行必要的更改：

• Private Interface - 与真实服务器连接的接口。

• Private IP Address - 服务器的实际 IP 地址。

• Private Service - 在真实服务器上运行的实际服务。

• Public Interface - 外部用户可访问真实服务器的接口。

• Public Address - 外部用户所看到的 IP 地址。

• Public Service - 转换地址上所运行的服务。点击 Information 图标，查看有关所支持的公共服务
的详细信息。

步骤 3 点击 OK，然后点击 Apply 保存更改。
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公共服务器的功能历史
表 4-1 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

表 4-1 公共服务器的功能历史

功能名称 平台版本 功能信息

公共服务器 8.3(1) 公共服务器允许内部用户和外部用户访问各种应用服务器。

引入了以下屏幕：

Configuration > Firewall > Public Servers
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5第 章
网络地址转换 (NAT) （ASA 8.3 及更高版本）

本章概述网络地址转换 (NAT) 在 ASA 上的工作原理。

• 第 5-1 页的为何使用 NAT？

• 第 5-2 页的 NAT 术语

• 第 5-2 页的 NAT 类型

• 第 5-11 页的路由和透明模式下的 NAT

• 第 5-13 页的 NAT 和 IPv6

• 第 5-13 页的如何实施 NAT 

• 第 5-18 页的 NAT 规则顺序

• 第 5-19 页的 NAT 接口

• 第 5-19 页的路由 NAT 数据包

• 第 5-23 页的面向 VPN 的 NAT

• 第 5-29 页的 DNS 和 NAT

• 第 5-34 页的更多信息指南

注 要开始配置 NAT，请参阅第 6 章，“网络对象 NAT （ASA 8.3 及更高版本）” 或第 7 章，“两次 
NAT （ASA 8.3 及更高版本）”。

为何使用 NAT？
IP 网络中的每台计算机和设备都分配了标识主机的唯一 IP 地址。因为缺乏公用 IPv4 地址，所以这
些 IP 地址中的大多数都是专用地址，在专用公司网络以外的任何地方都不可路由。 RFC 1918 定义
可以在内部使用但不应通告的专用 IP 地址：

• 10.0.0.0 到 10.255.255.255

• 172.16.0.0 到 172.31.255.255

• 192.168.0.0 到 192.168.255.255

NAT 的主要功能之一是使专用 IP 网络可以连接到互联网。NAT 用公用 IP 地址替换专用 IP 地址，将
内部专用网络中的专用地址转换为可在公用互联网上使用的合法的可路由地址。NAT 以此方式保存
公用地址，因为它可配置为至少仅将整个网络的一个公用地址向外界通告。
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  NAT 术语
NAT 的其他功能包括：

• 安全 - 隐藏内部 IP 地址可以阻止直接攻击。

• IP 路由解决方案 - 使用 NAT 时不会出现重叠 IP 地址。

• 灵活性 - 可以更改内部 IP 寻址方案，而不影响外部的可用公用地址；例如，对于可以访问互联
网的服务器，您可以维护供互联网使用的固定 IP 地址，但在内部，您可以更改服务器地址。

• 在 IPv4 和 IPv6 之间转换（仅路由模式）（9.0(1) 及更高版本）- 如果想将 IPv6 网络连接到 IPv4 
网络，可以利用 NAT 在两种类型的地址之间转换。

注 不需要 NAT。如果不为一组给定流量配置 NAT，将不转换这些流量，但会正常应用所有安全策略。

NAT 术语
本文档使用以下术语：

• 实际地址/主机/网络/接口 - 实际地址是指在主机上定义的转换前地址。在内部网络访问外部网
络时，您想转换内部网络的典型 NAT 场景中，内部网络会成为 “实际”网络。请注意，您可
以转换任何连接到 ASA 的网络，不仅仅是内部网络。因此，如果配置 NAT 以转换外部地址，
“实际”指的是访问内部网络时的外部网络。

• 映射地址/主机/网络/接口 - 映射地址是指实际地址转换而成的地址。在内部网络访问外部网络
时，您想转换内部网络的典型 NAT 场景中，外部网络会成为 “映射”网络。

注 在地址转换过程中，不会转换驻留在 ASA 的接口上的 IP 地址。

• 双向发起 - 静态 NAT 允许双向发起连接，意味着发起到主机和从主机发起。

• 源 NAT 和目标 NAT - 对于任何给定数据包，将源 IP 地址和目标 IP 地址与 NAT 规则进行比较，
转换/不转换一个或两个地址。对于静态 NAT，规则是双向的，因此，请注意，整个本指南中
命令和描述中使用的 “源”和 “目标”，即便是给定的连接，也可能源自 “目标”地址。

NAT 类型
以下主题介绍各种类型的 NAT。

• 第 5-3 页的 NAT 类型概述

• 第 5-3 页的静态 NAT

• 第 5-8 页的动态 NAT

• 第 5-9 页的动态 PAT

• 第 5-11 页的身份标识 NAT
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  NAT 类型
NAT 类型概述

可以使用以下方法实施 NAT：

• 静态 NAT - 实际 IP 地址和映射 IP 地址之间的一致映射。允许双向流量发起。请参阅第 5-3 页的
静态 NAT。

• 动态 NAT - 按先到先得的方式，将一组实际 IP 地址映射到一组映射 IP 地址（通常较小）。仅实
际主机可以发起流量。请参阅第 5-8 页的动态 NAT。

• 动态端口地址转换 (PAT) - 使用 IP 地址的唯一源端口，将一组实际 IP 地址映射到单一 IP 地址。
请参阅第 5-9 页的动态 PAT。

• 身份标识 NAT - 系统将实际地址静态转换为其本身，基本绕过 NAT。当您想转换一大组地址，
但又想免除一个较小的地址子集时，可能想这样配置 NAT。请参阅第 5-11 页的身份标识 NAT。

静态 NAT
以下主题介绍静态 NAT。

• 第 5-3 页的关于静态 NAT

• 第 5-4 页的带端口转换的静态 NAT

• 第 5-6 页的一对多静态 NAT

• 第 5-7 页的其他映射场景 （不推荐）

关于静态 NAT

静态 NAT 创建实际地址到映射地址的固定转换。因为映射地址对于每个连续连接都是相同的，所
以静态 NAT 允许双向连接发起，即到主机发起和从主机发起 （如果有允许这样做的访问规则）。
另一方面，通过动态 NAT 和 PAT，每台主机为每次后续转换使用不同的地址或端口，因此，不支持
双向发起。

下图显示了典型的静态 NAT 场景。转换始终处于活动状态，所以，实际主机和远程主机可以发起
连接。

图 5-1 静态 NAT

注 如果需要，可以禁用双向性。
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带端口转换的静态 NAT

通过带端口转换的静态 NAT，您可以指定实际和映射协议 （TCP 或 UDP）及端口。

• 第 5-4 页的关于带端口地址转换的静态 NAT

• 第 5-5 页的带身份端口转换的静态 NAT

• 第 5-5 页的面向非标准端口的带端口转换的静态 NAT

• 第 5-5 页的带端口转换的静态接口 NAT

关于带端口地址转换的静态 NAT

指定带静态 NAT 的端口时，可以选择将端口和/或 IP 地址映射到同一值或不同值。

下图显示带端口转换的静态 NAT 场景，其中显示映射到本身的端口和映射到不同值的端口；在这
两种情况下， IP 地址映射到不同值。转换始终处于活动状态，因此，转换主机和映射主机都能发起
连接。

图 5-2 带端口转换的典型静态 NAT 场景

注 对于需要应用检测以寻找辅助信道的应用 （例如， FTP 或 VOIP）， ASA 会自动转换辅助端口。
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带身份端口转换的静态 NAT

以下带端口转换的静态 NAT 示例为远程用户访问 FTP、HTTP 和 SMTP 提供单一地址。实际上，这
些服务器是实际网络上的不同设备，但对于每台服务器，可以指定采用端口转换规则的静态 NAT，
这些规则使用同一映射 IP 地址和不同端口。

图 5-3 带端口转换的静态 NAT

面向非标准端口的带端口转换的静态 NAT

还可以利用带端口转换的静态 NAT 将一个已知端口转换为一个非标准端口，反之亦然。例如，如
果内部网络服务器使用端口 8080，您可以允许外部用户连接到端口 80，然后取消转换到原始端口 
8080。同样，要提供额外安全性，您可以告知网络用户连接到非标准端口 6785，然后取消转换到端
口 80。

带端口转换的静态接口 NAT

可以配置静态 NAT，以将一个实际地址映射到一个接口地址/端口组合。例如，如果要将 ASA 外部
接口的 Telnet 访问重新定向到内部主机，可以将内部主机 IP 地址/端口 23 映射到 ASA 接口地址/端
口 23。（请注意，尽管不允许到 ASA 的 Telnet 连接到安全性最低的接口，但带接口端口转换的静态 
NAT 可以重新定向 Telnet 会话，而不是拒绝它）。
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一对多静态 NAT

通常，配置带一对一映射的静态 NAT。然而，在某些情况下，您可能想要将单一实际地址配置到多
个映射地址 （一对多）。配置一对多静态 NAT 时，当实际主机发起流量时，它始终使用第一个映
射地址。然而，对于发起到主机的流量，您可以发起到任何映射地址的流量，并且不将它们转换为
单一实际地址。

图 5-4 显示了典型的一对多静态 NAT 场景。因为实际主机做出的发起始终使用第一个映射地址，所
以实际主机 IP/第一个映射 IP 的转换在技术上只能是双向转换。

图 5-4 一对多静态 NAT

例如，在 10.1.2.27 上有一个负载平衡器。根据请求的 URL，它会将流量重新定向到正确的网络服
务器。

图 5-5 一对多静态 NAT 示例
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Web Servers

Undo Translation
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Undo Translation
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  NAT 类型
其他映射场景（不推荐）

 ASA 可以灵活地允许任何类别的静态映射场景：一对一、一对多、少对多、多对少、多对一映射。
我们推荐仅使用一对一或一对多映射。其他映射选项可能会导致意外后果。

在功能上，少对多与一对多相同；但是，因为此配置更加复杂，而且实际映射可能不会一目了然，
所以我们建议为每个需要一对多配置的实际地址创建该配置。例如，对于少对多场景，少量的实际
地址会按顺序映射到多个映射地址（A 到 1、B 到 2、C 到 3）。当映射所有实际地址时，下一个映
射地址会映射到第一个实际地址，等等，直到映射了所有映射地址为止 （A 到 4、 B 到 5、 C 到 
6）。这将导致每个实际地址有多个映射地址。就像一对多配置一样，仅第一个映射是双向的；后
续映射可以将流量发起到实际主机，但所有从实际主机发起的流量仅将第一个映射地址用于源。

下图显示了一个典型的少对多静态 NAT 场景。

图 5-6 少对多静态 NAT

对于实际地址多于映射地址的多对少或多对一配置，映射地址会在实际地址用尽之前先用尽。仅最
低实际 IP 地址和映射池之间的映射可以导致双向发起。剩余的更高的实际地址可以发起流量，但
不能将流量发起到这些地址 （由于唯一五元组 [源 IP、目标 IP、源端口、目标端口、协议]，连接
的返回流量会定向到正确的实际地址）。

注 多对少或多对一 NAT 不是 PAT。如果两台实际主机使用同一源端口号，连接到同一外部服务器和同
一 TCP 目标端口，并且两台主机转换到同一 IP 地址，那么由于地址冲突 （五元组不是唯一的），
将重置两个连接。

下图显示一个典型的多对少静态 NAT 场景。

图 5-7 多对少静态 NAT

我们建议不要这样使用静态规则，而是为需要双向发起的流量创建一对一规则，为其他地址创建动
态规则。
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10.1.2.27 209.165.201.5

10.1.2.28 209.165.201.6

10.1.2.27 209.165.201.7
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  NAT 类型
动态 NAT
以下主题介绍动态 NAT。

• 第 5-8 页的关于动态 NAT

• 第 5-9 页的动态 NAT 的缺点和优点

关于动态 NAT

动态 NAT 将一个实际地址组转换为一个可在目标网络上路由的映射地址池。映射池通常包含少于
实际地址组的地址。当您要转换的主机访问目标网络时， ASA 从映射池为主机分配一个 IP 地址。
仅在实际主机发起连接时创建转换。转换仅在连接期间发生，而且转换超时后，给定用户不保存同
一 IP 地址。因此，目标网络上的用户不能向使用动态 NAT 的主机发起可靠连接，即使访问规则允
许该连接。

下图显示典型的动态 NAT 场景。仅实际主机可以创建 NAT 会话，允许响应流量返回。

图 5-8 动态 NAT

下图显示一台远程主机尝试发起到映射地址的连接。此地址当前不在转换表中；因此，ASA 丢弃该
数据包。

图 5-9 远程主机尝试向映射地址发起连接
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  NAT 类型
注 在转换期间，如果访问规则允许到转换主机的连接，远程主机可以发起该连接。因为地址不可预
测，所以到主机的连接不可能发生。然而，在这种情况下，您可以依靠访问规则的安全性。

动态 NAT 的缺点和优点

动态 NAT 有以下缺点：

• 如果映射池的地址少于实际组，并且流量数量大于预期，可能会用尽地址。

如果此事件经常发生，请使用 PAT 或 PAT 退回方法，因为 PAT 可以使用单一地址的端口提供超
过 64,000 次转换。

• 您不得不利用映射池中的大量可路由地址，而且可能没有大量的可路由地址可用。

动态 NAT 的优点在于，某些协议不能使用 PAT。 PAT 不作用于以下各项：

• 没有超载端口的 IP 协议，例如 GRE 0 版本。

• 某些多媒体应用，它们在一个端口上有数据流，在另一个端口上有控制路径，并且不是开放标准。

有关 NAT 和 PAT 支持的详细信息，请参阅第 8-5 页的默认检测和 NAT 限制。

动态 PAT
以下主题介绍动态 PAT。

• 第 5-9 页的有关动态 PAT

• 第 5-10 页的每会话 PAT 与多会话 PAT （9.0(1) 及更高版本）

• 第 5-10 页的动态 PAT 缺点和优点

有关动态 PAT

通过将实际地址和源端口转换为映射地址和唯一端口，动态 PAT 可以将多个实际地址转换为单一映
射地址。如果可用，真实源端口号将用于映射端口。然而，如果真实端口不可用，将默认从与真实
端口号相同的端口范围选择映射端口：0 至 511、512 至 1023 以及 1024 至 65535。因此，低于 1024 
的端口只有一个可以使用的小 PAT 池。如果您有大量使用较低端口范围的流量，可以指定一个要使
用的单一端口范围，而不是三个大小不等的层。

每个连接都需要单独的转换会话，因为每个连接的源端口都不同。例如， 10.1.1.1:1025 需要来自 
10.1.1.1:1026 的单独的转换。
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下图显示一个典型的动态 PAT 场景。仅实际主机可以创建 NAT 会话，允许响应流量返回。映射地
址对于每次转换都是相同的，但端口需要动态分配。

图 5-10 动态 PAT

在连接过期后，端口转换也将过期。对于多会话 PAT，使用 PAT 超时，默认情况下为 30 秒。对于
每会话 PAT （9.0(1) 及更高版本），立即删除 xlate。目标网络上的用户不能可靠地发起到使用 PAT 
的主机的连接 （即使访问规则允许该连接）。

注 在转换期间，如果访问规则允许到转换主机的连接，远程主机可以发起该连接。因为端口地址
（实际和映射）不可预测，所以到该主机的连接不可能发生。然而，在这种情况下，您可以依靠访
问规则的安全性。

每会话 PAT 与多会话 PAT （9.0(1) 及更高版本）

每会话 PAT 可以提高 PAT 的可扩展性，对于集群，允许每个成员单元拥有自己的 PAT 连接；多会话 
PAT 连接必须转发到主单元并且归主单元所有。每会话 PAT 会话结束时，ASA 将发送重置，并立即
移除转换。此重置将导致结束节点立即释放连接，从而避免 TIME_WAIT 状态。另一方面，多会话 
PAT 使用 PAT 超时，默认情况下为 30 秒。

对于 “肇事逃逸”流量，例如 HTTP 或 HTTPS，每会话 PAT 可以显著增加一个地址支持的连接速
率。不使用每会话 PAT，IP 协议的一个地址的最大连接速率大约为每秒 2000。使用每会话 PAT，IP 
协议的一个地址的连接速率为 65535/平均生命周期。

默认情况下，所有 TCP 流量和 UDP DNS 流量均使用每会话 PAT 转换。对于可以受益于多会话 PAT 
的流量，例如 H.323、 SIP 或 Skinny，您可以创建每会话拒绝规则，以禁用每会话 PAT。请参阅第 
6-18 页的配置每会话 PAT 规则。

动态 PAT 缺点和优点

通过动态 PAT，可以使用单一映射地址，从而保存可路由地址。您甚至可以将 ASA 接口 IP 地址用
作 PAT 地址。

动态 PAT 不作用于某些数据流不同于控制路径的多媒体应用。有关 NAT 和 PAT 支持的详细信息，
请参阅第 8-5 页的默认检测和 NAT 限制。

动态 PAT 还可以创建大量显示为来自单一 IP 地址的连接，服务器可以将流量解释为 DoS 攻击。
（8.4(2)/8.5(1) 及更高版本）您可以配置一个 PAT 地址池，使用 PAT 地址轮询分配减少这种情况。
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  路由和透明模式下的 NAT
身份标识 NAT
您可能有一个 NAT 配置，在其中需要将 IP 地址转换为其本身。例如，如果创建一条将 NAT 应用于
每个网络的大体的规则，但想使一个网络免于 NAT，则可以创建一条静态 NAT 规则，以将地址转
换为其本身。身份标识 NAT 是远程访问 VPN 所必需的，您需要使客户端流量免于 NAT。

下图显示一个典型的身份标识 NAT 场景。

图 5-11 身份标识 NAT

路由和透明模式下的 NAT
您可以在路由和透明防火墙模式下配置 NAT。本节介绍每个防火墙模式的典型用途。

• 第 5-11 页的路由模式下的 NAT

• 第 5-12 页的透明模式下的 NAT

路由模式下的 NAT
下图显示路由模式下的一个典型 NAT 示例，专用网络位于内部。

图 5-12 NAT 示例：路由模式
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  路由和透明模式下的 NAT
1. 当位于 10.1.2.27 的内部主机将数据包发送到网络服务器时，数据包的实际源地址 10.1.2.27 被更
改为映射地址 209.165.201.10。

2. 当服务器响应时，它会将响应发送到映射地址 209.165.201.10， ASA 接收数据包，因为 ASA 执
行代理 ARP 以认领数据包。

3. 接下来，ASA 变更从映射地址 209.165.201.10 回到实际地址 10.1.2.27 的转换，然后再发送到
主机。

透明模式下的 NAT
在透明模式下使用 NAT 可以消除上游或下游路由器为它们的网络执行 NAT 的需求。

透明模式下的 NAT 有以下要求和限制：

• 因为透明防火墙没有任何接口 IP 地址，所以不能使用接口 PAT。

• 不支持 ARP 检测。此外，如果由于某种原因，ASA 一端的主机向 ASA 另一端的主机发送 ARP 
请求，而且发起主机实际地址被映射到同一子网的不同地址，那么实际地址在 ARP 请求中依然
可见。

• 不支持在 IPv4 和 IPv6 网络之间进行转换。支持在两个 IPv6 网络之间或两个 IPv4 网络之间进行
转换。

下图显示透明模式下的典型 NAT 场景，内部接口和外部接口上的网络相同。在此场景中，透明防
火墙执行 NAT 服务，因此，上游路由器不必执行 NAT。

图 5-13 NAT 示例：透明模式

Management IP
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Internet

Source Addr Translation
209.165.201.10192.168.1.2
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10.1.1.3

192.168.1.1

192.168.1.2

Network 2

Static route on router:
209.165.201.0/27 to 10.1.1.1

Static route on ASA:
192.168.1.0/24 to 10.1.1.3

25
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  NAT 和 IPv6
1. 当位于 10.1.1.75 的内部主机向网络服务器发送数据包时，数据包的实际源地址 10.1.1.75 被更改
为映射地址 209.165.201.15。

2. 当服务器响应时，它将响应发送到映射地址 209.165.201.15， ASA 接收数据包，因为上游路由
器将此映射网络包含在定向到 ASA 管理 IP 地址的静态路由中。有关所需路由的详细信息，请
参阅第 5-20 页的映射地址和路由。

3. 然后， ASA 取消映射地址 209.165.201.15 回到实际地址 10.1.1.1.75 的转换。因为实际地址是直
接连接的，所以 ASA 将实际地址直接发送到主机。

4. 对于主机 192.168.1.2，发生相同流程，但返回流量除外， ASA 在其路由表中查询路由，根据 
192.168.1.0/24 的 ASA 静态路由，将数据包发送到位于 10.1.1.3 的下游路由器。有关所需路由的
详细信息，请参阅第 5-22 页的远程网络的透明模式路由要求。

NAT 和 IPv6
您可以使用 NAT 在 IPv6 网络之间转换，以及在 IPv4 和 IPv6 网络之间转换（仅路由模式）。我们推
荐以下最佳实践：

• NAT66 （IPv6 对 IPv6） - 我们建议使用静态 NAT。尽管您可以使用 NAT 或 PAT，但由于 IPv6 
地址大量供应，因此您不必使用动态 NAT。如果不想允许返回流量，可以使静态 NAT 规则成
为单向的 （仅两次 NAT）。

• NAT46（IPv4 对 IPv6）- 我们建议使用静态 NAT。因为 IPv6 地址空间远远大于 IPv4 地址空间，
所以可以轻松满足静态转换需求。如果不想允许返回流量，可以使静态 NAT 规则成为单向的
（仅两次 NAT）转换为 IPv6 子网 （/96 或更低）时，默认情况下，生成的映射地址为有嵌入 
IPv4 的 IPv6 地址，其中 32 位 IPv4 地址嵌入在 IPv6 前缀后面。例如，如果 IPv6 前缀为 /96 前
缀，则 IPv4 地址附在最后的 32 位地址中。例如，如果将 192.168.1.0/24 映射到 201b::0/96，则 
192.168.1.4 将被映射到 201b::0.192.168.1.4 （通过混合表示法显示）。如果前缀较小 （例如 
/64），则 IPv4 地址附在前缀的后面，后缀 0 附在 IPv4 地址后面。或者，您还能够以网络对网
络的方式转换地址，其中第一个 IPv4 地址映射到第一个 IPv6 地址，第二个 IPv4 地址映射到第
二个 IPv6，依次类推。

• NAT64（IPv6 到 IPv4）- 您可能没有足够的 IPv4 地址来容纳大量的 IPv6 地址。我们建议使用动
态 PAT 池提供大量的 IPv4 转换。

有关特定的实施准则和限制，请参阅配置章节。

如何实施 NAT
ASA 可以通过两种方法实施地址转换：网络对象 NAT 和两次 NAT。

• 第 5-14 页的网络对象 NAT 和两次 NAT 之间的主要差异

• 第 5-14 页的网络对象 NAT

• 第 5-15 页的两次 NAT
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  如何实施 NAT
网络对象 NAT 和两次 NAT 之间的主要差异

这两类 NAT 之间的主要差异是：

• 定义实际地址的方法。

– 网络对象 NAT - 将 NAT 定义为网络对象的参数。网络对象命名 IP 主机、范围或子网，以便
您能在 NAT 配置中使用对象，而不是实际 IP 地址。网络对象 IP 地址用作实际地址。通过
此方法，您可以轻松将 NAT 添加到可能已在配置的其他部分使用的网络对象。

– 两次 NAT - 识别实际地址和映射地址的网络对象或网络对象组。在这种情况下， NAT 不是
网络对象的参数；网络对象或组是 NAT 配置的参数。可以使用实际地址的网络对象组意味
着两次 NAT 更具可扩展性。

• 实施源和目标 NAT 的方法。

– 网络对象 NAT - 每条规则都能应用于数据包的源或目标。因此，可能使用两条规则，一条
用于源 IP 地址，一条用于目标 IP 地址。这两条规则不能绑在一起以对源/目标组合实施特
定转换。

– 两次 NAT - 单一规则可以转换源和目标。匹配数据包仅匹配一条规则，不检查更多规则。
即使不为两次 NAT 配置可选的目标地址，匹配数据包依然仅匹配一条两次 NAT 规则。源
和目标绑在一起，使您可以根据源/目标组合实施不同的转换。例如，源 A/目标 A 可以有不
同于源 A/目标 B 的转换。

• NAT 规则顺序。

– 网络对象 NAT - 在 NAT 表中自动排序。

– 两次 NAT - 在 NAT 表中手动排序 （在网络对象 NAT 规则之前或之后）。

有关详细信息，请参阅第 5-18 页的 NAT 规则顺序。

我们建议使用网络对象 NAT，除非您需要两次 NAT 提供的额外功能。网络对象 NAT 更容易配置，
而且可能对应用（例如 Voice over IP (VoIP)）更加可靠。（对于 VoIP，因为两次 NAT 仅在两个对象
之间适用，所以您可能会看到不属于任何一个对象的间接地址转换失败。）

网络对象 NAT
配置为网络对象的参数的所有 NAT 规则都被视为网络对象 NAT 规则。网络对象 NAT 是一种为网络
对象配置 NAT 的快捷方便的方法，网络对象可以是单一 IP 地址、地址范围或子网。

配置网络对象之后，您可以接着将该对象的映射地址识别为内联地址或者另一个网络对象或网络对
象组。

当数据包进入 ASA 时，根据网络对象 NAT 规则检查源 IP 地址和目标 IP 地址。如果进行独立匹配，
可根据独立规则转换数据包中的源地址和目标地址。这些规则互不牵连，可以根据流量使用不同的
规则组合。

因为规则从未配对，所以您不能指定源 A/目标 A 应当有不同于源 A/目标 B 的转换。将两次 NAT 用
于此类功能 （两次 NAT 可以让您识别单一规则中的源地址和目标地址）。

要开始配置网络对象 NAT，请参阅第 6 章，“网络对象 NAT （ASA 8.3 及更高版本）”。
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  如何实施 NAT
两次 NAT
两次 NAT 可供您在单一规则中同时确定源和目标地址。指定源地址和目标地址，可以让您指定源 
A/目标 A 有不同于源 A/目标 B 的转换。

目标地址是可选的。如果指定目标地址，可以将它映射到其本身 （身份标识 NAT），或者将它映射
到不同的地址。目标映射始终是静态映射。

两次 NAT 还可以让您将服务对象用于带端口转换的静态 NAT；网络对象 NAT 仅接受内联定义。

要开始配置两次 NAT，请参阅第 7 章，“两次 NAT （ASA 8.3 及更高版本）”。

以下主题提供一些两次 NAT 的示例。

• 第 5-15 页的示例：使用不同目标地址的两次 NAT

• 第 5-16 页的示例：使用不同目标端口的两次 NAT

• 第 5-17 页的示例：带目标地址转换的两次 NAT

示例：使用不同目标地址的两次 NAT

下图显示 10.1.2.0/24 网络上的一台主机正在访问两台不同的服务器。当主机访问位于 
209.165.201.11 的服务器时，实际地址被转换为 209.165.202.129。当主机访问位于 209.165.200.225 
的服务器时，实际地址被转换为 209.165.202.130。

图 5-14 使用不同目标地址的两次 NAT
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  如何实施 NAT
示例：使用不同目标端口的两次 NAT

下图显示源端口和目标端口的使用情况。 10.1.2.0/24 网络上的主机同时因为网络服务和 Telnet 服务
访问单个主机。当主机访问服务器以获取网络服务时，实际地址被转换为 209.165.202.129。当主机
访问同一服务器以获取 Telnet 服务时，实际地址被转换为 209.165.202.130。

图 5-15 使用不同目标端口的两次 NAT
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209.165.201.11:23

13
00

40
5-16
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  如何实施 NAT
示例：带目标地址转换的两次 NAT

下图显示一台连接到映射主机的远程主机。映射主机有一个两次静态 NAT 转换，将仅面向流量的
实际地址转换到 209.165.201.0/27 网络或从 209.165.201.0/27 网络转换。不存在面向 
209.165.200.224/27 网络的转换，因此，转换主机不能连接到该网络，该网络上的主机也不能连接
到转换主机。

图 5-16 带目标地址转换的两次静态 NAT
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  NAT 规则顺序
NAT 规则顺序 
网络对象 NAT 规则和两次 NAT 规则存储在划分为三部分的单个表中。首先应用第一部分规则，其
次是第二部分，最后是第三部分，直到找到匹配项为止。例如，如果在第一部分找到匹配项，则不
评估第二部分和第三部分。下表显示每个部分的规则顺序。

例如，对于第二部分规则，在网络对象中已定义以下 IP 地址：

192.168.1.0/24 （静态）

192.168.1.0/24 （动态）

10.1.1.0/24 （静态）

192.168.1.1/32 （静态）

172.16.1.0/24 （动态）（对象 def）

172.16.1.0/24 （动态）（对象 abc）

表 5-1 NAT 规则表

表部分 规则类型 部分中的规则顺序

第一部分 两次 NAT 在第一个匹配的基础上，按照在配置中出现的顺序应用。因
为应用了第一个匹配，必须确保特定规则位于更加通用的规
则前面，否则不能按预期应用特定规则。默认情况下，两次 
NAT 规则添加到第一部分。

注 如果配置 EasyVPN Remote， ASA 动态地将不可见 
NAT 规则添加到此部分的末尾。确保勿在此部分配置
可能匹配 VPN 流量而不匹配不可见规则的两次 NAT 
规则。如果 VPN 由于 NAT 故障而无法工作，请考虑
将两次 NAT 规则添加到第三部分。

第二部分 网络对象 NAT 如果在第一部分没有找到匹配项，则按 ASA 自动确定的以
下顺序应用第二部分规则：

1. 静态规则。

2. 动态规则。

在每个规则类型中，使用以下排序准则：

1. 实际 IP 地址数量 - 从最小到最大。例如，带一个地址的
对象将在带 10 个地址的对象之前进行评估。

2. 如果数量相同，则按从最低到最高的顺序使用 IP 地址编
号。例如， 10.1.1.0 在 11.1.1.0 之前进行评估。

3. 如果使用同一 IP 地址，则按字母数字顺序使用网络对象
名称。例如， abracadabra 在 catwoman 之前进行评估。

第三部分 两次 NAT 如果仍未找到匹配项，则按照在配置中出现的顺序，在第一
个匹配的基础上应用第三部分规则。此部分应当包含最通用
的规则。您还必须确保此部分的任何特定规则在以其他方式
应用通用规则之前进行。添加规则时，可以指定是否将两次 
NAT 规则添加到第三部分。
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  NAT 接口
结果排序可能是：

192.168.1.1/32 （静态）

10.1.1.0/24 （静态）

192.168.1.0/24 （静态）

172.16.1.0/24 （动态）（对象 abc）

172.16.1.0/24 （动态）（对象 def）

192.168.1.0/24 （动态）

NAT 接口
您可以将 NAT 规则配置为应用到任何接口 （换句话说，所有接口），或者可以识别特定的实际接
口和映射接口。还可以为实际地址指定任何接口，为映射地址指定特定接口，反之亦然。

例如，如果在多个接口上使用相同的专用地址，并且在访问外部接口时要将这些地址全部转换到同
一全局池，则您可能想为实际地址指定任何接口，并且为映射地址指定外部接口。

图 5-17 指定任何接口

注 对于透明模式，必须选择特定源接口和目标接口。

路由 NAT 数据包
ASA 需要成为发送到映射地址的任何数据包的目标。此外， ASA 还需要为它收到的以映射地址为
目标的数据包确定出口接口。本节介绍 ASA 如何处理通过 NAT 接受和交付数据包。

• 第 5-20 页的映射地址和路由

• 第 5-22 页的远程网络的透明模式路由要求

• 第 5-22 页的确定出口接口
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  路由 NAT 数据包
映射地址和路由

当您将实际地址转换为映射地址时，如果需要，您选择的映射地址将确定如何为映射地址配置路由。

请参阅第 6 章，“网络对象 NAT（ASA 8.3 及更高版本）”和第 7 章，“两次 NAT（ASA 8.3 及更高
版本）”，了解有关映射 IP 地址的其他指南

以下主题解释映射地址类型：

• 第 5-20 页的与映射接口位于同一网络中的地址

• 第 5-20 页的唯一网络上的地址

• 第 5-21 页的与实际地址相同的地址 （身份标识 NAT）

与映射接口位于同一网络中的地址

如果使用与映射接口位于同一网络中的地址， ASA 使用代理 ARP 响应任何对映射地址的 ARP 请
求，从而解释以映射地址为目标的流量。此解决方案可以简化路由，因为 ASA 不必成为任何其他
网络的网关。如果外部网络包含足够多的空闲地址，并且您正在使用 1:1 转换 （例如动态 NAT 或
静态 NAT），此解决方案是理想选择。动态 PAT 可以显著增加您可以通过少量地址实现的转换数
量，因此，即使外部网络中的可用地址较少，依然可以使用此方法。对于 PAT，您甚至可以使用映
射接口的 IP 地址。

注 如果将映射接口配置为任何接口，而且在与其中一个映射接口相同的网络中指定映射地址，那么如
果对此映射地址的 ARP 请求在不同接口上进入，则需要为入口接口上的该网络手动配置 ARP 条
目，指定其 MAC 地址 （请参阅 Configuration > Device Management > Advanced > ARP > ARP Static 
Table）。通常，如果该映射接口指定任何接口，则将唯一网络用于此映射地址，避免此类情况发生。

唯一网络上的地址

如果您需要的地址数量多于映射接口网络上的可用地址数量，则可以识别不同子网上的地址。上游
路由器需要对指向 ASA 的映射地址进行静态路由。或者，对于路由模式，您可以将目标网络上的
任何 IP 地址用作网关，为映射地址配置 ASA 上的静态路由，然后使用路由协议重新分配路由。例
如，如果将 NAT 用于内部网络 (10.1.1.0/24)，并且使用映射 IP 地址 209.165.201.5，则可以配置以下
可以重新分配的静态路由：

209.165.201.5 255.255.255.255 10.1.1.99 中的路由

对于透明模式，如果直接连接实际主机，则将上游路由器的静态路由配置为指向 ASA：在 8.3 中，
指定全局管理 IP 地址；在 8.4(1) 及更高版本中，指定桥接组 IP 地址。对于透明模式下的远程主机，
在上游路由器上的静态路由中，还可以指定下游路由器 IP 地址。
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  路由 NAT 数据包
与实际地址相同的地址（身份标识 NAT）

（8.3(1)、 8.3(2) 和 8.4(1)）用于身份标识 NAT 的默认行为已禁用代理 ARP。无法配置此设置。

（8.4(2) 及更高版本）用于身份标识 NAT 的默认行为已启用代理 ARP，匹配其他静态 NAT 规则。如
果需要，可以禁用代理 ARP。如果需要，还可以为常规静态 NAT 禁用代理 ARP，在这种情况下，
需要确保上游路由器上有适当的路由。

通常，对于身份标识 NAT，是不需要代理 ARP 的，而且在某些情况下，会造成连接问题。例如，
如果为“任何” IP 地址配置一条大体的身份标识 NAT 规则，则使代理 ARP 保持启用状态会给直接
连接到映射接口的网络上的主机造成问题。在这种情况下，当映射网络上的主机要与同一网络上的
其他主机通信时，ARP 请求中的地址匹配 NAT 规则（匹配“任何”地址）。然后，ASA 将代理地
址的 ARP，即使数据包实际上不以 ASA 为目标。（请注意，此问题甚至会在您有两次 NAT 规则时发
生；尽管 NAT 规则必须匹配源地址和目标地址，但代理 ARP 决策仅在 “源”地址上做出）。如果 
ASA ARP 响应在实际主机 ARP 响应之前收到，则流量将被错误地发送到 ASA （请参阅图 5-18）。

图 5-18 身份标识 NAT 的代理 ARP 问题

在极少数情况下，需要面向身份标识 NAT 的代理 ARP；例如，对于虚拟 Telnet。将 AAA 用于网络
访问时，主机需要先利用 Telnet 等服务对 ASA 进行身份验证，然后才能让任何其他流量通过。您
可以在 ASA 上配置虚拟 Telnet 服务器，以提供必需的登录。从外部访问虚拟 Telnet 地址时，必需为
此地址配置身份标识 NAT，尤其是对于代理 ARP 功能而言。由于虚拟 Telnet 的内部流程，代理 
ARP 可以让 ASA 保存以虚拟 Telnet 地址为目标的流量，而不是根据 NAT 规则将流量向外发送到源
接口。（请参阅图 5-19）。

209.165.200.225

209.165.200.230

209.165.200.231

Identity NAT for
“any” with Proxy ARP

OutsideInside

1

2

4

ARP for 209.165.200.230.

Traffic incorrectly sent to ASA.

Proxy ARP for 209.165.200.230.

3ARP Response

Too late
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  路由 NAT 数据包
图 5-19 代理 ARP 和虚拟 Telnet

远程网络的透明模式路由要求

当您在透明模式下使用 NAT 时，某些类型的流量要求静态路由。有关详细信息，请参阅一般操作
配置指南。

确定出口接口

当 ASA 接收用于映射地址的流量时， ASA根据 NAT 规则取消转换目标地址，然后将数据包发送到
实际地址。 ASA 按照以下方式为数据包确定出口接口：

• 透明模式 - ASA 使用 NAT 规则，为实际地址确定出口接口；必须指定源接口和目标接口，作为 
NAT 规则的一部分。

• 路由模式 - ASA 按照以下方式之一确定出口接口：

– 在 NAT 规则中配置接口 - ASA 使用 NAT 规则确定出口接口。（8.3(1) 到 8.4(1)）唯一的例外
是面向身份标识 NAT，其中该身份标识 NAT 始终使用路由查询，无论 NAT 配置如何。
（8.4(2) 及更高版本）对于身份标识 NAT，默认行为是要使用 NAT 配置。然而，您可以选
择始终使用路由查询。在某些场景下，路由查询覆盖是必需的；例如，请参阅第 5-28 页的
NAT 和 VPN 管理访问。

– 不在 NAT 规则中配置接口 - ASA 使用路由查询确定出口接口。

下图显示路由模式下的出口接口选择方法。几乎在所有情况下，路由查询都等同于 NAT 规则接口，
但在某些配置中，这两种方法可能不同。

209.165.201.11

Virtual Telnet:
209.165.200.230

Identity NAT for
209.165.200.230

between inside and outside
with Proxy ARP

OutsideInside

Server

1

2

3

Telnet to 209.165.200.230.

Communicate with server.

Authenticate.
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  面向 VPN 的 NAT
图 5-20 路由模式出口接口选择

面向 VPN 的 NAT
以下主题借助各种类型的 VPN 来解释 NAT 用途。

• 第 5-23 页的 NAT 和远程访问 VPN

• 第 5-26 页的 NAT 和站点到站点 VPN

• 第 5-28 页的 NAT 和 VPN 管理访问

• 第 5-29 页的 NAT 和 VPN 故障排除

NAT 和远程访问 VPN
下图显示访问互联网的内部服务器 (10.1.1.6) 和 VPN 客户端 (209.165.201.10)。除非为 VPN 客户端配
置拆分隧道（其中，仅指定流量穿过 VPN 隧道），否则互联网绑定 VPN 流量也必须穿过 ASA。当 
VPN 流量进入 ASA 时， ASA 解密数据包；产生的数据包包含作为源地址的 VPN 客户端本地地址 
(10.3.3.10)。对于内部和 VPN 客户端本地网络，您需要使用 NAT 提供的公用 IP 地址访问互联网。
以下示例使用接口 PAT 规则。为使 VPN 流量可以退出其已进入的相同接口，您还需要启用接口内
通信 （也称为 “发夹”网络）。

Real: 10.1.1.78
Mapped: 209.165.201.08

Inside

Untranslation

Packet
Eng

Dest. 209.165.201.08

10.1.1.78209.165.201.08 to

NAT rule specifies interface? 

NAT rule specifies route lookup?

NoYes

Yes

No

Send packet out Inside interface.

Where to send 10.1.1.78?

Outside

Look up 10.1.1.78 in routing table.

37
00

49
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  面向 VPN 的 NAT
图 5-21 面向互联网绑定 VPN 流量的接口 PAT （接口内）

下图显示要访问内部邮件服务器的 VPN 客户端。因为 ASA 希望内部网络和任何外部网络之间的流
量匹配您为互联网访问建立的接口 PAT 规则，所以从 VPN 客户端 (10.3.3.10) 到 SMTP 服务器 
(10.1.1.6) 的流量将会因为逆向路径故障而被丢弃：从 10.3.3.10 到 10.1.1.6 的流量不匹配 NAT 规则，
但从 10.1.1.6 到 10.3.3.10 的返回流量应当匹配用于传出流量的接口 PAT 规则。因为正向流量和逆向
流量不匹配，所以 ASA 会在收到数据包后丢弃数据包。为避免这种故障，您需要在那些网络之间
使用身份标识 NAT 规则，使内部到 VPN 客户端流量免于应用接口 PAT 规则。身份标识 NAT 只能将
地址转换为其相同的地址。

VPN Client
209.165.201.10

Internet

Src: 209.165.201.10

10.3.3.10 203.0.113.1:6070

10.3.3.10

10.1.1.6

www.example.com

Inside

209.165.201.10

1. HTTP request to www.example.com

4. HTTP request to
www.example.com

C. HTTP request to www.example.com

2. ASA decrypts packet; src address is
now local address

Src: 203.0.113.1:6070

ASA Outside IP: 203.0.113.1

10.1.1.6 203.0.113.1:6075

Src: 10.1.1.6

A. HTTP to
www.example.com

B. ASA performs interface PAT for
outgoing traffic.

Src: 203.0.113.1:6075

3. ASA performs interface PAT for outgoing traffic.
Intra-interface config req’d.

30
34

62
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  面向 VPN 的 NAT
图 5-22 面向 VPN 客户端的身份标识 NAT

请参阅以下用于上述网络的 NAT 配置示例：

!Enable hairpin for non-split-tunneled VPN client traffic:
same-security-traffic permit intra-interface

!Identify local VPN network, & perform object interface PAT when going to Internet:
object network vpn_local

subnet 10.3.3.0 255.255.255.0
nat (outside,outside) dynamic interface

!Identify inside network, & perform object interface PAT when going to Internet:
object network inside_nw

subnet 10.1.1.0 255.255.255.0
nat (inside,outside) dynamic interface

!Use twice NAT to pass traffic between the inside network and the VPN client without
!address translation (identity NAT):
nat (inside,outside) source static inside_nw inside_nw destination static vpn_local 
vpn_local

VPN Client
209.165.201.10

Internet

10.1.1.6

Inside

1. SMTP request to 10.1.1.6

4. SMTP request to 10.1.1.6

2. ASA decrypts packet; src address is
now local address

10.3.3.10 209.165.201.10

7. ASA encrypts packet; dst address is now real address

Dst: 10.3.3.10

5. SMTP response to
VPN Client

Src: 10.3.3.10

Src: 209.165.201.10

8. SMTP response to
VPN Client

Dst: 209.165.201.10

6. Identity NAT

10.3.3.10

3. Identity NAT between inside and VPN Client NWs

Src: 10.3.3.10
10.1.1.6Dst: 10.1.1.6

10.3.3.10Dst: 10.3.3.10
10.1.1.6Src: 10.1.1.6

10.3.3.10209.165.201.10

30
34
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第 5 章      网络地址转换 (NAT) （ASA 8.3 及更高版本）

  面向 VPN 的 NAT
NAT 和站点到站点 VPN
下图显示连接博尔德办公室和圣荷西办公室的站点到站点隧道。对于要发送到互联网的流量 （例
如，从博尔德办公室中的 10.1.1.6 到 www.example.com），您需要利用 NAT 提供的公用 IP 地址访问
互联网。以下示例使用接口 PAT 规则。然而，对于要穿过 VPN 隧道的流量 （例如，从博尔德办公
室中的 10.1.1.6 到圣荷西办公室中的 10.2.2.78），您不想执行 NAT；您需要通过创建身份标识 NAT 
规则来豁免此流量。身份标识 NAT 只能将地址转换为其相同的地址。

图 5-23 用于站点到站点 VPN 的接口 PAT 和身份标识 NAT

下图显示连接到 ASA1（博尔德）的 VPN 客户端，以及可通过 ASA1 和 ASA2（圣荷西）之间的站
点到站点隧道访问的服务器 (10.2.2.78) 的 Telnet 请求。因为这是一种发夹连接，所以您需要启用接
口内通信，这也是来自 VPN 客户端的非拆分隧道互联网绑定流量所必需的。您还需要在 VPN 客户
端以及博尔德和圣荷西网络之间配置身份标识 NAT，就像在 VPN 连接的任何网络之间一样配置，
使此流量免于应用出站 NAT 规则。

图 5-24 VPN 客户端访问站点到站点 VPN

10.1.1.6 ASA1 ASA2 10.2.2.78

Internet

Src: 10.1.1.6

10.1.1.6 203.0.113.1:6070

Src: 10.1.1.6 10.1.1.6
Dst: 10.2.2.78 10.2.2.78

San Jose
Inside

Boulder

Inside

1. IM to 10.2.2.78

Src: 10.1.1.6

A. HTTP to
www.example.com

Src: 10.1.1.6

3. IM received

C. HTTP request to www.example.com

2. Identity NAT between NWs connected by VPN

B. ASA performs interface PAT for
outgoing traffic.

Src: 203.0.113.1:6070

www.example.com

ASA Outside IP: 203.0.113.1

30
34
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Site-to-Site VPN Tunnel

VPN Client
209.165.201.10

10.1.1.6 ASA1 ASA2 10.2.2.78

Internet

San Jose
Inside

Boulder
Inside

Site-to-Site VPN Tunnel

4. HTTP request received

1. HTTP request to 10.2.2.78

10.3.3.10209.165.201.10

2. ASA decrypts packet; src address is
now local address

Src: 10.3.3.10 10.3.3.10
Dst: 10.2.2.78 10.2.2.78

3. Identity NAT between VPN Client &
San Jose NWs; intra-interface config req’d

Src: 209.165.201.10

Src: 10.3.3.10
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  面向 VPN 的 NAT
请参阅以下用于 ASA1 （博尔德）的 NAT 配置示例：

!Enable hairpin for VPN client traffic:
same-security-traffic permit intra-interface

!Identify local VPN network, & perform object interface PAT when going to Internet:
object network vpn_local

subnet 10.3.3.0 255.255.255.0
nat (outside,outside) dynamic interface

!Identify inside Boulder network, & perform object interface PAT when going to Internet:
object network boulder_inside

subnet 10.1.1.0 255.255.255.0
nat (inside,outside) dynamic interface

!Identify inside San Jose network for use in twice NAT rule:
object network sanjose_inside

subnet 10.2.2.0 255.255.255.0

!Use twice NAT to pass traffic between the Boulder network and the VPN client without
!address translation (identity NAT):
nat (inside,outside) source static boulder_inside boulder_inside destination static 
vpn_local vpn_local

!Use twice NAT to pass traffic between the Boulder network and San Jose without
!address translation (identity NAT):
nat (inside,outside) source static boulder_inside boulder_inside destination static 
sanjose_inside sanjose_inside

!Use twice NAT to pass traffic between the VPN client and San Jose without
!address translation (identity NAT):
nat (outside,outside) source static vpn_local vpn_local destination static sanjose_inside 
sanjose_inside

请参阅以下用于 ASA2 （圣荷西）的 NAT 配置示例：

!Identify inside San Jose network, & perform object interface PAT when going to Internet:
object network sanjose_inside

subnet 10.2.2.0 255.255.255.0
nat (inside,outside) dynamic interface

!Identify inside Boulder network for use in twice NAT rule:
object network boulder_inside

subnet 10.1.1.0 255.255.255.0

!Identify local VPN network for use in twice NAT rule:
object network vpn_local

subnet 10.3.3.0 255.255.255.0

!Use twice NAT to pass traffic between the San Jose network and Boulder without
!address translation (identity NAT):
nat (inside,outside) source static sanjose_inside sanjose_inside destination static 
boulder_inside boulder_inside

!Use twice NAT to pass traffic between the San Jose network and the VPN client without
!address translation (identity NAT):
nat (inside,outside) source static sanjose_inside sanjose_inside destination static 
vpn_local vpn_local
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  面向 VPN 的 NAT
NAT 和 VPN 管理访问

使用 VPN 时，您可以对进入 ASA所通过的接口以外的接口进行管理访问。例如，如果您从外部接
口进入 ASA，管理访问功能可以让您使用 ASDM、SSH、Telnet 或 SNMP 连接到内部接口；或者您
可以 ping 内部接口。

下图显示通过 Telnet 连接到 ASA 内部接口的 VPN 客户端。当您使用管理访问接口，并且根据第 
5-23 页的 NAT 和远程访问 VPN 或第 5-26 页的 NAT 和站点到站点 VPN 配置身份标识 NAT 时，必
须为 NAT 配置路由查询选项。如果没有路由查询，ASA 会将流量向外发送到在 NAT 命令中指定的
接口，无论路由表显示什么；在以下示例中，出口接口为内部接口。您不希望 ASA 将管理流量向
外发送到内部网络；它永远不会返回到内部接口 IP 地址。路由查询选项可以让 ASA 将流量直接发
送到内部接口 IP 地址，而不是内部网络。对于从 VPN 客户端到内部网络上的主机的流量，路由查
询选项仍将导致正确的出口接口 （内部），因此，正常业务流不会受到影响。有关路由查询选项的
详细信息，请参阅第 5-22 页的确定出口接口。

图 5-25 VPN 管理访问

请参阅以下用于上述网络的 NAT 配置示例：

!Enable hairpin for non-split-tunneled VPN client traffic:
same-security-traffic permit intra-interface

!Enable management access on inside ifc:
management-access inside

!Identify local VPN network, & perform object interface PAT when going to Internet:
object network vpn_local

subnet 10.3.3.0 255.255.255.0
nat (outside,outside) dynamic interface

!Identify inside network, & perform object interface PAT when going to Internet:

VPN Client
209.165.201.10

InternetInside

1. Telnet request to ASA inside ifc;
management-access config req’d

4. Telnet request to 10.1.1.1

2. ASA decrypts packet; src address is now local address

Dst: 10.3.3.10 209.165.201.10

7. ASA encrypts packet; dst address is now real address

10.3.3.10

Src: 209.165.201.10

8. Telnet response to
VPN Client

Dst: 209.165.201.10

Dst: 10.3.3.10
10.1.1.1Src: 10.1.1.1

10.3.3.10

3. Identity NAT between inside &
VPN client NWs; route-lookup req’d

Src: 10.3.3.10
10.1.1.1Dst: 10.1.1.1

10.3.3.10209.165.201.10

ASA Inside IP:10.1.1.1

5. Telnet response
to VPN Client

Dst: 10.3.3.10

6. Identity NAT

Src: 10.3.3.10
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  DNS 和 NAT
object network inside_nw
subnet 10.1.1.0 255.255.255.0
nat (inside,outside) dynamic interface

!Use twice NAT to pass traffic between the inside network and the VPN client without
!address translation (identity NAT), w/route-lookup:
nat (outside,inside) source static vpn_local vpn_local destination static inside_nw 
inside_nw route-lookup

NAT 和 VPN 故障排除

请参阅以下用于排除 VPN 中 NAT 问题的监控工具：

• 数据包跟踪器 - 正确使用时，数据包跟踪器显示数据包命中了哪些 NAT 规则。

• show nat detail - 显示给定 NAT 规则的命中数和未转换流量。

• show conn all - 让您查看活动连接，包括流向设备的流量和通过设备的流量。

要让自己熟悉非工作配置和工作配置，您可以执行以下步骤：

1. 配置无身份标识 NAT 的 VPN。

2. 输入 show nat detail 和 show conn all。

3. 添加身份标识 NAT 配置。

4. 重复 show nat detail 和 show conn all。

DNS 和 NAT
您可能需要配置 ASA 以修改 DNS 回复，方法是用匹配 NAT 配置的地址替换回复中的地址。配置每
条转换规则时，您可以配置 DNS 修改。

此功能可以重写匹配 NAT 规则的 DNS 查询和回复中的地址 （例如，适用于 IPv4 的 A 记录；适用
于 IPv6 的 AAAA 记录；或者，适用于逆向 DNS 查询的 PTR 记录）。对于从映射接口穿越到任何其
他接口的 DNS 回复，记录会从映射值被重写为实际值。相反，对于从任何接口穿越到映射接口的 
DNS 回复，记录会从实际值被重写为映射值。

以下是 DNS 重写的某些限制：

• DNS 重写不适用于 PAT，因为多条 PAT 规则适用于每个 A 记录，而且要使用的 PAT 规则不确定。

• 如果配置了两次 NAT 规则，并且指定了源地址和目标地址，则不能配置 DNS 修改。或者，这
种规则发送到 A 和 B 时，对单一地址可能有不同的转换。因此， ASA 不能精确匹配 DNS 回复
中的 IP 地址和正确的两次 NAT 规则；DNS 回复不包含有关哪个源地址/目标地址组合位于提示 
DNS 请求的数据包中的信息。

• DNS 重写要求启用 DNS 应用检测，默认情况下 DNS 应用检测处于启用状态。有关详细信息，
请参阅第 9-1 页的 DNS 检测。

• 实际上， DNS 重写在 xlate 条目而非 NAT 规则上完成。因此，如果没有面向动态规则的 xlate，
则不能正确完成重写。静态 NAT 也会出现相同的问题。
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  DNS 和 NAT
以下主题提供 DNS 重写示例：

• 第 5-30 页的 DNS 回复修改，外部接口上的 DNS 服务器

• 第 5-31 页的独立网络上的 DNS 回复修改、 DNS 服务器、主机和服务器

• 第 5-32 页的 DNS 回复修改，主机网络上的 DNS 服务器

• 第 5-33 页的使用外部 NAT 进行 DNS64 回复修改

• 第 5-34 页的 PTR 修改，主机网络上的 DNS 服务器

DNS 回复修改，外部接口上的 DNS 服务器

下图显示可从外部接口访问的 DNS 服务器。服务器 ftp.cisco.com 在内部接口上。将 ASA 配置为静
态地将 ftp.cisco.com 实际地址 (10.1.3.14) 转换为在外部网络上可见的映射地址 (209.165.201.10)。

在这种情况下，您要在此静态规则上启用 DNS 回复修改，以便使用实际地址访问 ftp.cisco.com 的内
部用户可以接收来自 DNS 服务器的实际地址，而不是映射地址。当内部主机发送对 ftp.cisco.com 的
地址的 DNS 请求时，DNS 服务器将以映射地址 (209.165.201.10) 作为回复。ASA 是指内部服务器的
静态规则，并且将 DNS 回复中的地址转换为 10.1.3.14。如果不启用 DNS 回复修改，则内部主机尝
试将流量发送到 209.165.201.10，而不是直接访问 ftp.cisco.com。

图 5-26 DNS 回复修改，外部接口上的 DNS 服务器
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  DNS 和 NAT
独立网络上的 DNS 回复修改、 DNS 服务器、主机和服务器

下图显示一个内部网络的用户正在从外部 DNS 服务器请求 DMZ 网络上的 ftp.cisco.com 的 IP 地址。
DNS 服务器根据外部网络和 DMZ 网络之间的静态规则，以映射地址 (209.165.201.10) 作为回复，即
使该用户不在 DMZ 网络中。 ASA 将 DNS 回复中的地址转换为 10.1.3.14。

如果用户需要使用实际地址访问 ftp.cisco.com，则无需更多配置。如果内部网络和 DMZ 网络之间也
有静态规则，您还需要在此规则上启用 DNS 回复修改。然后， DNS 回复将被修改两次。在这种情
况下， ASA 会根据内部网络和 DMZ 网络之间的静态规则，再次将 DNS 回复中的地址转换为 
192.168.1.10。

图 5-27 独立网络上的 DNS 回复修改、 DNS 服务器、主机和服务器
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  DNS 和 NAT
DNS 回复修改，主机网络上的 DNS 服务器

下图显示外部网络上的 FTP 服务器和 DNS 服务器。 ASA 有面向外部服务器的静态转换。在这种情
况下，当内部用户从 DNS 服务器请求 ftp.cisco.com 的地址时， DNS 服务器将以实际地址 
209.165.20.10 作为响应。因为您想让内部用户使用 ftp.cisco.com 的映射地址 (10.1.2.56)，所以您需
要配置 DNS 回复修改以进行静态转换。

图 5-28 DNS 回复修改，主机网络上的 DNS 服务器
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  DNS 和 NAT
使用外部 NAT 进行 DNS64 回复修改

下图显示外部 IPv4 网络上的 FTP 服务器和 DNS 服务器。ASA 有面向外部服务器的静态转换。在这
种情况下，当内部 IPv6 用户从 DNS 服务器请求 ftp.cisco.com 的地址时，DNS 服务器将以实际地址 
209.165.200.225 作为响应。

因为您想让内部用户使用 ftp.cisco.com 的映射地址 (2001:DB8::D1A5:C8E1)，所以您需要配置 DNS 
回复修改以进行静态转换。本示例还包括面向 DNS 服务器的静态 NAT 转换和面向内部 IPv6 主机的 
PAT 规则。

图 5-29 使用外部 NAT 进行 DNS64 回复修改
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  更多信息指南
PTR 修改，主机网络上的 DNS 服务器

下图显示外部网络上的 FTP 服务器和 DNS 服务器。 ASA 有面向外部服务器的静态转换。在这种情
况下，当内部用户执行逆向 DNS 查询以获取 10.1.2.56 时， ASA 将通过实际地址修改逆向 DNS 查
询， DNS 服务器将以服务器名称 ftp.cisco.com 作为响应。

图 5-30 PTR 修改，主机网络上的 DNS 服务器

更多信息指南
要配置网络对象 NAT，请参阅第 6 章，“网络对象 NAT （ASA 8.3 及更高版本）”。

要配置两次 NAT，请参阅第 7 章，“两次 NAT （ASA 8.3 及更高版本）”。
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6第 章
网络对象 NAT （ASA 8.3 及更高版本）

配置为网络对象的参数的所有 NAT 规则都被视为网络对象 NAT 规则。网络对象 NAT 是一种为单一 
IP 地址、地址范围或子网配置 NAT 的快速便捷方法。配置网络对象后，随后可以识别该对象的映
射地址。

本章介绍如何配置网络对象 NAT，其中包含以下各节：

• 第 6-1 页的有关网络对象 NAT 的信息

• 第 6-2 页的网络对象 NAT 的许可要求

• 第 6-2 页的网络对象 NAT 的先决条件

• 第 6-2 页的准则和限制

• 第 6-3 页的默认设置

• 第 6-4 页的配置网络对象 NAT

• 第 6-19 页的监控网络对象 NAT

• 第 6-20 页的网络对象 NAT 配置示例

• 第 6-43 页的网络对象 NAT 的功能历史

注 有关 NAT 工作原理的详细信息，请参阅第 5 章，“网络地址转换 (NAT) （ASA 8.3 及更高版本）”。

有关网络对象 NAT 的信息
当数据包进入 ASA 时，根据网络对象 NAT 规则检查源 IP 地址和目标 IP 地址。如果进行独立匹配，
可根据独立规则转换数据包中的源地址和目标地址。这些规则互不牵连，可以根据流量使用不同的
规则组合。

因为从未对规则进行配对，所以无法指定源地址在转到目标 X 时应被转换为 A，但是，在转到目标 
Y 时应被转换为 B。将两次 NAT 用于此类功能 （两次 NAT 可以让您识别单一规则中的源地址和目
标地址）。

有关两次 NAT 和网络对象 NAT 之间的差异的详细信息，请参阅第 5-13 页的如何实施 NAT。

网络对象 NAT 已添加到 NAT 规则表中的第 2 部分。有关 NAT 排序的详细信息，请参阅第 5-18 页的
NAT 规则顺序。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 的许可要求
网络对象 NAT 的许可要求
下表显示此功能的许可要求：

网络对象 NAT 的先决条件
根据此配置，如果需要，您可以配置映射地址内联，或者可以为映射地址创建独立网络对象或网络
对象组。网络对象组对于使用不连续的 IP 地址范围或多台主机或多个子网创建映射地址池尤其有
用。要创建网络对象或组，请参阅一般操作配置指南。

有关对象和组的特定准则，请参阅与您想要配置的 NAT 类型对应的配置部分。另请参阅第 6-2 页的
准则和限制小节。

准则和限制

情景模式准则

在单一和多情景模式下受支持。

防火墙模式准则

• 在路由和透明防火墙模式下受支持。

• 在透明模式下，必须指定实际接口和映射接口；不能使用 --Any--。

• 在透明模式下，不能配置接口 PAT，因为透明模式接口没有 IP 地址。也不能将管理 IP 地址用
作映射地址。

• 在透明模式下，不支持在 IPv4 和 IPv6 网络之间进行转换。支持在两个 IPv6 网络之间或两个 
IPv4 网络之间进行转换。

IPv6 准则

• 支持 IPv6。另请参阅第 5-13 页的 NAT 和 IPv6。

• 对于路由模式，还可以在 IPv4 和 IPv6 之间进行转换。

• 对于透明模式，不支持在 IPv4 和 IPv6 网络之间进行转换。支持在两个 IPv6 网络之间或两个 
IPv4 网络之间进行转换。

• 对于透明模式，对于 IPv6 来说不支持 PAT 池。

• 对于静态 NAT，可以指定一个多达 /64 的 IPv6 子网。不支持更大的子网。

• 将 FTP 和 NAT46 配合使用时，当 IPv4 FTP 客户端连接到 IPv6 FTP 服务器时，客户端必须使用
扩展被动模式 (EPSV) 或扩展端口模式 (EPRT)；在使用 IPv6 时，PASV 和 PORT 命令不受支持。

型号 许可证要求

ASAv 标准或高级许可证。

所有其他型号 基础许可证。
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  默认设置
其他准则

• 只能为给定对象定义单一 NAT 规则；如果想为对象配置多条 NAT 规则，需要使用指定同一 IP 
地址的不同名称创建对个对象，例如， object network obj-10.10.10.1-01、 object network 
obj-10.10.10.1-02 等等。

• 如果更改 NAT 配置，而且在使用新 NAT 配置之前不想等待现有转换超时，则可以使用 clear 
xlate 命令清除转换表。然而，清除转换表将断开使用转换的当前所有连接。

注 如果移除动态 NAT 或 PAT 规则，然后使用与已移除规则中地址重叠的映射地址添加新
规则，则将不使用新规则，直至与已移除规则关联的所有连接超时，或已使用 clear 
xlate 命令将这些连接清除。此保护措施确保相同的地址将不分配至多个主机。

• NAT 中使用的对象和对象组不能是未定义的，它们必须包含 IP 地址。

• 不能使用同时包含 IPv4 和 IPv6 地址的对象组，对象组只能包括一种类型的地址。

• 可以在多条 NAT 规则中使用同一映射对象或组。

• 已映射 IP 地址池不能包括：

– 已映射接口的 IP 地址。如果为规则指定 --Any-- 接口，那么所有接口 IP 地址将不被允许。
对于接口 PAT （仅路由模式），请使用 interface name，而非 IP 地址。

– （透明模式）管理 IP 地址。

– （动态 NAT）启用 VPN 时，备用接口 IP 地址。

– 现有的 VPN 池地址。

• 避免在静态和动态 NAT 策略中使用重叠地址。例如，使用重叠地址，如果 PPTP 的辅助连接命
中静态而非动态 xlate，将无法建立 PPTP 连接。

• 有关 NAT 或 PAT 的应用检测限制，请参阅第 8 章，“应用层协议检测入门”中的第 8-5 页的默
认检测和 NAT 限制。

默认设置
• （路由模式）默认实际接口和映射接口为 Any，可将规则应用于所有接口。

• （8.3(1)、 8.3(2) 和 8.4(1)）用于身份标识 NAT 的默认行为已禁用代理 ARP。无法配置此设置。
（8.4(2) 及更高版本）用于身份标识 NAT 的默认行为已启用代理 ARP，匹配其他静态 NAT 规
则。如果需要，可以禁用代理 ARP。有关详细信息，请参阅第 5-19 页的路由 NAT 数据包。

• 如果指定可选接口，则 ASA 将使用 NAT 配置确定出口接口。（8.3(1) 到 8.4(1)）唯一的例外是
面向身份标识 NAT，其中该身份标识 NAT 始终使用路由查询，无论 NAT 配置如何。（8.4(2) 及
更高版本）对于身份标识 NAT，默认行为是使用 NAT 配置，但您可以选择始终使用路由查询。
有关详细信息，请参阅第 5-19 页的路由 NAT 数据包。
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  配置网络对象 NAT
配置网络对象 NAT
本节介绍如何配置网络对象 NAT。

• 第 6-4 页的使用 PAT 池配置动态 NAT 或动态 PAT

• 第 6-9 页的配置动态 PAT （隐藏）

• 第 6-12 页的配置静态 NAT 或带有端口转换的静态 NAT

• 第 6-15 页的配置身份标识 NAT

• 第 6-18 页的配置每会话 PAT 规则

使用 PAT 池配置动态 NAT 或动态 PAT
本节介绍如何使用 PAT 池为动态 NAT 或动态 PAT 配置网络对象 NAT。有关详细信息，请参阅第 5-8 
页的动态 NAT 或第 5-9 页的动态 PAT。

准则

对于 PAT 池：

• 如果可用，真实源端口号将用于映射端口。然而，如果真实端口不可用，将默认从与真实端口
号相同的端口范围选择映射端口：0 至 511、 512 至 1023 以及 1024 至 65535。因此，低于 1024 
的端口只有一个可以使用的小 PAT 池。（8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）如果您拥
有的大量流量使用较低端口范围，则现可为 PAT 池指定将要使用的无层次的端口范围，而不是
三个不同大小的层：1024 至 65535，或 1 至 65535。

• 如在两个不同的规则中使用相同的 PAT 池对象，则请确保为每条规则指定相同的选项。例如，
如果一条规则指定扩展 PAT 和无层次的范围，则另一条规则也必须指定扩展 PAT 和无层次的
范围。

对于适用于 PAT 池的扩展 PAT：

• 许多应用检测不支持扩展 PAT。有关不支持的检测的完整列表，请参阅第 8 章，“应用层协议
检测入门”中的第 8-5 页的默认检测和 NAT 限制。

• 如为动态 PAT 规则启用扩展 PAT，则不能也在带有端口转换规则的另一静态 NAT 中使用 PAT 池
中的地址作为 PAT 地址。例如，如果 PAT 池包括 10.1.1.1，则无法创建一个将 10.1.1.1 用作 PAT 
地址的采用端口转换规则的静态 NAT。

• 如使用 PAT 池，并为回退指定接口，则无法指定扩展 PAT。

• 对于使用 ICE 或 TURN 的 VoIP 部署，请勿使用扩展 PAT。 ICE 和 TURN 依赖于 PAT 绑定才能
对所有目标均保持相同。

对于 PAT 池的轮询调度：

• 如果主机拥有现有连接，并且端口可用，则来自该主机的后续连接将使用相同的 PAT IP 地址。
注意：此 “粘性”在故障转移后将不复存在。如果 ASA 进行故障转移，则来自某个主机的后
续连接可能将不使用初始 IP 地址。

• 轮询调度可能会消耗大量的内存，在与扩展 PAT 组合使用时尤其如此。由于将为每一个映射协
议/IP 地址/端口范围创建 NAT 池，因此，轮询调度会导致大量并发 NAT 池，从而消耗内存。扩
展 PAT 将导致甚至更多数量的并发 NAT 池。
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  配置网络对象 NAT
详细步骤

步骤 1 将 NAT 添加到新的或现有的网络对象中：

• 要添加新的网络对象，请选择 Configuration > Firewall > NAT Rules，然后点击 Add > Add 
Network Object NAT Rule。

• 要将 NAT 添加到现有的网络对象中，请选择 Configuration > Firewall > Objects > Network 
Objects/Groups，然后双击网络对象。

有关详细信息，请参阅一般操作配置指南。

系统将显示 Add/Edit Network Object 对话框。

步骤 2 对于新对象，请为以下字段输入值：

a. Name - 对象名称。使用字符 a 到 z、A 到 Z、 0 到 9、句号、破折号、逗号或下划线。名称不得
超过 64 个字符。

b. Type - 主机、网络或范围。

c. IP Address - IPv4 或 IPv6 地址。如果选择 Range 为对象类型，IP Address 字段变更为可以输入开
始地址和结束地址。

d. Netmask/Prefix Length - 输入子网掩码或前缀长度。

e. Description - （可选）网络对象描述 （长度至多 200 个字符）。
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  配置网络对象 NAT
步骤 3 如果 NAT 部分隐藏，请点击 NAT 展开此部分。

步骤 4 选中 Add Automatic Translation Rules 复选框。

步骤 5 从 Type 下拉列表中选择 Dynamic。选择 Dynamic，即使正在使用 PAT 地址配置动态 PAT。

步骤 6 使用 PAT 池配置动态 NAT 或动态 PAT：

• Dynamic NAT - 在 Translated Addr 字段右侧，点击浏览按钮，并选择一个现有网络对象，或者从 
Browse Translated Addr 对话框创建一个新对象。

注 对象或组不能包含子网。组不能包含 IPv4 和 IPv6 地址；但必须仅包含一个类型。
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  配置网络对象 NAT
• Dynamic PAT using a PAT pool -使 PAT 池能够用于：

a. 请不要为 Translated Addr.  字段输入值；将其留空。

b. 选中 PAT Pool Translated Address 复选框，然后点击浏览按钮，并选择一个现有网络对象，或
者从 Browse Translated PAT Pool Address 对话框创建一个新网络对象。

注 PAT 池对象或组不能包含子网。组不能包含 IPv4 和 IPv6 地址；但必须仅包含一个类型。

c. （可选）选中 Round Robin 复选框，以轮询方式分配地址/端口。默认情况下，如果不采用轮
询，在使用下一个 PAT 地址之前，将分配 PAT 地址的所有端口。在返回再次使用第一个地址、
第二个地址等等之前，轮询方法可以从池中的每个 PAT 地址分配一个地址/端口。

d. （可选， 8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）选中 Extend PAT uniqueness to per 
destination instead of per interface 复选框，以使用扩展 PAT。通过将目标地址和端口纳入转换
信息，相对于按 IP 地址，扩展 PAT 将按服务使用 65535 个端口。通常，创建 PAT 转换时，将不
考虑目标端口和地址，因此，限定您按 PAT 地址使用 65535 个端口。例如，借助于扩展 PAT，
可创建进入 192.168.1.7:23 时的 10.1.1.1:1027 转换，以及进入 192.168.1.7:80 时的 10.1.1.1:1027 
转换。

e. （可选，8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）选择 Translate TCP or UDP ports into flat 
range (1024-65535) 复选框，以在分配端口时使用 1024 到 65535 端口范围作为单一范围。为转
换选择映射端口号时， ASA 将使用真实源端口号（如可用）。然而，如不使用此选项，则当真
实端口不可用时，将默认从与真实端口号相同的端口范围选择映射端口：1 至 511、512 至 1023 
以及 1024 至 65535。为了避免用尽低端口号范围的端口，请配置此设置。要使用 1 至 65535 的
整个范围，也请选择 Include range 1 to 1023 复选框。

步骤 7 （可选，仅路由模式）当其他映射地址已分配时，要使用接口 IP 地址作为备份方法，请选中 Fall 
through to interface PAT (dest intf) 复选框，并从下拉列表选择接口。要使用接口的 IPv6 地址，另
请选中 Use IPv6 for interface PAT 复选框。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  配置网络对象 NAT
步骤 8 （可选）点击 Advanced，在 Advanced NAT Settings 对话框中配置以下选项。

• Translate DNS replies for rule - 转换 DNS 回复中的 IP 地址。确保启用 DNS 检测（默认情况下启
用）。有关详细信息，请参阅第 5-29 页的 DNS 和 NAT。

• （透明防火墙模式所必需的）Source Interface - 指定应用此 NAT 规则的实际接口。默认情况下，
此规则应用于所有接口。

• （透明防火墙模式所必需的）Destination Interface - 指定应用此 NAT 规则的映射接口。默认情况
下，此规则应用于所有接口。

完成设置后，点击 OK。返回到 Add/Edit Network Object 对话框。

步骤 9 点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  配置网络对象 NAT
配置动态 PAT （隐藏）

本节介绍如何为动态 PAT （隐藏）配置网络对象 NAT。对于使用 PAT 池的动态 PAT，请参阅第 6-4 
页的使用 PAT 池配置动态 NAT 或动态 PAT，而不是使用本节。有关详细信息，请参阅第 5-9 页的动
态 PAT。

详细步骤

步骤 1 将 NAT 添加到新的或现有的网络对象中：

• 要添加新的网络对象，请选择 Configuration > Firewall > NAT Rules，然后点击 Add > Add 
Network Object NAT Rule。

• 要将 NAT 添加到现有的网络对象中，请选择 Configuration > Firewall > Objects > Network 
Objects/Groups，然后双击网络对象。

有关详细信息，请参阅一般操作配置指南。

系统将显示 Add/Edit Network Object 对话框。

步骤 2 对于新对象，请为以下字段输入值：

a. Name - 对象名称。使用字符 a 到 z、A 到 Z、 0 到 9、句号、破折号、逗号或下划线。名称不得
超过 64 个字符。

b. Type - 主机、网络或范围。

c. IP Address - IPv4 或 IPv6 地址。如果选择 Range 为对象类型，IP Address 字段变更为可以输入开
始地址和结束地址。

d. Netmask/Prefix Length - 输入子网掩码或前缀长度。

e. Description - （可选）网络对象描述 （长度至多 200 个字符）。
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  配置网络对象 NAT
步骤 3 如果 NAT 部分隐藏，请点击 NAT 展开此部分。

步骤 4 选中 Add Automatic Translation Rules 复选框。

步骤 5 从 Type 下拉列表中选择 Dynamic PAT (Hide)。

注 要使用 PAT 池而非单一地址配置动态 PAT，请参阅第 6-4 页的使用 PAT 池配置动态 NAT 或
动态 PAT。

步骤 6 指定单一映射地址。在 Translated Addr. 字段中，通过执行以下某项操作来指定映射 IP 地址：

• 键入主机 IP 地址。

• 键入接口名称或点击浏览按钮，从 Browse Translated Addr 对话框中选择一个接口。

如果指定一个接口名称，则可以启用 interface PAT，其中指定的接口 IP 地址用作映射地址。要
使用 IPv6 接口地址，还请务必选中 Use IPv6 for interface PAT 复选框。使用接口 PAT 时，NAT 
规则仅应用于指定的映射地址。（如果不使用接口 PAT 时，则默认情况下，此规则应用于所有
接口。）请参阅步骤 7，或者将实际接口配置为特定接口，而非 --Any--。

注 不能在透明模式下指定接口。
6-10
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  配置网络对象 NAT
• 点击浏览按钮，从 Browse Translated Addr 对话框中选择一个现有主机地址。

• 点击浏览按钮，从 Browse Translated Addr 对话框中创建一个新的命名对象。

步骤 7 （可选）点击 Advanced，在 Advanced NAT Settings 对话框中配置以下选项。

• Translate DNS replies for rule - 转换 DNS 回复中的 IP 地址。确保启用 DNS 检测（默认情况下启
用）。有关详细信息，请参阅第 5-29 页的 DNS 和 NAT。

• （透明防火墙模式所必需的）Source Interface - 指定应用此 NAT 规则的实际接口。默认情况下，
此规则应用于所有接口。

• （透明防火墙模式所必需的）Destination Interface - 指定应用此 NAT 规则的映射接口。默认情况
下，此规则应用于所有接口。

完成设置后，点击 OK。返回到 Add/Edit Network Object 对话框。

步骤 8 点击 OK，然后点击 Apply。
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  配置网络对象 NAT
配置静态 NAT 或带有端口转换的静态 NAT
本节介绍如何使用网络对象 NAT 配置静态 NAT 规则。有关详细信息，请参阅第 5-3 页的静态 NAT。

详细步骤

步骤 1 将 NAT 添加到新的或现有的网络对象中：

• 要添加新的网络对象，请选择 Configuration > Firewall > NAT Rules，然后点击 Add > Add 
Network Object NAT Rule。

• 要将 NAT 添加到现有的网络对象中，请选择 Configuration > Firewall > Objects > Network 
Objects/Groups，然后双击网络对象。

有关详细信息，请参阅一般操作配置指南。

系统将显示 Add/Edit Network Object 对话框。

步骤 2 对于新对象，请为以下字段输入值：

a. Name - 对象名称。使用字符 a 到 z、A 到 Z、 0 到 9、句号、破折号、逗号或下划线。名称不得
超过 64 个字符。

b. Type - 网络、主机或范围。

c. IP Address - IPv4 或 IPv6 地址。如果选择 Range 为对象类型，IP Address 字段变更为可以输入开
始地址和结束地址。

d. Netmask/Prefix Length - 输入子网掩码或前缀长度。

e. Description - （可选）网络对象描述 （长度至多 200 个字符）。
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  配置网络对象 NAT
步骤 3 如果 NAT 部分隐藏，请点击 NAT 展开此部分。

步骤 4 选中 Add Automatic Translation Rules 复选框。

步骤 5 从 Type 下拉列表中选择 Static。

步骤 6 在 Translated Addr. 字段中，执行以下操作之一：

• 键入 IP 地址。

键入 IP 地址时，映射网络的网络掩码或范围与实际网络的相同。例如，如果实际网络为主机，
则该地址将是主机地址。如果是范围，则映射地址包含的地址数量与实际范围的相同。例如，
如果实际地址定义为 10.1.1.1 到 10.1.1.6 的范围，并且将 172.20.1.1 指定为映射地址，则映射范
围将包括 172.20.1.1 到 172.20.1.6。

• （仅对于带端口转换的静态 NAT）键入接口名称，或者点击浏览按钮，从 Browse Translated 
Addr 对话框中选择一个接口。

要使用 IPv6 接口地址，还请务必选中 Use IPv6 for interface PAT 复选框。另请确保在 Advanced 
NAT Settings 对话框中配置服务 （请参阅步骤 8）。（不能在透明模式下指定接口）。

• 点击浏览按钮，从 Browse Translated Addr 对话框中选择一个现有地址。

• 点击浏览按钮，从 Browse Translated Addr 对话框中创建一个新的地址。
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  配置网络对象 NAT
通常，配置相同数量的映射地址和实际地址，以便进行一对一映射。然而，地址数量可以不匹配。
有关详细信息，请参阅第 5-3 页的静态 NAT。

步骤 7 （可选）对于 NAT46，选中 Use one-to-one address translation。对于 NAT 46，指定一对一转换，将
第一个 IPv4 地址转换为第一个 IPv6 地址，将第二个 IPv4 地址转换为第二个 IPv6 地址，依次类推。
如果没有此选项，使用嵌入 IPv4 的方法。对于一对一转换，必须使用此关键字。

步骤 8 （可选）点击 Advanced，在 Advanced NAT Settings 对话框中配置以下选项。

• Translate DNS replies for rule - 转换 DNS 回复中的 IP 地址。确保启用 DNS 检测（默认情况下启
用）。有关详细信息，请参阅第 5-29 页的 DNS 和 NAT。

• Disable Proxy ARP on egress interface - 为流向映射 IP 地址的传入数据包禁用代理 ARP。有关详
细信息，请参阅第 5-20 页的映射地址和路由。

• （透明防火墙模式所必需的）接口：

– Source Interface - 指定应用此 NAT 规则的实际接口。默认情况下，此规则应用于所有接口。

– Destination Interface - 指定应用此 NAT 规则的映射接口。默认情况下，此规则应用于所有
接口。

• 服务：

– Protocol - 配置带端口转换的静态 NAT。选择 tcp 或 udp。

– Real Port - 可以键入端口号或已知端口名称 （例如 “ftp”）。

– Mapped Port - 可以键入端口号或已知端口名称 （例如 “ftp”）。

完成设置后，点击 OK。返回到 Add/Edit Network Object 对话框。
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  配置网络对象 NAT
步骤 9 点击 OK，然后点击 Apply。

因为静态规则是双向的 （允许启动到实际主机或从实际主机启动），所以 NAT Rules 表为每条静态
规则显示两行，为每个方向显示一行。

配置身份标识 NAT
本节介绍如何使用网络对象 NAT 配置身份标识 NAT 规则。有关详细信息，请参阅第 5-11 页的身份
标识 NAT。

详细步骤

步骤 1 将 NAT 添加到新的或现有的网络对象中：

• 要添加新的网络对象，请选择 Configuration > Firewall > NAT Rules，然后点击 Add > Add 
Network Object NAT Rule。

• 要将 NAT 添加到现有的网络对象中，请选择 Configuration > Firewall > Objects > Network 
Objects/Groups，然后双击网络对象。

有关详细信息，请参阅一般操作配置指南。

系统将显示 Add/Edit Network Object 对话框。
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步骤 2 对于新对象，请为以下字段输入值：

a. Name - 对象名称。使用字符 a 到 z、A 到 Z、 0 到 9、句号、破折号、逗号或下划线。名称不得
超过 64 个字符。

b. Type - 网络、主机或范围。

c. IP Address - IPv4 或 IPv6 地址。如果选择 Range 为对象类型，IP Address 字段变更为可以输入开
始地址和结束地址。

d. Netmask/Prefix Length - 输入子网掩码或前缀长度。

e. Description - （可选）网络对象描述 （长度至多 200 个字符）。

步骤 3 如果 NAT 部分隐藏，请点击 NAT 展开此部分。
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步骤 4 选中 Add Automatic Translation Rules 复选框。

步骤 5 从 Type 下拉列表中选择 Static。

步骤 6 在 Translated Addr. 字段中，执行以下操作之一：

• 键入用于实际地址的相同 IP 地址。

• 点击浏览按钮，从 Browse Translated Addr 对话框中选择一个带有匹配 IP 地址定义的网络对象。

• 点击浏览按钮，从 Browse Translated Addr 对话框中创建一个带有匹配 IP 地址定义的新网络
对象。

步骤 7 （可选）点击 Advanced，在 Advanced NAT Settings 对话框中配置以下选项。

• Disable Proxy ARP on egress interface - 为映射 IP 地址的传入数据包禁用代理 ARP。有关详细信
息，请参阅第 5-20 页的映射地址和路由。

• （路由模式；指定接口）Lookup route table to locate egress interface - 使用路由查找而不是 NAT 命
令中指定的接口来确定出口接口。有关详细信息，请参阅第 5-22 页的确定出口接口。

• （透明防火墙模式所必需的）接口：

– Source Interface - 指定应用此 NAT 规则的实际接口。默认情况下，此规则应用于所有接口。

– Destination Interface - 指定应用此 NAT 规则的映射接口。默认情况下，此规则应用于所有
接口。

请不要在此对话框中配置任何其他选项。完成设置后，点击 OK。返回到 Add/Edit Network Object 
对话框。
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步骤 8 点击 OK，然后点击 Apply。

因为静态规则是双向的 （允许启动到实际主机或从实际主机启动），所以 NAT Rules 表为每条静态
规则显示两行，为每个方向显示一行。

配置每会话 PAT 规则

默认情况下，所有 TCP PAT 流量和所有 UDP DNS 流量均使用每会话 PAT。要将多会话 PAT 用于流
量，可配置每会话 PAT 规则：一条允许规则使用每会话 PAT，一条拒绝规则使用多会话 PAT。有关
每会话 PAT 和 多会话 PAT 的详细信息，请参阅第 5-10 页的每会话 PAT 与多会话 PAT （9.0(1) 及更
高版本）。

默认值

默认情况下，安装以下规则：

• 允许从任何 （IPv4 和 IPv6）到任何 （IPv4 和 IPv6）的 TCP

• 允许从任何 （IPv4 和 IPv6）到域的 UDP

这些规则不会显示在规则表中。

注 无法移除这些规则，它们始终存在于任何手动创建的规则后面。因为按顺序评估规则，所以您可以
忽略默认规则。例如，要完全忽略这些规则，您可以添加以下规则：

• 拒绝从任何 （IPv4 和 IPv6）到任何 （IPv4 和 IPv6）的 TCP

• 拒绝从任何 （IPv4 和 IPv6）到域的 UDP

详细步骤

步骤 1 选择 Configuration > Firewall > Advanced > Per-Session NAT Rules，并点击 Add > Add Per-Session 
NAT Rule。
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步骤 2 点击 Permit 或 Deny。

允许规则使用每会话 PAT；拒绝规则使用多会话 PAT。

步骤 3 键入一个地址，或者点击 ... 按钮来选择一个对象，从而指定源地址。

步骤 4 指定源服务、 UDP 或 TCP。或者，可以指定源端口，尽管通常仅指定目标端口。在 UDP/port 或 
TCP/port 中键入，或者点击 ... 按钮选择一个通用值或对象。

步骤 5 键入一个地址，或者点击 ... 按钮来选择一个对象，从而指定目标地址。

步骤 6 指定目标服务、 UDP 或 TCP；这必须与源服务相匹配。或者，可以指定目标端口。在 UDP/port 或 
TCP/port 中键入，或者点击 ... 按钮选择一个通用值或对象。

步骤 7 点击 OK。

步骤 8 点击 Apply。

监控网络对象 NAT
在 Monitoring > Properties > Connection Graphs > Xlates 窗格中，可以图形格式查看活动的 Network 
Address Translations。您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时
打开多个图形窗口。

字段

• Available Graphs - 列出可以用图形显示的组件。

– Xlate Utilization - 显示 ASA NAT 利用率。

• Graph Window Title - 显示要向其添加图形类型的图形窗口的名称。要使用现有窗口标题，请从
下拉列表选择一个标题。要在新窗口中显示图形，请输入新的窗口标题。

• Add - 点击以将 Available Graphs 列表中的选定条目移至 Selected Graphs 列表。

• Remove - 点击以移除 Selected Graphs 列表中的选定条目。

• Show Graphs - 点击以显示新的或经过更新的图像窗口。

通过 Monitoring > Properties > Connection Graphs > Perfmon 窗格，能够以图形格式查看性能信息。您
可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
字段

• Available Graphs - 列出可以用图形显示的组件。

– AAA Perfmon - 显示 ASA AAA 性能信息。

– Inspection Perfmon - 显示 ASA 检测性能信息。

– Web Perfmon - 显示 ASA 网络性能信息，包括 URL 访问和 URL 服务器请求。

– Connections Perfmon - 显示 ASA 连接性能信息。

– Xlate Perfmon - 显示 ASA NAT 性能信息。

• Graph Window Title - 显示要向其添加图形类型的图形窗口的名称。要使用现有窗口标题，请从
下拉列表选择一个标题。要在新窗口中显示图形，请输入新的窗口标题。

• Add - 点击以将 Available Graphs 列表中的选定条目移至 Selected Graphs 列表。

• Remove - 点击以移除 Selected Graphs 列表中的选定统计类型。

• Show Graphs - 点击以显示新的或经过更新的图像窗口。

网络对象 NAT 配置示例
本节包括以下配置示例：

• 第 6-21 页的提供到内部网络服务器的访问 （静态 NAT）

• 第 6-23 页的面向内部主机的 NAT （动态 NAT）和面向外部网络服务器的 NAT （静态 NAT）

• 第 6-27 页的有多个映射地址的内部负载平衡器 （静态 NAT，一对多）

• 第 6-30 页的用于 FTP、 HTTP 和 SMTP （带端口转换的静态 NAT）的单一地址

• 第 6-34 页的映射接口上的 DNS 服务器、实际接口上的网络服务器（带 DNS 修改的静态 NAT）

• 第 6-36 页的映射接口上的 DNS 服务器和 FTP 服务器，FTP 服务器已转换（带 DNS 修改的静态 
NAT）

• 第 6-38 页的映射接口上的 IPv4 DNS 服务器和 FTP 服务器，实际接口上的 IPv6 主机 （带 
DNS64 修改的静态 NAT64）
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
提供到内部网络服务器的访问 （静态 NAT）
以下示例为内部网络服务器执行静态 NAT。实际地址位于专用网络上，因此，公共地址是必需的。
静态 NAT 是必需的，因此，主机能够在固定地址发起到网络服务器的流量。（请参阅图 6-1）。

图 6-1 内部网络服务器的静态 NAT

步骤 1 为内部网络服务器创建网络对象：

步骤 2 定义网络服务器地址：

Outside

Inside

10.1.2.1

209.165.201.1

Security
Appliance

myWebServ
10.1.2.27

209.165.201.12

10.1.2.27 209.165.201.10

24
87

72

Undo Translation
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 3 配置对象的静态 NAT：

步骤 4 点击 Advanced 配置实际接口和映射接口：

步骤 5 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
面向内部主机的 NAT （动态 NAT）和面向外部网络服务器的 NAT （静
态 NAT）

当专用网络上的内部用户访问外部网络服务器时，以下示例为他们配置动态 NAT。此外，当内部
用户连接到外部网络服务器时，该网络服务器地址被转换为显示在内部网络上的地址。（请参阅
图 6-2）。

图 6-2 面向内部网络的动态 NAT，面向外部网络服务器的静态 NAT

步骤 1 为内部网络创建网络对象：

Outside

Inside

10.1.2.1

209.165.201.1

Security
Appliance

myInsNet
10.1.2.0/24

Web Server
209.165.201.12

209.165.201.12 10.1.2.20

24
87

73

Undo Translation

10.1.2.10 209.165.201.20
Translation
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 2 定义内部网络地址：

步骤 3 为内部网络启用动态 NAT：

步骤 4 对于 Translated Addr 字段，点击浏览按钮，为要向其转换内部地址的动态 NAT 池添加新网络对象。

a. 添加新网络对象。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
b. 定义 NAT 池地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 5 点击 Advanced 配置实际接口和映射接口：

步骤 6 点击 OK 返回到 Edit Network Object 对话框，然后再次点击 OK 返回到 NAT Rules 表。

步骤 7 为外部网络服务器创建网络对象：
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 8 定义网络服务器地址：

步骤 9 为网络服务器配置静态 NAT：

步骤 10 点击 Advanced 配置实际接口和映射接口：

步骤 11 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
有多个映射地址的内部负载平衡器 （静态 NAT，一对多）

以下示例显示转换为多个 IP 地址的内部负载平衡器。当外部主机访问其中一个映射 IP 地址时，将
该地址反向转换为单一负载平衡器地址。根据请求的 URL，它会将流量重新定向到正确的网络服务
器。（请参阅图 6-3）。

图 6-3 内部负载平衡器的一对多静态 NAT

步骤 1 为负载平衡器创建网络对象：

Host

Outside

Inside

Load Balancer
10.1.2.27

Web Servers

Undo Translation
10.1.2.27209.165.201.3

Undo Translation
10.1.2.27209.165.201.4

Undo Translation
10.1.2.27209.165.201.5

24
86

33
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 2 定义负载平衡器地址：

步骤 3 为负载平衡器配置静态 NAT：

步骤 4 对于 Translated Addr 字段，点击浏览按钮，为要向其转换负载平衡器地址的静态 NAT 地址组添加新
网络对象。

a. 添加新网络对象。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
b. 定义静态 NAT 地址组，并点击 OK。

c. 双击以选择新网络对象。点击 OK 返回到 NAT 配置。

步骤 5 点击 Advanced 配置实际接口和映射接口：

步骤 6 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
用于 FTP、 HTTP 和 SMTP （带端口转换的静态 NAT）的单一地址

以下带端口转换的静态 NAT 示例为远程用户访问 FTP、HTTP 和 SMTP 提供单一地址。实际上，这
些服务器是实际网络上的不同设备，但对于每台服务器，可以指定采用端口转换规则的静态 NAT，
这些规则使用同一映射 IP 地址和不同端口。（请参阅图 6-4。）

图 6-4 带端口转换的静态 NAT

步骤 1 为 FTP 服务器地址创建网络对象：
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 2 定义 FTP 服务器地址，为 FTP 服务器配置带身份端口转换的静态 NAT：

步骤 3 点击 Advanced，为 FTP 配置实际接口和映射接口以及端口转换。

步骤 4 为 HTTP 服务器地址创建网络对象：
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 5 定义 HTTP 服务器地址，为 HTTP 服务器配置带身份端口转换的静态 NAT：

步骤 6 点击 Advanced，为 HTTP 配置实际接口和映射接口以及端口转换。

步骤 7 为 SMTP 服务器地址创建网络对象：
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  网络对象 NAT 配置示例
步骤 8 定义 SMTP 服务器地址，为 SMTP 服务器配置带身份端口转换的静态 NAT：

步骤 9 点击 Advanced，为 SMTP 配置实际接口和映射接口以及端口转换。

步骤 10 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
映射接口上的 DNS 服务器、实际接口上的网络服务器 （带 DNS 修改的
静态 NAT）

例如，可以从外部接口访问 DNS 服务器。服务器 ftp.cisco.com 在内部接口上。将 ASA 配置为静态
地将 ftp.cisco.com 实际地址 (10.1.3.14) 转换为在外部网络上可见的映射地址 (209.165.201.10)。（请
参阅图 6-5。）在这种情况下，您要在此静态规则上启用 DNS 回复修改，以便使用实际地址访问 
ftp.cisco.com 的内部用户可以接收来自 DNS 服务器的实际地址，而不是映射地址。

当内部主机发送对 ftp.cisco.com 的地址的 DNS 请求时，DNS 服务器将以映射地址 (209.165.201.10) 
作为回复。 ASA 是指内部服务器的静态规则，并且将 DNS 回复中的地址转换为 10.1.3.14。如果不
启用 DNS 回复修改，则内部主机尝试将流量发送到 209.165.201.10，而不是直接访问 ftp.cisco.com。

图 6-5 DNS 回复修改
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 1 为 FTP 服务器地址创建网络对象：

步骤 2 定义 FTP 服务器地址，并且配置带 DNS 修改的静态 NAT：

步骤 3 点击 Advanced 配置实际接口和映射接口以及 DNS 修改。

步骤 4 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
映射接口上的 DNS 服务器和 FTP 服务器， FTP 服务器已转换 （带 DNS 
修改的静态 NAT）

图 6-6 显示外部网络上的 FTP 服务器和 DNS 服务器。 ASA 有面向外部服务器的静态转换。在这种
情况下，当内部用户从 DNS 服务器请求 ftp.cisco.com 的地址时， DNS 服务器将以实际地址 
209.165.201.10 作为响应。因为您想让内部用户使用 ftp.cisco.com 的映射地址 (10.1.2.56)，所以您需
要配置 DNS 回复修改以进行静态转换。

图 6-6 使用外部 NAT 的 DNS 回复修改

步骤 1 为 FTP 服务器地址创建网络对象：
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 2 定义 FTP 服务器地址，并且配置带 DNS 修改的静态 NAT：

步骤 3 点击 Advanced 配置实际接口和映射接口以及 DNS 修改。

步骤 4 点击 OK 返回到 Edit Network Object 对话框，再次点击 OK，然后点击 Apply。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
映射接口上的 IPv4 DNS 服务器和 FTP 服务器，实际接口上的 IPv6 主机
（带 DNS64 修改的静态 NAT64）

图 6-6 显示外部 IPv4 网络上的 FTP 服务器和 DNS 服务器。ASA 有面向外部服务器的静态转换。在
这种情况下，当内部 IPv6 用户从 DNS 服务器请求 ftp.cisco.com 的地址时， DNS 服务器将以实际地
址 209.165.200.225 作为响应。因为您想让内部用户使用 ftp.cisco.com 的映射地址 
(2001:DB8::D1A5:C8E1)，所以您需要配置 DNS 回复修改以进行静态转换。本示例还包括面向 DNS 
服务器的静态 NAT 转换和面向内部 IPv6 主机的 PAT 规则。

图 6-7 使用外部 NAT 的 DNS 回复修改

ftp.cisco.com
209.165.200.225

IPv4 Internet

IPv6 Net

Static Translation on Inside to:
2001:DB8::D1A5:C8E1

PAT Translation on Outside to:
209.165.200.230

User:
2001:DB8::1

DNS Server
209.165.201.15

Static Translation on Inside to:
2001:DB8::D1A5:C90F

1

2

7

6

5

4

3

DNS Query
ftp.cisco.com?

DNS Reply
209.165.200.225

DNS Reply Modification
209.165.200.225 2001:DB8::D1A5:C8E1

DNS Reply
2001:DB8::D1A5:C8E1

FTP Request
209.165.200.225

Dest Addr. Translation
209.165.200.2252001:DB8::D1A5:C8E1

FTP Request
2001:DB8::D1A5:C8E1

ASA

33
33

68
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 1 为 FTP 服务器配置带 DNS 修改的静态 NAT。

a. 为 FTP 服务器地址创建网络对象。

b. 定义 FTP 服务器地址，配置带 DNS 修改的静态 NAT，因为这是一对一转换，所以配置网络对
网络一对一方法。

c. 点击 Advanced 配置实际接口和映射接口以及 DNS 修改。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
d. 点击 OK 返回到 Edit Network Object 对话框。

步骤 2 为 DNS 服务器配置 NAT。

a. 为 DNS 服务器地址创建网络对象。

b. 定义 DNS 服务器地址，并且使用一对一方法配置静态 NAT。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
c. 点击 Advanced 配置实际接口和映射接口。

d. 点击 OK 返回到 Edit Network Object 对话框。

步骤 3 配置 IPv4 PAT 池，以转换内部 IPv6 网络。

在 NAT 下，取消选中 Add Automatic Address Translation Rules 复选框。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 配置示例
步骤 4 为内部 IPv6 网络配置 PAT。

a. 为内部 IPv6 网络创建网络对象。

b. 定义 IPv6 网络地址，并且使用 PAT 池配置动态 NAT。

c. 在 PAT Pool Translated Address 字段旁边，点击 ... 按钮选择先前创建的 PAT 池，并且点击 OK。
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第 6 章      网络对象 NAT （ASA 8.3 及更高版本）

  网络对象 NAT 的功能历史
d. 点击 Advanced 配置实际接口和映射接口。

e. 点击 OK 返回到 Edit Network Object 对话框。

步骤 5 点击 OK，然后点击 Apply。

网络对象 NAT 的功能历史
表 6-1 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

表 6-1 网络对象 NAT 的功能历史

功能名称 平台版本 功能信息

网络对象 NAT 8.3(1) 为网络对象 IP 地址配置 NAT。

我们引入或修改了以下屏幕：
Configuration > Firewall > NAT Rules
Configuration > Firewall > Objects > Network Objects/Groups

身份标识 NAT 可配置代理 ARP 和路由查询 8.4(2)/8.5(1) 在身份标识 NAT 的更早版本中，代理 ARP 被禁用，路由
查询始终用于确定出口接口。无法配置这些设置。在 
8.4(2) 及更高版本中，身份标识 NAT 的默认行为已更改
为匹配其他静态 NAT 配置的行为：在默认情况下，代理 
ARP 已启用，并且 NAT 配置确定出口接口 （如果已指
定）。您可以原样保留这些设置，或者单独启用或禁用这
些设置。请注意，现在您也可以为常规静态 NAT 禁用代
理 ARP。

从 8.3(1)、 8.3(2) 和 8.4(1) 升级至 8.4(2) 时，所有标识 
NAT 配置现包含 no-proxy-arp 和 route-lookup 关键字，
以便维持现有功能。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit Network Object > Advanced NAT Settings。

PAT 池和轮询调度地址分配 8.4(2)/8.5(1) 现在，您可以指定 PAT 地址池，而不是单一地址。或者
还可以启用 PAT 地址的轮询调度分配，而不是先使用 
PAT 地址上的所有端口，然后再使用池中的下一个地址。
这些功能有助于防止来自单一 PAT 地址的大量连接显示
为 DoS 攻击的一部分，并使大量 PAT 地址的配置过程变
轻松。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit Network Object
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轮询调度 PAT 池分配使用现有主机的相同 IP 
地址

8.4(3) 组合使用 PAT 池与轮询调度分配时，如果主机拥有现有
连接，且有端口可用，则来自该主机的后续连接将使用
相同的 PAT IP 地址。

我们未修改任何屏幕。

此功能在 8.5(1) 或 8.6(1) 中不可用。

用于 PAT 池的无层次的 PAT 端口范围 8.4(3) 如果可用，实际源端口号可用于映射端口。然而，如果
实际端口不可用，默认情况下，从与实际端口号相同的
端口范围选择映射端口：0 到 511、512 到 1023、1024 到 
65535。因此， 1024 以下的端口只有一个小 PAT 池。

如您拥有的大量流量使用较低端口范围，在使用 PAT 池
时，现可指定将要使用的无层次的端口范围，而不是三
个不同大小的层：1024 至 65535，或 1 至 65535。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit Network Object

此功能在 8.5(1) 或 8.6(1) 中不可用。

用于 PAT 池的扩展 PAT 8.4(3) 每个 PAT IP 地址允许最多 65535 个端口。如果 65535 个
端口不能提供足够的转换，则现可启用适合 PAT 池的扩
展 PAT。通过将目标地址和端口纳入转换信息，相对于
按 IP 地址，扩展 PAT 将按服务使用 65535 个端口。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit Network Object

此功能在 8.5(1) 或 8.6(1) 中不可用。

自动 NAT 规则，这些规则可以将 VPN 对等
设备的本地 IP 地址转换回对等设备的真实 IP 
地址

8.4(3) 在极少数情况下，您可能想要使用 VPN 对等设备在内部
网络上的真实 IP 地址，而非已分配的本地 IP 地址。通常
而言，通过 VPN 为对等设备提供已分配的本地 IP 地址来
访问内部网络。然而，您可能想要将本地 IP 地址转换回
对等设备的真实公共 IP 地址，例如，如果您的内部服务
器和网络的安全性基于对等设备的真实 IP 地址。

您可以在每个隧道组的一个接口上启用此功能。当 VPN 
会话已建立或断开连接时，动态添加或删除对象 NAT 规
则。可使用 show nat 命令查看这些规则。

注 由于路由问题，我们不建议使用此功能，除非您知
道您需要此功能；请联系思科 TAC 确认网络的功
能兼容性。请参阅以下限制：

• 仅支持 Cisco IPsec 和 AnyConnect Client。

• 流向公共 IP 地址的返回流量必须路由回 ASA，
因此，可应用 NAT 策略和 VPN 策略。

• 不支持负载平衡 （由于路由问题）。

• 不支持漫游 （公共 IP 更改）。

ASDM 不支持该命令，请使用命令行工具输入该命令。

表 6-1 网络对象 NAT 的功能历史 （续）

功能名称 平台版本 功能信息
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对 IPv6 的 NAT 支持 9.0(1) NAT 现在支持 IPv6 流量，以及 IPv4 和 IPv6 之间的转换。
在透明模式下，不支持 IPv4 和 IPv6 之间的转换。

我们修改了以下屏幕：Configuration > Firewall > Objects > 
Network Objects/Group。

反向 DNS 查找的 NAT 支持 9.0(1) 在为 NAT 规则启用了 DNS 检测的情况下使用 IPv4 NAT、
IPv6 NAT 和 NAT64 时， NAT 现支持为反向 DNS 查找转
换 DNS PTR 记录。

每会话 PAT 9.0(1) 每会话 PAT 功能可以提高 PAT 的可扩展性，而且对于集
群，允许每个成员单元拥有自己的 PAT 连接；多会话 
PAT 连接必须转发到主单元并归主单元所有。每会话 PAT 
会话结束时， ASA 将发送重置，并立即移除转换。此重
置将导致结束节点立即释放连接，从而避免 TIME_WAIT 
状态。另一方面，多会话 PAT 使用 PAT 超时，默认情况
下为 30 秒。对于“游击”流量，如 HTTP 或 HTTPS，每
会话功能可以显著提高一个地址支持的连接速率。在不
使用每会话功能的情况下，对于 IP 协议，一个地址的最
大连接速率约为每秒 2000。在使用每会话功能的情况
下，对于 IP 协议，一个地址的连接速率为 
65535/average-lifetime。

默认情况下，所有 TCP 流量和 UDP DNS 流量均使用每会
话 PAT 转换。对于需要多会话 PAT 的流量，如 H.323、SIP
或 Skinny，可通过创建每会话拒绝规则来禁用每会话 PAT。

我们引入了以下屏幕：Configuration > Firewall > 
Advanced > Per-Session NAT Rules。

表 6-1 网络对象 NAT 的功能历史 （续）

功能名称 平台版本 功能信息
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7第 章
两次 NAT （ASA 8.3 及更高版本）

两次 NAT 可供您在单一规则中同时确定源和目标地址。本章向您展示如何配置两次 NAT。

• 第 7-1 页的有关两次 NAT 的信息

• 第 7-2 页的两次 NAT 的许可要求

• 第 7-2 页的两次 NAT 的先决条件

• 第 7-2 页的准则和限制

• 第 7-3 页的默认设置

• 第 7-4 页的配置两次 NAT

• 第 7-26 页的监控两次 NAT

• 第 7-27 页的两次 NAT 的配置示例

• 第 7-45 页的两次 NAT 的功能历史记录

注 有关 NAT 工作原理的详细信息，请参阅第 5 章，“网络地址转换 (NAT) （ASA 8.3 及更高版本）”。

有关两次 NAT 的信息
两次 NAT 可供您在单一规则中同时确定源和目标地址。如果同时指定源和目标地址，则可指定以
下情况：例如，在进入目标 X 时源地址应转换为 A，但在进入目标 Y 时转换为 B。

注 对于静态 NAT，规则是双向的，因此，请注意，整个本指南中命令和描述中使用的 “源”和 “目
标”，即便是给定的连接，也可能源自 “目标”地址。例如，如果使用端口地址转换配置静态 
NAT，将源地址指定为 Telnet 服务器，且您想要进入该 Telnet 服务器的所有流量将端口从 2323 转换
为 23，则在命令中，必须指定将要转换的 source 端口（real: 23， mapped: 2323）。您指定源端口是
因为您将 Telnet 服务器地址指定为源地址。

目标地址是可选的。如果指定目标地址，可以将它映射到其本身 （身份标识 NAT），或者将它映射
到不同的地址。目标映射始终是静态映射。

两次 NAT 还可供您将服务对象用于带有端口转换的静态 NAT；网络对象 NAT 仅接受内联定义。

有关两次 NAT 和网络对象 NAT 之间的差异的详细信息，请参阅第 5-13 页的如何实施 NAT。

两次 NAT 规则将添加至 NAT 规则表的第 1 部分，或如已指定，也将添加至第 3 部分。有关 NAT 排
序的详细信息，请参阅第 5-18 页的 NAT 规则顺序。
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两次 NAT 的许可要求

两次 NAT 的先决条件
• 对于真实和映射地址，请配置网络对象或网络对象组。在使用不连续的 IP 地址范围、多个主机

或子网创建映射地址池时，网络对象组特别有用。要创建网络对象或组，请参阅一般操作配置
指南。

• 对于带有端口转换的静态 NAT，请配置 TCP 或 UDP 服务对象。要创建服务对象，请参阅一般
操作配置指南。

有关对象和组的特定准则，请参阅与您想要配置的 NAT 类型对应的配置部分。另请参阅第 7-2 页的
准则和限制小节。

准则和限制
此节包括该功能的指导原则和限制。

情景模式准则

在单一和多情景模式下受支持。

防火墙模式准则

• 在路由和透明防火墙模式下受支持。

• 在透明模式下，必须指定实际接口和映射接口；不能使用 --Any--。

• 在透明模式下，不能配置接口 PAT，因为透明模式接口没有 IP 地址。也不能将管理 IP 地址用
作映射地址。

• 在透明模式下，不支持在 IPv4 和 IPv6 网络之间进行转换。支持在两个 IPv6 网络之间或两个 
IPv4 网络之间进行转换。

IPv6 准则

• 支持 IPv6。

• 对于路由模式，还可以在 IPv4 和 IPv6 之间进行转换。

• 对于透明模式，不支持在 IPv4 和 IPv6 网络之间进行转换。支持在两个 IPv6 网络之间或两个 
IPv4 网络之间进行转换。

• 对于透明模式，对于 IPv6 来说不支持 PAT 池。

• 对于静态 NAT，可以指定一个多达 /64 的 IPv6 子网。不支持更大的子网。

• 将 FTP 和 NAT46 配合使用时，当 IPv4 FTP 客户端连接到 IPv6 FTP 服务器时，客户端必须使用
扩展被动模式 (EPSV) 或扩展端口模式 (EPRT)；在使用 IPv6 时，PASV 和 PORT 命令不受支持。

型号 许可证要求

ASAv 标准或高级许可证。

所有其他型号 基础许可证。
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  默认设置
附加准则

• 当源 IP 地址为子网（或使用辅助连接的任何其他应用）时，无法配置 FTP 目标端口转换；FTP 
数据信道的建立将不成功。

• 如果更改 NAT 配置，且不想要在使用新 NAT 信息之前等待现有转换超时，则可使用 clear xlate 
命令清除转换表。然而，清除转换表将断开使用转换的当前所有连接。

注 如果移除动态 NAT 或 PAT 规则，然后使用与已移除规则中地址重叠的映射地址添加新
规则，则将不使用新规则，直至与已移除规则关联的所有连接超时，或已使用 clear 
xlate 命令将这些连接清除。此保护措施确保相同的地址将不分配至多个主机。

• 不能使用同时包含 IPv4 和 IPv6 地址的对象组，对象组只能包括一种类型的地址。

• 在 NAT 规则中使用 any 关键字时，“any”流量（IPv4 与  IPv6）的定义取决于规则。只有数据
包为 IPv6 至 IPv6 或 IPv4 至 IPv4， ASA 才能对数据包执行 NAT；借助此先决条件， ASA 可确
定 NAT 规则中的 any 的值。例如，如果配置一条从“any”到 IPv6 服务器的规则，且该服务器
映射自 IPv4 地址，则 any 意味着 “任何 IPv6 流量”。如果配置一条从 “any”到 “any”的规
则，且将源映射至接口的 IPv4 地址，则 any 意味着 “任何 IPv4 流量”，因为映射接口地址暗
示目标也是 IPv4。

• NAT 中使用的对象和对象组不能是未定义的，它们必须包含 IP 地址。

• 可在多个规则中使用相同的对象。

• 已映射 IP 地址池不能包括：

– 已映射接口的 IP 地址。如果为规则指定 --Any-- 任何接口，那么所有接口 IP 地址将不被允
许。对于接口 PAT （仅路由模式），请使用 interface name，而非 IP 地址。

– （透明模式）管理 IP 地址。

– （动态 NAT）启用 VPN 时，备用接口 IP 地址。

– 现有的 VPN 池地址。

• 避免在静态和动态 NAT 策略中使用重叠地址。例如，使用重叠地址，如果 PPTP 的辅助连接命
中静态而非动态 xlate，将无法建立 PPTP 连接。

• 可使用 NAT 的事务提交模型提高系统性能和可靠性。请参阅一般操作配置指南中的基本设置章
节，了解详细信息。该选项位于 Configurations > Device Management > Advanced > Rule 
Engine 下方。

默认设置
• 默认情况下，规则将添加至 NAT 表的第 1 部分的末尾。

• （路由模式）默认实际接口和映射接口为 Any，可将规则应用于所有接口。

• （8.3(1)、 8.3(2) 和 8.4(1)）用于身份标识 NAT 的默认行为已禁用代理 ARP。无法配置此设置。
（8.4(2) 及更高版本）用于身份标识 NAT 的默认行为已启用代理 ARP，匹配其他静态 NAT 规
则。如果需要，可以禁用代理 ARP。

• 如果指定可选接口，则 ASA 将使用 NAT 配置确定出口接口。（8.3(1) 到 8.4(1)）唯一的例外是
面向身份标识 NAT，其中该身份标识 NAT 始终使用路由查询，无论 NAT 配置如何。（8.4(2) 及
更高版本）对于身份标识 NAT，默认行为是使用 NAT 配置，但您可以选择始终使用路由查询。
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配置两次 NAT
本节描述如何配置两次 NAT。

• 第 7-4 页的配置动态 NAT 或使用 PAT 池的动态 PAT

• 第 7-11 页的配置动态 PAT （隐藏）

• 第 7-16 页的配置静态 NAT 或带有端口转换的静态 NAT

• 第 7-21 页的配置身份标识 NAT

• 第 7-26 页的配置每会话 PAT 规则

配置动态 NAT 或使用 PAT 池的动态 PAT
本节描述如何为动态 NAT 或为使用 PAT 池的动态 PAT 配置两次 NAT。有关详细信息，请参阅第 5-8 
页的动态 NAT 或第 5-9 页的动态 PAT。

准则

对于 PAT 池：

• 如果可用，真实源端口号将用于映射端口。然而，如果真实端口不可用，默认情况下，将从与
真实端口号相同的端口范围选择映射端口：0 至 511、 512 至 1023 以及 1024 至 65535。因此，
低于 1024 的端口仅拥有很小的可用 PAT 池。（8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）如果
您拥有的大量流量使用较低端口范围，则现可为 PAT 池指定将要使用的无层次的端口范围，而
不是三个不同大小的层：1024 至 65535，或 1 至 65535。

• （8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）如在两个不同的规则中使用相同的 PAT 池对象，
则请确保为每条规则指定相同的选项。例如，如果一条规则指定扩展 PAT 和无层次的范围，则
另一条规则也必须指定扩展 PAT 和无层次的范围。

对于用于 PAT 池的扩展 PAT （8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）：

• 许多应用检测不支持扩展 PAT。有关不支持的检测的完整列表，请参阅第 8 章，“应用层协议
检测入门”中的第 8-5 页的默认检测和 NAT 限制。

• 如为动态 PAT 规则启用扩展 PAT，则不能也在带有端口转换规则的另一静态 NAT 中使用 PAT 池
中的地址作为 PAT 地址。例如，如果 PAT 池包括 10.1.1.1，则无法创建一个将 10.1.1.1 用作 PAT 
地址的采用端口转换规则的静态 NAT。

• 因为将为每个唯一目标创建 NAT 池，扩展 PAT 可能消耗大量的内存，这将反而耗尽内存。即使
连接数量较少，这也将导致内存迅速耗尽。

• 如使用 PAT 池，并为回退指定接口，则无法指定扩展 PAT。

• 对于使用 ICE 或 TURN 的 VoIP 部署，请勿使用扩展 PAT。 ICE 和 TURN 依赖于 PAT 绑定才能
对所有目标均保持相同。
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对于 PAT 池的轮询调度：

• （8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）如果主机拥有现有连接，并且端口可用，则来自
该主机的后续连接均将使用相同的 PAT IP 地址。注意：此 “粘性”在故障转移后将不复存在。
如果 ASA 进行故障转移，则来自某个主机的后续连接可能将不使用初始 IP 地址。

• （8.4(2)、8.5(1) 和 8.6(1)）如果主机拥有现有连接，则由于轮询调度分配，则来自该主机的后续
连接将可能使用对于每条连接而言均不同的 PAT 地址。在此情况下，在访问两个交换该主机的
相关信息的网站 （电子商务站点和支付站点）时，可能遇到问题。当这些站点发现本应认为是
一个主机的两个不同 IP 地址时，事务将可能失败。

• 轮询调度可能会消耗大量的内存，在与扩展 PAT 组合使用时尤其如此。由于将为每一个映射协
议/IP 地址/端口范围创建 NAT 池，因此，轮询调度会导致大量并发 NAT 池，从而消耗内存。扩
展 PAT 将导致甚至更多数量的并发 NAT 池。

详细步骤

要配置动态 NAT，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > NAT Rules，然后点击 Add。

如果想要将此规则添加至网络对象规则之后的第 3 部分，则点击 Add 旁的向下箭头，并选择 Add 
NAT Rule After Network Object NAT Rules。
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  配置两次 NAT
系统将显示 Add NAT Rule 对话框。

步骤 2 设置源和目标接口。

默认情况下，在路由模式下，两个接口均设置为 --Any--。在透明防火墙模式下，必须设置特定接口。

a. 从 Match Criteria: Original Packet > Source Interface 下拉列表，选择源接口。

b. 从 Match Criteria: Original Packet > Destination Interface 下拉列表，选择目标接口。
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步骤 3 确定原始数据包地址，为 IPv4 或 IPv6 地址；即源接口网络上显示的数据包地址 （真实源地址和映
射目标地址）。请参阅下图，了解原始数据包与转换后数据包的示例。

a. 对于 Match Criteria: Original Packet > Source Address，从 Browse Original Source Address 对话框，
点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包含 IPv4 和 IPv6 地
址，它只能包含一种类型的地址。默认设置为 any。

b. （可选）对于 Match Criteria: Original Packet > Destination Address，从 Browse Original Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包
含 IPv4 和 IPv6 地址，它只能包含一种类型的地址。

尽管两次 NAT 的主要功能是纳入目标 IP 地址，但目标地址是可选的。如果您确实指定目标地
址，则可为该地址配置静态转换，或只需将标识 NAT 用于该地址。您可能想要配置没有目标地
址的两次 NAT，以利用两次 NAT 的一些其他特性，包括使用真实地址的网络对象组或对规则
手动排序。有关详细信息，请参阅第 5-14 页的网络对象 NAT 和两次 NAT 之间的主要差异。

步骤 4 （可选）确定原始数据包端口 （映射目标端口）。对于 Match Criteria: Original Packet > Service，从 
Browse Original Service 对话框，点击浏览按钮，并选择现有 TCP 或 UDP 服务对象，或新建对象。

动态 NAT 不支持端口转换。然而，由于目标转换始终为静态，因此，可为目标端口执行端口转换。
服务对象可能同时包含源和目标端口，但在此情况下，将仅使用目标端口。将忽略您指定的源端
口。NAT 仅支持 TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同（同为 TCP 
或同为 UDP）。对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运
算符不受支持。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
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步骤 5 从 Match Criteria: Translated Packet > Source NAT Type 下拉列表选择 Dynamic。

该设置仅应用于源地址；目标转换始终为静态。

步骤 6 确定转换后的数据包地址，为 IPv4 或 IPv6 地址；即目标接口网络上显示的数据包地址 （映射源地
址和真实目标地址）。如果需要，可在 IPv4 与 IPv6 之间进行转换。请参阅下图，了解原始数据包
与转换后数据包的示例。

a. 可执行动态 NAT 或使用 PAT 池的动态 PAT：

• 动态 NAT - 对于 Match Criteria: Translated Packet > Source Address，从 Browse Translated Source 
Address 对话框，点击浏览按钮，并选择现有网络对象或组，或者新建对象或组。

对于动态 NAT，您通常会配置将要映射至较小组的较大源地址组。

注 对象或组不能包含子网。

• 使用 PAT 池的动态 PAT -。要配置 PAT 池，选择 PAT Pool Translated Address 选框，然后点击
浏览按钮，并选择现有网络对象或组，或者从 Browse Translated PAT Pool Address 对话框中新建
对象或组。注意：将 Source Address 字段留空。

注 对象或组不能包含子网。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
7-8
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 7      两次 NAT （ASA 8.3 及更高版本）

  配置两次 NAT
（可选）对于 PAT 池，可配置以下选项：

– 要以轮询调度方式分配地址/端口，请选中 Round Robin 复选框。不使用轮询调度时，默认
情况下，在使用下一个 PAT 地址前，将分配 PAT 地址的所有端口。轮询调度方法分配来自
池中每个 PAT 地址的地址/端口，然后才返回再次使用第一个地址，然后是第二个地址，以
此类推。

– （8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）选中 Extend PAT uniqueness to per 
destination instead of per interface 复选框以使用扩展 PAT。通过将目标地址和端口纳入转
换信息，相对于按 IP 地址，扩展 PAT 将按服务使用 65535 个端口。通常，创建 PAT 转换
时，将不考虑目标端口和地址，因此，限定您按 PAT 地址使用 65535 个端口。例如，借助
于扩展 PAT，可创建进入 192.168.1.7:23 时的 10.1.1.1:1027 转换，以及进入 192.168.1.7:80 时
的 10.1.1.1:1027 转换。

– （8.4(3) 及更高版本，不包括 8.5(1) 或 8.6(1)）选中 Translate TCP or UDP ports into flat 
range (1024-65535) 复选框，以便在分配端口时，将端口范围 1024 至 65535 用作单个无层次
范围。为转换选择映射端口号时， ASA 将使用真实源端口号 （如可用）。然而，如不使用
此选项，则当真实端口不可用时，将默认从与真实端口号相同的端口范围选择映射端口：1 
至 511、 512 至 1023 以及 1024 至 65535。为了避免用尽低端口号范围的端口，请配置此设
置。要使用 1 至 65535 的整个范围，请也选择 Include range 1 to 1023 复选框。

b. （可选，仅路由模式）如果其他映射源地址已分配，要将接口 IP 地址用作备份方法，则请选择 
Fall through to interface PAT 复选框。要使用 IPv6 接口地址，请也选中 Use IPv6 for interface 
PAT 复选框。

将使用目标接口 IP 地址。只有配置特定目标接口，此选项才可用。

c. 对于 Match Criteria: Translated Packet > Destination Address，从 Browse Translated Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象、组或接口，或新建对象或组。

对于用于目标地址的标识 NAT，只需将相同的对象或组同时用于真实和映射地址。

如果您想要转换目标地址，则静态映射通常为一对一，因此，真实地址的数量与映射地址相
同。然而，如果需要，您可拥有不同的数量。有关详细信息，请参阅第 5-3 页的静态 NAT。有
关不允许的映射 IP 地址的详细信息，请参阅第 7-2 页的准则和限制。

对于仅带有端口转换的静态接口 NAT，请从 Browse 对话框选择接口。务必也配置服务转换
（请参阅步骤 7）。对于此选项，必须在步骤 2 中为源接口配置特定接口。有关详细信息，请参
阅第 5-5 页的带端口转换的静态接口 NAT。
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  配置两次 NAT
步骤 7 （可选）确定转换后的数据包端口 （真实目标端口）。对于 Match Criteria: Translated Packet > 
Service，从 Browse Translated Service 对话框，点击浏览按钮，并选择现有 TCP 或 UDP 服务对象，
或新建对象。

动态 NAT 不支持端口转换。然而，由于目标转换始终为静态，因此，可为目标端口执行端口转换。
服务对象可能同时包含源和目标端口，但在此情况下，将仅使用目标端口。将忽略您指定的源端
口。NAT 仅支持 TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同（同为 TCP 
或同为 UDP）。对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运
算符不受支持。

步骤 8 （可选）在 Options 区域中配置 NAT 选项。

a. Enable rule - 启用此 NAT 规则。该规则默认启用。

b. （对于源专用规则） Translate DNS replies that match this rule - 在 DNS 回复中重写 DNS A 记录。
确保启用 DNS 检测 （默认情况下启用）。如果配置目标地址，则无法配置 DNS 修改。有关详
细信息，请参阅第 5-29 页的 DNS 和 NAT。

c. Description - 添加规则的相关描述，最多 200 个字符长。

步骤 9 点击 OK。
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  配置两次 NAT
配置动态 PAT （隐藏）

本节描述如何为动态 PAT （隐藏）配置两次 NAT。对于使用 PAT 池的动态 PAT，请参阅第 7-4 页
的配置动态 NAT 或使用 PAT 池的动态 PAT，而不是使用本节。有关详细信息，请参阅第 5-9 页的
动态 PAT。

详细步骤

要配置动态 PAT，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > NAT Rules，然后点击 Add。

如果想要将此规则添加至网络对象规则之后的第 3 部分，则点击 Add 旁的向下箭头，并选择 Add 
NAT Rule After Network Object NAT Rules。

系统将显示 Add NAT Rule 对话框。
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  配置两次 NAT
步骤 2 设置源和目标接口。

默认情况下，在路由模式下，两个接口均设置为 --Any--。在透明防火墙模式下，必须设置特定接口。

a. 从 Match Criteria: Original Packet > Source Interface 下拉列表，选择源接口。

b. 从 Match Criteria: Original Packet > Destination Interface 下拉列表，选择目标接口。
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步骤 3 确定原始数据包地址，为 IPv4 或 IPv6 地址；即源接口网络上显示的数据包地址 （真实源地址和映
射目标地址）。请参阅下图，了解原始数据包与转换后数据包的示例。

a. 对于 Match Criteria: Original Packet > Source Address，从 Browse Original Source Address 对话框，
点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包含 IPv4 和 IPv6 地
址，它只能包含一种类型的地址。默认设置为 any。

b. （可选）对于 Match Criteria: Original Packet > Destination Address，从 Browse Original Destination 
Address 对话框，点击浏览按钮 ，并选择现有网络对象或组，或新建对象或组。组不能同时
包含 IPv4 和 IPv6 地址，它只能包含一种类型的地址。

尽管两次 NAT 的主要功能是纳入目标 IP 地址，但目标地址是可选的。如果您确实指定目标地
址，则可为该地址配置静态转换，或只需将标识 NAT 用于该地址。您可能想要配置没有目标地
址的两次 NAT，以利用两次 NAT 的一些其他特性，包括使用真实地址的网络对象组或对规则
手动排序。有关详细信息，请参阅第 5-14 页的网络对象 NAT 和两次 NAT 之间的主要差异。

步骤 4 （可选）确定原始数据包端口 （映射目标端口）。对于 Match Criteria: Original Packet > Service，从 
Browse Original Service 对话框，点击浏览按钮，并选择现有 TCP 或 UDP 服务对象，或新建对象。

动态 PAT 不支持其他端口转换。然而，由于目标转换始终为静态，因此，可为目标端口执行端口转
换。服务对象可能同时包含源和目标端口，但在此情况下，将仅使用目标端口。将忽略您指定的源
端口。 NAT 仅支持 TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 
TCP 或同为 UDP）。对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于”
(!=) 运算符不受支持。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
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步骤 5 从 Match Criteria: Translated Packet > Source NAT Type 下拉列表选择 Dynamic PAT (Hide)。

该设置仅应用于源地址；目标转换始终为静态。

注 要配置使用 PAT 池的动态 PAT，可选择 Dynamic，而非 Dynamic PAT (Hide)，请参阅第 7-4 
页的配置动态 NAT 或使用 PAT 池的动态 PAT。

步骤 6 确定转换后的数据包地址，为 IPv4 或 IPv6 地址；即目标接口网络上显示的数据包地址 （映射源地
址和真实目标地址）。如果需要，可在 IPv4 与 IPv6 之间进行转换。请参阅下图，了解原始数据包
与转换后数据包的示例。

a. 对于 Match Criteria: Translated Packet > Source Address，从 Browse Translated Source Address 对话
框，点击浏览按钮，并选择现有网络对象或接口，或新建对象。

如果想要使用接口的 IPv6 地址，请选中 Use IPv6 for interface PAT 复选框。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
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b. 对于 Match Criteria: Translated Packet > Destination Address，从 Browse Translated Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包
含 IPv4 和 IPv6 地址，它只能包含一种类型的地址。

对于用于目标地址的标识 NAT，只需将相同的对象或组同时用于真实和映射地址。

如果您想要转换目标地址，则静态映射通常为一对一，因此，真实地址的数量与映射地址相
同。然而，如果需要，您可拥有不同的数量。有关详细信息，请参阅第 5-3 页的静态 NAT。有
关不允许的映射 IP 地址的详细信息，请参阅第 7-2 页的准则和限制。

对于仅带有端口转换的静态接口 NAT，请从 Browse 对话框选择接口。务必也配置服务转换
（请参阅步骤 7）。对于此选项，必须在步骤 2 中为源接口配置特定接口。有关详细信息，请参
阅第 5-5 页的带端口转换的静态接口 NAT。

步骤 7 （可选）确定转换后的数据包端口 （真实目标端口）。对于 Match Criteria: Translated Packet > 
Service，从 Browse Translated Service 对话框，点击浏览按钮，并选择现有 TCP 或 UDP 服务对象。

还可从 Browse Translated Service 对话框新建服务对象，并将该对象用作映射目标端口。

动态 PAT 不支持其他端口转换。然而，由于目标转换始终为静态，因此，可为目标端口执行端口转
换。服务对象可能同时包含源和目标端口，但在此情况下，将仅使用目标端口。将忽略您指定的源
端口。 NAT 仅支持 TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 
TCP 或同为 UDP）。对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于”
(!=) 运算符不受支持。
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  配置两次 NAT
步骤 8 （可选）在 Options 区域中配置 NAT 选项。

a. Enable rule - 启用此 NAT 规则。该规则默认启用。

b. （对于源专用规则） Translate DNS replies that match this rule - 在 DNS 回复中重写 DNS A 记录。
确保启用 DNS 检测 （默认情况下启用）。如果配置目标地址，则无法配置 DNS 修改。有关详
细信息，请参阅第 5-29 页的 DNS 和 NAT。

c. Description - 添加规则的相关描述，最多 200 个字符长。

步骤 9 点击 OK。

配置静态 NAT 或带有端口转换的静态 NAT
本节描述如何使用两次 NAT 配置静态 NAT 规则。有关静态 NAT 的详细信息，请参阅第 5-3 页的静
态 NAT。

详细步骤

要配置静态 NAT，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > NAT Rules，然后点击 Add。

如果想要将此规则添加至网络对象规则之后的第 3 部分，则点击 Add 旁的向下箭头，并选择 Add 
NAT Rule After Network Object NAT Rules。
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系统将显示 Add NAT Rule 对话框。

步骤 2 设置源和目标接口。

默认情况下，在路由模式下，两个接口均设置为 --Any--。在透明防火墙模式下，必须设置特定接口。

a. 从 Match Criteria: Original Packet > Source Interface 下拉列表，选择源接口。

b. 从 Match Criteria: Original Packet > Destination Interface 下拉列表，选择目标接口。

步骤 3 确定原始数据包地址，为 IPv4 或 IPv6 地址；即源接口网络上显示的数据包地址 （真实源地址和映
射目标地址）。请参阅下图，了解原始数据包与转换后数据包的示例。
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a. 对于 Match Criteria: Original Packet > Source Address，从 Browse Original Source Address 对话框，
点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包含 IPv4 和 IPv6 地
址，它只能包含一种类型的地址。默认设置为 any，但除标识 NAT 外，请勿使用此选项。有关
详细信息，请参阅第 7-21 页的配置身份标识 NAT。

b. （可选）对于 Match Criteria: Original Packet > Destination Address，从 Browse Original Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象或组，或新建对象或组。

尽管两次 NAT 的主要功能是纳入目标 IP 地址，但目标地址是可选的。如果您确实指定目标地
址，则可为该地址配置静态转换，或只需将标识 NAT 用于该地址。您可能想要配置没有目标地
址的两次 NAT，以利用两次 NAT 的一些其他特性，包括使用真实地址的网络对象组或对规则
手动排序。有关详细信息，请参阅第 5-14 页的网络对象 NAT 和两次 NAT 之间的主要差异。

步骤 4 （可选）确定原始数据包源或目标端口 （真实源端口或映射目标端口）。对于 Match Criteria: 
Original Packet > Service，从 Browse Original Service 对话框，点击浏览按钮，并选择现有 TCP 或 
UDP 服务对象，或新建对象。

服务对象可能同时包含源和目标端口。应同时为真实和映射服务对象指定源或目标端口。如果您的
应用使用固定的源端口 （如某些 DNS 服务器），则您只能同时指定源和目标端口；然而，很少使
用固定源端口。在极少数情况下，您会在对象中同时指定源和目标端口，原始数据包服务对象包含
真实源端口/映射目标端口；转换后的数据包服务对象包含映射源端口/真实目标端口。 NAT 仅支持 
TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 TCP 或同为 UDP）。
对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运算符不受支持。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
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  配置两次 NAT
步骤 5 从 Match Criteria: Translated Packet > Source NAT Type 下拉列表选择 Static。 Static 为默认设置。

该设置仅应用于源地址；目标转换始终为静态。

步骤 6 确定转换后的数据包地址，为 IPv4 或 IPv6 地址；即目标接口网络上显示的数据包地址 （映射源地
址和真实目标地址）。如果需要，可在 IPv4 与 IPv6 之间进行转换。请参阅下图，了解原始数据包
与转换后数据包的示例。

a. 对于 Match Criteria: Translated Packet > Source Address，从 Browse Translated Source Address 对话
框，点击浏览按钮，并选择现有网络对象或组，或新建对象或组。

对于静态 NAT，映射通常为一对一，因此真实地址的数量与映射地址相同。然而，如果需要，
您可拥有不同的数量。

对于带有端口转换的静态接口 NAT，可为映射地址指定接口而非网络对象/组。如果想要使用
接口的 IPv6 地址，请选中 Use IPv6 for interface PAT 复选框。

有关详细信息，请参阅第 5-5 页的带端口转换的静态接口 NAT。有关不允许的映射 IP 地址的详
细信息，请参阅第 7-2 页的准则和限制。

Real: 192.168.1.1
Mapped: 10.1.1.1

Real: 10.1.2.2
Mapped: 192.168.2.2

NAT

Source Destination

OutsideInside

10.1.2.2 ---> 10.1.1.1 192.168.2.2 ---> 192.168.1.1

Original Packet Translated Packet
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  配置两次 NAT
b. 对于 Match Criteria: Translated Packet > Destination Address，从 Browse Translated Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象、组或接口，或新建对象或组。

对于静态 NAT，映射通常为一对一，因此真实地址的数量与映射地址相同。然而，如果需要，
您可拥有不同的数量。

对于带有端口转换的静态接口 NAT，可为映射地址指定接口而非网络对象/组。有关详细信息，
请参阅第 5-5 页的带端口转换的静态接口 NAT。有关不允许的映射 IP 地址的详细信息，请参阅
第 7-2 页的准则和限制。

步骤 7 （可选）确定转换后的数据包源或目标端口 （映射源端口或真实目标端口）。对于 Match Criteria: 
Translated Packet > Service，从 Browse Translated Service 对话框，点击浏览按钮，并选择现有 TCP 或 
UDP 服务对象，或新建对象。

服务对象可能同时包含源和目标端口。应同时为真实和映射服务对象指定源或目标端口。如果您的
应用使用固定的源端口 （如某些 DNS 服务器），则您只能同时指定源和目标端口；然而，很少使
用固定源端口。在极少数情况下，您会在对象中同时指定源和目标端口，原始数据包服务对象包含
真实源端口/映射目标端口；转换后的数据包服务对象包含映射源端口/真实目标端口。 NAT 仅支持 
TCP 或 UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 TCP 或同为 UDP）。
对于标识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运算符不受支持。

步骤 8 （可选）对于 NAT46，选中 Use one-to-one address translation 复选框。对于 NAT 46，指定 one-to-one
以将第一个 IPv4 地址转换为第一个 IPv6 地址，将第二个 IPv4 地址转换为第二个 IPv6 地址，以此类
推。如不使用此选项，则将使用 IPv4 嵌入式方法。对于一对一转换，必须使用此关键字。
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  配置两次 NAT
步骤 9 （可选）在 Options 区域中配置 NAT 选项。

a. Enable rule - 启用此 NAT 规则。该规则默认启用。

b. （对于源专用规则） Translate DNS replies that match this rule - 在 DNS 回复中重写 DNS A 记录。
确保启用 DNS 检测 （默认情况下启用）。如果配置目标地址，则无法配置 DNS 修改。有关详
细信息，请参阅第 5-29 页的 DNS 和 NAT。

c. Disable Proxy ARP on egress interface - 为流向映射 IP 地址的传入数据包禁用代理 ARP。有关详
细信息，请参阅第 5-20 页的映射地址和路由。

d. Direction - 要使规则成为单向，请选择 Unidirectional。默认设置为 Both。使规则成为单向可防
止流量发起通向真实地址的连接。

e. Description - 添加规则的相关描述，最多 200 个字符长。

步骤 10 点击 OK。

配置身份标识 NAT
本节描述如何使用两次 NAT 配置标识 NAT 规则。有关标识 NAT 的详细信息，请参阅第 5-11 页的身
份标识 NAT。

详细步骤

要配置标识 NAT，请执行以下步骤：

步骤 1 选择 Configuration > Firewall > NAT Rules，然后点击 Add。

如果想要将此规则添加至网络对象规则之后的第 3 部分，则点击 Add 旁的向下箭头，并选择 Add 
NAT Rule After Network Object NAT Rules。
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  配置两次 NAT
系统将显示 Add NAT Rule 对话框。

步骤 2 设置源和目标接口。

默认情况下，在路由模式下，两个接口均设置为 --Any--。在透明防火墙模式下，必须设置特定接口。

a. 从 Match Criteria: Original Packet > Source Interface 下拉列表，选择源接口。

b. 从 Match Criteria: Original Packet > Destination Interface 下拉列表，选择目标接口。

步骤 3 确定原始数据包地址，为 IPv4 或 IPv6 地址；即源接口网络上显示的数据包地址 （真实源地址和映
射目标地址）。请参阅下图，了解原始数据包与转换后数据包的示例，其中您在内部主机上执行标
识 NAT，但转换外部主机。

Real: 192.168.1.1
Mapped: 10.1.1.1

10.1.2.2
Identity

NAT

OutsideInside

10.1.2.2 ---> 10.1.1.1 10.1.2.2 ---> 192.168.1.1

Original Packet Translated Packet

Source Destination
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a. 对于 Match Criteria: Original Packet > Source Address，从 Browse Original Source Address 对话框，
点击浏览按钮，并选择现有网络对象或组，或新建对象或组。组不能同时包含 IPv4 和 IPv6 地
址，它只能包含一种类型的地址。默认设置为 any；只有也将映射地址设置为 any 时才能使用
此选项。

b. （可选）对于 Match Criteria: Original Packet > Destination Address，从 Browse Original Destination 
Address 对话框，点击浏览按钮 ，并选择现有网络对象或组，或新建对象或组。

尽管两次 NAT 的主要功能是纳入目标 IP 地址，但目标地址是可选的。如果您确实指定目标地
址，则可为该地址配置静态转换，或只需将标识 NAT 用于该地址。您可能想要配置没有目标地
址的两次 NAT，以利用两次 NAT 的一些其他特性，包括使用真实地址的网络对象组或对规则
手动排序。有关详细信息，请参阅第 5-14 页的网络对象 NAT 和两次 NAT 之间的主要差异。

步骤 4 （可选）确定原始数据包源或目标端口 （真实源端口或映射目标端口）。对于 Match Criteria: 
Original Packet > Service，从 Browse Original Service 对话框，点击浏览按钮，并选择现有 TCP 或 
UDP 服务对象，或新建对象。

服务对象可能同时包含源和目标端口。应为两个服务对象指定源或目标端口。如果您的应用使用固
定的源端口 （如某些 DNS 服务器），则您只能同时指定源和目标端口；然而，很少使用固定源端
口。在极少数情况下，您会在对象中同时指定源和目标端口，原始数据包服务对象包含真实源端口
/映射目标端口；转换后的数据包服务对象包含映射源端口/真实目标端口。 NAT 仅支持 TCP 或 
UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 TCP 或同为 UDP）。对于标
识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运算符不受支持。
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步骤 5 从 Match Criteria: Translated Packet > Source NAT Type 下拉列表选择 Static。 Static 为默认设置。

该设置仅应用于源地址；目标转换始终为静态。

步骤 6 确定转换后的数据包地址；即目标接口网络上显示的数据包地址 （映射源地址和真实目标地址）。
请参阅下图，了解原始数据包与转换后数据包的示例，其中您在内部主机上执行标识 NAT，但转换
外部主机。

a. 对于 Match Criteria: Translated Packet > Source Address，从您选择真实源地址的 Browse Translated 
Source Address 对话框，点击浏览按钮，并选择相同的网络对象或组。如为真实地址指定 any，
则请使用 any。

b. 对于 Match Criteria: Translated Packet > Destination Address，从 Browse Translated Destination 
Address 对话框，点击浏览按钮，并选择现有网络对象、组或接口，或新建对象或组。

对于用于目标地址的标识 NAT，只需将相同的对象或组同时用于真实和映射地址。

如果您想要转换目标地址，则静态映射通常为一对一，因此，真实地址的数量与映射地址相
同。然而，如果需要，您可拥有不同的数量。有关详细信息，请参阅第 5-3 页的静态 NAT。有
关不允许的映射 IP 地址的详细信息，请参阅第 7-2 页的准则和限制。

对于仅带有端口转换的静态接口 NAT，请选择接口。如指定接口，务必也配置服务转换。有关
详细信息，请参阅第 5-5 页的带端口转换的静态接口 NAT。

步骤 7 （可选）确定转换后的数据包源或目标端口 （映射源端口或真实目标端口）。对于 Match Criteria: 
Translated Packet > Service，从 Browse Translated Service 对话框，点击浏览按钮，并选择现有 TCP 或 
UDP 服务对象，或新建对象。

服务对象可能同时包含源和目标端口。应为两个服务对象指定源或目标端口。如果您的应用使用固
定的源端口 （如某些 DNS 服务器），则您只能同时指定源和目标端口；然而，很少使用固定源端
口。在极少数情况下，您会在对象中同时指定源和目标端口，原始数据包服务对象包含真实源端口
/映射目标端口；转换后的数据包服务对象包含映射源端口/真实目标端口。 NAT 仅支持 TCP 或 
UDP。转换端口时，请确保真实和映射服务对象中的协议相同 （同为 TCP 或同为 UDP）。对于标
识 NAT，可将相同的服务对象同时用于真实和映射端口。“不等于” (!=) 运算符不受支持。

Real: 192.168.1.1
Mapped: 10.1.1.1

10.1.2.2
Identity
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10.1.2.2 ---> 10.1.1.1 10.1.2.2 ---> 192.168.1.1
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Source Destination
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步骤 8 （可选）在 Options 区域中配置 NAT 选项。

a. Enable rule - 启用此 NAT 规则。该规则默认启用。

b. Disable Proxy ARP on egress interface - 为流向映射 IP 地址的传入数据包禁用代理 ARP。有关详
细信息，请参阅第 5-20 页的映射地址和路由。

c. （路由模式；指定接口）Lookup route table to locate egress interface - 使用路由查找而不是 NAT 命
令中指定的接口来确定出口接口。有关详细信息，请参阅第 5-22 页的确定出口接口。

d. Direction - 要使规则成为单向，请选择 Unidirectional。默认设置为 Both。使规则成为单向可防
止流量发起通向真实地址的连接。您可能想要将此设置用于测试目的。

e. Description - 添加规则的相关描述，最多 200 个字符长。

注 尽管“Translate DNS replies that match this rule”复选框可用，但是，如未配置目标地址，则
此选项不适用于标识 NAT，因为您正将地址转换为其自身，所以，此 DNS 回复不需要修
改。有关详细信息，请参阅第 5-29 页的 DNS 和 NAT。

步骤 9 点击 OK。
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配置每会话 PAT 规则

默认情况下，所有 TCP PAT 流量和所有 UDP DNS 流量均使用每会话 PAT。要将多会话 PAT 用于
流量，可配置每会话 PAT 规则：一条允许规则使用每会话 PAT，一条拒绝规则使用多会话 PAT。
有关每会话与多会话 PAT 的详细信息，请参阅第 5-10 页的每会话 PAT 与多会话 PAT （9.0(1) 及更
高版本）。

详细步骤

要配置每会话 PAT 规则，请参阅第 6-18 页的配置每会话 PAT 规则。

监控两次 NAT
在 Monitoring > Properties > Connection Graphs > Xlates 窗格中，可以图形格式查看活动的 Network 
Address Translations。您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时
打开多个图形窗口。

字段

• Available Graphs - 列出可以用图形显示的组件。

– Xlate Utilization - 显示 ASA NAT 利用率。

• Graph Window Title - 显示要向其添加图形类型的图形窗口的名称。要使用现有窗口标题，请从
下拉列表选择一个标题。要在新窗口中显示图形，请输入新的窗口标题。

• Add - 点击以将 Available Graphs 列表中的选定条目移至 Selected Graphs 列表。

• Remove - 点击以移除 Selected Graphs 列表中的选定条目。

• Show Graphs - 点击以显示新的或经过更新的图像窗口。

通过 Monitoring > Properties > Connection Graphs > Perfmon 窗格，能够以图形格式查看性能信息。您
可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。

字段

• Available Graphs - 列出可以用图形显示的组件。

– AAA Perfmon - 显示 ASA AAA 性能信息。

– Inspection Perfmon - 显示 ASA 检测性能信息。

– Web Perfmon - 显示 ASA 网络性能信息，包括 URL 访问和 URL 服务器请求。

– Connections Perfmon - 显示 ASA 连接性能信息。

– Xlate Perfmon - 显示 ASA NAT 性能信息。

• Graph Window Title - 显示要向其添加图形类型的图形窗口的名称。要使用现有窗口标题，请从
下拉列表选择一个标题。要在新窗口中显示图形，请输入新的窗口标题。

• Add - 点击以将 Available Graphs 列表中的选定条目移至 Selected Graphs 列表。

• Remove - 点击以移除 Selected Graphs 列表中的选定统计类型。

• Show Graphs - 点击以显示新的或经过更新的图像窗口。
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两次 NAT 的配置示例
本节包括以下配置示例：

• 第 7-27 页的取决于目标的不同转换 （动态 PAT）

• 第 7-36 页的取决于目标地址和端口的不同转换 （动态 PAT）

取决于目标的不同转换 （动态 PAT）
图 7-1 展示了 10.1.2.0/24 网络上的主机访问两个不同的服务器。当主机访问处于 209.165.201.11 的服
务器时，真实地址将转换为 209.165.202.129:port。当主机访问处于 209.165.200.225 的服务器时，真
实地址将转换为 209.165.202.130:port。

图 7-1 使用不同目标地址的两次 NAT
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步骤 1 为从内部网络流向 DMZ 网络 1 的流量添加 NAT 规则：

默认情况下，NAT 规则将添加至第 1 部分的末尾。如果想要将 NAT 规则添加至网络对象 NAT 规则
之后的第 3 部分，请选择 Add NAT Rule After Network Object NAT Rules。

系统将显示 Add NAT Rule 对话框。

步骤 2 设置源和目标接口：
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步骤 3 对于 Original Source Address，在 Browse Original Source Address 对话框中，点击浏览按钮以便为内
部网络添加新网络对象。

a. 添加新网络对象。

b. 定义内部网络地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 4 对于 Original Destination Address，在 Browse Original Destination Address 对话框中，点击浏览按钮以
便为 DMZ 网络 1 添加新网络对象。

a. 添加新网络对象。
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b. 定义 DMZ 网络 1 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 5 将 NAT Type 设置为 Dynamic PAT (Hide)：

步骤 6 对于 Translated Source Address，在 Browse Translated Source Address 对话框中，点击浏览按钮以便为 
PAT 地址添加新网络对象。

a. 添加新网络对象。
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  两次 NAT 的配置示例
b. 定义 PAT 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 7 对于 Translated Destination Address，键入 Original Destination Address 的名称 (DMZnetwork1)，或者
点击浏览按钮选择该地址。

由于您不想转换目标地址，因此，需要为其配置标识 NAT，只需为原始和转换后的目标地址指定相
同的地址。

步骤 8 点击 OK，以将规则添加至 NAT 表。
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  两次 NAT 的配置示例
步骤 9 为从内部网络流向 DMZ 网络 2 的流量添加 NAT 规则：

默认情况下，NAT 规则将添加至第 1 部分的末尾。如果想要将 NAT 规则添加至网络对象 NAT 规则
之后的第 3 部分，请选择 Add NAT Rule After Network Object NAT Rules。

系统将显示 Add NAT Rule 对话框。

步骤 10 设置源和目标接口：

步骤 11 对于 Original Source Address，键入内部网络对象的名称 (myInsideNetwork)，或者点击浏览按钮选择
该名称。
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  两次 NAT 的配置示例
步骤 12 对于 Original Destination Address，在 Browse Original Destination Address 对话框中，点击浏览按钮以
便为 DMZ 网络 2 添加新网络对象。

a. 添加新网络对象。

b. 定义 DMZ 网络 2 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 13 将 NAT Type 设置为 Dynamic PAT (Hide)：
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  两次 NAT 的配置示例
步骤 14 对于 Translated Source Address，在 Browse Translated Source Address 对话框中，点击浏览按钮以便为 
PAT 地址添加新网络对象。

a. 添加新网络对象。

b. 定义 PAT 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。
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  两次 NAT 的配置示例
步骤 15 对于 Translated Destination Address，键入 Original Destination Address 的名称 (DMZnetwork2)，或者
点击浏览按钮选择该地址。

由于您不想转换目标地址，因此，需要为其配置标识 NAT，只需为原始和转换后的目标地址指定相
同的地址。

步骤 16 点击 OK，以将规则添加至 NAT 表。

步骤 17 点击 Apply。
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  两次 NAT 的配置示例
取决于目标地址和端口的不同转换 （动态 PAT）
图 7-2 展示了源和目标端口的使用。 10.1.2.0/24 网络上的主机同时因为网络服务和 Telnet 服务访问
单个主机。当主机因为 Telnet 服务访问服务器时，真实地址将转换为 209.165.202.129:port。当主机
因为网络服务访问相同服务器时，真实地址将转换为 209.165.202.130:port。

图 7-2 使用不同目标端口的两次 NAT

步骤 1 为从内部网络流向 Telnet 服务器的流量添加 NAT 规则：

默认情况下，NAT 规则将添加至第 1 部分的末尾。如果想要将 NAT 规则添加至网络对象 NAT 规则
之后的第 3 部分，请选择 Add NAT Rule After Network Object NAT Rules。

系统将显示 Add NAT Rule 对话框。

Web and Telnet server:
209.165.201.11

Internet

Inside

Translation
209.165.202.12910.1.2.27:80

10.1.2.27

10.1.2.0/24

Translation
209.165.202.13010.1.2.27:23

Web Packet
Dest. Address:

209.165.201.11:80

Telnet Packet
Dest. Address:

209.165.201.11:23

13
00

40
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  两次 NAT 的配置示例
步骤 2 设置源和目标接口：

步骤 3 对于 Original Source Address，在 Browse Original Source Address 对话框中，点击浏览按钮以便为内
部网络添加新网络对象。

a. 添加新网络对象。
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  两次 NAT 的配置示例
b. 定义内部网络地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 4 对于 Original Destination Address，在 Browse Original Destination Address 对话框中，点击浏览按钮以
便为 Telnet/网络服务器添加网络对象。

a. 添加新网络对象。

b. 定义服务器地址，并点击 OK。
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  两次 NAT 的配置示例
c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 5 对于 Original Service，在 Browse Original Service 对话框中，点击浏览按钮，以便为 Telnet 添加新服
务对象。

a. 添加新服务对象。

b. 定义协议和端口，并点击 OK。

c. 选择新服务对象，双击它即可。点击 OK 以返回到 NAT 配置。
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  两次 NAT 的配置示例
步骤 6 将 NAT Type 设置为 Dynamic PAT (Hide)：

步骤 7 对于 Translated Source Address，在 Browse Translated Source Address 对话框中，点击浏览按钮以便为 
PAT 地址添加新网络对象。

a. 添加新网络对象。

b. 定义 PAT 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。
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  两次 NAT 的配置示例
步骤 8 对于 Translated Destination Address，键入 Original Destination Address 的名称 (TelnetWebServer)，或
者点击浏览按钮选择该地址。

由于您不想转换目标地址，因此，需要为其配置标识 NAT，只需为原始和转换后的目标地址指定相
同的地址。

步骤 9 点击 OK，以将规则添加至 NAT 表。

步骤 10 为从内部网络流向网络服务器的流量添加 NAT 规则：
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  两次 NAT 的配置示例
默认情况下，NAT 规则将添加至第 1 部分的末尾。如果想要将 NAT 规则添加至网络对象 NAT 规则
之后的第 3 部分，请选择 Add NAT Rule After Network Object NAT Rules。

系统将显示 Add NAT Rule 对话框。

步骤 11 设置真实和映射接口。

步骤 12 对于 Original Source Address，键入内部网络对象的名称 (myInsideNetwork)，或者点击浏览按钮选择
该名称。

步骤 13 对于 Original Destination Address，键入 Telnet/网络服务器网络对象的名称 (TelnetWebServer)，或者
点击浏览按钮选择该名称。

步骤 14 对于 Original Service，在 Browse Original Service 对话框中，点击浏览按钮，以便为 HTTP 添加新服
务对象。

a. 添加新服务对象。
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  两次 NAT 的配置示例
b. 定义协议和端口，并点击 OK。

c. 选择新服务对象，双击它即可。点击 OK 以返回到 NAT 配置。

步骤 15 将 NAT Type 设置为 Dynamic PAT (Hide)：

步骤 16 对于 Translated Source Address，在 Browse Translated Source Address 对话框中，点击浏览按钮以便为 
PAT 地址添加新网络对象。

a. 添加新网络对象。
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  两次 NAT 的配置示例
b. 定义 PAT 地址，并点击 OK。

c. 双击以选择新网络对象。点击 OK 以返回到 NAT 配置。

步骤 17 对于 Translated Destination Address，键入 Original Destination Address 的名称 (TelnetWebServer)，或
者点击浏览按钮选择该地址。

由于您不想转换目标地址，因此，需要为其配置标识 NAT，只需为原始和转换后的目标地址指定相
同的地址。

步骤 18 点击 OK，以将规则添加至 NAT 表。

步骤 19 点击 Apply。
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  两次 NAT 的功能历史记录
两次 NAT 的功能历史记录
表 7-1 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

表 7-1 两次 NAT 的功能历史记录

功能名称 平台版本 功能信息

两次 NAT 8.3(1) 两次 NAT 可供您在单一规则中同时确定源和目标地址。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules。

身份标识 NAT 可配置代理 ARP 和路由查询 8.4(2)/8.5(1) 在身份标识 NAT 的更早版本中，代理 ARP 被禁用，路由
查询始终用于确定出口接口。无法配置这些设置。在 
8.4(2) 及更高版本中，身份标识 NAT 的默认行为已更改
为匹配其他静态 NAT 配置的行为：在默认情况下，代理 
ARP 已启用，并且 NAT 配置确定出口接口 （如果已指
定）。您可以原样保留这些设置，或者单独启用或禁用这
些设置。请注意，现在您也可以为常规静态 NAT 禁用代
理 ARP。

对于 8.3 之前版本的配置， NAT 免除规则 （nat 0 
access-list 命令）至 8.4(2) 及更高版本的迁移现包含以下
关键字，以禁用代理 ARP 并使用路由查找：
no-proxy-arp 和 route-lookup。用于迁移至 8.3(2) 和 
8.4(1) 的 unidirectional 关键字不再用于迁移。从 8.3(1)、
8.3(2) 和 8.4(1) 升级至 8.4(2) 时，所有标识 NAT 配置现包
含 no-proxy-arp 和 route-lookup 关键字，以便维持现有
功能。 unidirectional 关键字已移除。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit NAT Rule

PAT 池和轮询调度地址分配 8.4(2)/8.5(1) 现在，您可以指定 PAT 地址池，而不是单一地址。或者
还可以启用 PAT 地址的轮询调度分配，而不是先使用 
PAT 地址上的所有端口，然后再使用池中的下一个地址。
这些功能有助于防止来自单一 PAT 地址的大量连接显示
为 DoS 攻击的一部分，并使大量 PAT 地址的配置过程变
轻松。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit NAT Rule。

轮询调度 PAT 池分配使用现有主机的相同 IP 
地址

8.4(3) 组合使用 PAT 池与轮询调度分配时，如果主机拥有现有
连接，且有端口可用，则来自该主机的后续连接将使用
相同的 PAT IP 地址。

我们未修改任何屏幕。

此功能在 8.5(1) 或 8.6(1) 中不可用。
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  两次 NAT 的功能历史记录
用于 PAT 池的无层次的 PAT 端口范围 8.4(3) 如果可用，真实源端口号将用于映射端口。然而，如果
真实端口不可用，将默认从与真实端口号相同的端口范
围选择映射端口：0 至 511、 512 至 1023 以及 1024 至 
65535。因此， 1024 以下的端口只有一个小 PAT 池。

如您拥有的大量流量使用较低端口范围，在使用 PAT 池
时，现可指定将要使用的无层次的端口范围，而不是三
个不同大小的层：1024 至 65535，或 1 至 65535。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit NAT Rule。

此功能在 8.5(1) 或 8.6(1) 中不可用。

用于 PAT 池的扩展 PAT 8.4(3) 每个 PAT IP 地址允许最多 65535 个端口。如果 65535 个
端口不能提供足够的转换，则现可启用适合 PAT 池的扩
展 PAT。通过将目标地址和端口纳入转换信息，相对于
按 IP 地址，扩展 PAT 将按服务使用 65535 个端口。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules > Add/Edit NAT Rule。

此功能在 8.5(1) 或 8.6(1) 中不可用。

自动 NAT 规则，这些规则可以将 VPN 对等
设备的本地 IP 地址转换回对等设备的真实 IP 
地址

8.4(3) 在极少数情况下，您可能想要使用 VPN 对等设备在内部
网络上的真实 IP 地址，而非已分配的本地 IP 地址。通常
而言，通过 VPN 为对等设备提供已分配的本地 IP 地址来
访问内部网络。然而，您可能想要将本地 IP 地址转换回
对等设备的真实公共 IP 地址，例如，如果您的内部服务
器和网络的安全性基于对等设备的真实 IP 地址。

您可以在每个隧道组的一个接口上启用此功能。当 VPN 
会话已建立或断开连接时，动态添加或删除对象 NAT 规
则。可使用 show nat 命令查看这些规则。

注 由于路由问题，我们不建议使用此功能，除非您知
道您需要此功能；请联系思科 TAC 确认网络的功
能兼容性。请参阅以下限制：

• 仅支持 Cisco IPsec 和 AnyConnect Client。

• 流向公共 IP 地址的返回流量必须路由回 ASA，
因此，可应用 NAT 策略和 VPN 策略。

• 不支持负载平衡 （由于路由问题）。

• 不支持漫游 （公共 IP 更改）。

ASDM 不支持该命令，请使用命令行工具输入该命令。

对 IPv6 的 NAT 支持 9.0(1) NAT 现在支持 IPv6 流量，以及 IPv4 和 IPv6 之间的转换。
在透明模式下，不支持 IPv4 和 IPv6 之间的转换。

我们修改了以下屏幕：Configuration > Firewall > NAT 
Rules。

反向 DNS 查找的 NAT 支持 9.0(1) 在为 NAT 规则启用了 DNS 检测的情况下使用 IPv4 NAT、
IPv6 NAT 和 NAT64 时， NAT 现支持为反向 DNS 查找转
换 DNS PTR 记录。

表 7-1 两次 NAT 的功能历史记录 （续）

功能名称 平台版本 功能信息
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  两次 NAT 的功能历史记录
每会话 PAT 9.0(1) 每会话 PAT 功能可以提高 PAT 的可扩展性，而且对于集
群，允许每个成员单元拥有自己的 PAT 连接；多会话 
PAT 连接必须转发到主单元并归主单元所有。每会话 PAT 
会话结束时， ASA 将发送重置，并立即移除转换。此重
置将导致结束节点立即释放连接，从而避免 TIME_WAIT 
状态。另一方面，多会话 PAT 使用 PAT 超时，默认情况
下为 30 秒。对于“游击”流量，如 HTTP 或 HTTPS，每
会话功能可以显著提高一个地址支持的连接速率。在不
使用每会话功能的情况下，对于 IP 协议，一个地址的最
大连接速率约为每秒 2000。在使用每会话功能的情况
下，对于 IP 协议，一个地址的连接速率为 
65535/average-lifetime。

默认情况下，所有 TCP 流量和 UDP DNS 流量均使用每会
话 PAT 转换。对于需要多会话 PAT 的流量，如 H.323、
SIP 或 Skinny，可通过创建每会话拒绝规则来禁用每会话 
PAT。

我们引入了以下屏幕：Configuration > Firewall > 
Advanced > Per-Session NAT Rules。

NAT 规则引擎上的事务提交模型 9.3(1) 启用时， NAT 规则更新将在规则编译完成后应用，而不
影响规则匹配性能。

我们已将 NAT 添加至以下屏幕：Configuration > Device 
Management > Advanced > Rule Engine。

表 7-1 两次 NAT 的功能历史记录 （续）

功能名称 平台版本 功能信息
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  两次 NAT 的功能历史记录
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8第 章
应用层协议检测入门

以下主题介绍如何配置应用层协议检测。

• 第 8-1 页的应用层协议检测

• 第 8-4 页的应用检测准则

• 第 8-4 页的应用检测的默认操作

• 第 8-8 页的配置应用层协议检测

• 第 8-10 页的配置正则表达式

• 第 8-13 页的应用检测历史记录

应用层协议检测
对于在用户数据包嵌入 IP 寻址信息的服务或在动态分配端口上打开辅助信道的服务，需要使用检
测引擎。这些协议需要 ASA 执行深度数据包检测，而不是通过快速路径传递数据包 （有关快速路
径的详细信息，请参阅一般操作配置指南）。因此，检测引擎可能会影响整体吞吐量。 ASA 默认启
用几个常见检测引擎，但可能需要根据网络启用其他检测引擎。

以下主题详细说明应用检测。

• 第 8-1 页的检测引擎如何工作

• 第 8-2 页的何时使用应用协议检测

• 第 8-3 页的检测策略映射

检测引擎如何工作

如下图所示， ASA 使用三个数据库来执行基本操作：

• ACL - 用于对基于特定网络、主机和服务 （TCP/UDP 端口号）的连接进行身份验证和授权。

• 检测 - 包含一组应用级别的预定义的静态检测功能。

• 连接（XLATE 和 CONN 表）- 维护关于每个已建立连接的状态和其他信息。自适应安全算法和
直通代理使用这些信息在已建立的会话中高效地转发流量。
8-1
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第 8 章      应用层协议检测入门

  应用层协议检测
图 8-1 检测引擎如何工作

在此图中，操作按发生的顺序进行编号：

1. TCP SYN 数据包到达 ASA 以建立新连接。

2. ASA 检查 ACL 数据库以确定是否允许连接。

3. ASA 在连接数据库 （XLATE 和 CONN 表）中创建新条目。

4. ASA 检查测数据库，以确定连接是否需要应用级别检测。

5. 在应用检测引擎对数据包完成所有需要的操作后， ASA 将数据包转发到目标系统。

6. 目标系统响应初始请求。

7. ASA 接收应答数据包，在连接数据库中查找连接，并转发数据包，因为数据包属于已建立的
会话。

ASA 的默认配置包括一组应用检测条目，这些条目将受支持的协议与特定 TCP 或 UDP 端口号关联
并识别所需的任何特殊处理。

何时使用应用协议检测

当用户建立连接时， ASA 会根据 ACL 检查数据包，创建地址转换，并在快速路径中创建会话条
目，以便后续数据包可以绕过耗时的检查。但是，快速路径依赖于可预测的端口号，且不在数据包
内执行地址转换。

许多协议开放辅助 TCP 或 UDP 端口。已知端口上的初始会话用于协商动态分配的端口号。

其他应用在需要匹配源地址的数据包中嵌入 IP 地址，源地址通常在通过 ASA 时进行转换。

如果使用类似的应用，需要启用应用检测。

如果对嵌入 IP 地址的服务启用应用检测， ASA 将会转换嵌入式地址，并更新受转换影响的所有校
验和或其他字段。

如果对使用动态分配的端口的服务启用应用检测，ASA 将会监控会话，识别动态端口分配，并允许
特定会话期间在这些端口上进行数据交换。

13
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75
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7
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2

3 4

Client

ACL

XLATE
CONN

Inspection

Server

ASA
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第 8 章      应用层协议检测入门

  应用层协议检测
检测策略映射

可以使用检测策略映射为许多应用检测配置特殊操作。这些映射是可选的：无需配置映射，就可以
为支持检测策略映射的协议启用检测。仅在需要执行非默认检测操作的情况下，才需要这些映射。

有关支持检测策略映射的应用列表，请参阅第 8-8 页的配置应用层协议检测。

检测策略映射由下列一个或多个要素组成：检测策略映射的确切可用选项视应用而定。

• 流量匹配条件 - 将应用流量与特定于应用的条件进行匹配（例如 URL 字符串，随后可以对这些
条件启用操作）。

对于某些流量匹配条件，可使用正则表达式来匹配数据包中的文本。请务必在配置策略映射之
前，在正则表达式类映射中单独或集中创建和测试正则表达式。

• 检测类映射 - 某些检测策略映射可以实现使用检测类映射包含多个流量匹配条件。然后，可以
在检测策略映射中识别检测类映射，并整体启用用于类的操作。创建类映射和直接在检测策略
映射中定义流量匹配的差别在于，您可以创建更复杂的匹配条件和重用类映射。然而，您无法
为不同的匹配设置不同操作。

• 参数 - 参数会影响检测引擎的行为。

以下主题提供了有关详细信息：

• 第 8-3 页的替换使用中的检测策略映射

• 第 8-3 页的如何处理多个流量类

替换使用中的检测策略映射

如果需要替换已在服务策略中使用的检测策略映射，可使用以下方法：

• 所有检测策略映射 - 如果要将使用中的检测策略映射替换为不同的映射名称，必须移除该映
射，应用更改，并将新的检测策略映射添加到服务策略。

• HTTP 检测策略映射 - 如果修改了使用中的 HTTP 检测策略映射，必须移除并重新应用检测策略
映射操作，所做的更改才会生效。例如，如果修改了 “http-map”检测策略映射，必须移除该
映射，应用更改，并将该检测策略映射重新添加到服务策略。

 如何处理多个流量类

在检测策略映射中可以指定多个检测类映射或直接匹配。

如果数据包匹配多个不同的 matches，ASA 应用操作的顺序将由内部 ASA 规则决定，而不是由向检
测策略映射添加的顺序决定。内部规则由应用类型和分解数据包的逻辑进展确定，并且不可由用户
配置。例如，对于 HTTP 流量，解析 Request Method 字段优先于解析 Header Host Length 字段；
Request Method 字段的操作早于 Header Host Length 字段的操作。

如果操作丢弃数据包，在检测策略映射中将不会执行进一步操作。例如，如果第一个操作是重置连
接，将不会匹配任何进一步的匹配条件。如果第一个操作是记录数据包，则会发生第二个操作，例
如，重置连接。

如果数据包匹配多个相同的 match criteria，那么它们将会按照在策略映射中出现的顺序进行匹配。

会根据类映射中的最低优先级 match option （优先级基于内部规则）来确定某类映射是与另一类映
射同类型还是直接匹配。如果某个类映射与另一个类映射有同一类型的最低优先级匹配选项，类映
射将根据被添加到策略映射中采用的顺序被匹配。如果每个类映射的最低优先级匹配不同，将会首
先匹配具有较高优先级 match option 的类映射。
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  应用检测准则
应用检测准则

故障转移准则 

需要检测的多媒体会话的状态信息不通过用于状态故障转移的状态链路进行传递。但 GTP 和 SIP 是
例外，它们在状态链路上复制。

IPv6 准则

以下检测中支持 IPv6：

• DNS

• FTP

• HTTP

• ICMP

• SCCP （瘦客户端）

• SIP

• SMTP

• IPsec 穿透

• IPv6

以下检测中支持 NAT64：

• DNS

• FTP

• HTTP

• ICMP

附加准则和限制 

• 某些检测引擎不支持 PAT、 NAT、外部 NAT 或相同安全接口之间的 NAT。有关 NAT 支持的详
细信息，请参阅第 8-5 页的默认检测和 NAT 限制。

• 对于所有应用检测， ASA 将同时活动的数据连接数限制为 200。例如，如果 FTP 客户端打开多
个辅助连接， FTP 检测引擎只允许 200 个活动连接，第 201 个连接将被丢弃，并且自适应安全
设备将生成系统错误消息。

• 检测的协议受制于高级 TCP 状态跟踪，这些连接的 TCP 状态不会自动复制。如果这些连接复
制到备用设备，将会尽力尝试重新建立 TCP 状态。

• 默认情况下，会检测流向 ASA （到接口）的 TCP/UDP 流量。但是，即使启用 ICMP 检测，也
不会检测流向接口的 ICMP 流量。因此，到接口的 ping （回应请求）可能会在特定情况下失
败，例如，如果回应请求来自 ASA 可以通过备用默认路由到达的源。

应用检测的默认操作
以下主题介绍应用检测的默认操作。

• 第 8-5 页的默认检测和 NAT 限制

• 第 8-7 页的默认检测策略映射
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  应用检测的默认操作
默认检测和 NAT 限制

默认情况下，配置包括会匹配所有默认应用检测流量并对所有接口的流量应用检测的策略 （全局
策略）。默认应用检测流量包括流向各个协议的默认端口的流量。只能应用一个全局策略，因此，
如果要改变全局策略 （例如，要对非标准端口应用检测，或者要添加默认情况下未启用的检测），
需要编辑默认策略或者禁用默认策略并应用新策略。

下表列出了所有支持的检测、用于默认类映射的默认端口和默认打开的检测引擎 （以粗体显示）。
该表中还对任何 NAT 限制作了备注。在该表中：

• 默认情况下为默认端口启用的检测引擎以粗体显示。

• ASA 符合指示的标准，但它不会对正接受检测的数据包执行合规性。例如， FTP 命令应该按照
特定的顺序，但 ASA 不执行该顺序。

表 8-1 支持的应用检测引擎

应用 默认端口 NAT 限制 标准 备注

CTIQBE TCP/2748 无扩展 PAT。

无 NAT64。

（集群）无静态 PAT。

- -

DCERPC TCP/135 无 NAT64。 - -

使用 UDP 的 
DNS

UDP/53 无可用于通过 WINS 进行名称
解析的 NAT支持。

RFC 1123 -

FTP TCP/21 （集群）无静态 PAT。 RFC 959 -

GTP UDP/3386
UDP/2123

无扩展 PAT。

无 NAT。

- 需要特殊许可证。

H.323 H.225 和 
RAS

TCP/1720 
UDP/1718
UDP (RAS) 
1718 - 1719

无动态 NAT 或 PAT。

静态 PAT 可能不起作用。

（集群）无静态 PAT。

无扩展 PAT。

不支持对每个会话执行 PAT。

不支持对同类安全接口执行 
NAT。

无 NAT64。

ITU-T H.323、
H.245、H225.0、
Q.931、 Q.932

-

HTTP TCP/80 - RFC 2616 请注意，MTU 限制会去除 ActiveX 和 
Java。如果 MTU 因为太小而不允许在
数据包中包含 Java 或 ActiveX 标记，
可能不会出现去除操作。

ICMP - - - 不会检测流向 ASA 接口的 ICMP 
流量。

ICMP 错误 - - - -

ILS (LDAP) TCP/389 无扩展 PAT。

无 NAT64。

- -
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  应用检测的默认操作
即时消息 (IM) 因客户端
而异

无扩展 PAT。

无 NAT64。

RFC 3860 -

IP 选项 - 无 NAT64。 RFC 791、 RFC 
2113

-

IPsec 穿透 UDP/500 无 PAT。

无 NAT64。

- -

IPv6 - 无 NAT64。 RFC 2460 -

MGCP UDP/2427、
2727

无扩展 PAT。

无 NAT64。

（集群）无静态 PAT。

RFC 2705bis-05 -

MMP TCP 5443 无扩展 PAT。

无 NAT64。

- -

使用 IP 的 
NetBIOS 域名服
务器

UDP/137、
138 （源
端口）

无扩展 PAT。

无 NAT64。

- 通过执行 NBNS UDP 端口 137 和 
NBDS UDP 端口 138 的数据包 NAT 来
支持 NetBIOS。

PPTP TCP/1723 无 NAT64。

（集群）无静态 PAT。

RFC 2637 -

RADIUS 计费 1646 无 NAT64。 RFC 2865 -

RSH TCP/514 无 PAT。

无 NAT64。

（集群）无静态 PAT。

Berkeley UNIX -

RTSP TCP/554 无扩展 PAT。

无 NAT64。

（集群）无静态 PAT。

RFC 2326、
2327、 1889

无 HTTP 掩蔽处理。

ScanSafe （云网
络安全）

TCP/80
TCP/413

- - 这些端口未包含在适用于 ScanSafe 检
测的 default-inspection-traffic 类中。

SIP TCP/5060
UDP/5060

不支持对同类安全接口执行 
NAT。

无扩展 PAT。

不支持对每个会话执行 PAT。

无 NAT64 或 NAT46。

（集群）无静态 PAT。

RFC 2543 某些情况下不处理 TFTP 上传的思科 
IP 电话配置。

表 8-1 支持的应用检测引擎（续）

应用 默认端口 NAT 限制 标准 备注
8-6
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 8 章      应用层协议检测入门

  应用检测的默认操作
默认检测策略映射

某些检测类型使用隐藏的默认策略映射。例如，如果启用 ESMTP 检测但不指定映射，将会使用 
_default_esmtp_map。

说明每种检测类型的各节中介绍了默认检测。可以使用 show running-config all policy-map 命令；
可以使用 Tools > Command Line Interface 查看这些默认映射。

DNS 检测是唯一一种采用明确配置的默认映射 preset_dns_map 的检测。

瘦客户端 
(SCCP)

TCP/2000 不支持对同类安全接口执行 
NAT。

无扩展 PAT。

不支持对每个会话执行 PAT。

无 NAT64、 NAT46 或 
NAT66。

（集群）无静态 PAT。

- 某些情况下不处理 TFTP 上传的思科 
IP 电话配置。

SMTP 和 
ESMTP

TCP/25 无 NAT64。 RFC 821、 1123 -

SNMP UDP/161、
162

无 NAT 或 PAT。 RFC 1155、
1157、 1212、
1213、 1215

v.2 RFC 1902 - 1908；v.3 RFC 2570 - 
2580。

SQL*Net TCP/1521 无扩展 PAT。

无 NAT64。

（集群）无静态 PAT。

- v.1 和 v.2。

使用 UDP 和 
TCP 的 Sun RPC

UDP/111 无扩展 PAT。

无 NAT64。

- 默认规则包括 UDP 端口 111；如果要
对 TCP 端口 111 启用 Sun RPC 检测，
需要创建匹配 TCP 端口 111 并执行 
Sun RPC 检测的新规则。

TFTP UDP/69 无 NAT64。

（集群）无静态 PAT。

RFC 1350 不转换负载 IP 地址。

WAAS TCP/1 - 
65535

无扩展 PAT。

无 NAT64。

- -

XDMCP UDP/177 无扩展 PAT。

无 NAT64。

（集群）无静态 PAT。

- -

表 8-1 支持的应用检测引擎（续）

应用 默认端口 NAT 限制 标准 备注
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  配置应用层协议检测
配置应用层协议检测
应用检测在服务策略中进行配置。服务策略提供一致且灵活的方式来配置 ASA 功能。例如，您可
以使用服务策略创建特定于某项 TCP 应用而非应用于所有 TCP 应用的超时配置。对于某些应用，
可以在启用检测后执行特殊操作。关于服务策略的一般信息，请参阅第 1 章，“服务策略”。

默认情况下，某些应用的检测已启用。有关详细信息，请参阅第 8-5 页的默认检测和 NAT 限制。可
按照本节所述的步骤修改检测策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy Rules。

步骤 2 按照第 1-10 页的为直通流量添加服务策略规则中所述添加或编辑服务策略规则，然后进入 Rule 
Actions 页面。

如果要匹配非标准端口，请创建适用于非标准端口的新规则。有关每个检测引擎的标准端口，请参
阅第 8-5 页的默认检测和 NAT 限制。

必要时可以将多个规则整合在同一服务策略中，因此，可以创建一个规则来匹配特定流量，创建另
一个规则来匹配不同流量。但是，如果流量匹配包含检测操作的某个规则，然后匹配也包含检测操
作的另一个规则，将会仅使用第一个匹配的规则。

如果要实施 RADIUS 计费检测，请按照第 1-12 页的为管理流量添加服务策略规则中所述创建管理
服务策略规则。

步骤 3 在 Rule Actions 页面上，点击 Protocol Inspection 选项卡。

步骤 4 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用原有
检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中相应协议的复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 5 选择要应用的检测类型。

只能对默认检测流量类选择多个选项。

某些检测引擎允许您在对流量应用检测时控制其他参数。点击检测类型的 Configure，配置检测策
略映射。可以选择现有映射，或者创建新的映射。可以从 Configuration > Firewall > Objects > 
Inspect Maps 列表预定义检测策略映射。

下表列出了可检测的协议，指明这些协议是允许检测策略映射还是检测类映射，还提供了指向相关
配置详细信息的链接。

表 8-2 检测协议

协议
支持检测策略
映射

支持检测类
映射 备注

CTIQBE 否 否 请参阅第 10-1 页的 CTIQBE 检测。

云网络安全 是 是 如果要启用 ScanSafe （云网络安全），请执行以
下主题中介绍的操作步骤而不要执行此步骤：第 
16-9 页的配置服务策略，将流量发送到云网络安
全。该操作步骤说明了全面策略配置，包括如何
配置检测策略映射。
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DCERPC 是 否 请参阅第 12-1 页的 DCERPC 检测。

DNS 是 是 请参阅第 9-1 页的 DNS 检测。

ESMTP 是 否 请参阅第 9-29 页的 SMTP 检测和扩展 SMTP 检测。

FTP 是 是 请参阅第 9-7 页的 FTP 检测。

GTP 是 否 请参阅第 12-3 页的 GTP 检测。

H.323 H.225 是 是 请参阅第 10-2 页的 H.323 检测。

H.323 RAS 是 是 请参阅第 10-2 页的 H.323 检测。

HTTP 是 是 请参阅第 9-12 页的 HTTP 检测。

ICMP 否 否 请参阅第 9-17 页的 ICMP 检测。

ICMP 错误 否 否 请参阅第 9-17 页的 ICMP 错误检测。

ILS 否 否 请参阅第 11-1 页的 ILS 检测。

IM 是 是 请参阅第 9-18 页的即时消息检测。

IP 选项 是 否 请参阅第 9-20 页的 IP 选项检测。

IPSec 穿透 是 否 请参阅第 9-23 页的 IPsec 穿透检测。

IPv6 是 否 请参阅第 9-25 页的 IPv6 检测。

MGCP 是 否 请参阅第 10-7 页的 MGCP 检测。

NetBIOS 是 否 请参阅第 9-27 页的 NetBIOS 检测。

PPTP 否 否 请参阅第 9-29 页的 PPTP 检测。

RADIUS 计费 是 否 请参阅第 12-8 页的 RADIUS 计费检测。

RADIUS 计费检测仅适用于管理服务策略。必须
选择一个策略映射来实施这项检测。

RSH 否 否 请参阅第 12-10 页的 RSH 检测。

RTSP 是 否 请参阅第 10-10 页的 RTSP 检测。

SCCP （瘦客
户端）

否 请参阅第 10-21 页的瘦客户端 (SCCP) 检测。

SIP 是 是 请参阅第 10-15 页的 SIP 检测。

SNMP 是 否 请参阅第 12-10 页的 SNMP 检测。

SQLNET 否 否 请参阅第 11-2 页的 SQL*Net 检测。

SUNRPC 否 否 请参阅第 11-3 页的 Sun RPC 检测。

默认类组映射包括 UDP 端口 111；如果要对 TCP 
端口 111 启用 Sun RPC 检测，需要创建匹配 TCP 
端口 111 的新的类映射，将该类添加到策略，然
后对该类应用 inspect sunrpc 命令。

TFTP 否 否 请参阅第 9-33 页的 TFTP 检测。

WAAS 否 否 启用 TCP 选项 33 解析。部署思科广域应用服务产
品时使用。

XDMCP 否 否 请参阅第 12-11 页的 XDMCP 检测。

表 8-2 检测协议 （续）

协议
支持检测策略
映射

支持检测类
映射 备注
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  配置正则表达式
步骤 6 如有必要，可使用其他 Rule Actions 选项卡来配置此规则的其他功能。

步骤 7 点击 OK （或在向导中点击 Finish）。

配置正则表达式
正则表达式定义文本字符串的模式匹配。可以在某些协议检测映射中使用这些表达式根据字符串
（例如， URL 或特定报头字段的内容）来匹配数据包。

• 第 8-10 页的创建正则表达式

• 第 8-13 页的创建正则表达式类映射

创建正则表达式

正则表达式可逐字地完全匹配文本字符串，或者，可以使用 metacharacters 来匹配文本字符串的多
个变体。可以使用正则表达式匹配某些应用流量的内容，例如，可以匹配 HTTP 数据包中的 URL 
字符串。

准备工作

有关将正则表达式与数据包进行匹配会造成的性能影响的信息，请参阅命令参考中的 regex 命令。
一般来说，匹配长输入字符串或尝试匹配大量的正则表达式将会降低系统性能。

注 作为一种优化手段， ASA 会在进行了去模糊化处理的 URL 进行搜索。去模糊化处理将多个正斜杠 
(/) 压缩为一个斜杠。对于通常使用双斜杠的字符串 （例如 “http://”），请务必搜索 “http:/”。

下表列出了有特殊意义的元字符。

表 8-3 正则表达式元字符

字符 说明 备注

. 点 匹配任何单个字符。例如，d.g 匹配 dog、dag、dtg 以
及任何含有这些字符的单词，如 doggonnit。

(exp) 子表达式 子表达式将字符与其周围的字符分隔开，从而可以在
子表达式上使用其他元字符。例如， d(o|a)g 匹配 dog 
和 dag，但是， do|ag 匹配 do 和 ag。子表达式还可以
与重复限定符配合使用，以区分意味着重复的字符。
例如， ab(xy){3}z 匹配 abxyxyxyz。

| 交替 匹配其分隔的任意一个表达式。例如， dog|cat 匹配 
dog 或 cat。

? 问号 一个限定符，表示前面有 0 个或 1 个表达式。例如，
lo?se 匹配 lse 或 lose。

* 星号 一个限定符，表示前面有 0 个、 1 个或任意数量的表
达式。例如， lo*se 匹配 lse、 lose、 loose 等等。

+ 加号 一个限定符，表示前面至少有 1 个表达式。例如，
lo+se 匹配 lose 和 loose，但不匹配 lse。
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操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Regular Expressions。

步骤 2 在 Regular Expressions 区域，执行以下操作之一：

• 选择 Add 添加新对象。为对象输入名称和或者描述。

• 选择现有对象并点击 Edit。

步骤 3 在 Value 字段中输入正则表达，或者点击 Build 获取有关创建表达式的帮助。

正则表达式最多可包含 100 个字符。

如果点击 Build，请按照以下过程创建表达式：

a. 在 Build Snippet 区域，使用以下选项创建表达式的组成部分。在本节末尾的 Snippet Preview 区
域可查看正在构建的表达式。

• Starts at the beginning of the line (^) - 使用脱字号 (^) 元字符指明代码片断应该始于行首。请
务必使用此选项在正则表达式开头插入任意代码片断。

{x} 或 {x,} 最小重复限定符 至少重复 x 次。例如， ab(xy){2,}z 匹配 abxyxyz、
abxyxyxyz 等等。

[abc] 字符类 匹配方括号中的任意字符。例如， [abc] 匹配 a、
b 或c。

[^abc] 求反字符类 匹配不包含在方括号中的单个字符。例如， [^abc] 匹
配 a、b 或 c 以外的任意字符。[^A-Z] 匹配非大写形式
的任意单个字符。

[a-c] 字符范围类 匹配范围内的任意字符。 [a-z] 匹配任意小写字母。可
以混合使用字符和字符范围：[abcq-z] 匹配 a、 b、 c、
q、r、s、 t、u、v、w、x、y 和 z，[a-cq-z] 也是匹配
这些字符。

破折号 (-) 字符仅在是括号中的最后一个或第一个字符
时，才是原义字符：例如， [abc-] 或 [-abc]。

“” 引号 保留字符串中的尾随空格或前导空格。例如，“test”
在查找匹配时会保留前导空格。

^ 脱字号 指定行首。

\ 转义字符 当与元字符一起使用时，可以匹配原义字符。例如，
\[ 匹配左方括号。

char 字符 当字符不是元字符时，匹配原义字符。

\r 回车符 匹配回车符 0x0d。

\n 换行符 匹配换行符 0x0a。

\t 制表符 匹配制表符 0x09。

\f 换页符 匹配换页符 0x0c。

\xNN 转义的十六进制数字 匹配十六进制的 ASCII 字符 （必须是两位数）。

\NNN 转义的八进制数字 匹配八进制的 ASCII 字符 （必须是三位数）。例如，
字符 040 代表空格。

表 8-3 正则表达式元字符 （续）

字符 说明 备注
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• Specify Character String - 如果您尝试匹配特定字符串 （例如字词或短语），请输入字符串。

如果文本字符串中有您想用作原义字符的任何元字符，请选择 Escape Special Characters，
在这些元字符前面添加反斜杠 (\) 转义字符。例如，如果输入 “example.com”，此选项会
将其转换为 “example\.com”。

如果要匹配大写和小写字符，请选择 Ignore Case。例如，“cats”将被转换为
“[cC][aA][tT][sS]”。

• Specify Character - 如果尝试匹配特定类型的字符或字符集，而不是匹配特定短语，请选择
此选项并使用以下选项对字符进行识别：

Negate the character - 指明不要匹配识别的字符。

Any character (.) - 插入句点 (.) 元字符以匹配任意字符。例如，d.g 匹配 dog、dag、dtg 以及
任何含有这些字符的单词，如 doggonnit。

Character set - 插入字符集。文本可匹配字符集中的任意字符。例如，如果指定 
[0-9A-Za-z]，该代码片断会匹配 A 到 Z （不区分大小写）之间的任意字符或 0 到 9 之间的
任意数字。 [\n\f\r\t] 字符集匹配换行符、换页符、回车符或制表符。

Special character - 插入需要转义的字符，包括 \、?、*、+、 |、.、[、( 或 ^。转义字符为反
斜杠 (\)；如果选择此选项，会自动输入转义字符。

Whitespace character - 空白字符包括 \n（换行符）、 \f（换页符）、 \r（回车符）或 \t（制
表符）。

Three digit octal number - 匹配八进制的 ASCII 字符 （最多可以是三位数）。例如，字符 
\040 代表空格。反斜杠 (\) 是自动输入的。

Two digit hexadecimal number - 匹配十六进制的 ASCII 字符（必须是两位数）。反斜杠 (\) 
是自动输入的。

Specified character - 输入任意单个字符。

b. 使用以下按钮之一将代码片断添加到正则表达式框中。请注意，也可以直接键入正则表达式。

• Append Snippet - 将代码片断添加到正则表达式结尾。

• Append Snippet as Alternate - 将代码片断添加到正则表达式结尾，代码片段与表达式之间
用竖线 (|) 分隔（这将会匹配竖线分隔的任何一个表达式）。例如，dog|cat 匹配 dog 或 cat。

• Insert Snippet at Cursor - 在光标处插入代码片断。

c. 继续按照上一个步骤添加代码片段，直至表达式完整。

d. （可选）在 Selection Occurrences 中，选择整个或部分表达式与文本之间的匹配频率达到多少
才视为匹配。选择 Regular Expression 字段中的文本，点击以下选项之一，然后点击 Apply to 
Selection。例如，如果正则表达式是 “test me”，而您选择 “me”并应用 One or more times，
正则表达式将更改为 “test (me)+”。

• Zero or one times (?) - 前面有 0 个或 1 个表达式。例如， lo?se 匹配 lse 或 lose。

• One or more times (+) - 前面至少有 1 个表达式。例如， lo+se 匹配 lose 和 loose，但不匹
配 lse。

• Any number of times (*) - 前面有 0 个、 1 个或任意数量的表达式。例如， lo*se 匹配 lse、
lose、 loose 等等。

• At least - 至少重复 x 次。例如， ab(xy){2,}z 匹配 abxyxyz、 abxyxyxyz 等等。

• Exactly - 准确重复 x 次。例如， ab(xy){3}z 匹配 abxyxyxyz。
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  应用检测历史记录
e. 点击 Test 验证表达式是否匹配预期的文本。如果测试不成功，可以尝试在测试对话框中编辑表
达式，或者返回到表达式构建器。如果在文本对话中编辑表达式并点击 OK，将会保存所做的
编辑并反映在表达式构建器中。

f. 点击 OK。

创建正则表达式类映射

正则表达式类映射识别一个或多个正则表达式，是正则表达式对象的集合。在很多情况下，可以使
用正则表达式类映射代替正则表达式对象。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Regular Expressions。

步骤 2 在 Regular Expressions Classes 区域，执行以下操作之一：

• 选择 Add 添加新的类映射。为对象输入名称和或者描述。

• 选择现有的类映射，然后点击 Edit。

步骤 3 在映射中选择所需的表达式，然后点击 Add。移除不想要的任何类映射。

步骤 4 点击 OK。

应用检测历史记录

功能名称 版本 说明

检测策略映射 7.2(1) 引入了检测策略映射。引入了以下命令：class-map type 
inspect。

正则表达式和策略映射 7.2(1) 引入了正则表达式和策略映射，在检测策略映射下使用。
引入了以下命令：class-map type regex、 regex、 match 
regex。

检测策略映射的 Match any 命令 8.0(2) 引入了关键字 match any，与检测策略映射一起使用：流
量可以匹配一个或多个条件以匹配类映射。过去，仅 
match all 命令可用。
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8-14
思科 ASA 系列防火墙 ASDM 配置指南

 



 

 

9第 章
基本互联网协议检测

以下主题介绍基本互联网协议的应用检测。有关为何需要对某些协议进行检测以及应用检测的总体
方法的信息，请参阅第 8-1 页的应用层协议检测入门。

• 第 9-1 页的 DNS 检测

• 第 9-7 页的 FTP 检测

• 第 9-12 页的 HTTP 检测

• 第 9-17 页的 ICMP 检测

• 第 9-17 页的 ICMP 错误检测

• 第 9-18 页的即时消息检测

• 第 9-20 页的 IP 选项检测

• 第 9-23 页的 IPsec 穿透检测

• 第 9-25 页的 IPv6 检测

• 第 9-27 页的 NetBIOS 检测

• 第 9-29 页的 PPTP 检测

• 第 9-29 页的 SMTP 检测和扩展 SMTP 检测

• 第 9-33 页的 TFTP 检测

DNS 检测
以下各节介绍 DNS 应用检测。

• 第 9-2 页的 DNS 检测操作

• 第 9-2 页的 DNS 检测的默认设置

• 第 9-2 页的配置 DNS 检测

• 第 9-6 页的监控 DNS 检测
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  DNS 检测
DNS 检测操作

默认情况下， DNS 检测已启用。可以自定义 DNS 检测来执行许多任务：

• 根据 NAT 配置转换 DNS 记录。有关详细信息，请参阅第 5-29 页的 DNS 和 NAT。

• 强制消息长度、域名长度和标签长度。

• 如果在 DNS 消息中遇到压缩指针，应验证指针所引用的域名的完整性。

• 检查是否存在压缩指针循环。

• 根据 DNS 报头、类型、类别等检测数据包。

DNS 检测的默认设置

默认情况下，启用 DNS 检测，使用 preset_dns_map 检测类映射：

• DNS 消息最大长度为 512 字节。

• 最大客户端 DNS 消息长度是自动设置的，以匹配资源记录。

• DNS 保护已启用，这样，一旦 ASA 转发 DNS 应答，ASA 就会断开与 DNS 查询相关的 DNS 会
话。另外， ASA 还监控消息交换，确保 DNS 回复 ID 匹配 DNS 查询 ID。

• 根据 NAT 配置的 DNS 记录转换已启用。

• 协议执行已启用，使得可以进行 DNS 消息格式检查 （具体检查内容包括：域名长度不得超过 
255 个字符，标签长度不得超过 63 个字符，压缩检查和循环指针检查）。

配置 DNS 检测

默认情况下，DNS 检测已启用。仅在需要非默认处理的情况下，才需要配置这项检测。如果要自定
义 DNS 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 9-2 页的配置 DNS 检测类映射。

步骤 2 第 9-4 页的配置 DNS 检测策略映射。

步骤 3 第 9-6 页的配置 DNS 检测服务策略。

配置 DNS 检测类映射

或者可以创建 DNS 检测类映射来定义 DNS 检测的流量类。另一种方法是，直接在 DNS 检测策略映
射中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法可以
创建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。
9-2
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 9 章      基本互联网协议检测

  DNS 检测
准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > DNS。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。

步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。

b. 选择匹配条件并定义其值：

• Header Flag - 选择标志是否应等于或包含指定值，然后选择报头标志名称或输入报头的十六
进制值 （0x0 至 0xfff）。如果选择多个报头值，“equals”要求数据包中存在所有标志，
“contains”要求数据包中存在任意一个标志。报头标志名称是 AA （授权应答）、 QR （查
询）、 RA （可用递归）、 RD （所需递归）、 TC （截断）。

• Type - 数据包中 DNS Type 字段的名称或值。字段名称是 A（IPv4 地址）、AXFR（完整区
域传送）、 CNAME （规范名称）、 IXFR （增量区域传送）、 NS （授权域名服务器）、
SOA （授权区域起始）或 TSIG （事务数字签名）。 DNS Type 字段中的值是 0 到 65535 之
间的任意数字：可输入具体值或值范围。

• Class - 数据包中 DNS Class 字段的名称或值。“互联网”是唯一可用于此字段的名称。DNS 
Class 字段中的值是 0 到 65535 之间的任意数字：可输入具体值或值范围。

• Question - DNS 消息的问题部分。

• Resource Record - DNS 资源记录。选择是否匹配资源记录的 additional、 answer 或 authority 
部分。

c. 点击 OK。

步骤 6 在 DNS Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 DNS 检测策略映射中。
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配置 DNS 检测策略映射

如果默认检测行为不能满足网络要求，可以创建 DNS 检测策略映射来自定义 DNS 检测操作。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > DNS。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 DNS Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级别为 Low。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 DNS 检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

步骤 5 点击 Protocol Conformance 选项卡并选择所需的选项：

• Enable DNS guard function - 如果使用 DNS 保护功能，一旦 ASA 转发 DNS 应答，ASA 就会断
开与 DNS 查询相关的 DNS 会话。ASA 还会监控消息交换，以确保 DNS 应答的 ID 与 DNS 查询
的 ID 匹配。

• Enable NAT re-write function - 根据 NAT 配置转换 DNS 记录。

• Enable protocol enforcement - 启用 DNS 消息格式检查 （具体检查内容包括：域名长度不得超
过 255 个字符，标签长度不得超过 63 个字符，压缩检查和循环指针检查）。

• Randomize the DNS identifier for DNS query。

• Enforce TSIG resource record to be present in DNS message - 可以丢弃或记录非不符合要求的数
据包，或者还可以记录丢弃的数据包。

步骤 6 点击 Filtering 选项卡并选择所需的选项。

• 全局设置 - 选择是否丢弃超过指定最大长度 （512 至 65535 字节）的数据包，无论数据包是来
自客户端还是服务器的数据包。

• 服务器设置 - Drop packets that exceed specified maximum length 和 Drop packets sent to server 
that exceed length indicated by the RR - 设置最大服务器 DNS 消息长度 （512 至 65535 字节），
或者将最大长度设置为资源记录中的值。如果启用这两个设置，将使用较小的值。

• 客户端设置 - Drop packets that exceed specified maximum length 和 Drop packets sent to server 
that exceed length indicated by the RR - 设置最大客户端 DNS 消息长度 （512 至 65535 字节），
或者将最大长度设置为资源记录中的值。如果启用这两个设置，将使用较小的值。
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步骤 7 点击 Mismatch Rate 选项卡，并选择当 DNS ID 不匹配率超过指定阈值时是否启用日志记录。例
如，可以将阈值设置为每 3 秒 30 次不匹配。

步骤 8 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 DNS 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两
种方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 DNS 类映射；请参阅第 9-2 页的配置 DNS 检测类映射）。

c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，如下配置条件：

• Header Flag - 选择标志是否应等于或包含指定值，然后选择报头标志名称或输入报头的十六
进制值 （0x0 至 0xfff）。如果选择多个报头值，“equals”要求数据包中存在所有标志，
“contains”要求数据包中存在任意一个标志。报头标志名称是 AA （授权应答）、 QR （查
询）、 RA （可用递归）、 RD （所需递归）、 TC （截断）。

• Type - 数据包中 DNS Type 字段的名称或值。字段名称是 A（IPv4 地址）、AXFR（完整区
域传送）、 CNAME （规范名称）、 IXFR （增量区域传送）、 NS （授权域名服务器）、
SOA （授权区域起始）或 TSIG （事务数字签名）。 DNS Type 字段中的值是 0 到 65535 之
间的任意数字：可输入具体值或值范围。

• Class - 数据包中 DNS Class 字段的名称或值。“互联网”是唯一可用于此字段的名称。DNS 
Class 字段中的值是 0 到 65535 之间的任意数字：可输入具体值或值范围。

• Question - DNS 消息的问题部分。

• Resource Record - DNS 资源记录。选择是否匹配资源记录的 additional、 answer 或 authority 
部分。

d. 选择要对匹配的流量执行的主要操作：丢弃数据包，断开连接，掩蔽 （仅适用于报头标志匹配
项）或者不执行任何操作。

e. 选择是否启用或禁用日志记录。如果要强制 TSIG，必须禁用日志记录。

f. 选择是否强制要求必须有 TSIG 资源记录。可以丢弃数据包，记录数据包或者丢弃并记录数据
包。要强制 TSIG，通常必须选择 Primary Action: None 和 Log: Disable。但是，对于报头标志
匹配项，可以将 TSIG 强制与掩蔽主要操作配合使用。

g. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 9 在 DNS Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 DNS 检测服务策略中。
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配置 DNS 检测服务策略

默认 ASA 配置包括对默认端口的 DNS 检测 （这项检测全局应用于所有接口）。自定义检测配置的
一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 DNS 检测规则，或者有要添加 DNS 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 DNS 检测策略映射，必须禁用 
DNS 检测，然后为其提供新的 DNS 检测策略映射名称并重新启用这项检测：

a. 取消选中 DNS 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 DNS。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 DNS 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 9-4 页的配置 DNS 检测策略映射。

b. 如果使用僵尸网络流量过滤器，请选择 Enable DNS snooping。我们建议仅在有外部 DNS 请求
经过的接口上启用 DNS 监听。如果对所有 UDP DNS 流量（包括流向内部 DNS 服务器的流量）
启用 DNS 监听，将会对 ASA 造成不必要的负载。如果要检测加密 SIP 流量，请选择 Enable 
encrypted traffic inspection 并选择 TLS 代理 （如有必要，点击 Manage 创建 TLS 代理）。例
如，如果 DNS 服务器位于某个外部接口，应该对该外部接口的所有 UDP DNS 流量启用具有监
听功能的 DNS 检测。

c. 在 Select DNS Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

监控 DNS 检测

要查看有关当前 DNS 连接的信息，请在 Tools > Command Line Interface 或 Monitoring > Properties > 
Connections 中输入以下命令：

hostname# show conn

对于使用 DNS 服务器的连接，可以用 show conn 命令输出中的 DNS 服务器的 IP 地址替换连接的源
端口。

可以为多个 DNS 会话创建单一连接，前提是，这些会话都在同两台主机之间且具有相同的五元组
（源/目标 IP 地址、源/目标端口和协议）。可通过 app_id 跟踪 DNS 标识，且每个 app_id 的空闲计时
器独立运行。
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由于 app_id 的期限是独立，因此，合法的 DNS 应答只能在有限的时间段内通过安全设备，而且不
会累积资源。但是，输入 show conn 命令时，将会看到新的 DNS 会话正在重置 DNS 连接的空闲计
时器。这是由共享 DNS 连接的性质决定的，也是如此设计的。

要显示 DNS 应用检测的统计信息，请输入 show service-policy 命令。以下是 show service-policy 命
令的输出示例：

hostname# show service-policy
Interface outside:
Service-policy: sample_policy
    Class-map: dns_port
      Inspect: dns maximum-length 1500, packet 0, drop 0, reset-drop 0

FTP 检测
以下各节介绍 FTP 检测引擎。

• 第 9-7 页的 FTP 检测概述

• 第 9-7 页的严格 FTP

• 第 9-8 页的配置 FTP 检测

• 第 9-12 页的验证和监控 FTP 检测

FTP 检测概述

FTP 应用检测检查 FTP 会话并执行以下四项任务：

• 准备动态辅助数据连接

• 跟踪 FTP 命令-响应序列

• 生成审核线索

• 转换嵌入式 IP 地址

FTP 应用检测为 FTP 数据传输准备辅助信道。这些信道的端口是通过 PORT 或 PASV 命令协商的。
这些信道根据文件上传、文件下载或目录列表事件进行分配。

注 如果您使用 no inspect ftp 命令禁用 FTP 检测引擎，出站用户只能在被动模式下启动连接，且所有入
站 FTP 都将被禁用。

严格 FTP
严格 FTP 可防止网络浏览器在 FTP 请求中发送嵌入式命令，从而提高受保护网络的安全。要启用严
格 FTP，请在 Configuration > Firewall > Service Policy Rules > Edit Service Policy Rule > Rule Actions > 
Protocol Inspection 选项卡中点击 FTP 旁边的 Configure 按钮。

如果使用严格 FTP，或者还可以指定 FTP 检测策略映射，以指定不允许通过 ASA 的 FTP 命令。

对接口启用 strict 选项后， FTP 检测将强制执行以下行为：

• ASA 在 FTP 命令得到确认后才允许新的命令。

• ASA 断开发送嵌入式命令的连接。

• 检查 227 命令和 PORT 命令，以确保这些命令不显示在错误字符串中。
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注意事项 使用 strict 选项可能会导致不完全符合 FTP RFC 要求的客户端发生故障。

如果启用 strict 选项，将会跟踪每个 FTP 命令-响应序列，以确定是否存在以下异常活动：

• 截断命令 - 检查 PORT 和 PASV 应答命令中逗号的数量是否是五个。如果不是五个，将会截断 
PORT 命令并关闭 TCP 连接。

• 错误命令 - 检查 FTP 命令以确定它是否以 <CR><LF> 字符结尾（如 RFC 所要求）。如果不是，
将会关闭连接。

• RETR 和 STOR 命令的大小 - 根据某个固定常数检查这些命令的大小。如果命令大小大于该固定
常数，将会记录错误消息并关闭连接。

• 命令欺骗 - PORT 命令应始终从客户端发送。如果 PORT 命令是从服务器发送，将会拒绝 TCP 
连接。

• 应答欺骗 - PASV 应答命令 (227) 应始终从服务器发送。如果 PASV 应答命令是从客户端发送，
将会拒绝 TCP 连接。这样可防止用户执行 “227 xxxxx a1, a2, a3, a4, p1, p2.”时出现安全漏洞

• TCP 数据流编辑 - 如果 ASA 检测到 TCP 数据流编辑，它会关闭连接。

• 无效的端口协商 - 检查协商的动态端口值是否小于 1024。由于 1 至 1024 范围内的端口号是为已
知连接保留的，因此，如果协商的端口在这个范围内，将会释放 TCP 连接。

• 命令管道 - 将 PORT 和 PASV 应答命令中在端口号后显示的字符数与常数值 8 进行比较。如果该
字符数大于 8，将会关闭 TCP 连接。

• ASA 用一系列 X 替换 FTP 服务器对 SYST 命令的响应，以防止服务器向 FTP 客户端显示其系统
类型。要覆盖此默认行为，请在 FTP 映射中使用 no mask-syst-reply 命令。

配置 FTP 检测

默认情况下， FTP 检测已启用。仅在需要非默认处理的情况下，才需要配置这项检测。如果要自定
义 FTP 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 9-8 页的配置 FTP 检测类映射。

步骤 2 第 9-10 页的配置 FTP 检测策略映射。

步骤 3 第 9-11 页的配置 FTP 检测服务策略。

配置 FTP 检测类映射

或者可以创建 FTP 检测类映射来定义 FTP 检测的流量类。另一种方法是，直接在 FTP 检测策略映
射中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法可以
创建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。
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准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > FTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。

步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。

b. 选择匹配条件并定义其值：

• File Name - 将正在传输的文件的名称与选定的正则表达式或正则表达式类进行匹配。

• File Type - 将正在传输的文件的 MIME 或媒体类型与选定的正则表达式或正则表达式类进行
匹配。

• Server - 将 FTP 服务器名称与选定的正则表达式或正则表达式类进行匹配。

• User - 将已登录用户的名称与选定的正则表达式或正则表达式类进行匹配。

• Request Command - 数据包中使用的 FTP 命令，可以是以下命令的任意组合：

APPE - 附加到文件。

CDUP - 更改为当前工作目录的父目录。

DELE - 删除服务器上的文件。

GET - 从服务器获取文件。

HELP - 提供帮助信息。

MKD - 在服务器上创建目录。

PUT - 向服务器发送文件。

RMD - 在服务器上删除目录。

RNFR - 指定 “rename-from”文件名

RNTO - 指定 “rename-to”文件名

SITE - 用于指定服务器特定命令。此命令通常用于远程管理。

STOU - 用唯一文件名存储文件。

c. 点击 OK。

步骤 6 在 FTP Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 FTP 检测策略映射中。
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配置 FTP 检测策略映射

使用严格 FTP 检测可进行 FTP 命令过滤和安全检查，从而提高安全和加强控制。协议符合性包括数
据包长度检查、分隔符和数据包格式检查、命令终止符检查以及命令验证。

也支持根据用户值阻止 FTP，这样， FTP 站点可以发布供下载的文件，但仅允许某些用户访问。可
以根据文件类型、服务器名称及其他属性阻止 FTP 连接。如果进行检测后 FTP 连接被拒绝，将会生
成系统消息日志。

如果您希望 FTP 检测允许 FTP 服务器向 FTP 客户端显示其系统类型，并限制允许的 FTP 命令，可
以创建并配置 FTP 检测策略映射。然后，可以在启用 FTP 检测时应用所创建的映射。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > FTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 FTP Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级别为 High。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 FTP 检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

提示 File Type Filtering 按钮是配置文件媒体或 MIME 类型检测的快捷方式 （下面将会加以
说明）。

步骤 5 点击 Parameters 选项卡，并选择是否掩蔽来自服务器的问候横幅或对 SYST 命令的应答。

掩蔽这些项目可防止客户端发现可能有助于攻击的服务器信息。

步骤 6 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 FTP 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两种
方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 FTP 类映射；请参阅第 9-8 页的配置 FTP 检测类映射）。
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c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，按照第 9-8 页的配置 FTP 检测类映射中所述
配置条件。

d. 选择是否启用或禁用日志记录。此操作必定会重置连接，从而导致丢弃数据包，关闭连接并向
服务器或客户端发送 TCP 重置。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 7 在 FTP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 FTP 检测服务策略中。

配置 FTP 检测服务策略

默认 ASA 配置包括对默认端口的 FTP 检测 （这项检测全局应用于所有接口）。自定义检测配置的
一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 FTP 检测规则，或者有要添加 FTP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 FTP 检测策略映射，必须禁用 
FTP 检测，然后为其提供新的 FTP 检测策略映射名称并重新启用这项检测：

a. 取消选中 FTP 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 FTP。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择 Use strict FTP。

b. 选择要使用默认映射还是配置的 FTP 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 9-10 页的配置 FTP 检测策略映射。

c. 在 Select FTP Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。
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验证和监控 FTP 检测

FTP 应用检测生成以下日志消息：

• 为检索或上传的每个文件生成审核记录 303002。

• 检查 FTP 命令以确定它是否是 RETR 或 STOR 命令，并记录检索命令和存储命令。

• 通过查找提供了 IP 地址的表格获取用户名。

• 记录用户名、源 IP 地址、目标 IP 地址、 NAT 地址和文件操作。

• 如果辅助动态信道准备因内存不足而失败，将会生成审核记录 201005。

如果与 NAT 配合使用， FTP 应用检测可转换应用负载中的 IP 地址。 RFC 959 中对此进行了说明。

HTTP 检测
以下各节介绍 HTTP 检测引擎。

• 第 9-12 页的 HTTP 检测概述

• 第 9-13 页的配置 HTTP 检测

HTTP 检测概述

提示 可以安装执行应用过滤和 URL 过滤 （包括 HTTP 检测）的服务模块，例如 ASA CX 或 ASA 
FirePOWER。ASA 上运行的 HTTP 检测与这些模块不兼容。请注意，使用专用模块配置应用过滤比
在 ASA 上使用 HTTP 检测策略映射手动配置应用过滤要容易得多。

使用 HTTP 检测引擎可防御特定攻击以及与 HTTP 流量相关的其他威胁。

HTTP 应用检测扫描 HTTP 报头和正文，并对数据执行各种检查。这些检查可防止各种 HTTP 构造、
内容类型、隧道协议和消息传送协议通过安全设备。

增强型 HTTP 检测功能（又称为应用防火墙，在配置 HTTP 检测策略映射时可使用此功能）有助于
防止攻击者使用 HTTP 消息来避开网络安全策略。

HTTP 应用检测可阻止通过隧道传送的应用以及 HTTP 请求和响应中的非 ASCII 字符，从而防止恶
意内容到达网络服务器。还支持对 HTTP 请求和响应报头中的各个元素进行大小限制、URL 拦截以
及 HTTP 服务器报头类型欺骗。

增强型 HTTP 检测验证所有 HTTP 消息是否满足以下条件：

• 符合 RFC 2616 的要求。

• 仅使用 RFC 定义的方法。

• 符合其他条件。
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配置 HTTP 检测

默认情况下， HTTP 检测未启用。如果 HTTP 检测和应用过滤未使用专用模块 （例如 ASA CX 或 
ASA FirePOWER），可以按照以下步骤在 ASA 上手动配置 HTTP 检测。

提示 请勿在服务模块和 ASA 上都配置 HTTP 检测，因为这两者上的检测是不兼容的。

操作步骤

步骤 1 第 9-13 页的配置 HTTP 检测类映射。

步骤 2 第 9-15 页的配置 HTTP 检测策略映射。

步骤 3 第 9-16 页的配置 HTTP 检测服务策略。

配置 HTTP 检测类映射

或者可以创建 HTTP 检测类映射来定义 HTTP 检测的流量类。另一种方法是，直接在 HTTP 检测策
略映射中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法
可以创建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > HTTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。
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步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。

b. 选择匹配条件并定义其值：

• Request/Response Content Type Mismatch - 匹配响应中内容类型与请求的接受字段中 MIME 
类型之一不匹配的数据包。

• Request Arguments - 将请求的参数与选定的正则表达式或正则表达式类进行匹配。

• Request Body Length - 匹配请求正文长度大于指定字节数的数据包。

• Request Body - 将请求的正文与选定的正则表达式或正则表达式类进行匹配。

• Request Header Field Count - 匹配请求中的报头字段数量大于指定数量的数据包。可以将字
段报头类型与正则表达式或预定义类型进行匹配。预定义类型包括：accept、 accept-charset、
accept-encoding、 accept-language、 allow、 authorization、 cache-control、 connection、
content-encoding、 content-language、 content-length、 content-location、 content-md5、
content-range、 content-type、 cookie、 date、 expect、 expires、 from、 host、 if-match、
if-modified-since、 if-none-match、 if-range、 if-unmodified-since、 last-modified、
max-forwards、pragma、proxy-authorization、range、referer、te、trailer、transfer-encoding、
upgrade、 user-agent、 via、 warning。

• Request Header Field Length - 匹配请求中的报头字段长度大于指定字节数的数据包。可以将
字段报头类型与正则表达式或预定义类型进行匹配。以上列出了适用于 Request Header 
Field Count 的预定义类型。

• Request Header Field - 将请求中选定报头字段的内容与选定的正则表达式或正则表达式类进
行匹配。可以指定预定义报头类型，或者使用正则表达式选择报头。

• Request Header Count - 匹配请求中的报头数量大于指定数量的数据包。

• Request Header Length - 匹配请求中的报头长度大于指定字节数的数据包。

• Request Header Non-ASCII - 匹配请求中的报头包含非 ASCII 字符的数据包。

• Request Method - 匹配请求方法与预定义类型或选定的正则表达式或正则表达式类相匹配的
数据包。预定义类型包括：bcopy、 bdelete、 bmove、 bpropfind、 bproppatch、 connect、
copy、delete、edit、get、getattribute、getattributenames、getproperties、head、index、lock、
mkcol、mkdir、move、 notify、 options、 poll、 post、 propfind、 proppatch、 put、 revadd、
revlabel、revlog、revnum、save、search、setattribute、startrev、stoprev、subscribe、trace、
unedit、 unlock、 unsubscribe。

• Request URI Length - 匹配请求 URI 长度大于指定字节数的数据包。

• Request URI - 将请求 URI 的内容与选定的正则表达式或正则表达式类进行匹配。

• Request Body - 将请求正文与选定的正则表达式或正则表达式类或者与 ActiveX 或 Java 小程
序内容进行匹配。

• Response Body Length - 匹配响应正文长度大于指定字节数的数据包。

• Response Header Field Count - 匹配响应中的报头字段数量大于指定数量的数据包。可以将字
段报头类型与正则表达式或预定义类型进行匹配。预定义类型包括：accept-ranges、 age、
allow、 cache-control、 connection、 content-encoding、 content-language、 content-length、
content-location、 content-md5、 content-range、 content-type、 date、 etag、 expires、
last-modified、 location、 pragma、 proxy-authenticate、 retry-after、 server、 set-cookie、
trailer、 transfer-encoding、 upgrade、 vary、 via、 warning、 www-authenticate。
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• Response Header Field Length - 匹配响应中的报头字段长度大于指定字节数的数据包。可以
将字段报头类型与正则表达式或预定义类型进行匹配。以上列出了适用于 Response Header 
Field Count 的预定义类型。

• Response Header Field - 将响应中选定报头字段的内容与选定的正则表达式或正则表达式类
进行匹配。可以指定预定义报头类型，或者使用正则表达式选择报头。

• Response Header Count - 匹配响应中的报头数量大于指定数量的数据包。

• Response Header Length - 匹配响应中的报头长度大于指定字节数的数据包。

• Response Header Non-ASCII - 匹配响应中的报头包含非 ASCII 字符的数据包。

• Response Status Line - 将响应状态的内容与选定的正则表达式或正则表达式类进行匹配。

c. 点击 OK。

步骤 6 在 HTTP Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 HTTP 检测策略映射中。

配置 HTTP 检测策略映射

要指定消息违反参数时要执行的操作，请创建 HTTP 检测策略映射。然后，可以在启用 HTTP 检测
时应用所创建的检测策略映射。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > HTTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 HTTP Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级别为 Low。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 HTTP 检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

提示 URI Filtering 按钮是配置请求 URI 检测的快捷方式 （下面将会加以说明）。
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步骤 5 点击 Parameters 选项卡并配置所需的选项。

• Body Match Maximum - 应在正文匹配中搜索的 HTTP 消息正文中的最大字符数。默认值为 200 
字节。字符数量大将会对性能造成明显影响。

• Check for protocol violations - 是否验证数据包是否符合 HTTP 协议。对于违规情况，可以断开
连接，重置连接或记录连接。断开或重置连接时，还可以启用日志记录。

• Spoof server string - 用指定的字符串 （最多包含 82 个字符）替换服务器 HTTP 报头值。

步骤 6 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 HTTP 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两
种方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 HTTP 类映射；请参阅第 9-13 页的配置 HTTP 检测类映射）。

c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，按照第 9-13 页的配置 HTTP 检测类映射中所
述配置条件。

d. 选择是否断开连接、重置连接或记录连接。对于断开连接和重置连接这两种情况，可以启用或
禁用日志记录。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 7 在 HTTP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 HTTP 检测服务策略中。

配置 HTTP 检测服务策略

HTTP 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。但是，默认检测类
包括默认 HTTP 端口，因此，只需简单地编辑默认全局检测策略即可添加 HTTP 检测。或者，可以
创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 HTTP 检测规则，或者有要添加 HTTP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。
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步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 HTTP 检测策略映射，必须禁
用 HTTP 检测，然后为其提供新的 HTTP 检测策略映射名称并重新启用这项检测：

a. 取消选中 HTTP 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 HTTP。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 HTTP 检测策略映射。可在此时创建映射。有关详细信息，请
参阅第 9-15 页的配置 HTTP 检测策略映射。

b. 在 Select HTTP Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

ICMP 检测
ICMP 检测引擎允许 ICMP 流量具有“会话”，这样可以像对 TCP 和 UDP 流量那样对这种流量进行
检测。如果没有 ICMP 检测引擎，我们建议不要允许 ICMP 通过 ACL 中的 ASA。如果不进行状态检
测， ICMP 可能被用于攻击网络。 ICMP 检测引擎确保每个请求只有一个响应，并确保序列号是正
确的。

但是，即使启用 ICMP 检测，也不会检测流向 ASA 接口的 ICMP 流量。因此，到接口的 ping（回应请
求）可能会在特定情况下失败，例如，如果回应请求来自 ASA 可以通过备用默认路由到达的源。

有关启用 ICMP 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

ICMP 错误检测
如果启用了 ICMP 错误检测， ASA 会根据 NAT 配置为发送 ICMP 错误消息的中间跃点创建转换会
话。 ASA 用转换后的 IP 地址覆盖数据包。

如果这项检测被禁用，ASA 不会为生成 ICMP 错误消息的中间节点创建转换会话。内部主机与 ASA 
之间的中间节点生成的 ICMP 错误消息可在不 占用任何额外 NAT 资源的情况下到达外部主机。如果
外部主机使用路由跟踪命令跟踪到达 ASA 内部目标的跃点，不需要执行此操作。如果 ASA 不转换
中间跃点时，所有中间跃点都将与映射的目标 IP 地址一起显示。

会扫描 ICMP 负载，以从原始数据包检索五元组。然后，会使用检索到的五元组进行查找，以确定
客户端的原始地址。 ICMP 错误检测引擎会对 ICMP 数据包进行以下更改：

• 在 IP 报头中，映射 IP 更改为实际 IP （目标地址）并修改 IP 校验和。

• 在 ICMP 报头中，会根据 ICMP 数据包的变化修改 ICMP 校验和。

• 在负载中，会进行以下更改：

– 原始数据包映射 IP 更改为实际 IP

– 原始数据包映射端口更改为实际端口

– 重新计算原始数据包 IP 校验和

有关启用 ICMP 错误检测的信息，请参阅第 8-8 页的配置应用层协议检测。
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即时消息检测
使用即时消息 (IM) 检测引擎可以控制 IM 的网络使用情况，以及阻止机密数据泄露、蠕虫传播和针
对公司网络的其他威胁。

默认情况下， IM 检测未启用。如果需要 IM 检测，必须对其进行配置。

操作步骤

步骤 1 第 9-18 页的配置即时消息检测策略映射。

步骤 2 第 9-19 页的配置 IM 检测服务策略。

配置即时消息检测策略映射

要指定消息违反参数时要执行的操作，请创建 IM 检测策略映射。然后，可以在启用 IM 检测时应用
所创建的检测策略映射。

或者可以创建 IM 检测类映射来定义 IM 检测的流量类。另一种方法是，直接在 IM 检测策略映射中
定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法可以创建
更复杂的匹配条件，并且可以重复使用类映射。以下操作步骤说明了检测映射；类映射与检测映射
基本上是相同的，唯一不同之处在于，在类映射中，无需为匹配的流量指定操作。可以通过选择 
Configuration > Firewall > Objects > Class Maps > Instant Messaging (IM) 配置 IM 类映射。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > Instant Messaging (IM)。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 定义要根据流量特性实施的特定检查。

可以根据 IM 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两种
方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。
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b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 IM 类映射）。点击 Manage 创建新的类映射。

c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，配置条件。

• Protocol - 匹配特定 IM 协议的流量，例如 Yahoo Messenger 或 MSN Messenger。

• Service - 匹配特定 IM 服务，例如聊天、文件传输、网络摄像头、语音聊天、会议或游戏。

• Version - 将 IM 消息的版本与选定的正则表达式或正则表达式类进行匹配。

• Client Login Name - 将 IM 消息的源客户端登录名与选定的正则表达式或正则表达式类进行
匹配。

• Client Peer Login Name - 将 IM 消息的目标对等体登录名与选定的正则表达式或正则表达式
类进行匹配。

• Source IP Address - 匹配源 IP 地址和掩码。

• Destination IP Address - 匹配目标 IP 地址和掩码。

• Filename - 将 IM 消息的文件名与选定的正则表达式或正则表达式类进行匹配。

d. 选择是否断开连接、重置连接或记录连接。对于断开连接和重置连接这两种情况，可以启用或
禁用日志记录。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 5 在 IM Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 IM 检测服务策略中。

配置 IM 检测服务策略

IM 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。但是，默认检测类包
括默认 IM 端口，因此，只需简单地编辑默认全局检测策略即可添加 IM 检测。或者，可以创建所需
的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 IM 检测规则，或者有要添加 IM 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 IM 检测策略映射，必须禁用 
IM 检测，然后为其提供新的 IM 检测策略映射名称并重新启用这项检测：

a. 取消选中 IM 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。
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步骤 4 选择 IM。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 IM 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 9-18 页的配置即时消息检测策略映射。

b. 在 Select IM Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

IP 选项检测
可以配置 IP 选项检测来控制具有特定 IP 选项的哪些 IP 数据包可以通过 ASA。可以通过配置这项检
测来指示 ASA 采取以下行动：允许数据包通过；或者清除指定的 IP 选项，然后允许数据包通过。

以下各节介绍 IP 选项检测引擎。

• 第 9-20 页的 IP 选项检测概述

• 第 9-21 页的 IP 选项检测的默认设置

• 第 9-21 页的配置 IP 选项检测

• 第 9-23 页的监控 IP 选项检测

IP 选项检测概述

每个 IP 数据包都包含一个带有 Options 字段的 IP 报头。Options 字段（通常称为 IP 选项）提供了某
些情况下需要使用的控制功能，但这些功能在大多数常见通信中是不必要的。具体来说， IP 选项提
供了时间戳、安全性和特殊路由。并非必须使用 IP 选项，此字段可能包括零个、一个或多个选项。

有关 IP 选项的列表以及相关 RFC 的引用，请参阅 IANA 页面 
http://www.iana.org/assignments/ip-parameters/ip-parameters.xhtml。

可以配置 IP 选项检测来控制具有特定 IP 选项的哪些 IP 数据包可以通过 ASA。可以通过配置这项检
测来指示 ASA 采取以下行动：允许数据包通过；或者清除指定的 IP 选项，然后允许数据包通过。

清除选项时会发生的情况

配置 IP 选项检测策略映射时，可以指定是否要允许或清除每种选项类型。如果不指定某个选项类
型，包含该选项的数据包将被丢弃。

如果仅允许一个选项，包含该选项的数据包将会在不发生变化的情况下通过。

如果指定了要从 IP 报头中清除的选项， IP 报头会发生如下变化：

• 将会从报头中移除该选项。

• 将会填充 Options 字段，以使该字段以 32 位边界结尾。

• 数据包中的互联网报头长度 (IHL) 将会发生变化。

• 数据包的总长度将会发生变化。

• 将会重新计算校验和。
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支持检测的 IP 选项

IP 选项检测可以检查数据包中的以下 IP 选项。如果 IP 报头包含除这些选项外的其他选项，那么，
无论 ASA 是否配置为允许这些选项， ASA 都会丢弃数据包。

• End of Options List (EOOL) 或 IP 选项 0 - 此选项仅包含一个零字节，显示在所有选项的末尾，用
于标记选项列表的末尾。根据报头长度，这可能与报头末尾不一致。

• No Operation (NOP) 或 IP 选项 1 - IP 报头中的 Options 字段可能包括零个、一个或多个选项，这
些选项共同构成此字段变量的总长度。但是， IP 报头必须是 32 位的倍数。如果所有选项的位
数不是 32 位的倍数， NOP 选项将被作为 “内部填充”，用于对齐 32 位边界上的选项。

• Router Alert (RTRALT) 或 IP 选项 20 - 此选项通知中转路由器应检测数据包的内容，即使数据包
不是发送给该路由器。实施 RSVP 以及实施需要路由器沿着数据包传送路径进行相对复杂的处
理的类似协议时，这项检查很有用。丢弃包含 Router Alert 选项的 RSVP 数据包可能会导致 VoIP 
的实施出现问题。

IP 选项检测的默认设置

默认情况下， IP 选项检测已使用 _default_ip_options_map 检测策略映射启用。

• 允许使用 Router Alert 选项。

• 包含任何其他选项 （包括不受支持的选项）的数据包将被丢弃。

配置 IP 选项检测

默认情况下， IP 选项检测已启用。仅在要允许默认映射允许的选项以外的其他选项时，才需要配置
这项检测。

操作步骤

步骤 1 第 9-21 页的配置 IP 选项检测策略映射。

步骤 2 第 9-22 页的配置 IP 选项检测服务策略。

配置 IP 选项检测策略映射

如果要执行非默认 IP 选项检测，请创建 IP 选项检测策略映射，以指定要如何处理每种受支持的选
项类型。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。
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操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > IP Options。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择要允许的选项。有关每种选项类型的说明，请参阅第 9-21 页的支持检测的 IP 选项。

包含未选择的任何选项的数据包将被丢弃。

步骤 5 对于每个允许的选项，选择是否在允许数据包前将其清除。

如果您清除某个选项，检测会在数据包传输之前从数据包报头中移除该选项。

步骤 6 点击 OK。

这样即可将检测映射用于 IP 选项检测服务策略中。

配置 IP 选项检测服务策略

默认 ASA 配置包括全局应用于所有接口的 IP 选项检测。自定义检测配置的一种常用方法是自定义
默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 IP 选项检测规则，或者有要添加 IP 选项检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 IP 选项检测策略映射，必须禁
用 IP 选项检测，然后为其提供新的 IP 选项检测策略映射名称并重新启用这项检测：

a. 取消选中 IP Options 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 IP Options。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 IP 选项检测策略映射。可在此时创建映射。有关详细信息，请
参阅第 9-21 页的配置 IP 选项检测策略映射。

b. 在 Select IP Options Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。
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监控 IP 选项检测

可以使用以下方法来监控 IP 选项检测的结果：

• 每次数据包因检测而被丢弃时，都会发出系统日志 106012。该消息会显示是哪个选项导致数据
包被丢弃。

• 使用 show service-policy inspect ip-options 命令可查看每个选项的统计信息。

IPsec 穿透检测
以下各节介绍 IPsec 穿透检测引擎。

• 第 9-23 页的 IPsec 穿透检测概述

• 第 9-23 页的配置 IPsec 穿透检测

IPsec 穿透检测概述

互联网协议安全 (IPsec) 是一个协议集，用于通过验证和加密数据流的每个 IP 数据包来保护 IP 通
信。 IPsec 还包括用于会话开始时在代理之间建立相互身份验证以及用于协商将在会话期间使用的
加密密钥的协议。 IPsec 可用于保护一对主机之间 （例如，计算机用户或服务器）、一对安全网关
之间 （例如，路由器或防火墙）或安全网关与主机之间的数据流。

IPSec 穿透应用检测使得与 IKE UDP 端口 500 连接相关的 ESP （IP 协议 50）和 AH （IP 协议 51）
流量可以轻松地通过。这项检测避免了为允许 ESP 和 AH 流量而需要进行冗长的 ACL 配置，并使
用超时和最大连接数实现安全性。

可以为 IPsec 穿透检测配置策略映射，以指定 ESP 或 AH 流量的限制。可以为每个客户端设置最大
连接数和空闲超时。

允许 NAT 流量和非 NAT 流量。但是，不支持 PAT。

配置 IPsec 穿透检测

默认情况下， IPSec 穿透检测未启用。如果需要 IPsec 穿透检测，必须对其进行配置。

操作步骤

步骤 1 第 9-24 页的配置 IPsec 穿透检测策略映射。

步骤 2 第 9-24 页的配置 IPSec 穿透检测服务策略。
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配置 IPsec 穿透检测策略映射

通过 IPsec 穿透映射可以更改用于 IPSec 穿透应用检测的默认配置值。借助 IPsec 穿透映射，无需使
用 ACL 即可允许某些数据流。

配置包括默认映射 _default_ipsec_passthru_map，该默认映射设置每个客户端的最大 ESP 连接数，并
将 ESP 空闲超时设置为 10 分钟。仅在需要非默认值或者需要设置 AH 值的情况下，才需要配置检
测策略映射。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > IPsec Pass Through。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 IPsec Pass Through Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 IPsec 穿透检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

步骤 5 选择是否允许 ESP 和 AH 隧道。

对于每个协议，还可以设置每个客户端的最大允许连接数和空闲超时。

步骤 6 点击 OK。

这样即可将检测映射用于 IPsec 穿透检测服务策略中。

配置 IPSec 穿透检测服务策略

IPsec 穿透检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。但是，默认检
测类包括默认 IPsec 端口，因此，只需简单地编辑默认全局检测策略即可添加 IPsec 检测。或者，可
以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 IPsec 穿透检测规则，或者有要添加 IPsec 穿透检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。
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步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 IPsec 
穿透检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中 IPsec Pass Through 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 IPsec Pass Through。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 IPsec 穿透检测策略映射。可在此时创建映射。有关详细信息，
请参阅第 9-24 页的配置 IPsec 穿透检测策略映射。

b. 在 Select IPsec Pass Through Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

IPv6 检测
IPv6 检测根据扩展报头有选择性地记录或丢弃 IPv6 流量。此外， IPv6 检测可以检查 IPv6 数据包中
扩展报头的类型和顺序是否符合 RFC 2460 的要求。

• 第 9-25 页的 IPv6 检测的默认设置

• 第 9-25 页的配置 IPv6 检测

IPv6 检测的默认设置

如果启用 IPv6 检测但不指定检测策略映射，将会使用默认 IPv6 检测策略映射并执行以下操作：

• 仅允许已知的 IPv6 扩展报头。丢弃并记录不符合要求的数据包。

• 按照 RFC 2460 规范的规定实施 IPv6 扩展报头顺序。丢弃并记录不符合要求的数据包。

• 丢弃带有路由类型报头的任何数据包。

配置 IPv6 检测

默认情况下， IPv6 检测未启用。如果需要 IPv6 检测，必须对其进行配置。

操作步骤

步骤 1 第 9-26 页的配置 IPv6 检测策略映射。

步骤 2 第 9-27 页的配置 IPv6 检测服务策略。
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配置 IPv6 检测策略映射 

要标识要丢弃或记录的扩展报头，或者要禁用数据包验证，请创建 IPv6 检测策略映射以用于服务
策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > IPv6。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 点击 Enforcement 选项卡，并选择是仅允许已知的 IPv6 扩展报头还是按照 RFC 2460 的规定实施 
IPv6 扩展报头顺序。丢弃并记录不符合要求的数据包。

步骤 5 （可选）点击 Header Matches 选项卡，以根据 IPv6 消息中的报头标识要丢弃或记录的流量。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择要匹配的 IPv6 扩展报头：

– 身份验证 (AH) 报头。

– 目标选项报头。

– 封装安全负载 (ESP) 报头。

– 分片报头。

– 逐跳选项检测。

– 路由报头 - 指定一个报头类型编号或编号范围。

– 报头数 - 指定在不丢弃或记录数据包的情况下允许的最大扩展报头数量。

– 路由报头地址数 - 指定在不丢弃或记录数据包的情况下允许类型 0 路由报头中存在的最大地
址数量。

c. 选择是要丢弃数据包还是记录数据包。如果选择丢弃数据包，还可以启用日志记录。

d. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 6 在 IPv6 Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 IPv6 检测服务策略中。
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配置 IPv6 检测服务策略

IPv6 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。可以简单地编辑默认
全局检测策略来添加 IPv6 检测。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 IPv6 检测规则，或者有要添加 IPv6 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的 IPv6 检测策略映射，必须禁用 
IPv6 检测，然后为其提供新的 IPv6 检测策略映射名称并重新启用这项检测：

a. 取消选中 IPv6 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 IPv6。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 IPv6 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 9-26 页的配置 IPv6 检测策略映射。

b. 在 Select IPv6 Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

NetBIOS 检测
默认情况下，NetBIOS 检测已启用。NetBIOS 检测引擎根据 ASA NAT 配置转换 NetBIOS 名称服务 
(NBNS) 数据包中的 IP 地址。或者可以创建策略映射以便丢弃或记录 NetBIOS 协议违规情况。

操作步骤

步骤 1 第 9-28 页的为其他检测控制配置 NetBIOS 检测策略映射。

步骤 2 第 9-28 页的配置 NetBIOS 检测服务策略。
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为其他检测控制配置 NetBIOS 检测策略映射

要指定出现协议违规时应执行的操作，请创建 NETBIOS 检测策略映射。然后，可以在启用 
NETBIOS 检测时应用所创建的检测策略映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > NetBIOS。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择 Check for Protocol Violations。如果不选择此选项，则没有理由创建映射。

步骤 5 选择要执行的操作 （丢弃数据包或记录数据包）。如果选择丢弃数据包，还可以启用日志记录。

步骤 6 点击 OK。

这样即可将检测映射用于 NetBIOS 检测服务策略中。

配置 NetBIOS 检测服务策略

NetBIOS 应用检测为 NetBIOS 名称服务数据包和 NetBIOS 数据报服务数据包中的嵌入式 IP 地址执
行 NAT。这项检测还会检查各个数量字段和长度字段的一致性，从而强制执行协议符合性。

默认 ASA 配置包括对默认端口的 NetBIOS 检测 （这项检测全局应用于所有接口）。自定义检测
配置的一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特
定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 NetBIOS 检测规则，或者有要添加 NetBIOS 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 NetBIOS。

步骤 4 如果需要非默认检测，请点击 Configure，并选择要使用默认映射还是配置的 NetBIOS 检测策略映
射。可在此时创建映射。有关详细信息，请参阅第 9-28 页的为其他检测控制配置 NetBIOS 检测策
略映射。

步骤 5 在 Select NetBIOS Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。
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PPTP 检测
PPTP 是用于对 PPP 流量进行隧道传送的协议。PPTP 会话通常包括一个 TCP 信道和两个 PPTP GRE 
隧道。TCP 信道是用于协商和管理 PPTP GRE 隧道的控制信道。GRE 隧道在两台主机之间传送 PPP 
会话。

启用后，PPTP 应用检测会检查 PPTP 协议数据包，并动态创建允许 PPTP 流量所需的 GRE 连接和
转换。

具体来说，ASA 检查 PPTP 版本公告和传出呼叫的请求-响应序列。如 RFC 2637 所要求，仅检测 
PPTP 版本 1。如果任一端公布的版本不是版本 1，将会禁用对 TCP 控制信道的进一步检测。此
外，会跟踪传出呼叫的请求-应答序列。会根据需要动态分配连接和转换，以允许后续辅助 GRE 
数据流量。

要以 PAT 方式转换 PPTP 流量，必须启用 PPTP 检测引擎。此外，仅对符合如下条件的 GRE 版本
执行 PAT：经过修改的 （如 RFC2637 所要求）；且是通过 TCP 控制信道协商的。不会对未经修
改的 GRE 版本执行 PAT （如 RFC 1701 和 RFC 1702 所要求）。

有关启用 PPTP 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

SMTP 检测和扩展 SMTP 检测
ESMTP 检测检查各种攻击，包括垃圾邮件、网络钓鱼、畸形消息攻击、缓冲区溢出/下溢攻击。这
项检测还支持应用安全和协议符合性检查，即，会对 ESMTP 消息执行健全性检查，检测若干种攻
击，阻止发件人/收件人，以及阻止邮件转发。

以下各节介绍 ESMTP 检测引擎。

• 第 9-29 页的 SMTP 检测和 ESMTP 检测概述

• 第 9-30 页的 ESMTP 检测的默认设置

• 第 9-31 页的配置 ESMTP 检测

SMTP 检测和 ESMTP 检测概述

ESMTP 应用检测能够限制可通过 ASA 的 SMTP 命令类型以及添加监控功能，从而加强针对基于 
SMTP 的攻击的防御。

ESMTP 是增强型 SMTP 协议，在大多数方面和 SMTP 类似。为方便起见，本文档中用 SMTP 来同
时指代 SMTP 和 ESMTP。扩展 SMTP 的应用检测流程类似于 SMTP 应用检测，这项检测支持 SMTP 
会话。扩展 SMTP 会话中使用的大多数命令与 SMTP 会话中使用的命令相同，但 ESMTP 会话的速
度快很多，而且提供了更多与可靠性和安全性相关的选项，例如，传送状态通知。

扩展 SMTP 应用检测增加了对如下扩展 SMTP 命令的支持：AUTH、 EHLO、 ETRN、 HELP、
SAML、 SEND、 SOML、 STARTTLS 和 VRFY。 ASA 另外还支持七个 RFC 821 命令 （DATA、
HELO、 MAIL、 NOOP、 QUIT、 RCPT、 RSET），也就是说，总共支持十五个 SMTP 命令。

不支持其他扩展 SMTP 命令（例如 ATRN、ONEX、VERB、CHUNKING）和专用扩展。不受支持
的命令将被转换为 X （内部服务器会拒绝这些命令）。这将会生成消息，例如 “500 Command 
unknown: 'XXX'.”。不完整的命令将被丢弃。

ESMTP 检测引擎将服务器 SMTP 横幅中的字符更改为星号，但对“2”、“0”、“0”字符除外。会
忽略回车符 (CR) 和换行符 (LF)。
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在 SMTP 检测启用的情况下，如果不遵守以下规则，用于交互式 SMTP 的 Telnet 会话可能会挂起：
SMTP 命令长度必须至少为四个字符；必须以回车符和换行符终止；且必须在获得响应后才能发出
下一个应答。

SMTP 服务器使用数字应答代码和（可选）人可读字符串来响应客户端请求。 SMTP 应用检测控制
和减少用户可使用的命令以及服务器返回的消息。 SMTP 检测主要执行以下三项任务：

• 将 SMTP 请求限制为七个基本 SMTP 命令和八个扩展命令。

• 监控 SMTP 命令-响应序列。

• 生成审核线索 - 邮件地址中嵌入的无效字符被替换时，会生成审核记录 108002。有关详细信
息，请参阅 RFC 821。

SMTP 检测监控以下异常签名的命令-响应序列：

• 截断的命令。

• 命令终止错误 （不是以 <CR><LR> 终止）。

• MAIL 和 RCPT 命令指定邮件的发件人和收件人。会扫描邮件地址以检测异常字符。竖线 (|) 将
被删除 （更改为空格）； “<”和 “>”只能用于定义邮件地址 （“>”前面必须有 “<”）。

• SMTP 服务器执行的意外转换。

• 对于未知命令， ASA 会将数据包中的所有字符更改为 X。在这种情况下，服务器会对客户端生
成错误代码。由于数据包发生了变化，因此必须重新计算或调整 TCP 校验和。

• TCP 数据流编辑。

• 命令管道。

ESMTP 检测的默认设置

默认情况下， ESMTP 选项检测已使用 _default_esmtp_map 检测策略映射启用。

• 会掩蔽服务器横幅。

• 会检测加密流量。

• 不会查找发件人和收件人地址中的特殊字符，不会执行任何操作。

• 会丢弃并记录命令行长度大于 512 的连接。

• 会丢弃并记录有多于 100 个收件人的连接。

• 会记录正文长度超过 998 字节的消息。

• 会丢弃并记录报头行长度大于 998 的连接。

• 会丢弃并记录 MIME 文件名超过 255 个字符的消息。

• 会掩蔽匹配 “others”的 EHLO 应答参数。
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配置 ESMTP 检测

默认情况下， ESMTP 检测已启用。仅在要执行非默认检测映射流程的情况下，才需要配置这项
检测。

操作步骤

步骤 1 第 9-31 页的配置 ESMTP 检测策略映射。

步骤 2 第 9-33 页的配置 ESMTP 检测服务策略。

配置 ESMTP 检测策略映射

要指定消息违反参数时要执行的操作，请创建 ESMTP 检测策略映射。然后，可以在启用 ESMTP 检
测时应用所创建的检测策略映射。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > ESMTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 ESMTP Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 ESMTP 检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

提示 MIME File Type Filtering 按钮是配置文件类型检测的快捷方式 （下面将会加以说明）。

步骤 5 点击 Parameters 选项卡并配置所需的选项。

• Mask Server Banner - 是否掩蔽来自 ESMTP 服务器的横幅。

• Encrypted Packet Inspection - 是否允许 ESMTP 在未经检测的情况下通过 TLS （加密连接）。
如有需要，可以记录加密连接。
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步骤 6 点击 Filtering 选项卡并配置所需的选项。

• Configure mail relay - 标识用于邮件转发的域名。可以断开连接和 （可选）记录连接，或者只
记录连接。

• Check for special characters - 标识要对发件人或收件人邮件地址中包含特殊字符 （竖线 (|)、反
引号和空字符）的消息执行的操作。可以断开连接和 （可选）记录连接，或者只记录连接。

步骤 7 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。然后，配置条件：

• Body Length - 匹配 ESMTP 消息正文长度大于指定字节数的消息。

• Body Line Length - 匹配 ESMTP 消息正文的行长度大于指定字节数的消息。

• Commands - 匹配消息中的命令谓词。可以指定以下一个或多个命令：auth、 data、 ehlo、
etrn、 helo、 help、 mail、 noop、 quit、 rcpt、 rset、 saml、 soml、 vrfy。

• Command Recipient Count - 匹配收件人数量大于指定数量的消息。

• Command Line Length - 匹配命令谓词中行长度大于指定字节数的消息。

• EHLO Reply Parameters - 匹配 ESMTP EHLO 应答参数。可以指定以下一个或多个参数：
8bitmime、 auth、 binaryname、 checkpoint、 dsn、 etrn、 others、 pipelining、 size、 vrfy。

• Header Length - 匹配 ESMTP 报头长度大于指定字节数的消息。

• Header Line Length - 匹配 ESMTP 报头的行长度大于指定字节数的消息。

• Header To: Fields Count - 匹配报头中 To 字段数量大于指定数量的消息。

• Invalid Recipients Count - 匹配无效收件人数量大于指定数量的消息。

• MIME File Type - 将 MIME 或媒体文件类型与指定的正则表达式或正则表达式类进行匹配。

• MIME Filename Length - 匹配文件名长度大于指定字节数的消息。

• MIME Encoding - 匹配 MIME 编码类型。可以指定以下一个或多个类型：7bit、 8bit、
base64、 binary、 others、 quoted-printable。

• Sender Address - 将发件人邮件地址与指定的正则表达式或正则表达式类进行匹配。

• Sender Address Length - 匹配发件人地址长度大于指定字节数的消息。

c. 选择是否断开连接、重置连接或记录连接。对于断开连接和重置连接这两种情况，可以启用或
禁用日志记录。对于命令匹配和 EHLO 应答参数匹配，还可以掩蔽此命令。对于命令匹配，还
可以对数据包数应用每秒速率限制。

d. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 8 在 ESMTP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 ESMTP 检测服务策略中。
9-32
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 9 章      基本互联网协议检测

  TFTP 检测
配置 ESMTP 检测服务策略

默认 ASA 配置包括全局应用于所有接口的 ESMTP 检测。自定义检测配置的一种常用方法是自定义
默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 ESMTP 检测规则，或者有要添加 ESMTP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 
ESMTP 检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中 ESMTP 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 ESMTP。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 ESMTP 检测策略映射。可在此时创建映射。有关详细信息，
请参阅第 9-31 页的配置 ESMTP 检测策略映射。

b. 在 Select ESMTP Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

TFTP 检测
默认情况下， TFTP 检测已启用。

如 RFC 1350 中所述， TFTP 是用于在 TFTP 服务器与客户端之间读取和写入文件的简单协议。

ASA 会检查 TFTP 流量，并在必要时动态创建连接和转换，以允许 TFTP 客户端与服务器之间进行
文件传输。具体来说，此检测引擎检查 TFTP 读取请求 (RRQ)、写入请求 (WRQ) 和错误通知 
(ERROR)。

如有必要，在接收有效的读取 (RRQ) 或写入 (WRQ) 请求时会分配动态辅助信道和 PAT 转换。随
后， TFTP 会使用该辅助信道进行文件传输或错误通知。

只有 TFTP 服务器可以通过辅助信道发起流量；此外， TFTP 客户端与服务器之间最多只能有一个
不完整的辅助信道。服务器发出的错误通知会致使辅助信道关闭。

如果静态 PAT 用于重定向 TFTP 流量，必须启用 TFTP 检查检测。

有关启用 TFTP 检测的信息，请参阅第 8-8 页的配置应用层协议检测。
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10第 章
语音和视频协议的检测

以下主题介绍针对语音和视频协议的应用检测。有关为何需要对某些协议进行检测以及应用检测的
总体方法的基本信息，请参阅第 8-1 页的应用层协议检测入门。

• 第 10-1 页的 CTIQBE 检测

• 第 10-2 页的 H.323 检测

• 第 10-7 页的 MGCP 检测

• 第 10-10 页的 RTSP 检测

• 第 10-15 页的 SIP 检测

• 第 10-21 页的瘦客户端 (SCCP) 检测

• 第 10-25 页的语音和视频协议检测的历史记录

CTIQBE 检测
CTIQBE 协议检测支持 NAT、 PAT 和双向 NAT。这使得 Cisco IP SoftPhone 和其他思科 
TAPI/JTAPI 应用可与 Cisco CallManager 配合使用，从而能够越过 ASA 建立呼叫。

许多思科 VoIP 应用都使用 TAPI 和 JTAPI。思科 TSP 通过 CTIQBE 与 Cisco CallManager 通信。

有关启用 CTIQBE 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

• 第 10-1 页的 CTIQBE 检测的局限性

CTIQBE 检测的局限性

下面总结了 CTIQBE 应用检测的局限性：

• CTIQBE 应用检测不支持使用 alias 命令的配置。

• 不支持 CTIQBE 呼叫状态故障转移。

• 对 CTIQBE 检测进行调试可能会延迟消息传输，这在实时环境中可能会造成性能影响。如果您
启用了这种调试或日志记录，但 Cisco IP SoftPhone 似乎无法通过 ASA 完成呼叫建立，请在运
行 Cisco IP SoftPhone 的系统上增大思科 TSP 设置中的超时值。

下面总结了在特定情况下使用 CTIQBE 应用检测时的特殊注意事项：

• 如果两个 Cisco IP SoftPhone 注册到不同的 Cisco CallManager，而这些 Cisco CallManager 连接到 
ASA 的不同接口，那么这两个电话之间的呼叫将会失败。
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• 当 Cisco CallManager 位于安全性高于 Cisco IP SoftPhone 的接口上时，如果 Cisco CallManager IP 
地址需要 NAT 或外部 NAT，则映射必须是静态的，因为 Cisco IP SoftPhone 要求在 PC 上的思科 
TSP 配置中明确指定 Cisco CallManager IP 地址。

• 当使用 PAT 或外部 PAT 时，如果 Cisco CallManager IP 地址将被转换，它的 TCP 端口 2748 必须
静态映射到 PAT（接口）地址的同一端口，这样 Cisco IP SoftPhone 注册才能成功。CTIQBE 侦
听端口 (TCP 2748) 是固定的，用户不可在 Cisco CallManager、Cisco IP SoftPhone 或思科 TSP 上
配置该端口。

H.323 检测
以下部分介绍 H.323 应用检测。

• 第 10-2 页的 H.323 检测概述

• 第 10-2 页的 H.323 如何工作

• 第 10-3 页的 H.245 消息中的 H.239 支持

• 第 10-4 页的 H.323 检测的局限性

• 第 10-4 页的配置 H.323 检测

• 第 10-7 页的配置 H.323 和 H.225 超时值

H.323 检测概述

H.323 检测为符合 H.323 的应用（例如 Cisco CallManager 和 VocalTec Gatekeeper）提供支持。H.323 
是国际电信联盟制定的一套协议，用于通过 LAN 进行多媒体会议。 ASA 最高支持 H.323 v6，其中
包括 H.323 v3 的 “支持在一个呼叫信令信道上进行多个呼叫”功能。

启用 H.323 检测后，ASA 支持在同一呼叫信令信道上进行多个呼叫（此功能在 H.323 v3 中引入）。
此功能可缩短呼叫建立时间并减少 ASA 上端口的使用。

H.323 检测具有如下两个主要功能：

• 对 H.225 和 H.245 消息中必要的嵌入式 IPv4 地址进行 NAT 转换。由于 H.323 消以 PER 编码格
式进行编码，因此， ASA 使用 ASN.1 解码器来解码 H.323 消息。

• 动态分配协商的 H.245 和 RTP/RTCP 连接。使用 RAS 时，也可以动态分配 H.225 连接。

H.323 如何工作

H.323 协议集合总共最多可以使用两个 TCP 连接和四到八个 UDP 连接。 FastConnect 仅使用一个 
TCP 连接，且 RAS 使用单个 UDP 连接用于注册、准入和状态。

首先， H.323 客户端可以使用 TCP 端口 1720 建立与 H.323 服务器之间的 TCP 连接，以请求 Q.931 
呼叫建立。作为呼叫建立流程的一部分， H.323 终端会向客户端提供用于 H.245 TCP 连接的端口
号。在使用 H.323 网守的环境中，初始数据包使用 UDP 进行传输。

H.323 检测会监控 Q.931 TCP 连接以确定 H.245 端口号。如果 H.323 终端不使用 FastConnect，ASA 
会根据 H.225 消息的检测情况动态分配 H.245 连接。

注 使用 RAS 时，也可以动态分配 H.225 连接。
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在每个 H.245 消息中，H.323 终端交换用于后续 UDP 数据流的端口号。H.323 检测会检测 H.245 消
息来标识这些端口，并动态创建用于媒体交换的连接。 RTP 使用协商的端口号，而 RTCP 使用下一
个更高的端口号。

H.323 控制信道处理 H.225、 H.245 和 H.323 RAS。 H.323 检测使用以下端口。

• 1718 - 网守发现 UDP 端口

• 1719 - RAS UDP 端口 

• 1720 - TCP 控制端口 

要实现 RAS 信令，必须允许已知 H.323 端口 1719 的流量。此外，要实现 H.225 呼叫信令，必须允
许已知 H.323 端口 1720 的流量；但是，H.245 信令端口在 H.225 信令中的终端之间协商。如果有使
用 H.323 网守， ASA 会根据 ACF 和 RCF 消息的检测情况打开 H.225 连接。

检测 H.225 消息后，ASA 会打开 H.245 信道，然后检测通过 H.245 信道发送的流量。所有通过 ASA 
的 H.245 消息都要接受 H.245 应用检测，这项检测会转换嵌入式 IP 地址并打开 H.245 消息中协商的
媒体信道。

H.323 ITU 标准要求，定义消息长度的 TPKT 报头在传递到可靠连接之前应先于 H.225 和 H.245。由
于 TPKT 报头不一定要在 H.225 和 H.245 消息所在的 TCP 数据包中发送，因此， ASA 必须记住 
TPKT 长度，以便正确处理和解码消息。对于每个连接， ASA 会保留包含下一个预期消息的 TPKT 
长度的记录。

如果 ASA 需要对消息中的 IP 地址执行 NAT，它会更改校验和、UUIE 长度和 TPKT（如果 TPKT 和 
H.225 消息位于同一个 TCP 数据包中）。如果 TPKT 在单独的 TCP 数据包中发送，ASA 代理会确认
该 TPKT，并将具有新长度的新 TPKT 附加到 H.245 消息。

注 在针对 TPKT 的代理确认中， ASA 不支持 TCP 选项。

每个具有通过 H.323 检测的数据包的 UDP 连接将被标记为 H.323 连接，每个这些连接的超时为 
Configuration > Firewall > Advanced > Global Timeouts 窗格中配置的 H.323 超时。

注 如果网守在网络内部，可以在 H.323 终端之间启用呼叫建立。 ASA 包含用于根据 
RegistrationRequest/RegistrationConfirm (RRQ/RCF) 消息为呼叫打开针孔的选项。由于这些 
RRQ/RCF 消息在终端与网守之间来回发送，因此，呼叫终端的 IP 地址是未知的，ASA 则会通过源 
IP 地址/端口 0/0 打开针孔。默认情况下，此选项已禁用。

H.245 消息中的 H.239 支持

ASA 位于两个 H.323 终端之间。两个 H.323 终端建立电话演示会话并可以相互之间发送和接收数据
演示 （例如电子表格数据）后， ASA 会确保这些终端之间可实现成功 H.239 协商。

H.239 是一项标准，使 H.300 系列终端能够在单个呼叫中打开另外一个视频信道。在呼叫中，终端
（例如视频电话）会发送视频信道和数据演示信道。 H.239 协商在 H.245 信道上发生。

ASA 打开用于另外一个媒体信道和媒体控制信道的针孔。终端使用开放逻辑信道 (OLC) 消息来发
出有关新信道创建的信息。消息扩展是 H.245 v13 的一部分。

默认情况下，电话演示会话的解码和编码已启用。 H.239 的编码和解码由 ASN.1 编码器执行。
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H.323 检测的局限性

H.323 检测已经过测试，受 Cisco Unified Communications Manager (CUCM) 7.0 支持。 CUCM 8.0 及
更高版本不支持这项检测。 H.323 检测可能适用于其他版本和产品。

以下是 H.323 应用检测的一些已知问题和局限性：

• 仅完全支持静态 NAT。静态 PAT 可能无法正确转换 H.323 消息内嵌入到可选字段中的 IP 地址。
如果遇到这种问题，请勿对 H.323 使用静态 PAT。

• 不支持动态 NAT 或 PAT。

• 不支持扩展 PAT。

• 不支持同一安全级别接口之间的 NAT。

• 不支持外部 NAT。

• 不支持 NAT64。

• 如果 NetMeeting 客户端已注册到 H.323 网守，并尝试呼叫也已注册到 H.323 网守的 H.323 网
关，将会建立连接，但两端都不会听到语音。这个问题与 ASA 无关。

• 如果将网络静态地址配置为与第三方子网掩码和地址相同，任何出站 H.323 连接都将失败。

配置 H.323 检测

H.323 检测支持 RAS、 H.225 和 H.245，这项检测会转换所有嵌入式 IP 地址和端口。它执行状态跟
踪和过滤，并且可以级联检测功能激活。H.323 检测支持电话号码过滤、动态 T.120 控制、H.245 隧
道控制、 HSI 组、协议状态跟踪、 H.323 呼叫持续时间实施和音频/视频控制。

默认情况下， H.323 检测已启用。仅在需要非默认处理的情况下，才需要配置这项检测。如果要自
定义 H.323 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 10-4 页的配置 H.323 检测类映射

步骤 2 第 10-5 页的配置 H.323 检测策略映射

步骤 3 第 10-7 页的配置 H.323 检测服务策略

配置 H.323 检测类映射

可以选择创建 H.323 检测类映射来定义 H.323 检测的流量类。另一种方法是，直接在 H.323 检测策
略映射中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法
可以创建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。
10-4
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 10 章      语音和视频协议的检测

  H.323 检测
操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > H.323。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。

步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match（流量必须与条件匹配）或者 No Match（流量不得与条件匹配）。

b. 选择匹配条件并定义其值：

• Called Party - 将 H.323 被叫方与选定的正则表达式或正则表达式类进行匹配。

• Calling Party - 将 H.323 主叫方与选定的正则表达式或正则表达式类进行匹配。

• Media Type - 匹配媒体类型：音频、视频或数据。

c. 点击 OK。

步骤 6 在 H.323 Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 H.323 检测策略映射中。

配置 H.323 检测策略映射

如果默认检测行为不能满足网络要求，可以创建 H.323 检测策略映射来自定义 H.323 检测操作。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > H.323。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 H.323 Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级别为 Low。
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如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 H.323 检测。

提示 Phone Number Filtering 按钮是配置被叫方或主叫方检测的快捷方式 （下面将会加以说
明）。

步骤 5 如果需要进一步自定义设置，请点击 Details 并执行以下操作：

a. 点击 State Checking 选项卡，选择是否启用 RAS 和 H.225 消息的状态转换检查。

还可以检查 RCF 消息并打开用于 RRQ 消息中存在的呼叫信号地址的针孔，这样，如果网守在
网络内部，可以在 H.323 终端之间启用呼叫建立。使用此选项可根据 
RegistrationRequest/RegistrationConfirm (RRQ/RCF) 消息为呼叫打开针孔。由于这些 RRQ/RCF 
消息在终端与网守之间来回发送，因此，呼叫终端的 IP 地址是未知的， ASA 则会通过源 IP 地
址/端口 0/0 打开针孔。默认情况下，此选项已禁用。

b. 点击 Call Attributes 选项卡，并选择是要执行呼叫持续时间限制（最多为 1193 小时）还是要在
呼叫建立期间执行主叫方号码和被叫方号码显示。

c. 点击 Tunneling and Protocol Conformance 选项卡，并选择是否检查 H.245 隧道；可以断开连接
或记录连接。

还可以选择是否检查流经针孔的 RTP 数据包的协议符合性。如果检查符合性，还可以选择是否
根据信令交换限制音频或视频的负载。

步骤 6 如有必要，请点击 HSI Group Parameters 选项卡并定义 HSI 组。

a. 执行以下任意操作：

• 点击 Add 添加新组。

• 选择现有组并点击 Edit。

b. 指定组 ID （0 到 2147483647）和 HSI 的 IP 地址。

c. 要向 HSI 组添加终端，请输入 IP 地址，选择终端连接到 ASA 所通过的接口，然后点击 
Add>>。可移除不再需要的任何终端。每个组最多可以有 10 个终端。

d. 点击 OK 添加组。根据需要重复上述步骤。

步骤 7 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 H.323 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两
种方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 H.323 类映射；请参阅第 10-4 页的配置 H.323 检测类映射）。

c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。然后，如下配置条件：

• Called Party - 将 H.323 被叫方与选定的正则表达式或正则表达式类进行匹配。

• Calling Party - 将 H.323 主叫方与选定的正则表达式或正则表达式类进行匹配。

• Media Type - 匹配媒体类型：音频、视频或数据。
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d. 选择要对匹配的流量执行的操作。对于匹配的主叫方或被叫方，可以丢弃数据包，断开连接或
重置连接。对于媒体类型匹配，操作始终是丢弃数据包；可以对此操作启用日志记录。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 8 在 H.323 Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 H.323 检测服务策略中。

配置 H.323 检测服务策略

默认 ASA 配置包括对默认端口的 H.323 H.255 和 RAS 检测（这两项检测全局应用于所有接口）。自
定义检测配置的一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，
接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 H.323 检测规则，或者有要添加 H.323 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 H.323 H.255 和 H.323 RAS。

步骤 4 如果需要非默认检测，请点击 Configure，并选择要使用默认映射还是配置的 H.323 检测策略映射。
可在此时创建映射。有关详细信息，请参阅第 10-5 页的配置 H.323 检测策略映射。

在 Select H.323 Inspect Map 对话框中点击 OK，以将映射分配到策略。

步骤 5 点击 OK 或 Finish 以保存服务策略规则。

配置 H.323 和 H.225 超时值

可以在 Configuration > Firewall > Advanced > Global Timeouts 页面上配置 H.323/H.255 全局超时
值。可以设置 H.255 信令连接关闭前的非活动时间间隔 （默认值为 1 小时）或 H.323 控制连接关闭
前的非活动时间间隔 （默认为 5 分钟）。

MGCP 检测
以下各节介绍 MGCP 应用检测。

• 第 10-8 页的 MGCP 检测概述

• 第 10-9 页的配置 MGCP 检测

• 第 10-10 页的配置 MGCP 超时值
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MGCP 检测概述

MGCP 是一个主/从协议，用于控制来自称为媒体网关控制器或呼叫代理的外部呼叫控制元件的媒
体网关。媒体网关通常是一个网络元素，用于在电话电路上传送的音频信号和互联网上或其他数据
包网络上传送的数据包之间提供转换。借助具有 MGCP 的 NAT 和 PAT，可以使用一组有限的外部
（全局）地址来支持内部网络中的大量设备。下面列举了一些媒体网关：

• 中继网关：用于在电话网络和 IP 语音网络之间建立连接。这种网关通常管理大量的数字电路。

• 家庭网关：提供用于连接到 IP 语音网络的传统模拟 (RJ11) 接口。电缆调制解调器/电缆机顶盒、
xDSL 设备、宽带无线设备都是家庭网关。

• 企业网关：提供用于连接到 IP 语音网络的传统数字 PBX 接口或集成 soft PBX 接口。

MGCP 消息通过 UDP 传输。响应发回到命令的源地址（IP 地址和 UDP 端口号），但是响应可能不
来自命令发送到的那个地址。如果在同一故障转移配置中使用多个呼叫代理，且接收命令的呼叫代
理已经将控制转交给备用呼叫代理，由备用呼叫代理来发送响应，可能会发生这种情况。下图说明
如何配合使用 NAT 与 MGCP。

图 10-1 配合使用 NAT 与 MGCP

MGCP 终端是数据的物理或虚拟源及目标。媒体网关包含终端，呼叫代理可以在这些终端上创建、
修改和删除连接，从而建立并控制与其他多媒体终端之间的媒体会话。此外，呼叫代理可以指示终
端检测特定事件和生成信号。终端会自动将服务状态变化情况告知呼叫代理。

• 网关通常会侦听 UDP 端口 2427 以接收来自呼叫代理的命令。

• 呼叫代理所在的端口接收来自网关的命令。呼叫代理通常会侦听 UDP 端口 2727 以接收来自网
关的命令。

注 MGCP 检测不支持对 MGCP 信令和 RTP 数据使用不同的 IP 地址。建议的常见做法是，从弹性 IP 地
址 （例如，环回或虚拟 IP 地址）发送 RTP 数据；但是， ASA 要求 RTP 数据来自与 MGCP 信令相
同的地址。
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配置 MGCP 检测

可按照以下过程启用 MGCP 检测。

操作步骤

步骤 1 第 10-9 页的为其他检测控制配置 MGCP 检测策略映射。

步骤 2 第 10-10 页的配置 MGCP 检测服务策略。

为其他检测控制配置 MGCP 检测策略映射

如果网络有 ASA 必须为其打开针孔的多个呼叫代理和网关，应创建 MGCP 映射。然后，可以在启
用 MGCP 检测时应用所创建的 MGCP 映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > MGCP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 （可选）点击 Command Queue 选项卡，并指定 MGCP 命令队列允许的最大命令数。默认值为 200，
允许的范围是 1 到 2147483647。

步骤 5 点击 Gateways and Call Agents 选项卡，并为映射配置网关组和呼叫代理组。

a. 点击 Add 创建新组，或者选择组并点击 Edit。

b. 在 Group ID 中输入呼叫代理组的组 ID。呼叫代理组将一个或多个呼叫代理与一个或多个 
MGCP 媒体网关关联。有效范围为 0 到 2147483647。

c. 要向组添加由关联的呼叫代理控制的媒体网关 IP 地址，请在 Gateway to Be Added 中输入这些
地址并点击 Add>>。可删除不再使用的任何网关。

媒体网关通常是一个网络元素，用于在电话电路上传送的音频信号和互联网上或其他数据包网
络上传送的数据包之间提供转换。通常，网关将命令发送到呼叫代理的默认 MGCP 端口 UDP 
2727。

d. 要添加控制 MGCP 媒体网关的呼叫代理的 IP 地址，请在 Call Agent to Be Added 中输入这些地
址并点击 Add>>。可删除不再需要的任何代理。

通常，呼叫代理将命令发送到网关的默认 MGCP 端口 UDP 2427。

e. 在 MGCP Group 对话框中点击 OK。根据需要重复上述步骤，添加其他组。

步骤 6 在 MGCP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 MGCP 检测服务策略中。
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配置 MGCP 检测服务策略

MGCP 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。但是，默认检测类
包括默认 MGCP 端口，因此，只需简单地编辑默认全局检测策略即可添加 MGCP 检测。或者，可
以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 MGCP 检测规则，或者有要添加 RTSP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 MGCP。

步骤 4 如果需要非默认检测，请点击 Configure，并选择要使用默认映射还是配置的 MGCP 检测策略映
射。可在此时创建映射。有关详细信息，请参阅第 10-9 页的为其他检测控制配置 MGCP 检测策略
映射。

在 Select MGCP Inspect Map 对话框中点击 OK，以将映射分配到策略。

步骤 5 点击 OK 或 Finish 以保存服务策略规则。

配置 MGCP 超时值

可以在 Configuration > Firewall > Advanced > Global Timeouts 页面上配置多个 MGCP 全局超时值。
可以设置 MGCP 媒体连接关闭前的非活动时间间隔（默认值为 5 分钟）。还可以设置 PAT 转换的超
时 （30 秒）。

RTSP 检测
以下各节介绍 RTSP 应用检测。

• 第 10-11 页的 RTSP 检测概述

• 第 10-11 页的 RealPlayer 配置要求

• 第 10-11 页的 RSTP 检测的局限性

• 第 10-12 页的配置 RTSP 检测
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RTSP 检测概述

RTSP 检测引擎使 ASA 可以传递 RTSP 数据包。 RealAudio、 RealNetworks、 Apple QuickTime 4、
RealPlayer 和思科 IP/TV 连接都使用 RTSP。

注 对于思科 IP/TV，请使用 RTSP TCP 端口 554 和 8554。

RTSP 应用使用已知 TCP 端口 554 （很少用 UDP）作为控制信道。 ASA 仅支持 TCP （这符合 RFC 
2326 的要求）。该 TCP 控制信道用于根据客户端配置的传输模式协商用于传输音频/视频流量的数
据信道。

支持如下 RDT 传输：rtp/avp、 rtp/avp/udp、 x-real-rdt、 x-real-rdt/udp 和 x-pn-tng/udp。

ASA 解析状态代码为 200 的 Setup 响应消息。如果响应消息为入站消息，服务器相对于 ASA 为外部
设备，则需要为来自服务器的入站连接打开动态信道。如果响应消息为出站消息，ASA 将无需打开
动态信道。

由于 RFC 2326 不要求客户端和服务器端口必须处于 SETUP 响应消息中，因此，ASA 会保持状态并
记住 SETUP 消息中的客户端端口。 QuickTime 将客户端端口置于 SETUP 消息中，这样，服务器仅
会使用服务器端口作出响应。

RTSP 检测不支持 PAT 或双 NAT。此外，ASA 无法识别 HTTP 掩蔽（即，RTSP 消息隐藏在 HTTP 
消息中）。

RealPlayer 配置要求

使用 RealPlayer 时，正确配置传输模式非常重要。对于 ASA，应从服务器向客户端添加 access-list 
命令；反之亦然。对于 RealPlayer，可点击 Options > Preferences > Transport > RTSP Settings 更改
传输模式。

如果 RealPlayer 使用 TCP 模式，请选择 Use TCP to Connect to Server 和 Attempt to use TCP for all 
content 复选框。在 ASA 中，无需配置检测引擎。

如果 RealPlayer 使用 UDP 模式，请选择 Use TCP to Connect to Server 和 Attempt to use UDP for 
static content 复选框，而且直播内容不可进行组播。在 ASA 中，应添加 inspect rtsp port 命令。

RSTP 检测的局限性

RSTP 检测有以下局限性。

• ASA 不支持通过 UDP 组播 RTSP 或 RTSP 消息。

• ASA 不能识别 HTTP 掩蔽 （即， RTSP 消息隐藏在 HTTP 消息中）。

• 由于嵌入式 IP 地址作为 HTTP 或 RTSP 消息的一部分包含在 SDP 文件中，因此， ASA 无法对 
RTSP 消息执行 NAT。数据包可以分片，但 ASA 无法对分片数据包执行 NAT。

• 对于思科 IP/TV， ASA 在消息的 SDP 部分上转换的数量与内容管理器中的节目列表数成正比
（每个节目列表可至少有六个嵌入式 IP 地址）。

• 可以为 Apple QuickTime 4 或 RealPlayer 配置 NAT。如果查看器和内容管理器位于外部网络，而
服务器位于内部网络，则思科 IP/TV 只能采用 NAT。
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配置 RTSP 检测

默认情况下， RTSP 检测已启用。仅在需要非默认处理的情况下，才需要配置这项检测。如果要自
定义 RTSP 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 10-12 页的配置 RTSP 检测类映射

步骤 2 第 10-13 页的配置 RTSP 检测策略映射

步骤 3 第 10-14 页的配置 RTSP 检测服务策略

配置 RTSP 检测类映射

可以选择创建 RTSP 检测类映射来定义 RTSP 检测的流量类。另一种方法是，直接在 RTSP 检测策略
映射中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法可
以创建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > RTSP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。

步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。
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b. 选择匹配条件并定义其值：

• URL Filter - 将 URL 与选定的正则表达式或正则表达式类进行匹配。

• Request Method - 匹配请求方法：announce、 describe、 get_parameter、 options、 pause、
play、 record、 redirect、 setup、 set_parameters、 teardown。

c. 点击 OK。

步骤 6 在 RTSP Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 RTSP 检测策略映射中。

配置 RTSP 检测策略映射

如果默认检测行为不能满足网络要求，可以创建 RTSP 检测策略映射来自定义 RTSP 检测操作。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > RTSP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 点击 Parameters 选项卡并配置所需的选项：

• Enforce Reserve Port Protection - 是否在媒体端口协商期间限制保留端口的使用。

• Maximum URL Length - 消息中允许的最大 URL 长度 （0 到 6000）。

步骤 5 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 RTSP 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两
种方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 RTSP 类映射；请参阅第 10-12 页的配置 RTSP 检测类映射）。
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c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，如下配置条件：

• URL Filter - 将 URL 与选定的正则表达式或正则表达式类进行匹配。

• Request Method - 匹配请求方法：announce、 describe、 get_parameter、 options、 pause、
play、 record、 redirect、 setup、 set_parameters、 teardown。

d. 选择要对匹配的流量执行的操作。对于 URL 匹配，可以断开连接或记录连接，而且可以对断开
的连接启用日志记录。对于请求方法匹配，可以对数据包数应用每秒速率限制。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 6 在 RTSP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 RTSP 检测服务策略中。

配置 RTSP 检测服务策略

默认 ASA 配置包括对默认端口的 RTSP 检测（这项检测全局应用于所有接口）。自定义检测配置的
一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 RTSP 检测规则，或者有要添加 RTSP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 RTSP。

步骤 4 如果需要非默认检测，请点击 Configure，并选择要使用默认映射还是配置的 RTSP 检测策略映射。
可在此时创建映射。有关详细信息，请参阅第 10-13 页的配置 RTSP 检测策略映射。

在 Select RTSP Inspect Map 对话框中点击 OK，以将映射分配到策略。

步骤 5 点击 OK 或 Finish 以保存服务策略规则。
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SIP 检测
SIP 是一种广泛用于网络会议、电话、展示、事件通知和即时消息的协议。由于 SIP 本质上是文本
协议，而且具有灵活性，因此， SIP 网络面临大量安全威胁。

SIP 应用检测会在消息报头和正文中提供地址转换，会动态打开端口，还会执行基本健全性检查。
它还支持应用安全和协议符合性 （此功能强制对 SIP 消息进行健全性检查，以及检测基于 SIP 的
攻击）。

默认情况下， SIP 检测已启用。只有需要非默认处理时，或者要标识 TLS 代理来启用加密流量检测
时，才需要配置这项检测。以下主题详细说明 SIP 检测。

• 第 10-15 页的 SIP 检测概述

• 第 10-15 页的 SIP 检测的局限性

• 第 10-16 页的 SIP 即时消息

• 第 10-17 页的默认 SIP 检测

• 第 10-17 页的配置 SIP 检测

• 第 10-21 页的配置 SIP 超时值

SIP 检测概述

如 IETF 所定义，SIP 能够实现呼叫处理会话，特别是双方音频会议（又称为“通话”）。SIP 可与 
SDP 配合使用来实现呼叫信令。 SDP 指定用于媒体流的端口。借助 SIP， ASA 可以支持任何 SIP 
VoIP 网关和 VoIP 代理服务器。 SIP 和 SDP 在以下 RFC 中定义：

• SIP：会话初始协议， RFC 3261

• SDP：会话描述协议， RFC 2327

要支持通过 ASA 的 SIP 呼叫，必须检测媒体连接地址的信令消息、媒体端口和媒体的初期连接，因
为发送信令到已知目标端口 (UDP/TCP 5060) 的同时，也会动态分配媒体流。此外， SIP 还会在 IP 
数据包的用户数据部分嵌入 IP 地址。请注意， ASA 支持的 SIP 请求 URI 的最大长度为 255。

SIP 检测的局限性

SIP 检测适用于嵌入式 IP 地址的 NAT。但是，如果配置 NAT 来转换源地址和目标地址，将不会重
写外部地址（“trying”响应消息的 SIP 报头中的 “from”）。因此，在处理 SIP 流量时应使用对象 
NAT，从而避免转换目标地址。

对 SIP 使用 PAT 时，有以下限制：

• 如果远程终端尝试注册到受 ASA 保护的网络中的 SIP 代理，在某些非常特定的情况下，注册会
失败，如下所示：

– 对远程终端配置了 PAT。

– SIP 注册服务器位于外部网络。

– 终端发送到代理服务器的 REGISTER 消息中的联系人字段缺少端口。
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• 如果 SIP 设备传输的数据包中 SDP 部分在所有者/创建者字段 (o=) 中有一个 IP 地址，且该 IP 地
址不同于在连接字段 (c=) 中的 IP 地址，则在 o= 字段中的 IP 地址可能无法正确转换。这是 SIP 
协议的如下局限性造成的：不在 o= 字段中提供端口值。

• 使用 PAT 时，任何包含无端口的内部 IP 地址的 SIP 报头字段可能不会转换，因此，内部 IP 地
址将向外泄漏。如果要避免这种泄漏，请配置 NAT 来代替 PAT。

SIP 即时消息

即时消息 (IM) 是指消息在用户之间以近实时的方式传输。SIP 仅支持 Windows XP 上使用 Windows 
Messenger RTC Client v4.7.0105 的聊天功能。MESSAGE/INFO 方法和 202 Accept 响应用于支持 IM，
如以下 RFC 所定义：

• 会话初始协议 (SIP) - 特定事件通知， RFC 3265

• 会话初始协议 (SIP) 即时消息扩展， RFC 3428

MESSAGE/INFO 请求可以在注册/订用后随时进入。例如，两个用户可以随时在线，但几个小时都
不聊天。因此， SIP 检测引擎会根据配置的 SIP 超时值打开超时的针孔。该值必须配置为比订用持
续时间至少长 5 分钟。订用持续时间在 Contact Expires 值中定义，通常是 30 分钟。

由于 MESSAGE/INFO 请求通常使用动态分配的端口（而不是端口 5060）发送，因此，这些请求必
须通过 SIP 检测引擎。

注 仅支持聊天功能。不支持白板、文件传输和应用共享。不支持 RTC Client 5.0。

SIP 检测转换基于文本的 SIP 消息，重新计算消息的 SDP 部分的内容长度，并重新计算数据包长度
和校验和。对于在 SIP 消息的 SDP 部分中被指定为终端应对其进行侦听的地址/端口，该检测会动
态打开这些端口的媒体连接。

SIP 检测带有一个数据库，该数据库的索引 CALL_ID/FROM/TO 来自 SIP 负载。这些索引标识呼
叫、源和目标。该数据库包含在 SDP 媒体信息字段中发现的媒体地址和媒体端口以及媒体类型。
一个会话可以有多个媒体地址和端口。 ASA 会打开使用这些媒体地址/端口的两个终端之间的 
RTP/RTCP 连接。

初始呼叫建立 (INVITE) 消息必须使用已知端口 5060；但是，后续消息可能没有此端口号。SIP 检测
引擎会打开信令连接针孔，并将这些连接标记为 SIP 连接。会对要到达 SIP 应用并进行转换的消息
执行此操作。

呼叫建立后， SIP 会话将处于 “临时”状态，直至在响应消息中收到来自被叫终端的媒体地址和媒
体端口（该消息指明被叫终端侦听的 RTP 端口）。如果未能在一分钟内收到响应消息，将会断开信
令连接。

完成最终握手后，呼叫将变为活动状态，信令连接将保持，直至收到 BYE 消息。

如果内部终端向外部终端发起呼叫，将会对外部接口打开媒体孔，以允许 RTP/RTCP UDP 数据包流
向来自内部终端的 INVITE 消息中指定的内部终端媒体地址和媒体端口。流向内部接口的主动提供
的 RTP/RTCP UDP 数据包不会流经 ASA，除非 ASA 配置特别允许。
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默认 SIP 检测

默认情况下， SIP 检测已通过默认检测映射启用，具体以下：

• SIP 即时消息 (IM) 扩展：已启用。

• SIP 端口的非 SIP 流量：允许。

• 隐藏服务器和终端的 IP 地址：已禁用。

• 掩蔽软件版本和非 SIP URI：已禁用。

• 确保到目标的跳数大于 0：已启用。

• RTP 符合性：未执行。

• SIP 符合性：请勿执行状态检查和报头验证。

另请注意，加密流量检测未启用。要检测加密流量，必须配置 TLS 代理。

配置 SIP 检测

SIP 应用检测会在消息报头和正文中提供地址转换，会动态打开端口，还会执行基本健全性检查。
它还支持应用安全和协议符合性 （此功能强制对 SIP 消息进行健全性检查，以及检测基于 SIP 的
攻击）。

默认情况下， SIP 检测已启用。只有需要非默认处理时，或者要标识 TLS 代理来启用加密流量检测
时，才需要配置这项检测。如果要自定义 SIP 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 10-17 页的配置 SIP 检测类映射

步骤 2 第 10-18 页的配置 SIP 检测策略映射

步骤 3 第 10-20 页的配置 SIP 检测服务策略

配置 SIP 检测类映射

可以选择创建 SIP 检测类映射来定义 SIP 检测的流量类。另一种方法是，直接在 SIP 检测策略映射
中定义流量类。创建类映射与直接在检测映射中定义流量匹配之间的差别在于，前一种做法可以创
建更复杂的匹配条件，并且可以重复使用类映射。

提示 除了以下所述的操作步骤外，还可以在创建检测映射或服务策略时配置类映射。无论如何创建，映
射的内容都相同。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。
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操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > SIP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新的类映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 选择匹配选项：Match All 或 Match Any。

Match All 是默认选项，指明流量必须与所有条件匹配才算是与类映射匹配。 Match Any 表示流量
只要与至少一个条件匹配，即为与类映射匹配。

步骤 5 可通过在匹配表中添加或编辑条目来配置匹配条件。可以任意添加所需的条目来定义目标流量。

a. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映射排除任何包含
“example.com”的流量。

b. 选择匹配条件并定义其值：

• Called Party - 将 To 报头中指定的被叫方与选定的正则表达式或正则表达式类进行匹配。

• Calling Party - 将 From 报头中指定的主叫方与选定的正则表达式或正则表达式类进行匹配。

• Content Length - 匹配长度大于指定长度 （0 到 65536 字节）的 SIP 内容报头。

• Content Type - 匹配 Content Type 报头 （SDP 类型或者与选定的正则表达式或正则表达式类
相匹配的类型）。

• IM Subscriber - 将 SIP IM 用户与选定的正则表达式或正则表达式类进行匹配。

• Message Path - 将 SIP Via 报头与选定的正则表达式或正则表达式类进行匹配。

• Request Method - 匹配 SIP 请求方法：ack、 bye、 cancel、 info、 invite、 message、 notify、
options、 prack、 refer、 register、 subscribe、 unknown、 update。

• Third-Party Registration - 将第三方注册的请求方与选定的正则表达式或正则表达式类进行
匹配。

• URI Length - 匹配长度大于指定长度 （0 到 65536 字节）的选定类型 （SIP 或 TEL）的 SIP 
报头 URI。

c. 点击 OK。

步骤 6 在 SIP Traffic Class Map 对话框中点击 OK。

这样即可将类映射用于 SIP 检测策略映射中。

配置 SIP 检测策略映射

如果默认检测行为不能满足网络要求，可以创建 SIP 检测策略映射来自定义 SIP 检测操作。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。
10-18
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 10 章      语音和视频协议的检测

  SIP 检测
准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > SIP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 SIP Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级别为 Low。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 SIP 检测。

步骤 5 如果需要进一步自定义设置，请点击 Details 并执行以下操作：

a. 点击 Filtering 选项卡，选择是要启用 SIP 即时消息 (IM) 扩展还是允许 SIP 端口上出现非 SIP 
流量。

b. 点击 IP Address Privacy 选项卡，并选择是否隐藏服务器和终端的 IP 地址。

c. 点击 Hop Count 选项卡，并选择是否确保到目标的跳数大于 0。这样将会检查 Max-Forwards 报
头值 （在到达目标之前，此值不能为 0）。必须选择要对不符合要求的流量执行的操作 （丢弃
数据包、断开连接、重置连接或记录连接）以及是否启用或禁用日志记录。

d. 点击 RTP Conformance 选项卡，并选择是否检查流经针孔的 RTP 数据包的协议符合性。如果
检查符合性，还可以选择是否根据信令交换限制音频或视频的负载。

e. 点击 SIP Conformance 选项卡，并选择是否启用状态转换检查和报头字段严格验证。对于所选
的每个选项，应选择要对不符合要求的流量执行的操作 （丢弃数据包、断开连接、重置连接或
记录连接）以及是否启用或禁用日志记录。

f. 点击 Field Masking 选项卡，并选择是否检测 Alert-Info 和 Call-Info 报头中的非 SIP URI 以及是
否检测 User-Agent 和 Server 报头中的服务器和终端的软件版本。对于所选的每个选项，应选择
要执行的操作 （掩蔽或记录）以及是否启用或禁用日志记录。

步骤 6 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

可以根据 SIP 类映射定义流量匹配条件，或者直接在检测映射中配置匹配，还可以同时使用这两种
方法。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择 Single Match 直接定义条件，或者选择 Multiple Match （如果选择后一个选项，需要选择
定义条件的 SIP 类映射；请参阅第 10-17 页的配置 SIP 检测类映射）。

c. 如果在这里定义条件，请选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match
（流量不得与条件匹配）。例如，如果对字符串 “example.com”选择了 No Match，将会从类映
射排除任何包含 “example.com”的流量。然后，如下配置条件：

• Called Party - 将 To 报头中指定的被叫方与选定的正则表达式或正则表达式类进行匹配。

• Calling Party - 将 From 报头中指定的主叫方与选定的正则表达式或正则表达式类进行匹配。
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• Content Length - 匹配长度大于指定长度 （0 到 65536 字节）的 SIP 内容报头。

• Content Type - 匹配 Content Type 报头 （SDP 类型或者与选定的正则表达式或正则表达式类
相匹配的类型）。

• IM Subscriber - 将 SIP IM 用户与选定的正则表达式或正则表达式类进行匹配。

• Message Path - 将 SIP Via 报头与选定的正则表达式或正则表达式类进行匹配。

• Request Method - 匹配 SIP 请求方法：ack、 bye、 cancel、 info、 invite、 message、 notify、
options、 prack、 refer、 register、 subscribe、 unknown、 update。

• Third-Party Registration - 将第三方注册的请求方与选定的正则表达式或正则表达式类进行
匹配。

• URI Length - 匹配长度大于指定长度 （0 到 65536 字节）的选定类型 （SIP 或 TEL）的 SIP 
报头 URI。

d. 选择要对匹配的流量执行的操作 （丢弃数据包、断开连接、重置连接或记录连接）以及是否启
用或禁用日志记录。对于匹配 “invite”和 “register”的请求方法，还可以对数据包数应用每
秒速率限制。

e. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 7 在 SIP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 SIP 检测服务策略中。

配置 SIP 检测服务策略

默认 ASA 配置包括对默认端口的 SIP 检测（这项检测全局应用于所有接口）。自定义检测配置的一
种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 SIP 检测规则，或者有要添加 SIP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 SIP。

步骤 4 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 SIP 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 10-18 页的配置 SIP 检测策略映射。

b. 如果要检测加密 SIP 流量，请选择 Enable encrypted traffic inspection 并选择 TLS 代理 （如有
必要，点击 Manage 创建 TLS 代理）。

虽然可以选择电话代理或 UC-IME 代理并将 TLS 代理与这些代理关联起来，但我们不再建议采
用这一配置。一次只能有一个 TLS 代理分配给电话代理或 UC-IME 代理。如果为电话代理或 
UC-IME 代理检测配置多于一个服务策略规则并尝试给它们分配另一个 TLS 代理，ASDM 将会
显示警告，指出用于电话代理或 UC-IME 代理检测的所有其他服务策略规则将会改为使用最新
选择的 TLS 代理。
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UC-IME 代理配置要求有两个 TLS 代理 - 分别用于出站流量和入站流量。TLS 代理通过 SIP 检测
规则与 UC-IME 代理间接关联，而不是直接与 TLS 代理关联 （电话代理属于后一种情况）。

c. 在 Select SIP Inspect Map 对话框中点击 OK。

步骤 5 点击 OK 或 Finish 以保存服务策略规则。

配置 SIP 超时值

连接变为空闲状态后两分钟内，媒体连接将会断开。但是，此超时是可配置的，可以设置为更短或
更长时间。

可以在 Configuration > Firewall > Advanced > Global Timeouts 页面上配置多个 SIP 全局超时值。

瘦客户端 (SCCP) 检测
以下各节介绍 SCCP 应用检测。

• 第 10-21 页的 SCCP 检测概述

• 第 10-22 页的支持思科 IP 电话

• 第 10-22 页的 SCCP 检测的局限性

• 第 10-22 页的默认 SCCP 检测

• 第 10-23 页的配置 SCCP （瘦客户端）检测

SCCP 检测概述

瘦客户端 (SCCP) 是用于 VoIP 网络的简化协议。使用 SCCP 的思科 IP 电话可共存于 H.323 环境中。
与 Cisco CallManager 一起使用时， SCCP 客户端可以与兼容 H.323 的终端进行互操作。

ASA 支持对 SCCP 执行 PAT 和 NAT。如果要使用的 IP 电话多于 IP 电话可使用的全局 IP 地址，必
须进行 PAT。通过支持对 SCCP 信令数据包执行 NAT 和 PAT，瘦客户端应用检测确保所有 SCCP 信
令和媒体数据包都可流经 ASA。

Cisco CallManager 与思科 IP 电话之间的正常流量使用 SCCP，这些流量由 SCCP 检测处理，无需任
何特殊配置。 ASA 还支持 DHCP 选项 150 和 66；它通过向思科 IP 电话及其他 DHCP 客户端发送 
TFTP 服务器的位置来实现这种支持。思科 IP 电话可能在请求中还包含 DHCP 选项 3 （该选项用于
设置默认路由）。

注 ASA 支持检测来自运行 SCCP 协议 v22 及更低版本的思科 IP 电话的流量。
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支持思科 IP 电话

在 Cisco CallManager 位于安全性高于 Cisco IP SoftPhone 的接口的拓扑中，如果 Cisco CallManager IP 
地址需要进行 NAT，则映射必须是静态的，因为思科 IP 电话要求在其配置中明确指定 Cisco 
CallManager IP 地址。静态标识条目使位于安全性较高的接口的 Cisco CallManager 可以接受来自思
科 IP 电话的注册。

思科 IP 电话需要访问 TFTP 服务器，以下载它们连接到 Cisco CallManager 服务器所需要的配置信息。

如果思科 IP 电话位于安全性高于 TFTP 服务器的接口，必须使用 ACL 来连接到受保护的 TFTP 服务
器 UDP 端口 69。虽然需要对 TFTP 服务器使用静态条目，但该静态条目不一定必须是静态标识条
目。如果使用 NAT，静态标识条目将映射到相同的 IP 地址。如果使用 PAT，静态标识条目将映射
到相同的 IP 地址和端口。

如果思科 IP 电话位于安全性高于 TFTP 服务器和 Cisco CallManager 的接口，思科 IP 电话无需 ACL 
或静态条目即可发起连接。

SCCP 检测的局限性

如果将内部 Cisco CallManager 的地址配置为要通过 NAT 或 PAT 方式转换到另一个 IP 地址或端口，
外部思科 IP 电话的注册将会失败，因为 ASA 目前不支持对通过 TFTP 传输的文件内容进行 NAT 或 
PAT。尽管 ASA 支持对 TFTP 消息进行 NAT 并会打开用于 TFTP 文件的针孔，但 ASA 无法转换嵌
入到在电话注册期间通过 TFTP 传输的思科 IP 电话配置文件中的 Cisco CallManager IP 地址和端口。

注 ASA 支持 SCCP 呼叫的状态故障转移，但处于建立过程中的呼叫除外。

默认 SCCP 检测

默认情况下， SCCP 检测已启用，默认设置如下：

• 注册：未执行。

• 最大消息 ID：0x181。

• 最小前缀长度：4。

• 媒体超时：00:05:00。

• 信令超时：01:00:00。

• RTP 符合性：未执行。

另请注意，加密流量检测未启用。要检测加密流量，必须配置 TLS 代理。
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配置 SCCP （瘦客户端）检测

SCCP （瘦客户端）应用检测对数据包数据中的嵌入式 IP 地址和端口号执行转换，并会动态打开针
孔。它还执行其他协议符合性检查和基本状态跟踪。

默认情况下， SCCP 检测已启用。只有需要非默认处理时，或者要标识 TLS 代理来启用加密流量检
测时，才需要配置这项检测。如果要自定义 SCCP 检测，请按照以下流程进行操作。

操作步骤

步骤 1 第 10-23 页的为其他检测控制配置瘦客户端 (SCCP) 检测策略映射。

步骤 2 第 10-24 页的配置 SCCP 检测服务策略。

为其他检测控制配置瘦客户端 (SCCP) 检测策略映射

要指定消息违反参数时要执行的操作，请创建 SCCP 检测策略映射。然后，可以在启用 SCCP 检测
时应用所创建的检测策略映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > SCCP (Skinny)。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 SCCP (Skinny) Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。默认级
别为 Low。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 SCCP 检测。

步骤 5 如果需要进一步自定义设置，请点击 Details 并执行以下操作：

a. 点击 Parameters 选项卡，根据需要选择以下选择：

• Enforce endpoint registration - 瘦终端是否必须注册后才能发出或接收呼叫。

• Maximum Message ID - 允许的最大 SCCP 站消息 ID。默认最大值是 0x181。十六进制数字
可以是 0x0 到 0xffff。

• SCCP Prefix Length - 最大和最小 SCCP 前缀长度。默认最小值是 4；没有默认最大值。

• Timeouts - 是否设置媒体和信令连接超时以及这些超时的值。默认的媒体超时是 5 分钟，默
认的信令超时是 1 小时。

b. 点击 RTP Conformance 选项卡，并选择是否检查流经针孔的 RTP 数据包的协议符合性。如果
检查符合性，还可以选择是否根据信令交换限制音频或视频的负载。
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步骤 6 （可选）点击 Message ID Filtering 选项卡，以根据 SCCP 消息的站消息 ID 字段标识要丢弃的流量。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。

b. 选择条件的匹配类型：Match（流量必须与条件匹配）或者 No Match（流量不得与条件匹配）。

c. 在 Value 字段中，根据十六进制的站消息 ID 值 （0x0 到 0xffff）标识流量。可以输入单个消息 
ID 的值，或者输入 ID 范围的开始值和结束值。

d. 选择是否启用或禁用日志记录。操作始终是丢弃数据包。

e. 点击 OK 添加过滤器。根据需要重复上述步骤。

步骤 7 在 SCCP (Skinny) Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 SCCP 检测服务策略中。

配置 SCCP 检测服务策略

默认 ASA 配置包括对默认端口的 SCCP 检测（这项检测全局应用于所有接口）。自定义检测配置的
一种常用方法是自定义默认全局策略。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 SCCP 检测规则，或者有要添加 SCCP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 选择 SCCP (Skinny)。

步骤 4 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 SCCP 检测策略映射。可在此时创建映射。有关详细信息，请
参阅第 10-23 页的为其他检测控制配置瘦客户端 (SCCP) 检测策略映射。

b. 如果要检测加密 SCCP 流量，请选择 Enable encrypted traffic inspection 并选择 TLS 代理 （如
有必要，点击 Manage 创建 TLS 代理）。

虽然也可以使用在 ASA 中配置的电话代理来检测瘦客户端应用流量，但我们不再建议采用这一
配置。

c. 在 Select SCCP Inspect Map 对话框中点击 OK。

步骤 5 点击 OK 或 Finish 以保存服务策略规则。
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语音和视频协议检测的历史记录

功能名称 版本 功能信息

适用于 IPv6 的 SIP、 SCCP 和 TLS 代理支持 9.3(1) 现在，使用 SIP、SCCP 和 TLS 代理时，可以检测 IPv6 流
量 （使用 SIP 或 SCCP）。

我们未修改任何 ASDM 屏幕。
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11第 章
数据库和目录协议的检测

以下主题说明数据库和目录协议的应用检测。有关为什么需要对某些协议进行检测以及应用检测的
总体方法的信息，请参阅第 8-1 页的应用层协议检测入门。

• 第 11-1 页的 ILS 检测

• 第 11-2 页的 SQL*Net 检测

• 第 11-3 页的 Sun RPC 检测

ILS 检测
ILS 检测引擎可为 Microsoft NetMeeting、 SiteServer 以及使用 LDAP 与 ILS 服务器交换目录信息的 
Active Directory 产品提供 NAT 支持。

ASA 支持对 ILS 使用 NAT，其用于在 ILS 或 SiteServer Directory 中注册和查找端点。因为 LDAP 数
据库仅存储 IP 地址，所以，无法支持 PAT。

对于搜索响应，当 LDAP 服务器位于外部时，应考虑 NAT，以允许内部对等设备在注册到外部 
LDAP 服务器时进行本地通信。对于此类搜索响应，会先搜索 xlate，然后搜索 DNAT 条目以获得正
确地址。如果上述两种搜索都失败，则地址未更改。对于使用 NAT 0 （无 NAT）且不期望 DNAT 
交互的站点，建议关闭检测引擎以提供更佳性能。

当 ILS 服务器位于 ASA 边界内部时，可能需要进行其他配置。这需要一个孔，可供外部客户端访
问指定端口 （通常是 TCP 389）上的 LDAP 服务器。

注 由于 ILS 流量（H225 呼叫信号）仅出现在辅助 UDP 信道上，因此，过了 TCP 非活动间隔后，TCP 
连接将断开。默认情况下，此间隔为 60 分钟，且可使用 TCP timeout 命令进行调整。在 ASDM 中，
可在 Configuration > Firewall > Advanced > Global Timeouts 窗格上完成此操作。

ILS/LDAP 遵循客户端/服务器模型，通过单一 TCP 连接处理会话。根据客户端的操作，将可能创建
多个上述会话。

在连接协商期间， BIND PDU 从客户端发送至服务器。一旦收到来自服务器的成功 BIND 
RESPONSE，就可能交换其他操作消息（例如 ADD、 DEL、 SEARCH 或 MODIFY），以对 ILS 目
录执行多项操作。ADD REQUEST 和 SEARCH RESPONSE PDU 可能包含 NetMeeting 对等设备的 IP 
地址，供 H.323 （SETUP 和 CONNECT 消息）用于建立 NetMeeting 会话。 Microsoft NetMeeting 
v2.X 和 v3.X 提供 ILS 支持。
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ILS 检测将执行以下操作：

• 使用 BER 解码功能解码 REQUEST/RESPONSE PDU。

• 解析 LDAP 数据包。

• 提取 IP 地址。

• 根据需要转换 IP 地址。

• 使用 BER 编码功能，用已转换地址对 PDU 进行编码。

• 将新编码的 PDU 复制回 TCP 数据包。

• 执行递增 TCP 校验和与序列号调整。

ILS 检测存在如下限制：

• 推荐请求和响应不受支持。

• 多个目录中的用户不统一。

• NAT 无法识别在多个目录中有多个标识的单一用户。

有关启用 ILS 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

SQL*Net 检测
系统已默认启用 SQL*Net 检测。

SQL*Net 协议包括不同类型的数据包， ASA 将处理这些数据包，以使数据流对 ASA 任一侧的 
Oracle 应用显示为一致。

SQL*Net 的默认端口赋值为 1521。这是 Oracle 用于 SQL*Net 的值，但是，该值与结构化查询语言 
(SQL) 的 IANA 端口赋值不符。

注 当与 SQL 控制 TCP 端口 1521 相同的端口上发生 SQL 数据传输时，请禁用 SQL*Net 检测。安全设
备在启用 SQL*Net 检测之后充当代理，且将客户端窗口大小从 65000 缩小至大约 16000，从而导致
数据传输问题。

ASA 将转换所有地址，并在数据包中查找要为 SQL*Net 第 1 版打开的所有嵌入式端口。

对于 SQL*Net 第 2 版，将修复紧跟 REDIRECT 数据包且数据长度为零的所有 DATA 或 REDIRECT 
数据包。

需要修复的数据包包含以下格式的嵌入式主机/端口地址：

(ADDRESS=(PROTOCOL=tcp)(DEV=6)(HOST=a.b.c.d)(PORT=a))

将不在 SQL*Net 第 2 版 TNSFrame 类型 （连接、接受、拒绝、重新发送和标记）中扫描 NAT 地
址，检测也将不为数据包中的任何嵌入式端口打开动态连接。

如果负载前面是数据长度为零的 REDIRECT TNSFrame 类型，则将在 SQL*Net 第 2 版 TNSFrames、
Redirect 和 Data 数据包中扫描要打开的端口和 NAT 地址。当数据长度为零的 Redirect 消息通过 ASA 
时，将会在连接数据结构中设置标志，以期转换后续的 Data 或 Redirect 消息并动态打开端口。如果
上一个段落中的其中一个 TNS 帧在 Redirect 消息后到达，则将重置该标志。

SQL*Net 检测引擎将使用新旧消息的长度差异，重新计算校验和，更改 IP、TCP 长度，并重新调整
序列号和确认号。
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针对所有其他情况对 SQL*Net 第 1 进行假设。将在 TNSFrame 类型 （连接、接受、拒绝、重新发
送、标记、重定向和数据）和所有数据包中扫描端口和地址。系统将转换地址并打开端口连接。

有关启用 SQL*Net 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

Sun RPC 检测
本节介绍 Sun RPC 应用检测。

• 第 11-3 页的 Sun RPC 检测概述

• 第 11-3 页的确定允许的 Sun RPC 服务

Sun RPC 检测概述

Sun RPC 检测引擎为 Sun RPC 协议启用或禁用应用检测。Sun RPC 可供 NFS 和 NIS 使用。Sun RPC 
服务可在任何端口上运行。当客户端尝试访问服务器上的 Sun RPC 服务时，必须获悉服务运行所在
的端口。它通过查询端口映射程序进程执行此操作，通常为 rpcbind，位于公认端口 111。

客户端将发送服务的 Sun RPC 程序号，而端口映射程序进程将用服务的端口号进行响应。客户端发
送其 Sun RPC 查询至服务器，指定端口映射程序进程识别的端口。服务器回复后，ASA 会截取此数
据包，并打开该端口上的初始化 TCP 和 UDP 连接。

提示 系统将默认启用 Sun RPC 检测。您只需管理 Sun RPC 服务器表，即可确定允许穿越防火墙的服务。
有关启用 Sun RPC 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

以下限制适用于 SUN RPC 检测：

• 不支持 Sun RPC 负载信息的 NAT 或 PAT。

• Sun RPC 检测仅支持入站 ACL。由于检测引擎使用动态 ACL 而不是辅助连接，因此，Sun RPC 
检测不支持出站 ACL。由于始终在入口方向而不是出口方向添加动态 ACL；因此，此检测引擎
不支持出站 ACL。要查看为 ASA 配置的动态 ACL，请使用 show asp table classify domain 
permit 命令。

确定允许的 Sun RPC 服务

您需要确定要允许其通过防火墙的 Sun RPC 服务器和服务。 SUN RPC 检测在评估流量时会使用
此表。

操作步骤

步骤 1 选择 Configuration > Firewall > Advanced > SUNRPC Server。

步骤 2 执行以下操作之一：

• 点击 Add 以添加新服务器。

• 选择服务器，然后点击 Edit。
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步骤 3 配置服务属性：

• Interface Name - 流量流向服务器所流经的接口。

• IP Address/Mask - Sun RPC 服务器的地址。

• Service ID - 服务器上的服务类型。要确定服务类型（例如，100003），请在 Sun RPC 服务器计
算机上的 UNIX 或 Linux 命令行处使用 sunrpcinfo 命令。

• Protocol - 服务使用 TCP 还是 UDP。

• Port/Port Range - 服务使用的端口或端口范围。

• Timeout - 连接的空闲超时。

步骤 4 点击 OK。
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12第 章
管理应用协议检测

以下主题介绍管理应用协议的应用检测。有关为什么需要对某些协议进行检测以及应用检测的总体
方法的信息，请参阅第 8-1 页的应用层协议检测入门。

ASA 默认启用几个常见检测引擎，但可能需要根据网络启用其他检测引擎。

• 第 12-1 页的 DCERPC 检测

• 第 12-3 页的 GTP 检测

• 第 12-8 页的 RADIUS 计费检测

• 第 12-10 页的 RSH 检测

• 第 12-10 页的 SNMP 检测

• 第 12-11 页的 XDMCP 检测

DCERPC 检测
以下各节介绍 DCERPC 检测引擎。

• 第 12-1 页的 DCERPC 概述

• 第 12-2 页的配置 DCERPC 检测

DCERPC 概述

DCERPC 是由 Microsoft 分布式客户端和服务器应用广泛使用的、允许软件客户端在服务器远程执
行程序的协议。

这通常涉及查询称为终端映射器的服务器 （用于侦听已知端口号，以获取所需服务的动态分配网
络信息）的客户端。然后，客户端建立与提供服务的服务器实例之间的辅助连接。安全设备允许相
应的端口号以及网络地址，如有必要，还会为辅助连接应用 NAT。

DCERPC 检测映射检测已知 TCP 端口 135 上 EPM 与客户端之间的本地 TCP 通信。支持客户端的 
EPM 映射和查找操作。客户端和服务器可位于任何安全区域。从适用的 EPM 响应消息接收嵌入式
服务器 IP 地址和端口号。由于客户端可能尝试多次连接到 EPM 返回的服务器端口，因此，允许使
用可配置超时的多个针孔。

注 DCERPC 检测仅支持 EPM 与客户端之间的通信通过 ASA 打开针孔。如果客户端进行不使用 EPM 
的 RPC 通信，则不支持 DCERPC 检测。
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配置 DCERPC 检测

默认情况下， DCERPC 检测未启用。如果需要 DCERPC 检测，必须对其进行配置。

操作步骤

步骤 1 第 12-2 页的配置 DCERPC 检测策略映射。

步骤 2 第 12-3 页的配置 DCERPC 检测服务策略。

配置 DCERPC 检测策略映射

要指定其他 DCERPC 检测参数，请创建 DCERPC 检测策略映射。然后，可以在启用 DCERPC 检测
时应用所创建的检测策略映射。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > DCERPC。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。可以直接更改安全级别，或者点击 Customize 编辑映射。此操作过程
的剩余步骤假设要自定义或添加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 在 DCERPC Inspect Map 对话框的 Security Level 视图中，选择最符合所需配置的级别。

如果有预设级别符合您的要求，执行到这一步即可。只需点击 OK，跳过此操作过程的剩余步骤，
并将映射用于服务策略规则中以执行 DCERPC 检测。

如果需要进一步自定义设置，请点击 Details 并继续执行操作步骤。

步骤 5 配置所需选项。

• Pinhole Timeout - 设置针孔超时。由于客户端可将终端映射器返回的服务器信息用于多个连
接，因此，超时值可根据客户端应用环境进行配置。超时范围是 0:0:1 到 1193:0:0。

• Enforce endpoint-mapper service - 是否在捆绑期间执行终端映射器服务，从而仅处理其服务流
量。

• Enable endpoint-mapper service lookup - 是否启用终端映射器服务的查找操作。还可以执行服
务查找的超时。如果未配置超时，将会使用针孔超时。

步骤 6 点击 OK。

这样即可将检测映射用于 DCERPC 检测服务策略中。
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配置 DCERPC 检测服务策略

DCERPC 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。可以简单地编辑
默认全局检测策略来添加 DCERPC 检测。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 DCERPC 检测规则，或者有要添加 DCERPC 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 
DCERPC 检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中 DCERPC 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 DCERPC。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 DCERPC 检测策略映射。可在此时创建映射。有关详细信息，
请参阅第 12-2 页的配置 DCERPC 检测策略映射。

b. 在 Select DCERPC Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。

GTP 检测
以下各节介绍 GTP 检测引擎。

注 GTP 检测需要特殊许可证。

• 第 12-4 页的 GTP 检测概述

• 第 12-5 页的 GTP 检测的默认设置

• 第 12-5 页的配置 GTP 检测
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GTP 检测概述

GPRS 为移动用户提供 GSM 网络与公司网络或互联网之间的不间断连接。GGSN 是 GPRS 无线数据
网络与其他网络之间的接口。 SGSN 执行移动管理、数据会话管理和数据压缩。

图 12-1 GPRS 隧道协议

UMTS 是固定线路电话、移动电话、互联网和计算机技术的商业融合。 UTRAN 是在系统中实施无
线网络所使用的网络协议。 GTP 使多协议数据包可通过 GGSN、 SGSN 和 UTRAN 之间的 
UMTS/GPRS 主干进行隧道传输。

GTP 不包含用户数据的任何固有安全或加密，但是，使用具有 ASA 的 GTP 有助于保护网络免受这
些风险。

SGSN 逻辑上连接到使用 GTP 的 GGSN。 GTP 允许多协议数据包通过 GSN 之间的 GPRS 主干进行
隧道传输。 GTP 提供隧道控制和管理协议，使 SGSN 可通过创建、修改和删除隧道为移动站提供 
GPRS 网络访问。 GTP 使用隧道机制提供用户数据包传输服务。

注 使用具有故障转移的 GTP 时，如果 GTP 连接已建立，而主用设备在数据通过隧道传输之前发生故
障，则 GTP 数据连接 （设置了 “j”标志）不会复制到备用设备。这是因为主用设备不会将半开连
接复制到备用设备。
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GTP 检测的默认设置

默认情况下， GTP 检测未启用。但是，如果在未指定检测映射的情况下启用 GTP 检测，将会使用
默认映射 （默认映射提供以下处理）。仅在需要不同值的情况下，才需要配置映射。

• 不允许错误。

• 最大请求数为 200。

• 最大隧道数为 500。

• GSN 超时为 30 分钟。

• PDP 情景超时为 30 分钟。

• 请求超时为 1 分钟。

• 信令超时为 30 分钟。

• 隧道超时为 1 小时。

• T3 响应超时为 20 秒。

• 未知消息 ID 已被丢弃并作了记录。

配置 GTP 检测

默认情况下， GTP 检测未启用。如果需要 GTP 检测，必须对其进行配置。

操作步骤

步骤 1 第 12-5 页的配置 GTP 检测策略映射。

步骤 2 第 12-7 页的配置 GTP 检测服务策略。

步骤 3 （可选）配置 RADIUS 计费检测，以防止过度计费攻击。请参阅第 12-8 页的 RADIUS 计费检测。

配置 GTP 检测策略映射

如果要对 GTP 流量执行其他参数，而默认映射不能满足需求，则可以创建并配置 GTP 映射。

准备工作

某些流量匹配选项使用正则表达式实现匹配。如果要使用这些方法之一，应首先创建正则表达式或
正则表达式类映射。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > GTP。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射以查看其内容。点击 Customize 编辑映射。此操作过程的剩余步骤假设要自定义或添
加映射。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。
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步骤 4 在 GTP Inspect Map 对话框的 Security Level 视图中，查看映射的当前配置。

该视图会指出使用的是默认映射还是自定义映射。如果需要进一步自定义设置，请点击 Details 并
继续执行操作步骤。

提示 IMSI Prefix Filtering 按钮是配置 IMSI 前缀过滤的快捷方式 （下面将会加以说明）。

步骤 5 点击 Permit Parameters 选项卡并配置所需的选项。

• Permit Response - ASA 执行 GTP 检测时，默认情况下，ASA 会丢弃来自未在 GTP 请求中指定
的 GSN 的 GTP 响应。如果在 GSN 池中使用负载平衡来实现 GPRS 的效率和可扩展性，将会出
现这种情况。

要配置 GSN 池并支持负载平衡，请创建指定 GSN 的网络对象组，并选择该对象组作为“From 
Object Group”。同样，请为 SGSN 创建一个网络对象组，并选择该对象组作为 “To Object 
Group”。如果 GSN 响应与 GTP 请求所发送到的 GSN 属于同一个对象组，且 SGSN 所在的对
象组允许响应 GSN 向其发送 GTP 响应，则 ASA 允许响应。

网络对象组可以通过主机地址或包含主机地址的子网来标识 GSN 或 SGSN。

• Permit Errors - 是否允许无效数据包或在检测期间遇到错误的数据包通过 ASA 发送，而不是丢
弃这些数据包。

步骤 6 点击 General Parameters 选项卡并配置所需的选项：

• Maximum Number of Requests - 排队等待响应的最大 GTP 请求数。

• Maximum Number of Tunnels - 允许的最大 GTP 隧道数。

• Enforce Timeout - 是否为以下行为执行空闲超时。超时格式为 hh:mm:ss。

– GSN - 移除 GSN 之前允许处于非活动状态的最长时间。

– PDP 情景 - 接收 GTP 会话的 PDP 情景之前允许处于非活动状态的最长时间。

– 请求 - GTP 会话期间接收 GTP 消息之前允许处于非活动状态的最长时间。

– 信令 - 移除 GTP 信令之前允许处于非活动状态的最长时间。

– T3 响应超时 - 移除连接之前允许处于非活动状态的最长时间。

– 隧道 - GTP 隧道允许处于非活动状态的最长时间。

步骤 7 如有需要，请点击 IMSI Prefix Filtering 选项卡并配置 IMSI 前缀过滤。

默认情况下，安全设备不检查有效的移动设备国家/地区代码 (MCC)/移动网络代码 (MNC) 组合。如
果配置 IMSI 前缀过滤，接收到的数据包 IMSI 中的 MCC 和 MNC 将会与配置的 MCC/MNC 组合进
行比较，如果不匹配，数据包将被丢弃。

移动设备国家/地区代码是非零的三位数值；应在一位或两位数值前添加零作为前缀。移动网络代
码是两位或三位数值。

可添加所有允许的 MCC 和 MNC 组合。默认情况下， ASA 不检查 MNC 和 MCC 组合有效性，因
此，必须验证所配置组合的有效性。有关 MCC 和 MNC 代码的详细信息，请参阅 ITU E.212 建议
《Identification Plan for Land Mobile Stations》（陆地移动站识别计划）。

步骤 8 点击 Inspections 选项卡，并定义要基于流量特性实施的特定检测。

a. 执行以下任意操作：

• 点击 Add 添加新条件。

• 选择现有条件并点击 Edit。
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b. 选择条件的匹配类型：Match （流量必须与条件匹配）或者 No Match （流量不得与条件匹
配）。然后，配置条件：

• Access Point Name - 根据指定的正则表达式或正则表达式类匹配接入点名称。默认情况下，
会检测所有具有有效接入点名称的消息，且允有任何名称。

• Message ID - 匹配消息 ID（范围是 1 到 255）。可以指定一个值或值范围。默认情况下，允
许所有有效的消息 ID。

• Message Length - 匹配 UDP 负载长度介于指定的最小长度和最大长度之间的消息。

• Version - 匹配 GTP 版本 （范围是 0 到 255）。可以指定一个值或值范围。 GTP 0 版本使用
端口 3386，而 1 版本使用端口 2123。默认情况下，允许所有 GTP 版本。

c. 对于消息 ID 匹配，请选择是要丢弃数据包还是要对数据包应用每秒速率限制。对于所有其他
匹配，操作是丢弃数据包。对于所有匹配，可以选择是否启用日志记录。

d. 点击 OK 添加检测。根据需要重复上述步骤。

步骤 9 在 GTP Inspect Map 对话框中点击 OK。

这样即可将检测映射用于 GTP 检测服务策略中。

配置 GTP 检测服务策略

GTP 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。可以简单地编辑默认
全局检测策略来添加 GTP 检测。或者，可以创建所需的新服务策略，例如，接口特定策略。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 GTP 检测规则，或者有要添加 GTP 检测的规则，请选择该规则并点击 Edit。

步骤 2 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 3 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 GTP 
检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中 GTP 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 4 选择 GTP。

步骤 5 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射还是配置的 GTP 检测策略映射。可在此时创建映射。有关详细信息，请参
阅第 12-5 页的配置 GTP 检测策略映射。

b. 在 Select GTP Inspect Map 对话框中点击 OK。

步骤 6 点击 OK 或 Finish 以保存服务策略规则。
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RADIUS 计费检测
以下各节介绍 RADIUS 计费检测引擎。

• 第 12-8 页的 RADIUS 计费检测概述

• 第 12-8 页的配置 RADIUS 计费检测

RADIUS 计费检测概述

RADIUS 计费检测是为了防止使用 RADIUS 服务器的 GPRS 网络上出现过度计费攻击。尽管实施 
RADIUS 计费检测不需要 GTP/GPRS 许可证，但如果不实施 GTP 检测并设置 GPRS，实施 RADIUS 
计费检测将毫无意义。

GPRS 网络上的过度计费攻击会导致消费者为他们未使用的服务付费。在这种情况下，恶意攻击者
会建立与服务器之间的连接，并从 SGSN 获取 IP 地址。即使攻击者结束呼叫，恶意服务器仍会向其
发送数据包；虽然 GGSN 会丢弃这些数据包，但来自服务器的连接仍会保持活动状态。分配给恶意
攻击者的 IP 地址将被释放，并重新分配给某个合法用户 （该用户将需要为攻击者将会使用的服务
付费）。

RADIUS 计费检测可确保流经 GGSN 的流量都是合法流量，从而防止此类攻击。通过正确配置的 
RADIUS 计费功能， ASA 可根据 Radius Accounting Request Start 消息和 Radius Accounting Request 
Stop 消息中的 Framed IP 属性匹配情况来断开连接。如果 Framed IP 属性中显示有关匹配的 IP 地址
的 Stop 消息， ASA 将会查找具有与该 IP 地址匹配的源的所有连接。

可以选择对 RADIUS 服务器配置预共享密钥，以便 ASA 能够验证消息。如果没有配置共享密钥，
ASA 仅会检查源 IP 地址是否是其中一个已配置为可以传输 RADIUS 信息的地址。

注 如果在启用了 GPRS 的情况下使用 RADIUS 计费检测， ASA 会检查 Accounting Request STOP 消息
中的 3GPP-Session-Stop-Indicator，以便正确处理辅助 PDP 情景。具体而言， ASA 要求 Accounting 
Request STOP 消息必须包含 3GPP-SGSN-Address 属性，它才会终止用户会话及所有相关连接。默
认情况下，某些第三方 GGSN 可能不发送此属性。

配置 RADIUS 计费检测

默认情况下， RADIUS 计费检测未启用。如果需要 RADIUS 计费检测，必须对其进行配置。

操作步骤

步骤 1 第 12-9 页的配置 RADIUS 计费检测策略映射。

步骤 2 第 12-10 页的配置 RADIUS 计费检测服务策略。
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配置 RADIUS 计费检测策略映射

要配置 RADIUS 计费检测所需的属性，必须创建 RADIUS 计费检测策略映射。

提示 除了以下所述的操作步骤外，还可以在创建服务策略时配置检测映射。无论如何创建，映射的内容
都相同。

操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > RADIUS Accounting。

步骤 2 执行以下操作之一：

• 点击 Add 添加新映射。

• 选择映射并点击 Edit。

步骤 3 对于新的映射，输入名称 （最多可包含 40 个字符）和描述。编辑映射时，只可以更改描述。

步骤 4 点击 Host Parameters 选项卡，并添加各个 RADIUS 服务器或 GGSN 的 IP 地址。

或者，可以包括密钥，以便 ASA 可以验证消息。如果没有密钥，则只检查 IP 地址。 ASA 收到来自
这些主机的 RADIUS 计费消息的副本。

步骤 5 点击 Other Parameters 选项卡并配置所需的选项。

• Send responses to the originator of the RADIUS accounting message - 是否掩蔽来自 ESMTP 服务
器的横幅。

• Enforce user timeout - 是否实施用户空闲超时和超时值。默认值为 1 小时。

• Enable detection of GPRS accounting - 是否实施 GPRS 过度计费防护。 ASA 会在 
Accounting-Request Stop 和 Disconnect 消息中检查 3GPP VSA 26-10415 属性，以便正确处理辅助 
PDP 情景。如果该属性存在， ASA 会断开源 IP 地址与已配置端口上的用户 IP 地址相匹配的所
有连接。

• Validate Attribute - 接收 Accounting-Request Start 消息时用于构建用户帐户表的其他条件。这些
属性有助于 ASA 决定是否断开连接。

如果没有指定要验证的其他属性， ASA 将会以 Framed IP Address 属性中的 IP 地址作为唯一依
据作出决定。如果您配置了其他属性，且 ASA 接收到包含当前正被跟踪的地址的开始计费消
息，但是其他要验证的属性不同，那么将断开所有用原来属性开始的连接 （假设 IP 地址已重
新分配给新用户）。

值范围是 1 到 191，而且可以多次输入命令。有关属性编号及其描述的列表，请访问 
http://www.iana.org/assignments/radius-types。

步骤 6 点击 OK。

这样即可将检测映射用于 RADIUS 计费检测服务策略中。
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配置 RADIUS 计费检测服务策略

RADIUS 计费检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。由于 
RADIUS 计费检测适用于流向 ASA 的流量，因此，必须将这项检测配置为管理检测规则而不是标
准规则。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要创建新规则，请点击 Add > Add Management Service Policy Rule。如第 1-12 页的为管理流量
添加服务策略规则中所述，通过向导进入 Rule Actions 页面。

• 如果有 RADIUS 计费检测规则，或者有要添加 RADIUS 计费检测的管理规则，请选择该规则并
点击 Edit，然后点击 Rule Actions 选项卡。

步骤 2 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 
RADIUS 计费检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 为 RADIUS 计费映射选择 None。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 3 从 RADIUS Accounting Map 选择所需的 RADIUS 计费映射。可在此时创建映射。有关详细信息，
请参阅第 12-9 页的配置 RADIUS 计费检测策略映射。

步骤 4 点击 OK 或 Finish 以保存管理服务策略规则。

RSH 检测
默认情况下，RSH 检测已启用。RSH 协议在 TCP 端口 514 上使用从 RSH 客户端到 TCP RSH 服务器
的连接。客户端和服务器协商用于客户端会侦听 STDERR 输出流的 TCP 端口号。如有必要， RSH 
检测支持协商端口号的 NAT。

有关启用 RSH 检测的信息，请参阅第 8-8 页的配置应用层协议检测。

SNMP 检测
通过 SNMP 应用检测可以将 SNMP 流量限制于特定 SNMP 版本。SNMP 早期版本的安全性较低；因
此，安全策略可能要求拒绝使用某些 SNMP 版本。ASA 可能会拒绝 SNMP 1、2、2c 或 3 版本。可
以创建 SNMP 映射来控制允许的版本。

SNMP 检测在默认检测策略中未启用，如果需要进行这项检测，必须先启用它。可以简单地编辑默
认全局检测策略来添加 SNMP 检测。或者，可以创建所需的新服务策略，例如，接口特定策略。
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操作步骤

步骤 1 选择 Configuration > Firewall > Objects > Inspect Maps > SNMP 并执行以下操作：

a. 点击 Add，或者选择映射并点击 Edit。添加映射时，请输入映射名称。

b. 选择不允许的 SNMP 版本。

c. 点击 OK。

步骤 2 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

• 要编辑默认全局策略，请在 Global 文件夹中选择 “inspection_default”规则，然后点击 Edit。

• 要创建新规则，请点击 Add > Add Service Policy Rule。如第 1-10 页的为直通流量添加服务策略
规则中所述，通过向导进入 Rules 页面。

• 如果有 SNMP 检测规则，或者有要添加 SNMP 检测的规则，请选择该规则并点击 Edit。

步骤 3 在 Rule Actions 向导页或选项卡上，选择 Protocol Inspection 选项卡。

步骤 4 （要更改使用中的策略）如果要编辑任何使用中的策略来使用不同的检测策略映射，必须禁用 
SNMP 检测，然后为其提供新的检测策略映射名称并重新启用这项检测：

a. 取消选中 SNMP 复选框。

b. 点击 OK。

c. 点击 Apply。

d. 重复这些步骤以返回到 Protocol Inspections 选项卡。

步骤 5 选择 SNMP。

步骤 6 如果需要非默认检测，请点击 Configure，然后执行以下操作：

a. 选择要使用默认映射（默认映射允许所有版本）还是配置的 SNMP 检测策略映射。可在此时创
建映射。

b. 在 Select SNMP Inspect Map 对话框中点击 OK。

步骤 7 点击 OK 或 Finish 以保存服务策略规则。

XDMCP 检测
默认情况下， XDMCP 已启用；但是， XDMCP 检测引擎取决于 established 命令的正确配置。

XDMCP 是使用 UDP 端口 177 来协商 X 会话 （建立后使用 TCP）的协议。

为了成功协商和启动 XWindows 会话，ASA 必须允许来自 Xhosted 计算机的 TCP 向后连接。要允许
向后连接，请在 ASA 上使用 established 命令。一旦 XDMCP 协商端口发送显示， established 命令
将接受咨询，以验证是否应允许此向后连接。

在 XWindows 会话期间，管理器与已知端口 6000 | n 上的显示 Xserver 进行通信。由于以下终端设
置，每个显示都具有与 Xserver 的单独连接。

setenv DISPLAY Xserver:n

其中， n 是显示编号。

如果使用 XDMCP，将会使用 IP 地址对显示进行协商 （如有必要， ASA 可以对这些 IP 地址进行 
NAT）。 XDCMP 检测不支持 PAT。

有关启用 XDMCP 检测的信息，请参阅第 8-8 页的配置应用层协议检测。
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13第 章
连接设置

本章介绍如何为通过 ASA 的连接或指向 ASA 的管理连接配置连接设置。连接设置包括：

• 最大连接数 （TCP 和 UDP 连接、半开连接、每客户端连接）

• 连接超时

• 死连接检测

• TCP 序列随机化

• TCP 规范化自定义

• TCP 状态旁路

• 全局超时

• 第 13-1 页的有关连接设置的信息

• 第 13-4 页的连接设置的许可要求

• 第 13-4 页的准则和限制

• 第 13-5 页的默认设置

• 第 13-5 页的配置连接设置

• 第 13-10 页的连接设置的功能历史

有关连接设置的信息
本节介绍了您可能需要限制连接的原因。

• 第 13-2 页的 TCP 拦截和限制半开连接

• 第 13-2 页的因无客户端 SSL 兼容性而禁用管理数据包的 TCP 拦截

• 第 13-2 页的死连接检测 (DCD)

• 第 13-2 页的 TCP 序列随机化

• 第 13-3 页的 TCP 规范化

• 第 13-3 页的 TCP 状态旁路
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第 13 章      连接设置

  有关连接设置的信息
TCP 拦截和限制半开连接

限制半开连接数可保护系统免受 DoS 攻击。 ASA 使用每客户端限制和半开连接限制触发 TCP 拦
截，保护内部系统免受对具有 TCP SYN 数据包的接口以泛洪方式发起的 DoS 攻击。半开连接是指
在源和目标之间尚未完成必要的握手的连接请求。TCP 拦截使用 SYN cookie 算法防止 TCP SYN 泛
洪攻击。SYN 泛洪攻击包括通常由伪装 IP 地址发起的一系列 SYN 数据包。SYN 数据包的持续泛洪
使服务器 SYN 队列保持已满的状态，从而阻止它处理连接请求。当超过某个连接的半开连接阈值
时，ASA 作为服务器代理对客户端 SYN 请求产生 SYN-ACK 响应。当 ASA 收到客户端返回的 ACK 
时，它可以对客户端进行身份验证并允许连接到服务器。

注 当您使用 TCP SYN Cookie 保护以防止服务器遭受 SYN 攻击时，您必须设置半开连接限制，使之低
于您想要保护的服务器上的 TCP SYN 缓冲区队列。否则，在 SYN 攻击期间，有效客户端将无法访
问服务器。

要查看 TCP 拦截的统计信息，包括遭受攻击的前 10 名服务器，请参阅第 17 章，“威胁检测”。

因无客户端 SSL 兼容性而禁用管理数据包的 TCP 拦截

默认情况下， TCP 管理连接会始终启用 TCP 拦截。启用 TCP 拦截时，它会拦截三次 TCP 连接建立
握手数据包并阻止 ASA 为无客户端 SSL 处理数据包。无客户端 SSL 要求能够处理三次握手数据
包，以便为无客户端 SSL 连接提供选择性 ACK 和其他 TCP 选项。要禁用管理流量的 TCP 拦截，您
可以设置半开连接限制；只有达到半开连接限制后， TCP 拦截才会启用。

死连接检测 (DCD)
DCD 检测死连接并允许其过期，无需使仍然可以处理流量的连接过期。如果希望存留空闲但有效
的连接，您可以配置 DCD。

如果启用 DCD，空闲超时行为会发生变化。当发生空闲超时时， DCD 探测器会被发送至两个终端
主机以确定连接的有效性。如果终端主机未能在探测器按配置的时间间隔被发送后作出响应，连接
即被释放，而且重设值 （如果已配置的话）将被发送到每个终端主机。如果两个终端主机均响应
连接有效，活动超时更新到当前时间，而系统会相应地重新安排空闲超时。

启用 DCD 会更改 TCP 规范器中的空闲超时处理行为。DCD 探测器重置在 show conn 命令中看到的
连接上的空闲超时。为了确定连接在什么时候超出 timeout 命令中配置的超时值但因 DCD 探测器而
保持运行， show service-policy 命令包括显示来自 DCD 的活动数量的计数器。

TCP 序列随机化

每个 TCP 连接都有两个 ISN：一个由客户端生成，另一个由服务器生成。ASA 将通过入站和出站方
向的 TCP SYN 的 ISN 随机化。

随机化受保护主机的 ISN 可以防止攻击者预测新连接的下一个 ISN 并可能对新会话进行拦截。

如果需要的话，您可以禁用 TCP 初始序列号随机化。例如：

• 如果另一个在线防火墙也执行初始序列号随机化，尽管此操作不会影响流量，但无需两个防火
墙同时执行此操作。

• 如果您使用 eBGP 多跳通过 ASA，并且 eBGP 的对等体在使用 MD5。随机化会中断 MD5 校验和。

• 您使用一台要求 ASA 不对连接序列号进行随机化的 WAAS 设备。
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第 13 章      连接设置

  有关连接设置的信息
TCP 规范化

TCP 规范化功能可识别异常数据包，检测到该等数据包时， ASA 可对其进行操作；例如， ASA 可
允许、丢弃或清除数据包。 TCP 规范化有助于保护 ASA 免受攻击。 TCP 规范化始终启用，但是，
您可以自定义某些功能的行为方式。

TCP 规范器包括不可配置操作和可配置操作。通常，丢弃或清除连接的不可配置操作适用于始终不
良的数据包。可配置操作（有关详细信息，请参阅第 13-5 页的用 TCP 映射自定义 TCP 规范器）可
能需要根据网络需求自定义。

有关 TCP 规范化的信息，请参阅以下准则：

• 规范器无法防止 SYN 泛洪。 ASA 包括其他方式的 SYN 泛洪保护。

• 除非 ASA 因故障转移而处于松散模式，否则规范器始终将 SYN 数据包视为流量中的第一个数
据包。

TCP 状态旁路

默认情况下，系统对通过 ASA 的所有流量均使用自适应安全算法进行检查并根据安全策略允许通
过或丢弃。 ASA 通过检查每个数据包的状态 （是新连接还是已建立连接？）并将其分配到会话管
理路径 （新连接 SYN 数据包）、快速路径 （已建立连接），或控制层面路径 （高级检测）来实现
防火墙性能的最大化。有关状态防火墙的详细信息，请参阅一般操作配置指南。

与快速路径中现有连接的相匹配的 TCP 数据包可以通过 ASA，而无需重新检查安全策略的各个方
面。此功能可最大限度地提高性能。但是，使用 SYN 数据包在快速路径中建立会话的方法以及快
速路径中发生的检查 （如 TCP 序列号），可能会阻碍非对称路由解决方案：连接的出站和入站流
量必须通过同一个 ASA。

例如，新连接指向 ASA 1。 SYN 数据包通过会话管理路径，而后连接条目成功添加至快速路径表。
如果此连接的后续数据包通过 ASA 1，则数据包将与快速路径中的条目相匹配并通过。但是，如果
后续数据包到达 ASA 2，其中不存在经过管理会话路径的 SYN 数据包，则连接的快速路径中没有
条目，导致数据包会被丢弃。图 13-1 显示一个非对称路由示例，其中，出站流量通过一个与入站
流量不同的 ASA：

图 13-1 非对称路由：

ISP A

Inside
network

Outbound?Traffic

Return?Traffic

ISP B

25
11

55

Security
appliance 1

Security
appliance 2
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第 13 章      连接设置

  连接设置的许可要求
如果上游路由器配置了非对称路由，而且流量在两个 ASA 之间交替，则可为特定流量配置 TCP 状
态旁路。 TCP 状态旁路修改在快速路径中建立会话的方式并禁用快速路径检查。此功能将 TCP 流
量视作 UDP 连接处理：如果一个与指定网络相匹配的非 SYN 数据包进入 ASA，而且不存在快速路
径条目，则该数据包通过会话管理路径以在快速路径中建立连接。一旦进入快速路径，流量就会绕
过快速路径检查。

连接设置的许可要求

准则和限制

情景模式准则

在单一和多情景模式下受支持。

防火墙模式准则

在路由和透明模式中支持。

故障转移准则

支持故障转移。

TCP 状态旁路不支持的功能

使用 TCP 状态旁路时，系统不支持以下功能：

• 应用检测 - 应用检测要求入站和出站流量通过同一个 ASA，因此， TCP 状态旁路不支持应用
检测。

• AAA 身份验证会话 - 当用户与一个 ASA 进行身份验证，通过其他 ASA 返回的流量会被拒绝，
因为用户未与该 ASA 进行身份验证。

• TCP 拦截、最大半开连接限制及 TCP 序列号随机化 - ASA 不记录连接状态，因此，这些功能无
法应用。

• TCP 规范化 - TCP 规范器被禁用。

• SSM 和 SSC 功能 - 无法使用 SSM 或 SSC 上运行的 TCP 状态旁路和任何应用，例如 IPS 或 CSC。

TCP 状态旁路 NAT 准则

由于每个 ASA 的转换会话是分别建立的，需确保在两个 ASA 上为 TCP 状态旁路流量配置静态 
NAT；如果使用动态 NAT，为 ASA 1 上会话选择的地址与为 ASA 2 上会话选择的地址将会不同。

型号 许可证要求

ASAv 标准或高级许可证。

所有其他型号 基础许可证。
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第 13 章      连接设置

  默认设置
最大并发和半开连接准则

根据 ASA 型号的 CPU 内核数量，由于每个内核管理连接的方式不同，最大并发和半开连接可能超
出配置的数量。在最坏的情况下， ASA 允许高达 n-1 个额外连接和半开连接，其中， n 为内核的数
量。例如，如果设备型号有 4 个内核，如果配置了 6 个并发连接和 4 个半开连接，每个类型可额外
配置 3 个连接。要确定型号的内核数量，请输入 show cpu core 命令。

默认设置

TCP 状态旁路

TCP 状态旁路默认为禁用。

配置连接设置
• 第 13-5 页的用 TCP 映射自定义 TCP 规范器

• 第 13-7 页的配置连接设置

• 第 13-8 页的配置全局超时

配置连接设置的任务流

步骤 1 对于 TCP 规范化自定义，根据第 13-5 页的用 TCP 映射自定义 TCP 规范器创建一个 TCP 映射。

步骤 2 对于除全局超时以外的所有连接设置，根据第 1 章，“服务策略”配置服务策略。

步骤 3 根据第 13-7 页的配置连接设置配置连接设置。

步骤 4 根据第 13-8 页的配置全局超时配置全局超时。

用 TCP 映射自定义 TCP 规范器 
要自定义 TCP 规范器，首先使用 TCP 映射定义设置。

详细步骤

步骤 1 选择 Configuration > Firewall > Objects > TCP Maps 窗格，然后点击 Add。

系统将显示 Add TCP Map 对话框。

步骤 2 在 TCP Map Name 字段中，输入一个名称。

步骤 3 在 Queue Limit 字段中，输入无序数据包的最大数量，介于 0 至 250 个数据包之间。

Queue Limit 设置 TCP 连接可缓冲并按顺序排列的最大无序数据包数量。默认值为 0，表示禁用此设
置，而且使用的默认系统队列限制取决于流量类型：

• 对于用于应用检测、IPS 和 TCP 检查重传的连接，队列限制为 3 个数据包。如果 ASA 收到一个
具有不同窗口大小的 TCP 数据包，则队列限制可动态变更以匹配通告的设置。

• 对于其他 TCP 连接，无序数据包保留原样通过。
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  配置连接设置
如果将 Queue Limit 设置为 1 或以上，则允许用于所有 TCP 流量的无序数据包的数量与此设置匹
配。例如，对于应用检测、 IPS 和 TCP 检查重发流量，来自 TCP 数据包的所有通告设置将被忽略，
以支持 Queue Limit 设置。对于其他 TCP 流量，无序数据包现在可进行缓冲并按顺序排列而非保留
原样通过。

步骤 4 在 Timeout 字段中，设置无序数据包可以保留在缓冲区的最长时间，介于 1 至 20 秒之间。

如果这些数据包在超时期间未按顺序排列并通过，则会被丢弃。默认值为 4 秒。如果 Queue Limit 
设置为 0，则无法为任何流量更改超时；您需将 limit 设置为 1 或以上，以便使 Timeout 生效。

步骤 5 在 Reserved Bits 区域，点击 Clear and allow、 Allow only，或 Drop。

Allow only 允许在 TCP 报头中具有保留位的数据包。

Clear and allow 清除 TCP 报头中的保留位并允许数据包。

Drop 丢弃在 TCP 报头中具有保留位的数据包。

步骤 6 选择下列任一选项：

• Clear urgent flag - 通过 ASA 清除 URG 标记。 URG 标记用于表示数据包包含优先级高于数据流
内其他数据的信息。 TCP RFC 对 URG 标记的确切解释比较模糊，因此终端系统以不同的方式
处理紧急偏移，这可能使终端系统容易受到攻击。

• Drop connection on window variation - 丢弃意外更改其窗口大小的连接。窗口大小机制允许 TCP 
通告一个大窗口，随后通告一个不接受过多数据的较小窗口。根据 TCP 规范，强烈反对 “缩
小窗口”。检测到这种情况时，可以丢弃该连接。

• Drop packets that exceed maximum segment size - 丢弃超过对等设置的 MSS 的数据包。

• Check if transmitted data is the same as original - 启用重传数据检查。

• Drop packets which have past-window sequence - 丢弃具有超出窗口序列号的数据包，即收到的 
TCP 数据包的序列号超出 TCP 接收窗口的右边。如果不选择此选项，则 Queue Limit 必须设置
为 0 （禁用）。

• Drop SYN Packets with data - 丢弃具有数据的 SYN 数据包。

• Enable TTL Evasion Protection - 启用 ASA 提供的 TTL 规避保护。如果要阻止尝试规避安全策略
的攻击，请勿启用此选项。

• 例如，攻击者可能发送一个使用极短 TTL 通过策略的数据包。如果 TTL 变为零， ASA 与终端
之间的路由器将丢弃数据包。此时攻击者可发送一个具有较长 TTL 的恶意数据包，该数据包对 
ASA 显示为重传并获得通过。但是，在终端主机，它是攻击者收到的第一个数据包。在这种情
况下，没有安全防止攻击，攻击者便可达到目的。

• Verify TCP Checksum - 启用校验和验证。

• Drop SYNACK Packets with data - 丢弃包含数据的 TCP SYNACK 数据包。

• Drop packets with invalid ACK - 丢弃具有无效 ACK 的数据包。您可能会在下列情况下看到无效 
ACK：

– 在 SYN-ACK 已收到的 TCP 连接状态下，如果已收到 TCP 数据包的 ACK 号码与发送的下
一个 TCP 数据包的序列号不完全相同，则为无效 ACK。

– 如果已收到 TCP 数据包的 ACK 号码大于发送的下一个 TCP 数据包的序列号，则为无效 
ACK。

注 对于 WAAS 连接，具有无效 ACK 的 TCP 数据包自动被允许。
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  配置连接设置
步骤 7 要设置 TCP 选项，请选择下列任一选项：

• Clear Selective Ack - 设置是否允许或清除 selective-ack TCP 选项。

• Clear TCP Timestamp - 设置是否允许或清除 TCP timestamp 选项。

• Clear Window Scale - 设置是否允许或清除 window scale timestamp 选项。

• Range - 设置有效 TCP 选项的范围，该范围应介于 6 - 7 和 9 - 255 之间。下界应小于或等于上界。
为每个范围选择 Allow 或 Drop。

步骤 8 点击 OK。

配置连接设置

要设置连接设置，请执行以下步骤。

详细步骤

步骤 1 根据第 1 章，“服务策略”，在 Configuration > Firewall > Service Policy Rules 窗格配置服务策略。

您可以将连接限制配置为新服务策略规则的一部分，或者，您也可以修改现有的服务策略。

步骤 2 在 Rule Actions 对话框上，点击 Connection Settings 选项卡。

步骤 3 要设置最大连接数，请在 Maximum Connections 区域配置以下值：

• TCP & UDP Connections - 指定流量类中所有客户端的最大并发 TCP 和 UDP 连接数，高达 
2000000。两个协议的默认值均为 0，表示允许的最大可能连接数。

• Embryonic Connections - 指定初每台主机的始化连接数，高达 2000000。半开连接是指在源和目
标之间尚未完成必要的握手的连接请求。此限制启用了 TCP 拦截功能。默认值为 0，表示最大
半开连接数。 TCP 拦截保护内部系统免受通过泛洪具有 TCP SYN 数据包的接口进行的 DoS 攻
击。如果超过了半开限制， TCP 拦截功能会拦截从客户端发送至较高安全级别服务器的 TCP 
SYN 数据包。在验证过程中使用 SYN cookie，帮助最大限度地减少丢弃的有效流量数量。因
此，无法访问主机的连接尝试将无法到达服务器。

• Per Client Connections - 指定每个客户端的并发 TCP 和 UDP 连接数，高达 2000000。如果一个已
打开最大每客户端连接数的客户端尝试一个新的连接， ASA 会拒绝该连接并丢弃数据包。

• Per Client Embryonic Connections - 指定每个客户端的最大并发 TCP 半开连接数，高达 2000000。
如果一个已通过 ASA 打开最大每客户端半开连接数的客户端尝试一个新的 TCP 连接， ASA 将
该请求代理至 TCP 拦截功能，防止连接。

步骤 4 要配置连接超时，请在 TCP Timeout 区域配置以下值：

• Connection Timeout - 指定连接插槽（任意协议，不仅仅是 TCP 的）被释放之前的空闲时间。输
入 0:0:0 将禁用连接超时。此持续时间必须为至少 5 分钟。默认值为 1 小时。

• Send reset to TCP endpoints before timeout - 指定 ASA 应在释放连接插槽之前，向连接终端发送 
TCP 重置消息。

• Embryonic Connection Timeout - 指定半开连接插槽被释放之前的空闲时间。输入 0:0:0 将禁用连
接超时。默认值为 30 秒。

• Half Closed Connection Timeout - 设置半关闭连接关闭之前的空闲超时时间，介于 0:5:0 （用于 
9.1(1) 及以前版本）或 0:0:30 （用于 9.1(2) 及以后版本）至 1193:0:0 之间。默认值为 0:10:0。半
关闭连接不受 DCD 的影响。此外，如果取消半关闭连接， ASA 将不发送重置消息。
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步骤 5 要禁用随机化序列号，请取消选中 Randomize Sequence Number。

如果另一个在线防火墙也在执行初始序列号随机化，您可以禁用 TCP 初始序列号随机化，因为不
需要两个防火墙同时执行此操作。但是，在两个防火墙上均启用 ISN 随机化不会影响流量。

每个 TCP 连接都有两个 ISN：一个由客户端生成，另一个由服务器生成。安全设备随机化通过出站
方向的 TCP SYN 的 ISN。如果连接在具有相同安全级别的两个接口之间，则 ISN 会在 SYN 中进行
两个方向的随机化。

随机化受保护主机的 ISN 可以防止攻击者预测新连接的下一个 ISN 并可能对新会话进行拦截。

步骤 6 要配置 TCP 规范化，选中 Use TCP Map。从下拉列表中选择一个现有的 TCP 映射 （如果有），或
通过点击 New 添加新的 TCP 映射。

系统将显示 Add TCP Map 对话框。请参阅第 13-5 页的用 TCP 映射自定义 TCP 规范器。

步骤 7 点击 OK。

步骤 8 要设置存留时间，选中 Decrement time to live for a connection。

步骤 9 要启用 TCP 状态旁路，在 Advanced Options 区域中，选中 TCP State Bypass。

步骤 10 点击 OK 或 Finish。

配置全局超时

在 Configuration > Firewall > Advanced > Global Timeouts 窗格，您可以设置用于配合 ASA 使用的超
时时间。所有持续时间以 hh:mm:ss 的格式显示。它设置各种协议连接和转换插槽的空闲时间。如果
插槽在指定的空闲时间内未使用，资源将被返回空闲池。 TCP 连接插槽在正常连接关闭序列约 60 
秒后释放。

字段

在所有情况下，除 Authentication absolute 和 Authentication inactivity，取消选中复选框表示没有超时
值。在这两种情况下，清除此复选框表示对每个新连接重新进行身份验证。

• Connection - 修改连接插槽被释放前的空闲时间。输入 0:0:0，以便禁用连接超时。此持续时间
必须为至少 5 分钟。默认值为 1 小时。

• Half-closed - 修改 TCP 半关闭连接关闭前的空闲时间。最小值为 5 分钟。默认值为 10 分钟。输
入 0:0:0 将禁用半关闭连接的超时。

• UDP - 修改 UDP 协议连接关闭前的空闲时间。此持续时间必须为至少 1 分钟。默认值为 2 分
钟。输入 0:0:0 将禁用超时。

• ICMP - 修改通用 ICMP 状态关闭之前的空闲时间。

• H.323 - 修改 H.323 媒体连接关闭前的空闲时间。默认值为 5 分钟。输入 0:0:0 将禁用超时。

• H.225 - 修改 H.225 信令连接关闭前的空闲时间。 H.225 默认超时时间为 1 小时 (1:0:0)。将该值
设置为 0:0:0 表示从不关闭此连接。要在所有呼叫清除之后立即关闭此连接，建议将该值设置
为 1 秒 (0:0:1)。

• MGCP - 修改代表 MGCP 媒体端口关闭前空闲时间的 MGCP 超时值。MGCP 默认超时值为 5 秒 
(0:5:0)。输入 0:0:0 将禁用超时。

• MGCP PAT - 修改 MGCP PAT 转换被移除前的空闲时间。默认值为 5 秒 (0:5:0)。最短时间为 30 
秒。取消选中复选框将返回默认值。

• TCP Proxy Reassembly - 配置等待重组的缓冲数据包将被丢弃前的空闲超时，介于 0:0:10 至 
1193:0:0 之间。默认值为 1 分钟 (0:1:0)。
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• Floating Connection - 如果存在多条静态路由连至具有不同度量的网络，ASA 在创建连接时使用
具有最佳度量的网络。如果有更好的路由可用，则此超时会关闭连接，因而可以使用更好的路
由重新建立连接。默认值为 0 （连接永不会超时）。要利用此功能，请将超时更改为 0:1:0 至 
1193:0:0 范围内的一个新值。

• SUNRPC - 修改 SunRPC 插槽被释放前的空闲时间。此持续时间必须为至少 1 分钟。默认值为 
10 分钟。输入 0:0:0 将禁用超时。

• SIP - 修改 SIP 信令端口连接关闭前的空闲时间。此持续时间必须为至少 5 分钟。默认值为
30 分钟。

• SIP Media - 修改 SIP 媒体端口连接关闭前的空闲时间。此持续时间必须为至少 1 分钟。默认值
为 2 分钟。

• SIP Provisional Media - 修改 SIP 临时媒体连接的超时值，介于 0:1:0 至 1193:0:0 之间。默认值为 
2 分钟。

• SIP Invite - 修改临时响应和媒体转换关闭前的空闲时间。最小值为 0:1:0，最大值为 0:30:0。默
认值为 0:3:0。

• SIP Disconnect - 修改在 CANCEL 或 BYE 消息未收到 200 OK 情况下 SIP 会话被删除前的空闲时
间。最小值为 0:0:1，最大值为 0:10:0。默认值为 0:2:0。

• Authentication absolute - 修改身份验证缓存超时且必须重新验证新连接前的持续时间。此持续时
间必须短于 Translation Slot 值。系统保持等待，直到您开始新连接后，再次提示您重新验证。
输入 0:0:0 将禁用缓存并重新验证每个新连接。

注 如果连接使用被动 FTP，请勿将该值设为 0:0:0。

注 如果 Authentication Absolute = 0， HTTPS 身份验证可能不起作用。如果浏览器在 HTTPS 身
份验证之后发起多个 TCP 连接加载网页，第一个连接会被允许通过，但是后续连接会触发
身份验证。因此，即使在身份验证成功后，系统也会不断地向用户显示身份验证页。要解
决该问题，请将身份验证绝对超时设置为 1 秒。此解决方法会打开 1 秒钟的窗口，可以允许
未经身份验证的用户通过防火墙 （如果这些用户来自相同源 IP 地址的话）。

• Authentication inactivity - 修改身份验证缓存超时且用户必须重新验证新连接前的持续时间。此
持续时间必须短于 Translation Slot 值。

• Translation Slot - 修改转换插槽被释放前的空闲时间。此持续时间必须为至少 1 分钟。默认值为 
3 小时。输入 0:0:0 将禁用超时。

• （8.4(3) 及更高版本，不包括 8.5(1) 和 8.6(1)）PAT Translation Slot - 修改直到 PAT 转换插槽被释
放前的空闲时间，介于 0:0:30 至 0:5:0 之间。默认值为 30 秒。如果上游路由器因先前的连接可
能仍在上游设备打开而拒绝使用已释放 PAT 端口的新连接，您可能希望增加超时。
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连接设置的功能历史
表 13-1 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

表 13-1 连接设置的功能历史

功能名称 平台版本 功能信息

TCP 状态旁路 8.2(1) 引入了此功能。以下命令已引入：set connection 
advanced-options tcp-state-bypass。

所有协议的连接超时 8.2(2) 空闲超时已被更改为应用于所有协议，而不仅是 TCP 
协议。

我们修改了以下屏幕：Configuration > Firewall > Service 
Policies > Rule Actions > Connection Settings。

使用备份静态路由的连接超时 8.2(5)/8.4(2) 如果存在多条静态路由连至具有不同度量的网络， ASA 
在创建连接时使用具有最佳度量的网络。如果有更好的
路由可用，则此超时会关闭连接，因而可以使用更好的
路由重新建立连接。默认值为 0 （连接永不会超时）。要
利用此功能，请更改超时值。

我们修改了以下屏幕：Configuration > Firewall > 
Advanced > Global Timeouts。

PAT 转换可配置超时 8.4(3) 如果 PAT 转换超时 （默认情况下在 30 秒之后），而且 
ASA 重复使用该端口进行新的转换，一些上游路由器可
能因为先前的连接可能仍在上游设备上打开而拒绝新连
接。 PAT 转换超时现在可配置为一个介于 30 秒至 5 分钟
之间的值。

我们修改了以下屏幕：Configuration > Firewall > 
Advanced > Global Timeouts。

此功能在 8.5(1) 或 8.6(1) 中不可用。

服务策略规则增加的最大连接数限制 9.0(1) 服务策略规则的最大连接数从 65535 增加至 2000000。

我们修改了以下屏幕：Configuration > Firewall > Service 
Policy Rules > Connection Settings。

半关闭超时最小值减小至 30 秒 9.1(2) 全局超时和连接超时的半关闭超时最小值从 5 分钟缩短
至 30 秒，以提供更好的 DoS 保护。

我们修改了以下屏幕：

Configuration > Firewall > Service Policy Rules > Connection 
Settings

Configuration > Firewall > Advanced > Global Timeouts。
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14第 章
服务质量

您是否曾用过使用卫星连接的长途电话？对话可能会不定期中断，出现短暂但可察觉的间隙。这些
短暂间隙是在网络上传输的数据包到达之间的时间，即延迟。某些网络流量，例如语音和视频，无
法容忍较长的延迟时间。服务质量 (QoS) 功能使您能够优先考虑关键流量，防止带宽 占用和管理网
络瓶颈以防止丢包。

注 对于 ASASM，我们建议在交换机上而非 ASASM 上运行 QoS。交换机在此领域具有更多功能。一
般来说，网络中 QoS 在路由器和交换机上运行最佳，往往比 ASA 更具广泛的功能。

本章介绍如何应用 QoS 策略。

• 第 14-1 页的关于 QoS

• 第 14-3 页的 QoS 准则

• 第 14-4 页的配置 QoS

• 第 14-7 页的监控 QoS

• 第 14-9 页的 QoS 的历史记录

关于 QoS
应考虑到在不断变化的网络环境中， QoS 不是一次性部署，而是网络设计的持续必要的部分。

本章节介绍 ASA 上可用的 QoS 功能。

• 第 14-2 页的支持的 QoS 功能

• 第 14-2 页的什么是令牌桶？

• 第 14-2 页的策略管制

• 第 14-2 页的优先级队列

• 第 14-3 页的 DSCP （区分服务）保留
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支持的 QoS 功能

ASA 也支持下列 QoS 功能：

• 策略管制 - 要防止分类流量 占用网络带宽，可以限制每个类别使用的最大带宽。有关详细信
息，请参阅第 14-2 页的策略管制。

• 优先级队列 - 对于无法容忍延迟的关键流量，例如 IP 语音 (VoIP)，您可以将此流量标记为低延
迟队列的 (LLQ) 流量，以便其始终在其他流量之前传输。请参阅第 14-2 页的优先级队列。

什么是令牌桶？

令牌桶用于管理对流量中的数据进行管制的设备，例如流量监管器。令牌桶本身不具有丢弃或优先
级策略。相反，如果流量超过管制器，令牌桶会丢弃令牌，并将管理传输队列的问题留给流量。

令牌桶是传输速率的正式定义。它包含三个组成部分：突发大小、平均速率和时间间隔。虽然平均
速率通常表示为位/秒，但任意两个值可以通过以下关系从第三个值中推出：

平均速率 = 突发大小/时间间隔

以下是这些术语的部分定义：

• 平均速率 - 亦称承诺信息速率 (CIR)，指定单位时间平均发送或转发的数据量。

• 突发大小 - 亦称承诺突发 (Bc) 大小，以每次突发的字节为单位指定在给定的单位时间内可以发
送而不引起调度问题的流量大小。

• 时间间隔 - 亦称测量间隔，以每次突发的秒为单位指定时间量。

在令牌桶比喻中，以一定速率将令牌添加到桶中。令牌桶本身有指定的容量。如果令牌桶容量已
满，新到达的令牌会被丢弃。每个令牌允许源将一定数量的位发送到网络中。要发送数据包，管制
器必须从令牌桶中移除与所代表的数据包大小相等的若干令牌。

如果令牌桶内没有足够的令牌来发送数据包，数据包会一直等，直到数据包被丢弃或被降级。如果
令牌桶的令牌已满，传入的令牌会溢出而不能用于后续数据包。因此，在任何时刻，源能够发送到
网络中的最大突发流量都大致与令牌桶的大小成正比。

策略管制

策略管制是一种通过确保流量不超过配置的最大速率 （以位/秒为单位）以保证任何一个流量类都
不会沿用全部资源的方式。如果流量超出最大速率，ASA 会丢弃超额流量。策略管制还设定了允许
的单次最大突发流量。

优先级队列

LLQ 优先级队列使您可以在处理其他流量之前优先处理特定流量 （例如，像语音和视频之类的延
迟敏感型流量）。优先级队列使用接口上的一个 LLQ 优先级队列 （请参阅第 14-5 页的配置接口的
优先级队列），而其他流量进入 “尽力而为”队列。由于大小有限制，队列可以填装和溢出。当队
列已满时，任何额外的数据包都无法进入队列并将被丢弃。这称为尾部丢弃。要避免队列被填满，
您可以增加队列缓冲区的大小。还可以优化允许进入传输队列的数据包的最大数。这些选项使您能
够控制优先级队列的延迟和稳健性。在 LLQ 队列中的数据包始终在 “尽力而为”队列中的数据包
之前传输。
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QoS 功能如何相互作用

如果 ASA 需要，您可以单独配置各 QoS 功能。但是，通常您要在 ASA 上配置多个 QoS 功能，以允
许更多操作，例如，可以优先处理某些流量，并防止其它流量引起带宽问题。您可以配置：

优先级队列 （用于特定流量） + 策略管制 （用于其余流量）。

您无法对同一组的流量配置优先级队列和策略管制。

DSCP （区分服务）保留

DSCP (DiffServ) 标记保留在所有通过 ASA 的流量上。ASA 不对任何分类流量做本地标记/注释。例
如，可以解密每个数据包的加速转发 (EF) DSCP 位以确定其是否需要 “优先级”处理并让 ASA 将
这些数据包送到 LLQ。

QoS 准则

情景模式准则

仅支持单一情景模式。不支持多情景模式。

防火墙模式准则

仅支持路由防火墙模式。不支持透明防火墙模式。

IPv6 准则

不支持 IPv6。

型号准则

• （ASA 5512-X 到 ASA 5555-X）管理 0/0 接口不支持优先级队列。

• (ASASM) 仅支持策略管制。

附加准则和限制

• QoS 只能单向应用；只有进入（或退出，根据 QoS 功能而定）应用了策略映射的接口的流量才
会受到影响。有关详细信息，请参阅第 1-4 页的功能方向性。

• 对于优先级流量，您无法使用 class-default 类映射。

• 对于优先级队列，优先级队列必须是为某个物理接口或为 ASASM （一个 VLAN）配置的。

• 策略管制不支持流向设备的流量。

• 对于策略管制，往返 VPN 隧道的流量会绕过接口策略管制。

• 对于策略管制，匹配隧道组类映射时，仅支持出站策略管制。
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配置 QoS
采用以下顺序在 ASA 上执行 QoS。

步骤 1 第 14-4 页的确定优先级队列的队列和传输环路限制。

步骤 2 第 14-5 页的配置接口的优先级队列。

步骤 3 第 14-6 页的配置优先级队列和策略管制的服务规则。

确定优先级队列的队列和传输环路限制

使用下列工作表确定优先级队列和传输环路限制。

• 第 14-4 页的队列限制工作表

• 第 14-5 页的传输环路限制工作表

队列限制工作表

下列工作表显示如何计算优先级队列大小。由于大小有限制，队列可以填装和溢出。当队列已满
时，任何额外的数据包都无法进入队列并将被丢弃 （称为尾部丢弃）。要避免队列被填满，您可以
根据第 14-5 页的配置接口的优先级队列调整队列缓冲区大小。

关于工作表的小提示：

• 出站带宽 - 例如， DSL 的上行链路速度可能为 768 Kbps。请与供应商核对。

• 平均数据包大小 - 通过编码解码器或样本量确定此值。例如，对于 VPN上 的 VoIP，可以使用 
160 字节。如果不知道使用哪种大小，我们建议使用 256 字节。

• 延迟 - 延迟取决于应用程序。例如， VoIP 建议的最大延迟是 200 毫秒。如果您不知道使用哪种
延迟，我们建议使用 500 字节。

表 14-1 队列限制工作表

1 

__________

出站带宽
（单位为 
Mbps 或 
Kbps）

Mbps x 125 =
__________

# 字节/毫秒

Kbps x .125 = __________

# 字节/毫秒

2 

___________

来自第 1 步的 # 
字节/毫秒

÷

 

__________

平均数据包大小
（字节）

x __________

延迟 （毫秒）

= __________

队列限制
（# 数据包）
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传输环路限制工作表

下列工作表显示如何计算 传输环路限制。此限制确定在以太网传输驱动器推回到接口的队列之前允
许进入驱动器的数据包的最大数量以便缓冲数据包，直到堵塞消除为止。该设置确保基于硬件的传
输环路对高优先级数据包施加有限数量的额外延迟。

关于工作表的小提示：

• 出站带宽 - 例如， DSL 的上行链路速度可能为 768 Kbps。请与供应商核对。

• 最大数据包 - 通常，最大数据包为 1538 字节 （标记的以太网为 1542 字节）。如果允许超巨型
帧 （如果平台支持），则该数据包可能更大。

• 延迟 - 延迟取决于应用程序。例如，要控制 VoIP 的抖动，应使用 20 毫秒。

配置接口的优先级队列

如果启用物理接口上流量的优先级队列，您还需要在每个接口上创建优先级队列。每个物理接口使
用两个队列：一个用于优先级流量和另一个用于所有其他的流量。对于其他流量，您或者可以配置
策略管制。

准备工作

• (ASASM) ASASM 不支持优先级队列。

• （ASA 5512-X 到 ASA 5555-X）管理 0/0 接口不支持优先级队列。

操作步骤

步骤 1 选择 Configuration > Device Management > Advanced > Priority Queue，然后点击 Add。

步骤 2 配置以下选项：

• Interface - 想要启用优先级队列的物理接口名称，或 VLAN 接口名称 （对于ASASM）。

• Queue Limit - 在 500 毫秒间隔内指定接口可传输的平均数， 256 字节数据包。

如果一个数据包在在网络节点中停留时间超过 500 毫秒，可能会触发端到端应用程序的超时。
各网络节点可以丢弃这类数据。

表 14-2 传输环路限制工作表

1 

__________

出站带宽
（单位为 
Mbps 或 
Kbps）

Mbps x 125 = __________

# 字节/毫秒

kbps x 0.125 = __________

# 字节/毫秒

2 

___________

来自第 1 步的 # 
字节/毫秒

÷

 

__________

最大数据包大小
（字节）

x __________

延迟 （毫秒）

=
__________

传输环路限制
（# 数据包）
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  配置 QoS
由于大小有限制，队列可以填装和溢出。当队列已满时，任何额外的数据包都无法进入队列并
将被丢弃 （称为尾部丢弃）。要避免队列被填满，可以使用此选项增大队列缓冲区大小。

此选项数值范围的上限在运行时动态确定。关键决定因素是支持队列所需的内存和设备上的可
用内存。

指定的 Queue Limit 对更高优先级的低延迟队列和 “尽力而为”队列都有影响。

• Transmission Ring Limit - 优先级队列的深度，是指定接口在 10 毫秒时间间隔内可以传输的最
大 1550 字节数据包的数量。

该设置确保基于硬件的传输环路对高优先级数据包的额外延迟不超过 10 毫秒。

此选项设定在以太网传输驱动器推回到接口上的队列之前允许进入驱动器的低延迟或正常优先
级数据包的最大数量以便缓冲数据包，直到堵塞消除为止。

数值范围的上限在运行时动态确定。关键决定因素是支持队列所需的内存和设备上的可用内存。

指定的 Transmission Ring Limit 对更高优先级的低延迟队列和 “尽力而为”队列都有影响。

步骤 3 点击 OK。

步骤 4 点击 Apply。

配置优先级队列和策略管制的服务规则

您可以为同一策略映射中不同类映射配置优先级队列和策略管制。关于有效 QoS 配置的详细信息，
请参阅第 14-3 页的 QoS 功能如何相互作用。

准备工作

• 无法为优先级流量使用 class - default 类映射。

• (ASASM) ASASM 仅支持策略管制。

• 策略管制不支持流向设备的流量。

• 对于策略管制，往返 VPN 隧道的流量会绕过接口策略管制。

• 对于策略管制，匹配隧道组类映射时，仅支持出站策略管制。

• 优先级流量仅识别延迟敏感型流量。

• 关于策略管制流量，可以选择对其他流量进行策略管制，也可以将流量限制到特定类型。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy，然后打开一个规则。

您可以将 QoS 配置为新的服务策略规则的一部分，或者修改现有服务策略。

步骤 2 通过向导到 Rules 页面，选择接口 （或全局）以及相应的流量匹配标准。

对于策略管制流量，您可以选择对不做优先级处理的所有流量进行策略管制，或者可以将流量限制
到特定类型。

提示 如果使用 ACL 进行流量匹配，仅在 ACL 指定的方向上应用策略管制。即从源到目标的流量
受到策略管制，但是从目标到源的流量则不受策略管制。

有关详细的信息服务策略规则，请参阅第 1 章，“服务策略”。
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  监控 QoS
步骤 3 在 Rule Actions 对话框内，点击 QoS 选项卡。

步骤 4 选择 Enable priority for this flow。

如果服务策略规则适用于单个接口，ASDM 会自动为接口创建优先级队列（Configuration > Device 
Management > Advanced > Priority Queue；有关详细信息，请参阅第 14-5 页的配置接口的优先级队
列）。如果此规则适用于全局策略，则需要在配置服务策略规则之前向一个或多个接口手动添加优
先级队列。

步骤 5 选择 Enable policing，然后选中 Input policing 或 Output policing 复选框 （或两者）以启用指定类
型的流量策略管制。对于每类流量策略管制，请配置以下选项：

• Committed Rate - 此流量的速率限制；这是一个介于 8000 和 2000000000 之间的一个值，指定
允许的最大速度 （位/秒）。

• Conform Action - 在速率低于 conform-burst 值时待采取的操作。值将被发送或丢弃。

• Exceed Action - 在速率介于 conform-rate 和 conform-burst 值之间时采取的操作 值将被发送或丢弃。

• Burst Rate - 介于 1000 和 512000000 之间的一个值，指定在减速到合格速率值之前持续突发中
允许的最大短暂字节的数量。

步骤 6 点击 Finish。

步骤 7 点击 Apply 以将配置发送到设备。

监控 QoS
要监控 ASDM 中的 QoS，可以在命令行界面工具中输入命令。

• 第 14-7 页的 QoS 策略统计信息

• 第 14-8 页的 QoS 优先级统计信息

• 第 14-8 页的 QoS 优先级队列统计信息

QoS 策略统计信息

要查看流量策略管制的 QoS 统计信息，请使用 show service-policy police 命令。

hostname# show service-policy police

Global policy:
Service-policy: global_fw_policy

Interface outside:
Service-policy: qos

Class-map: browse
police Interface outside:

cir 56000 bps, bc 10500 bytes
conformed 10065 packets, 12621510 bytes; actions: transmit
exceeded 499 packets, 625146 bytes; actions: drop
conformed 5600 bps, exceed 5016 bps

Class-map: cmap2
police Interface outside:

cir 200000 bps, bc 37500 bytes
conformed 17179 packets, 20614800 bytes; actions: transmit
exceeded 617 packets, 770718 bytes; actions: drop
conformed 198785 bps, exceed 2303 bps
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QoS 优先级统计信息

要查看执行 priority 命令的服务策略的统计信息，请使用 show service-policy priority 命令。

hostname# show service-policy priority
Global policy:

Service-policy: global_fw_policy
Interface outside:

Service-policy: qos
Class-map: TG1-voice

Priority:
Interface outside: aggregate drop 0, aggregate transmit 9383

“Aggregate drop”表示此接口中的汇聚丢弃；“Aggregate transmit”表示此接口中已传输数据包的
汇聚数量。

QoS 优先级队列统计信息

要显示接口的优先级队列统计信息，请使用 show priority-queue statistics 命令。结果将显示尽力而
为 (BE) 队列和低延迟队列 (LLQ) 的统计信息。以下示例显示使用 show priority-queue statistics 命令
进行接口命名测试。

hostname# show priority-queue statistics test

Priority-Queue Statistics interface test

Queue Type        = BE
Packets Dropped   = 0
Packets Transmit  = 0
Packets Enqueued  = 0
Current Q Length  = 0
Max Q Length      = 0

Queue Type        = LLQ
Packets Dropped   = 0
Packets Transmit  = 0
Packets Enqueued  = 0
Current Q Length  = 0
Max Q Length      = 0
hostname#

在此统计报告中：

• “Packets Dropped”表示此队列中已丢弃数据包的总数量。

• “Packets Transmit”表示此队列中已传输数据包的总数量。

• “Packets Enqueued”表示此队列中排队数据包的总数量。

• “Current Q Length”表示此队列当前的深度。

• “Max Q Length”表示此队列曾发生过的最大深度。
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QoS 的历史记录

功能名称 平台版本 说明

优先级队列和策略管制 7.0(1) 我们引入了 QoS 优先级队列和策略管制。

我们引入了以下屏幕：

Configuration > Device Management > Advanced > Priority 
Queue
Configuration > Firewall > Service Policy Rules

整形和分级式优先级队列 7.2(4)/8.0(4) 我们引入了 QoS 整形和分级式优先级队列。

我们修改了以下屏幕：Configuration > Firewall > Service 
Policy Rules。

ASA 5585-X 标准优先级队列支持万兆以太网 8.2(3)/8.4(1) 我们为 ASA 5585-X 支持万兆以太网接口上的标准优先级
队列。
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15第 章
连接和资源故障排除

本章介绍如何对 ASA 进行故障排除。

• 第 15-1 页的测试配置

• 第 15-8 页的监控性能

• 第 15-9 页的监控系统资源

• 第 15-11 页的监控连接

• 第 15-11 页的监控每个进程的 CPU 使用情况

测试配置
此章节介绍如何为单模式 ASA 或每个安全情景测试连接，如何 ping ASA 接口，以及如何让一个接
口上的主机 ping 到另一个接口的主机上。

• 第 15-1 页的 ping ASA 接口

• 第 15-3 页的验证 ASA 配置和运行并使用 ping 测试接口

• 第 15-5 页的使用 traceroute 功能确定数据包路由

• 第 15-6 页的使用数据包跟踪器跟踪数据包

ping ASA 接口

要测试 ASA 接口是否打开并正常运行，以及 ASA 和相连的路由器是否正常运行，您可以 ping ASA 
接口。

要 ping ASA 接口，请执行以下步骤：

步骤 1 绘制显示接口名称、安全级别和 IP 地址的单模式 ASA 或安全情景的示意图。

注 虽然此操作步骤使用 IP 地址，但是 ping 命令也支持 DNS 名称以及通过 name 命令分配到本
地 IP 地址的名称。

示意图也应该包括所有直接连接的路由器和一台主机，该主机位于用于 ping ASA 的路由器的另一
端。（请参阅图 15-1。）
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  测试配置
图 15-1 接口、路由器和主机的网络图

步骤 2 从直接相连的路由器 ping 每个 ASA 接口。在透明模式中，ping 管理 IP 地址。此测试旨在确保 ASA 
接口处于活动状态，并且接口配置正确。

如果 ASA 接口处于非活动状态、接口配置不正确，或如果 ASA 与路由器之间的交换机关闭（请参
阅图 15-2）， ping 操作可能会失败。在这种情况下，数据包不能到达 ASA，因此调试消息或系统日
志消息不会显示。

图 15-2 ASA 接口 ping 故障

如果 ping 到达 ASA 并且得到响应，调试消息显示类似的以下内容：

ICMP echo reply (len 32 id 1 seq 256) 209.165.201.1 > 209.165.201.2
ICMP echo request (len 32 id 1 seq 512) 209.165.201.2 > 209.165.201.1

Routed ASA

10.1.1.56 10.1.3.6209.265.200.230

10.1.2.90 10.1.4.6710.1.0.34

209.165.201.24

10.1.1.5

Transp. ASA
10.1.0.3

Host

Host

dmz1
192.1
68.1.

outside
209.165.201.1

security0

inside
192.168.0.1
security100

outside
security0

inside
security100

dmz2
192.168.2.1

security40

dmz3
192.1
68.3.

dmz4
192.168.4.1
security80

33
08

57

Host Host

Host HostHost

Host

RouterRouter Router

RouterRouter Router Router

Router

Ping

RouterHost

?

ASA 33
08

58
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如果 ping 回复没有返回路由器，则可能存在一个交换机环路或冗余 IP 地址 （请参阅图 15-3）。

图 15-3 IP 编址问题引发的 ping 故障

步骤 3 从一台远程主机上 ping 每个 ASA 接口。在透明模式中，ping 管理 IP 地址。此测试检查直接连接的
路由器是否能在主机和 ASA 之间路由数据包，以及 ASA 是否可以正确地将数据包路由回主机。

如果 ASA 没有通过中间路由器返回路由到主机， ping 操作可能失败 （请参阅图 15-4）。在这种情
况下，调试消息显示 ping 成功，但是系统日志消息 110001 显示，提示出现路由故障。

图 15-4 ASA 没有返回路由引发的 ping 故障

验证 ASA 配置和运行并使用 ping 测试接口 
Ping 工具在验证 ASA 配置和运行和周围的通信连接时用处较大，也可以用于测试其他网络设备。

• 第 15-3 页的 ping 相关信息

• 第 15-4 页的从 ASA 接口进行 ping

• 第 15-4 页的 ping 到一个 ASA 接口

• 第 15-4 页的通过 ASA 接口进行 ping

• 第 15-4 页的 ping 工具故障排除

• 第 15-5 页的使用 ping 工具

ping 相关信息

向 IP 地址发送 ping 并且获得回复。此过程可以让网络设备发现、识别并相互测试。

Ping 工具使用 ICMP （如 RFC 777 和 RFC 792 所述）定义两个网络设备之间的回应请求和应答处
理。回应请求数据包被发送至一台网络设备的 IP 地址。接收设备反转源地址和目标地址，并将数
据包发回进行回应应答。

管理员可以通过下列方法使用 ASDM Ping 交互诊断工具：

• 两个接口环回测试 - 可以从同一个 ASA 上的一个接口发起 ping 到另一个接口，作为外部环回测
试验证每个接口的基本 “打开”状态和操作。

Ping

ASARouter

33
08

60
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• Ping 到一个 ASA - Ping 工具可以在另一个 ASA 上 ping 接口来验证该接口处于打开状态并可以
响应。

• 通过 ASA 进行 ping - 源自 ping 工具的 ping 数据包可能在到达一个设备的过程中通过一个中间 
ASA。回应数据包返回时也会通过它的两个接口。此操作步骤可用来执行中间单位接口、运行
和响应时间的基本测试。

• 使用 ping 测试网络设备的可疑运行 - 可以从一个 ASA 接口发起 ping 到一台可能存在功能异常的
网络设备。如果接口配置正确但没有收到回应，则可能是设备出现问题。

• 使用 ping 测试中间通信 - 可以从一个 ASA 接口发起到一个已知正常运行并返回回应请求的网络
设备。如果接收到回应，任意中间设备的正确运行和物理连接都得以确认。

从 ASA 接口进行 ping

若是对一个接口进行基本测试，您可以从一个 ASA 接口发起 ping 到一个已知正常运行并通过中间
通信路径返回应答的网络设备。若是进行基本测试，请确保执行如下操作：

• 通过 “已知良好的”设备验证来自 ASA 接口的 ping。如果没有收到 ping，传输硬件或接口配
置中可能存在问题。

• 如果 ASA 接口已正确配置但没有收到来自 “已知良好的”设备的回应应答，接口硬件的接收
功能可能存在问题。如果另一个具有 “已知良好的”接收功能的接口可以在 ping 过该 “已知
良好的”设备后收到回应，则可以确认第一个接口硬件的接收功能存在问题。

ping 到一个 ASA 接口

当您尝试 ping 到一个 ASA 接口时，选择 Tools > Ping 验证该接口的 ping 应答 （ICMP 回应应答）
已启用。当 ping 功能禁用时， ASA 无法被其他设备或软件应用检测到，并且也不会对 ASDM ping 
工具作出回应。

通过 ASA 接口进行 ping

要验证来自“已知良好的”源的其他类型网络流量是否通过 ASA，请选择 Monitoring > Interfaces > 
Interface Graphs 或一个 SNMP 管理站。

要启用内部主机 ping 外部主机，请配置 ICMP 检测。选择 Configuration > Firewall > Service 
Policies。

ping 工具故障排除

当 ping 未能收到回应时，可能是 ASA 配置或操作错误的结果，并不一定是由于被 ping 的 IP 地址没
有回应。在使用 ping 工具从 ASA 接口发起 ping、接收 ping 或通过该接口进行 ping 前，请执行以下
基本验证：

• 验证接口是否已配置。选择 Configuration > Device Setup > Interfaces。

• 验证中间通信路径中的设备 （例如交换机或路由器）是否可以正确传输其他类型的网络流量。

• 确保来自 “已知良好的”源的其他类型流量可以正常通过。选择 Monitoring > Interfaces > 
Interface Graphs。
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使用 ping 工具

要使用 ping 工具，请执行以下步骤：

步骤 1 在 ASDM 主应用窗口中，选择 Tools > Ping。

系统将显示 Ping 对话框。

步骤 2 在 IP Address 字段中，输入 ICMP 回应请求数据包的目标 IP 地址。

Ping 也支持 IPv6 地址。

注 如果在 Configuration > Firewall > Objects > Service Objects/Groups 窗格分配了主机名，您可以
使用主机名替换 IP 地址。

步骤 3 （可选）从下拉列表中选择传输回应请求数据包的 ASA 接口。如果未指定， ASA 将核对路由表查
找目标地址并使用所需接口。

步骤 4 点击 Ping 从指定或默认接口将一个 ICMP 回应请求数据包发送到指定 IP 地址，并启动响应计时器。

Ping Output 区域将出现回应。进行过三次尝试以 ping IP 地址，结果显示以下字段：

• 被 ping 设备的 IP 地址或设备名称 （如有）。如果有分配设备名称，则可能显示设备名称，即
使结果是没有回应。

• 传输 ping 时，毫秒计时器从指定最大值或超时值开始计时。此计时器在测试不同路由或活动级
别的相对响应时间时很有用。

• Ping 输出示例：

Sending 5, 100-byte ICMP Echos to out-pc, timeout is 2 seconds:
!!!!!
Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/1 ms

如果 ping 失败，输出如下：

Sending 5, 100-byte ICMP Echos to 10.132.80.101, timeout is 2 seconds:
?????
Success rate is 0 percent (0/5)

步骤 5 要输入新的 IP 地址，点击 Clear Screen 移除 Ping 输出区以前的响应。

使用 traceroute 功能确定数据包路由

Traceroute 工具帮助您确定数据包到达目标地址所要经过的路由。工具能打印每个探测器发送的结
果。每行输出以递增顺序对应一个 TTL 值。下表列出了此工具打印的输出符号。

输出符号 说明

* 在超时时间内探测器没有接收到回应。

nn msec 每个节点指定数量探测器的往返时间 （以毫秒为单位）。

!N. 无法访问 ICMP 网络。

!H 无法访问 ICMP 主机。
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要使用 Traceroute 工具，请执行以下步骤：

步骤 1 在 ASDM 主应用窗口中，选择 Tools > Traceroute。

系统将显示 Traceroute 对话框。

步骤 2 输入要跟踪路由的主机名或 IP 地址。如果已有主机名，选择 Configuration > Firewall > Objects > 
Service Objects/Groups 对其进行定义，或者配置一个 DNS 服务器来启用此工具，把主机名解析为 
IP 地址。

步骤 3 输入在连接超时前等待回应的时间 （以秒计）。默认值为 3 秒钟。

步骤 4 键入 UDP 探测器消息使用的目标端口。默认值为 33434。

步骤 5 输入在每个 TTL 级别要发送的探测器数量。默认值为 3。

步骤 6 为第一批探测器指定最小和最大 TTL 值。默认最小值是 1，但也可以设置更高值来阻止显示已知的
中继段。最大默认值为 30。当数据包到达目标地址或达到最大值时， traceroute 终止。

步骤 7 选中 Specify source interface or IP address 复选框。从下拉列表中选择用于数据包跟踪的源接口或 
IP 地址。此 IP 地址必须是其中一个接口的 IP 地址。处于透明模式下时，它必须是 ASA 的管理 IP 
地址。

步骤 8 如果已配置域名解析，请选中 Reverse Resolve 复选框将输出显示中继段的名称。不选中此复选框
则输出显示 IP 地址。

步骤 9 选中 Use ICMP 复选框指定使用 ICMP 探测器数据包而非 UDP 探测器数据包。

步骤 10 点击 Trace Route 开始 traceroute。

Traceroute Output 区域将显示有关 traceroute 结果的详细信息。

步骤 11 要开始进行新的 traceroute，请点击 Clear Output。

使用数据包跟踪器跟踪数据包

数据包跟踪器工具为数据包嗅探和网络故障隔离提供数据包跟踪服务，也可以提供数据包的详细信
息以及 ASA 如何处理数据包。如果配置命令没有导致数据包被丢弃，数据包跟踪器工具会以便于
读取的方式提供其原因的相关信息。

您可以使用数据包跟踪器工具进行以下操作：

• 通过 ASA 跟踪数据包的使用期限，查看数据包是否正常运行。

• 在生产网络中调试所有数据包丢失。

• 验证配置是否按预期运行。

• 显示适用于数据包的所有规则，同时也显示引发规则增加的 CLI 命令。

• 在数据路径显示数据包变更的时间线。

!P 无法访问 ICMP。

!A ICMP 被管理禁用。

? 未知 ICMP 错误！

输出符号 （续） 说明 （续）
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• 在数据路径中注入跟踪器数据包。

• 基于用户身份和 FQDN 搜索 IPv4 或 IPv6 地址。

• 调试允许或拒绝特定会话的原因。

• 确定正在使用哪种安全组标记 (SGT) 值 （即来自数据包中的 SGT、 IP-SGT 管理器，或接口上
配置的 policy static sgt 命令）。

• 确定应用了哪些基于安全组的安全政策。

要使用数据包跟踪器，请执行以下步骤：

步骤 1 在 ASDM 主应用窗口中，请选择 Tools > Packet Tracer。

系统将显示 Cisco ASDM Packet Tracer 对话框。

步骤 2 从下拉列表中选择用于数据包跟踪的源接口。

步骤 3 指定用于数据包跟踪的协议类型。可用的协议类型包括 ICMP、 IP、 TCP 和 UDP。

步骤 4 选中 SGT number 复选框并输入安全组标记号以便为与思科 TrustSec 解决方案集成时 ASA 发送的
安全组标记启用数据跟踪。有效的安全组标记编号范围为 0 至 65533。

步骤 5 在 Source 下列下拉列表中，选择以下某个选项：

• IP Address

• User

• FQDN

• Security Tag

• Security Name

当您要跟踪与思科 TrustSec 解决方案集成时 ASA 发送的数据包时，选择 Security Tag 或 Security 
Name 选项。思科 ISE 上创建了安全名称，为安全组提供用户友好型名称。

如果已在带有那些安全标记或安全名的 ASA 上配置了安全策略，ASA 将实施该策略。（您可以
在包含安全标记或安全名称的 ASA 上创建安全策略。要执行基于安全组名称的策略， ASA 需
要安全组表以将安全名称映射到安全标记）。

有关将 ASA 配置成与思科 TrustSec 解决方案集成的详细信息，请参阅一般操作配置指南。

步骤 6 基于您从 Source 下拉列表中选择的选项，输入要跟踪项目相应的文本；例如，在 Source IP Address 
字段中输入用于数据包跟踪的源 IP 地址。

步骤 7 如果仅有 TCP 和 UDP，请从下拉列表中选择用于数据包跟踪的源端口。

步骤 8 在 Destination 下列下拉列表中，选择以下其中一个选项：

• IP Address

• FQDN

• Security Tag

• Security Name

步骤 9 基于您从 Destination 下拉列表中选择的选项，输入要跟踪项目相应的文本；例如，在 Destination IP 
Address 字段中输入用于数据包跟踪的目标 IP 地址。

步骤 10 如果仅有 TCP 和 UDP，请从下拉列表中选择用于数据包跟踪的目标端口。

步骤 11 如果仅有 ICMP，请从 Type 下拉列表中选择数据包跟踪的类型。然后在相应的字段中输入跟踪代码
和跟踪 ID。

步骤 12 如果仅有 IP，请在 Protocol 字段输入协议编号。有效值范围为 0 到 255。
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步骤 13 点击 Start，开始跟踪数据包。

Information Display 区域将会显示数据包跟踪结果的详细消息。

注 要显示数据包跟踪的图形形式，请选中 Show animation 复选框。

步骤 14 点击 Clear，创建新的数据包跟踪。

监控性能
要以图形或表格的形式查看 ASA 性能信息，请执行下列步骤：

步骤 1 在 ASDM 主窗口中，选择 Monitoring > Properties > Connection Graphs > Perfmon。

步骤 2 从 Available Graphs 列表中选择一个或多个条目表，然后点击 Add 将其移至 Selected Graphs 列表。
要从 Selected Graphs 列表中移除一个条目，点击 Remove。可用的选项如下：

• AAA Perfmon - 显示 ASA AAA 性能信息。

• Inspection Perfmon - 显示 ASA 检测性能信息。

• Web Perfmon - 显示 ASA 网络性能信息，包括 URL 访问和 URL 服务器请求。

• Connections Perfmon - 显示 ASA 连接性能信息。

• Xlate Perfmon - 显示 ASA NAT 性能信息。

您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。

步骤 3 要使用现有窗口标题，请从下拉列表选择一个标题。要在新窗口中显示图形，请在 Graph Window 
Title 字段中输入一个新窗口标题。

步骤 4 点击 Show Graphs，在新建或更新图形窗口中查看性能统计信息。

步骤 5 点击 Table 选项卡，以表格形式查看相同的性能统计信息。

步骤 6 在其中一个选项卡的 View 下拉列表中，选择在下列时间段显示更新信息：实时、数据每 10 秒一次；
过去 10 分钟、数据每 10 秒一次；过去 60 分钟、数据每 1 分钟一次；过去 12 小时、数据每 12 分钟
一次；或者过去 5 天、数据每两小时一次。

步骤 7 （可选）点击 Export 显示 Export Graph Data 对话框。需要导出的所选性能统计信息已勾选。

步骤 8 （可选）再次点击 Export 显示 Save 对话框。

步骤 9 （可选）点击 Save 将性能统计信息文本文件 (.txt) 保存到本地驱动器以供将来参考。

步骤 10 （可选）点击 Print 显示 Print Graph 对话框。

步骤 11 （可选）从下拉列表中选择图形或表格名称，然后点击 Print 显示 Print 对话框。

步骤 12 （可选）点击 OK 打印选定的性能统计信息。
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监控系统资源
• 第 15-9 页的块

• 第 15-9 页的 CPU

• 第 15-10 页的内存

块

要查看空闲和 占用的内存块，请执行以下步骤：

步骤 1 在 ASDM 主窗口中，选择 Monitoring > Properties > System Resources Graphs > Blocks。

步骤 2 从 Available Graphs 列表中选择一个或多个条目表，然后点击 Add 将其移至 Selected Graphs 列表。
要从 Selected Graphs 列表中移除一个条目，点击 Remove。可用的选项如下：

• Blocks Used - 显示 ASA 已 占用的内存块。

• Blocks Free - 显示 ASA 空闲的内存块。

您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。

步骤 3 要使用现有窗口标题，请从下拉列表中选择。要在新窗口中显示图形，请在 Graph Window Title 字
段中输入一个新窗口标题。

步骤 4 点击 Show Graphs，在新建或更新图形窗口中查看系统资源统计信息。

步骤 5 点击 Table 选项卡，以表格形式查看相同的性能统计信息。

步骤 6 在其中一个选项卡的 View 下拉列表中，选择在下列时间段显示更新信息：实时、数据每 10 秒一次；
过去 10 分钟、数据每 10 秒一次；过去 60 分钟、数据每 1 分钟一次；过去 12 小时、数据每 12 分钟
一次；或者过去 5 天、数据每两小时一次。

步骤 7 （可选）点击 Export 显示 Export Graph Data 对话框。需要导出的所选内在块统计信息已勾选。

步骤 8 （可选）再次点击 Export 显示 Save 对话框。

步骤 9 （可选）点击 Save 将内在块统计信息文本文件 (.txt) 保存到本地驱动器以供将来参考。

步骤 10 （可选）点击 Print 显示 Print Graph 对话框。

步骤 11 （可选）从下拉列表中选择图形或表格名称，然后点击 Print 显示 Print 对话框。

步骤 12 （可选）点击 OK 打印选定的内在块统计信息。

CPU
要查看 CPU 使用情况，请执行以下步骤：

步骤 1 在 ASDM 主窗口中，选择 Monitoring > Properties > System Resources Graphs > CPU。

步骤 2 从 Available Graphs 列表中选择一个或多个条目表，然后点击 Add 将其移至 Selected Graphs 列表。
要从 Selected Graphs 列表中移除一个条目，点击 Remove。

您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。
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步骤 3 要使用现有窗口标题，请从下拉列表中选择。要在新窗口中显示图形，请在 Graph Window Title 字
段中输入一个新窗口标题。

步骤 4 点击 Show Graphs，在新建或更新图形窗口中查看系统资源统计信息。

步骤 5 点击 Table 选项卡，以表格形式查看相同的性能统计信息。

步骤 6 在其中一个选项卡的 View 下拉列表中，选择在下列时间段显示更新信息：实时、数据每 10 秒一次；
过去 10 分钟、数据每 10 秒一次；过去 60 分钟、数据每 1 分钟一次；过去 12 小时、数据每 12 分钟
一次；或者过去 5 天、数据每两小时一次。

步骤 7 （可选）点击 Export 显示 Export Graph Data 对话框。需要导出的所选CPU 使用情况统计信息已勾选。

步骤 8 （可选）再次点击 Export 显示 Save 对话框。

步骤 9 （可选）点击 Save 将 CPU 使用情况统计信息文本文件 (.txt) 保存到本地驱动器以供将来参考。

步骤 10 （可选）点击 Print 显示 Print Graph 对话框。

步骤 11 （可选）从下拉列表中选择图形或表格名称，然后点击 Print 显示 Print 对话框。

步骤 12 （可选）点击 OK 打印选定的 CPU 使用情况统计信息。

内存

要查看内存使用情况，请执行以下步骤：

步骤 1 在 ASDM 主窗口中，选择 Monitoring > Properties > System Resources Graphs > Blocks。

步骤 2 从 Available Graphs 列表中选择一个或多个条目表，然后点击 Add 将其移至 Selected Graphs 列表。
要从 Selected Graphs 列表中移除一个条目，点击 Remove。可用的选项如下：

• Free Memory - 显示 ASA 空闲的内存。

• Used Memory - 显示 ASA 已 占用的内存。

您可以选择多达四种类型的统计信息，显示在一个图形窗口中。您可以同时打开多个图形窗口。

步骤 3 要使用现有窗口标题，请从下拉列表中选择。要在新窗口中显示图形，请在 Graph Window Title 字
段中输入一个新窗口标题。

步骤 4 点击 Show Graphs，在新建或更新图形窗口中查看系统资源统计信息。

步骤 5 点击 Table 选项卡，以表格形式查看相同的性能统计信息。

步骤 6 在其中一个选项卡的 View 下拉列表中，选择在下列时间段显示更新信息：实时、数据每 10 秒一次；
过去 10 分钟、数据每 10 秒一次；过去 60 分钟、数据每 1 分钟一次；过去 12 小时、数据每 12 分钟
一次；或者过去 5 天、数据每两小时一次。

步骤 7 （可选）点击 Export 显示 Export Graph Data 对话框。需要导出的所选内存使用情况统计信息已勾选。

步骤 8 （可选）再次点击 Export 显示 Save 对话框。

步骤 9 （可选）点击 Save 将内存使用情况统计信息文本文件 (.txt) 保存到本地驱动器以供将来参考。

步骤 10 （可选）点击 Print 显示 Print Graph 对话框。

步骤 11 （可选）从下拉列表中选择图形或表格名称，然后点击 Print 显示 Print 对话框。

步骤 12 （可选）点击 OK 打印选定的内存使用情况统计信息。
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监控连接
要以表格的形式查看当前连接，请在 ASDM 主窗口中选择 Monitoring > Properties > Connections。
每个连接都可以通过以下参数识别：

• 协议

• 数据来源：

– 安全 ID

– 安全名称

– IP 地址

– 端口

• 目标：

– 安全 ID

– 安全名称

– IP 地址

– 端口

• 最后一个数据包发送或接收后的空闲时间

• 连接上发送和接收的流量数

监控每个进程的 CPU 使用情况
您可以监控 CPU 上运行的进程。可以获得某个进程的 CPU 使用百分比信息。CPU 使用情况统计信
息以降序排序显示， 占比最高的进程排在顶部。也包括每个进程的 CPU 负载信息，显示日志时间
之前 5 秒、 1 分钟和 5 分钟的数据。此信息每 5 秒自动更新一次，提供实时的统计信息。在 ASDM 
中，统计信息每 30 秒更新一次。

要查看每个进程的 CPU 使用情况，请执行以下步骤：

步骤 1 在 ASDM 主窗口中，选择 Monitoring > Properties > Per-Process CPU Usage。

步骤 2 要暂停屏幕的自动刷新，请点击 Stop auto-refresh。

步骤 3 要将屏幕上的信息保存到本地文本文件，请点击 Save log to local file。

系统将显示 Save 对话框。

步骤 4 输入文本文件的名称，然后点击 Save。

要根据 CPU 使用情况范围为代码进程标色，请点击 Configure CPU usage。

系统将出现 Color Settings 对话框。

步骤 5 从下列选项中选择一个范围：49% 及以下、 50% - 79% 和 80% 及以上。

步骤 6 点击前景或背景网格，显示 Pick a Color 对话框，选择指定范围的前景和背景颜色。

步骤 7 点击以下选项卡之一选择调色板：Swatches、 HSB 或 RGB。完成后，点击 OK。

步骤 8 点击 OK，查看颜色编码的条目。

步骤 9 点击 Refresh，随时手动刷新数据。
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16第 章
ASA 和思科云网络安全

思科云网络安全通过软件即服务 (SaaS) 模式提供网络安全和网络过滤服务。如果在网络中已部署 
ASA，企业无需安装附加硬件即可使用云网络安全服务。

当云网络安全在 ASA 上启用时，ASA 会将选择的 HTTP 和 HTTPS 流量透明地重定向到云网络安全
代理服务器。然后，云网络安全代理服务器扫描内容，根据在思科 ScanCenter 中配置的策略，允
许、阻止或发送有关流量的警告，以执行可接受的使用并保护用户不受恶意软件攻击。

或者，ASA 可以利用身份防火墙 (IDFW) 和 AAA 规则进行身份验证以识别用户。ASA 对用户凭证
（包括用户名和/或用户组）进行加密，将其包含在被重定向到云网络安全的流量中。然后，云网络
安全服务使用这些用户凭证使流量与策略匹配。此外，还将这些凭证用于基于用户的报告。如果没
有用户身份验证， ASA 能够提供 （可选）默认用户名和/或组，尽管云网络安全服务应用策略并不
要求用户和组。

创建服务策略规则时，您可以自定义想要发送到云网络安全的流量。此外，您还可以配置一份
“白名单”，使匹配服务策略规则的网络流量子集不经云网络安全扫描便直接流向最初请求的网络
服务器。

您可以配置一台主用云网络安全代理服务器和一台备用云网络安全代理服务器，ASA 会定期轮询每
台服务器，以检查可用性。

注 此功能也叫作 “ScanSafe”，因此， ScanSafe 名称出现在一些命令中。

• 第 16-2 页的有关思科云网络安全的信息

• 第 16-6 页的思科云网络安全的许可证要求

• 第 16-6 页的云网络安全先决条件

• 第 16-7 页的准则和限制

• 第 16-7 页的默认设置

• 第 16-8 页的配置思科云网络安全

• 第 16-24 页的监控云网络安全

• 第 16-24 页的相关文档

• 第 16-25 页的功能历史思科云网络安全
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  有关思科云网络安全的信息
有关思科云网络安全的信息
• 第 16-2 页的网络流量重定向到云网络安全

• 第 16-2 页的用户身份验证和云网络安全

• 第 16-2 页的身份验证密钥

• 第 16-3 页的 ScanCenter 策略

• 第 16-5 页的云网络安全操作

• 第 16-5 页的通过白名单绕过扫描

• 第 16-5 页的 IPv4 和 IPv6 支持

• 第 16-6 页的从主用代理服务器到备用代理服务器的故障转移

网络流量重定向到云网络安全

当最终用户发送 HTTP 或 HTTPS 请求时， ASA 接收请求，并或者检索用户和/或组信息。如果流量
匹配 ASA 云网络安全服务策略， ASA 会将请求重定向到云网络安全代理服务器。通过将连接重定
向到代理服务器， ASA 充当最终用户和云网络安全代理服务器之间的媒介。 ASA 改变客户请求中
的目标 IP 地址和端口，添加云网络安全特定 HTTP 标头，然后将修改的请求发送到云网络安全代理
服务器。这些云网络安全 HTTP 标头包括各种信息，包括用户名和用户组 （如果可用）。

用户身份验证和云网络安全

用户身份可用于在云网络安全中应用策略。此外，用户身份对于云网络安全报告也非常有用。使用
云网络安全并不要求用户身份。还存在其他为云网络安全策略识别流量的方法。

ASA 支持以下确定用户身份或提供默认身份的方法：

• AAA 规则 - 当 ASA 使用 AAA 规则执行用户身份验证时，从 AAA 服务器或本地数据库检索用
户名。来自 AAA 规则的身份不包含组信息。如果已配置默认组，则使用默认组。有关配置 
AAA 规则的详细信息，请参阅旧版功能指南。

• IDFW - 当 ASA 使用带 Active Directory (AD) 的 IDFW 时，在您通过在访问规则等功能或服务策
略中使用 ACL，或者通过配置用户身份监控直接下载用户身份信息激活用户和/或组时，从 AD 
代理检索用户名和组。

有关配置 IDFW 的详细信息，请参阅一般操作配置指南。

• 默认用户名和组 - 如果没有用户身份验证，ASA 会将可选的默认用户名和/组用于所有匹配云网
络安全服务策略的用户。

身份验证密钥

每个 ASA 必须使用您从云网络安全获取的身份验证密钥。身份验证密钥可以让云网络安全识别与
网络请求相关联的公司，确保 ASA 与有效的客户相关联。

您可以将两种身份验证密钥的其中一种用于 ASA：公司密钥和组密钥。

• 第 16-3 页的公司身份验证密钥

• 第 16-3 页的组身份验证密钥
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公司身份验证密钥

公司身份验证密钥可以在同一公司内的多个 ASA 上使用。此密钥可以为 ASA 启用云网络安全服
务。管理员在 ScanCenter (https://scancenter.scansafe.com/portal/admin/login.jsp) 中生成此密钥；您可
以通过邮件发送此密钥，以备后续使用。您后续无法在 ScanCenter 中查找此密钥；ScanCenter 中仅
显示最后 4 位数。有关详细信息，请参阅云网络安全文档：
http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html。

组身份验证密钥

组身份验证密钥是一个特殊密钥，对于每个执行两项功能的 ASA 具有唯一性：

• 为一个 ASA 启用云网络安全服务。

• 识别所有来自 ASA 的流量，因此，您能够为每个 ASA 创建 ScanCenter 策略。

有关将组身份验证密钥用于策略的详细信息，请参阅第 16-3 页的 ScanCenter 策略。

管理员在 ScanCenter (https://scancenter.scansafe.com/portal/admin/login.jsp) 中生成此密钥；您可以通
过邮件发送此密钥，以备后续使用。您后续无法在 ScanCenter 中查找此密钥；ScanCenter 中仅显示
最后 4 位数。有关详细信息，请参阅云网络安全文档：
http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html。

ScanCenter 策略

在 ScanCenter 中，流量按顺序匹配策略规则，直到某个规则被匹配。然后，云网络安全应用已配置的
规则操作。用户流量可以根据组关联在 ScanCenter 中匹配策略规则：directory group或custom group。

• 第 16-3 页的目录组

• 第 16-4 页的自定义组

• 第 16-4 页的组和身份验证密钥如何进行互操作

目录组

目录组定义流量所属的组。如果有的话，组包含在客户端请求的 HTTP 标头中。当您配置 IDFW 
时，ASA 将组包含在 HTTP 标头中。如果不使用 IDFW，您可以为匹配 ASA 云网络安全检测规则的
流量配置默认组。

当您配置目录组时，必须正确输入组名。

• IDFW 组名按以下格式发送：

domain-name\group-name

当 ASA 获悉 IDFW 组名时，ASA 上的格式为 domain-name\\group-name。然而，ASA 会修改此
名称，仅使用一个反斜线符号 (\) 以符合典型的 ScanCenter 表示法。

• 默认组名按以下格式发送：

[domain\]group-name

在 ASA 上，您需要配置可选域名，使选域名后跟 2 个反斜线符号 (\\)；然而， ASA 会修改此名
称，仅使用一个反斜线符号 (\) 以符合典型的 ScanCenter 表示法。例如，如果您指定
“Cisco\\Boulder1”，ASA 会在将组名发送到云网络安全时，将组名修改为“Cisco\Boulder1”，
仅使用一个反斜线符号 (\)。
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自定义组

使用以下一个或多个条件定义自定义组：

• ScanCenter 组身份验证密钥 - 您可以为自定义组生成一个组身份验证密钥。然后，如果在配置 
ASA 时识别此组密钥，所有来自 ASA 的流量都将使用此组密钥标记。

• 源 IP 地址 - 您可以在自定义组中识别源 IP 地址。请注意， ASA 服务策略基于源 IP 地址，因
此，您可能会想在 ASA 上配置任何基于 IP 地址的策略。

• 用户名 - 您可以在自定义组中识别用户名。

– IDFW 用户名按以下格式发送：

domain-name\username

– 使用 RADIUS 或 TACACS+ 时， AAA 用户名按以下格式发送：

LOCAL\username

– 使用 LDAP 时， AAA 用户名按以下格式发送：

domain-name\username

– 默认用户名按以下格式发送：

[domain-name\]username

例如，如果您将默认用户名配置为 “Guest”， ASA 则发送 “Guest”。如果您将默认用户
名配置为 “Cisco\Guest”， ASA 则发送 “Cisco\Guest”。

组和身份验证密钥如何进行互操作

除非您需要自定义 group+group 密钥提供的每 ASA 策略，否则您可能将使用公司密钥。请注意，并
非所有的自定义组都与组密钥相关联。未加密的自定义组可用于识别 IP 地址或用户名，并且可在
策略以及使用目录组的规则中使用。

即使您的确需要每 ASA 策略并且正在使用组密钥，您也可以使用目录组和非加密自定义组提供的
匹配功能。在这种情况下，您可能需要基于 ASA 的策略，但有一些基于组成员身份、 IP 地址或用
户名的策略除外。例如，如果您想免除所有 ASA 上 America/Management 组中的用户：

1. 为 America/Management 添加目录组。

2. 为此组添加免除规则。

3. 在免除规则的后面，为每个自定义 group+group 密钥添加规则，以按 ASA 应用策略。

4. 来自 America\Management 中的用户的流量将匹配免除规则，而所有其他流量将匹配其来源 
ASA 的规则。

您可以将诸多密钥、组和策略规则进行组合。
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云网络安全操作

在应用已配置的策略之后，云网络安全阻止、允许或发送有关用户请求的警告：

• 允许 - 当云网络安全允许客户端请求时，会联系最初请求的服务器并检索数据。云网络安全将
服务器响应转发给 ASA，然后再转发给用户。

• 阻止 - 当云网络安全阻止客户端请求时，会通知用户访问已被阻止。云网络安全发送 HTTP 302
“Moved Temporarily”响应，将客户端应用重定向到云网络安全代理服务器托管的网页，该网
页显示被阻止的错误消息。 ASA 将 302 响应转发给客户端。

• 警告 - 当云网络安全代理服务器确定网站可能违反了可接受的使用策略时，会显示有关网站的
警告页面。您可以选择听从警告并丢弃连接请求，也可以点击浏览警告，转到请求的站点。

此外，您还可以选择 ASA 对无法到达主或备云网络安全代理服务器的网络流量的处理方式。可以
阻止或允许所有网络流量。默认情况下，阻止网络流量。

通过白名单绕过扫描

如果您使用 AAA 规则或 IDFW，您可以配置 ASA，使来自特定用户或组的匹配服务策略规则的网
络流量不被重定向到云网络安全代理服务器进行扫描。当您绕过云网络安全扫描时，ASA 不会联系
代理服务器，而直接从最初请求的网络服务器检索内容。当 ASA 收到来自网络服务器的响应时，
会将数据发送到客户端。此过程被称作 “白名单”流量。

尽管在使用 ACL 配置流量类以发送到云网络安全时，实现的结果与根据用户或组免除流量实现的
结果相同，但您可能发现，使用白名单更加简单。请注意，白名单功能仅基于用户和组，不基于 IP 
地址。

IPv4 和 IPv6 支持

云网络安全目前仅支持 IPv4 地址。如果您在内部使用 IPv6，必须对任何需要发送到云网络安全的 
IPv6 流量执行 NAT 64。

下表显示了云网络安全重定向支持的类映射流量：

类映射流量 云网络安全检测

从 IPv4 到 IPv4 支持

从 IPv6 到 IPv4 （使用 NAT64） 支持

从 IPv4 到 IPv6 不支持

从 IPv6 到 IPv6 不支持
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从主用代理服务器到备用代理服务器的故障转移

当您订用思科云网络安全服务时，您将被分配一台主用云网络安全代理服务器和一台备用代理服
务器。

如果任何客户端都无法到达主用服务器，则 ASA 开始轮询塔式服务器，以确定可用性。（如果没有
客户端活动，则 ASA 每 15 分钟轮询一次。）如果代理服务器在配置的重试次数 （默认为 5 次，此
设置可以配置）之后不可用，该服务器将被宣布为无法访问，进而备用代理服务器进入活动状态。

如果在达到重试计数之前，客户端或 ASA 至少能够连续两次到达该服务器，轮询将停止，而且塔
式服务器被确定可以访问。

在故障转移到备用服务器后， ASA 继续轮询主用服务器。如果主用服务器恢复为可以访问，则 
ASA 重新使用主用服务器。

思科云网络安全的许可证要求

在云网络安全端，您必须购买思科云网络安全许可证，并识别 ASA 处理的用户数量。然后，登录 
ScanCenter，生成身份验证密钥。

云网络安全先决条件

（可选）用户身份验证先决条件

要将用户身份信息发送到云网络安全，请在 ASA 上配置以下项目之一：

• AAA 规则 （仅用户名） - 请参阅旧版功能指南。

• IDFW （用户名和组） - 请参阅一般操作配置指南。

（可选）完全限定域名先决条件

如果您将 ACL 中的 FQDN 用于服务策略规则或云网络安全服务器，您必须根据一般操作配置指南
为 ASA 配置 DNS 服务器。

型号 许可证要求

ASAv 标准或高级许可证。

所有其他型号 强加密 (3DES/AES) 许可证，以加密安全设备和云网络安全服务器之间的流量。
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准则和限制

情景模式准则

支持单一和多情景模式。

在多情景模式中，仅允许在系统中进行服务器配置，并且仅允许在安全情景中进行服务器策略规则
配置。

如果需要的话，每个情景都可以拥有各自的身份验证密钥。

防火墙模式准则

仅支持路由防火墙模式。不支持透明防火墙模式。

IPv6 准则

不支持 IPv6。请参阅第 16-5 页的 IPv4 和 IPv6 支持。

附加准则

• 云网络安全不支持 ASA 集群。

• 无客户端 SSL VPN 不支持云网络安全，请务必将任何无客户端 SSL VPN 流量从 ASA 云网络安
全服务策略中免除。

• 当指向云网络安全代理服务器的接口发生故障时， show scansafe server 命令输出要花大约 
15-25 分钟才能显示出两台服务器。发生这种情况的原因是，轮询机制基于活动连接，而且接
口发生故障，显示零连接，所以采用了轮询时间最长的方法。

• 云网络安全不支持 ASA CX 模块。如果为同一流量配置 ASA CX 操作和云网络安全检测，则 
ASA 仅执行 ASA CX 操作。

• 对于同一流量，云网络安全检测兼容 HTTP 检测。 HTTP 检测作为默认全局策略的一部分默认
被启用。

• 云网络安全不支持扩展 PAT 或任何可能使用同一源端口和 IP 地址进行不同连接的应用。例如，
如果两个不同连接 （以不同服务器为目标）使用扩展 PAT， ASA 可能将同一源 IP 和源端口重
用于两个连接转换，因为对于不同目标来说它们是有区别的。当 ASA 将这些连接重定向到云网
络安全服务器时，会用云网络安全服务器 IP 地址和端口 （默认为 8080）替换目标。结果，两
个连接现在看起来属于同一流量 （相同源 IP/端口和目标 IP/端口），导致返回流量无法被适当
地反向转换。

• match default-inspection-traffic 命令 Default Inspection Traffic 流量类不包含云网络安全检测的默
认端口 （80 和 443）。

默认设置
默认情况下，不启用思科云网络安全。
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配置思科云网络安全
• 第 16-8 页的配置与云网络安全代理服务器的通信

• 第 16-9 页的 （多情景模式）根据安全情景允许云网络安全

• 第 16-9 页的配置服务策略，将流量发送到云网络安全

• 第 16-21 页的 （可选）配置白名单流量

• 第 16-24 页的配置云网络安全策略

配置与云网络安全代理服务器的通信

准则

公钥嵌入在 ASA 软件中，因此，您无需配置。

详细步骤

步骤 1 选择 Configuration > Device Management > Cloud Web Security。

步骤 2 在 Primary Server 区域，输入以下条目：

• IP Address/Domain Name - 输入主用服务器的 IPv4 地址或 FQDN。

• HTTP Port - 输入主用服务器的 HTTP 端口 （流量必须被重定向到该端口）。默认情况下，此端
口为 8080；除非您被要求更改，否则请勿更改此值。

步骤 3 在 Backup Server 区域，输入以下条目：

• IP Address/Domain Name - 输入备用服务器的 IPv4 地址或 FQDN。

• HTTP Port - 输入备用服务器的 HTTP 端口 （流量必须被重定向到该端口）。默认情况下，该端
口为 8080。有效值介于 1 到 65535 之间。
16-8
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 16 章      ASA 和思科云网络安全

  配置思科云网络安全
步骤 4 在 Other 区域，输入以下条目：

• Retry Counter - 在确定云网络安全代理服务器无法访问之前，输入服务器连续轮询失败的次数。
每 30 秒执行一次轮询。有效值介于 2 和 100 之间，默认为 5。

• License Key - 配置 ASA 发送到云网络安全代理服务器的身份验证密钥，指明请求来自哪个公
司。身份验证密钥是一个 16 字节的十六进制数字。请参阅第 16-2 页的身份验证密钥。

• Confirm License Key - 确认身份验证密钥。

步骤 5 点击 Apply。

（多情景模式）根据安全情景允许云网络安全

在多情景模式下，您必须根据情景允许云网络安全。有关详细信息，请参阅一般操作配置指南。

注 必须在管理员情景和特定情景中指定一个指向 Scansafe 塔式服务器的路由。这可以确保 Scansafe 塔
式服务器不会在主动/主动故障转移情境中变得无法访问。

配置服务策略，将流量发送到云网络安全

服务策略包括多条服务策略规则，这些规则被全局应用或者被应用到单个接口。每条服务策略规则
都可以将流量发送到云网络安全 （Match）或使流量免于被发送到云网络安全 （Do Not Match）。
为以互联网为目标的流量创建规则。这些规则的顺序非常重要。当 ASA 决定转发或免除数据包时，
ASA 会按照规则被列出的顺序，使用每条规则测试数据包。发现某个匹配后，不再检查其他规则。
例如，如果您在明确匹配所有流量的策略的开头创建规则，将不检查更多语句。添加规则后，您可
以按需重新排列规则。

有关服务策略规则的详细信息，请参阅第 1 章，“服务策略”。

先决条件

（可选）如果您需要使用白名单，使某些流量免于被发送到云网络安全，则首先根据第 16-21 页的
（可选）配置白名单流量创建白名单，以便在服务策略规则中参照此白名单。
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详细步骤

步骤 1 选择 Configuration > Firewall > Service Policy Rules，然后点击 Add > Service Policy Rule，添加服
务策略规则。

步骤 2 在 Service Policy 对话框中，您可以将云网络安全配置为新服务策略的一部分，或者编辑现有的服务
策略。点击 Next。

步骤 3 在 Traffic Classification Criteria 对话框中，命名流量类 （或者接受默认名称），使 Create a new 
traffic class 选项保持选中，点击 Source and Destination IP address (Uses ACL)，然后点击 Next。

创建这一类型的新流量类时，您最初只能指定一个访问控制条目 (ACE)。完成添加规则之后，您可
以将新规则添加到同一接口或全局策略，以添加附加 ACE，然后在 Traffic Classification 对话框中指
定 Add rule to existing traffic class。

系统将显示 Traffic Match - Source and Destination 对话框。
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a. 点击 Match 或 Do Not Match。

Match 指定将匹配源和目标的流量发送到云网络安全。Do Not Match 使匹配流量免于被发送到
云网络安全。您稍后可以添加附加规则，以匹配或不匹配其他流量。

创建规则时，请考虑如何匹配以互联网为目标的相应流量，但不匹配以其他内部网络为目标的
流量。例如，当目标为 DMZ 上的内部服务器时，为阻止内部流量被发送到云网络安全，请务
必将 deny ACE 添加到 ACL，使流量免于被发送到 DMZ。

b. 在 Source Criteria 区域，输入或浏览找到源 IP 地址或网络对象，可选的 IDFW 用户名或组，以
及可选的 TrustSec Security Group。

c. 在 Destination Criteria 区域，输入或浏览找到目标 IP 地址或网络对象，以及可选的 TrustSec 安
全组。

对于使流量匹配到或免于被发送到特定服务器， FQDN 网络对象可能比较有用。

d. 在 Service 字段中，输入 http 或 https，点击 Next。

注 云网络安全只能在 HTTP 和 HTTPS 流量上运行。每种类型的流量都被 ASA 单独处理。
因此，您需要创建仅 HTTP 规则 和仅 HTTPS 规则。

系统将显示 Rule Actions 对话框。

步骤 4 在 Protocol Inspection 选项卡上，选中 Cloud Web Security 复选框。

步骤 5 点击 Configure，设置流量操作 （失效开启或失效关闭），添加检测策略映射。

检测策略映射可以为规则配置基本参数，或者也可以识别白名单。对于您想发送到云网络安全的每
个流量类，都要求检测策略映射。您还可以从 Configuration > Firewall > Objects > Inspect Maps > 
Cloud Web Security 窗格预配置检测策略映射。

系统将显示 Select Cloud Web Security Inspect Map 对话框。
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a. 为云网络安全流量操作选择以下某项：

– Fail Close - 如果云网络安全服务器不可用，则将丢弃所有流量。

– Fail Open - 如果云网络安全服务器不可用，则将允许流量穿过 ASA。

b. 选择一个现有的检测策略映射，或者使用 Add 按钮，添加一个检测策略映射。

c. 点击 Add，添加新的检测策略映射。

系统将显示 Add Cloud Web Security Inspect Map 对话框。
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d. 在 Name 字段中，指定检测策略映射的名称，最大长度为 40 个字符。

e. （可选）编辑说明。

f. （可选）在 Parameters 选项卡上，指定 Default User 和/或 Default Group。如果 ASA 无法确定进
入 ASA 的用户的身份，则应用默认用户和/或组。

g. 对于 Protocol，请点击 HTTP 或 HTTPS，匹配您在步骤 3d 中设置的服务。云网络安全单独处
理每种类型的流量。

h. （可选）要识别白名单，请点击 Inspections 选项卡。

– 点击 Add，添加在第 16-21 页的 （可选）配置白名单流量中创建的检测类映射。

系统将显示 Add Cloud Web Security Match Criterion 对话框。

– 从 Cloud Web Security Traffic Class 下拉菜单中，选择一个检测类映射。

要添加或编辑类映射，请点击 Manage。

– 对于 Action，请点击 Whitelist。

– 点击 OK，将白名单添加到策略映射中。

– 点击 OK。

步骤 6 点击 Finish。规则已添加到 Service Policy Rules 表。
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步骤 7 要添加该流量类的附加子规则 (ACE)，匹配或免除其他流量：

a. 请选择 Configuration > Firewall > Service Policy Rules，点击 Add > Service Policy Rule。

b. 选择与步骤 2 中相同的服务策略。点击 Next。

c. 在 Traffic Classification Criteria 对话框中，选择 Add Rule to Existing Traffic Class，并选择在步
骤 3 中创建的名称。点击 Next。
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d. 在 Traffic Match - Source and Destination 对话框中，选择 Match，添加检测附加流量，或者选择 
Do Not Match，使流量免受云网络安全的检测。请务必将服务设置为匹配该类的先前规则
（HTTP 或 HTTPS）；您无法为云网络安全在同一流量类中同时采用 HTTP 和 HTTPS。点击 
Next。

e. 请勿在 Rule Actions 对话框中做任何更改；点击 Finish。对于该流量类，即使您添加多个 ACE，
也只能有一套规则操作，因此，以前指定的操作将被继承。

步骤 8 重复这一完整操作步骤，创建附加流量类，例如， HTTPS 流量类。您可以按需创建多项规则和子
规则。

步骤 9 在 Service Policy Rules 窗格中，安排云网络安全规则和子规则的顺序。请参阅第 1-13 页的管理服务
策略规则的顺序，了解有关更改 ACE 顺序的详细信息。
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步骤 10 点击 Apply。

示例

以下示例使所有 IPv4 HTTP 和 HTTPS 流量免于被发送到 10.6.6.0/24 (test_network)，并且将所有其他 
HTTPS 和 HTTPS 流量发送到云网络安全，并将该服务策略规则作为现有全局策略的一部分应用到
所有接口。如果云网络安全服务器无法访问，ASA 将丢弃所有匹配流量（失效关闭）。如果用户没
有用户身份信息，则使用默认用户 Boulder 和组 Cisco。

步骤 1 请选择 Configuration > Firewall > Service Policy Rules，点击 Add > Service Policy Rule。将该规则
添加到 global_policy：
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步骤 2 添加被称作 “scansafe-http”的新流量类，并指定用于流量匹配的 ACL：

步骤 3 选择 Match，并将 Source 和 Destination 指定为 any4。将 Service 指定为 tcp/http。

步骤 4 选中 Cloud Web Security，然后点击 Configure。
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步骤 5 接受默认 Fail Close 操作，然后点击 Add。

步骤 6 将检测策略映射命名为 “http-map”，将默认用户设置为 Boulder，将默认组设置为 Cisco。选择 
HTTP。

步骤 7 点击 OK 和 OK，然后点击 Finish。规则已添加到 Service Policy Rules 表。
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步骤 8 请选择 Configuration > Firewall > Service Policy Rules，点击 Add > Service Policy Rule。将新规则
添加到 global_policy：

步骤 9 点击 Add rule to existing traffic class，然后选择 scansafe-http。
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步骤 10 选择 Do not match，将 Source 设置为 any4，将 Destination 设置为 10.6.6.0/24。将 Service 设置为 
tcp/http。

步骤 11 点击 Finish。
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步骤 12 重新排列规则，使 Do not match 规则在 Match 规则上方。

按顺序比较用户流量和这些规则；如果此 Match 规则是列表中的第一条规则，所有流量（包括发送
到 test_network 的流量）仅匹配此规则，Do not match 规则将永远不会被匹配。如果将 Do not match 
规则移动到 Match 规则上方，发送到 test_network 的流量将匹配 Do not match 规则，所有其他流量将
匹配 Match 规则。

步骤 13 重复上述步骤并做出以下更改：添加被称作 “scansafe-https”的新流量类，为检测策略映射选择 
HTTPS。

步骤 14 点击 Apply。

（可选）配置白名单流量

如果您使用用户身份验证，可以根据用户名和/或组名，使某些流量免于被云网络安全过滤。配置
云网络安全服务策略规则时，您可以参考白名单检测类映射。 IDFW 和 AAA 用户凭证均可以与此
功能一起使用。

尽管配置服务策略规则时实现的结果与根据用户或组免除流量实现的结果相同，但您可能发现，使
用白名单更简单。请注意，白名单功能仅基于用户和组，不基于 IP 地址。
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详细步骤

步骤 1 选择 Configuration > Firewall > Objects > Class Maps > Cloud Web Security。

步骤 2 点击 Add，创建新的类映射。

系统将显示 Add Cloud Web Security Traffic Class Map 屏幕。

步骤 3 在 Name 字段中，输入新类映射的名称 （40 个或更少字符）。

步骤 4 在 Description 字段中，为类映射提供说明 （200 个或更少字符）。

步骤 5 为您点击 Add 时定义的条件选择 Match Option：

• Match All - 指定流量必须匹配所有条件才能匹配类映射。

• Match Any - 指定如果流量匹配至少一个条件则匹配类映射。

步骤 6 点击 Add。

系统将显示 Add Cloud Web Security Match Criterion Window 对话框。

步骤 7 选择 Match Type：

• Match - 指定您想列入白名单的用户和/或组。

• No Match - 指定您不想列入白名单的用户和/或组；例如，如果您将组“cisco”列入白名单，但
想扫描来自用户 “johncrichton”和 “aerynsun”的流量，您可以为这些用户指定 No Match。

步骤 8 选择 Match Criterion：

• User - 指定用户。

• Group - 指定组。

• User and Group - 指定用户和组。

步骤 9 点击 OK。

步骤 10 按需继续添加匹配条件。

步骤 11 点击 OK，添加类映射。
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步骤 12 点击 Apply。

步骤 13 根据第 16-9 页的配置服务策略，将流量发送到云网络安全，在云网络安全策略中使用白名单。

（可选）配置用户身份监控

使用 IDFW 时，ASA 仅为包含在活动 ACL 中的用户和组从 AD 服务器下载用户身份信息；该 ACL 
必须在访问规则、 AAA 规则、服务、策略规则等功能或者被视为活动的其他功能中使用。因为云
网络安全可以使其策略以用户身份为基础，所以您可能需要下载不包含在活动 ACL 中的组，使 
IDFW 覆盖所有用户。例如，尽管您可以配置云网络安全服务策略规则使用带用户和组的 ACL，从
而激活任何相关组，但这不是必需的；您可以使用完全基于 IP 地址的 ACL。通过用户身份监控功
能，您可以让直接从 AD 代理下载组信息。

限制

ASA 最多只能监控 512 个组，包括为用户身份监控配置的组和通过活动 ACL 监控的组。

详细步骤

步骤 1 选择 Configuration > Firewall > Identity Options，滚动到 Cloud Web Security Configuration 部分。

步骤 2 点击 Add。

系统将显示 Add Monitor User 对话框。

步骤 3 要添加域，请点击 Manage，然后点击 Add。您只能监控在 ASA 上预定义的域的组。

系统将显示 Configure Identity Domains 对话框。有关添加域的详细信息，请参阅一般操作配置指南。

步骤 4 域添加完成后，点击 OK。

步骤 5 您可以键入组名，或者在 AD 代理上按域搜索组。

• 要直接键入组名，请按以下格式在底部字段中输入名称，点击 OK：

domain-name\\group

• 要在 AD 代理上搜索组，请执行以下操作：

a. 从 Domain 下拉列表中选择域。

b. 在 Find 字段中，输入匹配组名的文本字符串，然后点击 Find。

ASA 从 AD 代理下载指定域的名称。

c. 双击您想监控的名称；此名称已添加到底部字段。

d. 点击 OK。

重复此操作，添加附加组。

步骤 6 添加想要监控的组后，点击 Apply。
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配置云网络安全策略

配置 ASA 服务策略规则后，启动 ScanCenter Portal，配置网络内容扫描、过滤、恶意软件检查服务
和报告。

详细步骤

转至：https://scancenter.scansafe.com/portal/admin/login.jsp。

有关详细信息，请参阅 《思科 ScanSafe 云网络安全配置指南》：

http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html

监控云网络安全

相关文档 

命令 用途

Monitoring > Properties > Cloud Web Security 显示服务器状态，无论是当前的活动服务器、备用服务器，还是无法
访问的服务器。

显示全部和当前 HTTP(S) 连接。在多情景模式下，仅在一个情景中显
示统计信息。

请参见以下 URL：

http://Whoami.scansafe.net

从客户端访问此网站，确定流量是否流向到云网络安全服务器。

相关文档 URL

思科 ScanSafe 云网络安全配置指南 http://www.cisco.com/en/US/products/ps11720/products_installation_
and_configuration_guides_list.html
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功能历史思科云网络安全
表 16-1 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

表 16-1 功能历史云网络安全

功能名称 平台版本 功能信息

云网络安全 9.0(1) 引入了此功能。

思科云网络安全为网络流量提供内容扫描和其他恶意软
件防护服务。还能够根据用户身份重定向网络流量和提
交相关报告。

我们引入或修改了以下屏幕：

Configuration > Device Management > Cloud Web Security
Configuration > Firewall > Objects > Class Maps > Cloud Web 
Security
Configuration > Firewall > Objects > Class Maps > Cloud Web 
Security > Add/Edit 
Configuration > Firewall > Objects > Inspect Maps > Cloud 
Web Security
Configuration > Firewall > Objects > Inspect Maps > Cloud 
Web Security > Add/Edit 
Configuration > Firewall > Objects > Inspect Maps > Cloud 
Web Security > Add/Edit > Manage Cloud Web Security Class 
Maps
Configuration > Firewall > Identity Options
Configuration > Firewall > Service Policy Rules 
Monitoring > Properties > Cloud Web Security
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17第 章
威胁检测

本章介绍如何配置威胁检测统计信息和扫描威胁检测。

• 第 17-1 页的检测威胁

• 第 17-3 页的威胁检测准则

• 第 17-3 页的威胁检测的默认设置

• 第 17-4 页的配置威胁检测

• 第 17-6 页的监控威胁检测

• 第 17-7 页的威胁检测历史

检测威胁
ASA 上的威胁检测可以针对威胁提供第一道防御。威胁检测在第 3 层和第 4 层上工作，为设备上的
流量制定基准，基于流量模式分析丢包统计信息，以及累计 “前面的”报告。相比之下，提供 IPS 
或下一代 IPS 服务的模块可以在 ASA 允许的流量上识别和减少高达第 7 层的攻击媒介，并且无法看
到已被 ASA 丢弃的流量。因此，威胁检测和 IPS 能够协同工作，以提供更加全面的威胁防御。

威胁检测由以下要素组成：

• 为各种威胁收集的不同级别统计信息。

威胁检测统计信息可以帮助您管理 ASA 遭遇的威胁；例如，如果启用扫描威胁检测，则查看统
计信息有助于分析威胁。您可以配置两种类型的威胁检测统计信息：

– 基础威胁检测统计信息 - 包括有关针对整个系统的攻击活动的信息。默认情况下启用基础
威胁检测统计信息，并且不会对性能产生影响。

– 高级威胁检测统计信息 - 跟踪对象级活动，因此， ASA 能够报告针对单个主机、端口、协
议或 ACL 的活动。高级威胁检测统计信息会对性能产生重要影响，具体情况视收集的统计
信息而定，因此，在默认情况下，仅启用 ACL 统计信息。

• 扫描威胁检测，其确定主机何时执行扫描。或者，您可以避开任何被确定为扫描威胁的主机。
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基础威胁检测统计信息

使用基础威胁检测统计信息， ASA 监控由以下原因造成的丢包和安全事件比率：

• 被 ACL 拒绝。

• 数据包格式不对 （例如， invalid-ip-header 或 invalid-tcp-hdr-length）。

• 超出连接限制 （系统范围的资源限制和在配置中设定的限制）。

• 检测到 DoS 攻击 （例如，无效 SPI、状态防火墙检查故障）。

• 基础防火墙检查失败。此选项是一个组合比率，包含此列表中所有与防火墙有关的丢包。它不
包含与防火墙无关的丢包，例如接口过载、应用检测失败的数据包以及检测到的扫描攻击。

• 检测到可疑的 ICMP 数据包。

• 数据包未通过应用检测。

• 接口过载。

• 检测到扫描攻击。此选项监控扫描攻击；例如，第一个 TCP 数据包不是 SYN 数据包，或者 
TCP 连接在三次握手时失败。例如，完整扫描威胁检测采用此扫描攻击比率信息，通过将主机
分类为攻击者并自动避开它们，从而对此信息发挥作用。

• 检测到不完整会话，例如，检测到 TCP SYN 攻击或未检测到数据 UDP 会话攻击。

当 ASA 检测威胁时，它会立即发送系统日志消息 (733100)。 ASA 跟踪两种类型的比率：间隔期间
的平均事件比率和较短爆发间隔期间的突发事件比率。突发率间隔为三十分之一平均率间隔或 10 
秒，以较大者为准。对于收到的每个事件， ASA 检查平均和突发率限制；如果超出了两个比率，
ASA 会发送两条独立的系统消息，每突发时期每比率类型最多一条消息。

基础威胁检测仅在有丢包或潜在威胁时影响性能；甚至在这种情况下，性能影响也微乎其微。

高级威胁检测统计信息

高级威胁检测统计信息显示单个对象（例如，主机、端口、协议或 ACL）允许和丢弃的流量比率。

注意事项 启用高级统计信息会影响 ASA 性能，具体情况视启用的统计信息类型而定。启用主机统计信息会
显著影响性能；如果有高流量负载，您可能会考虑临时启用此类型的统计信息。然而，端口统计信
息会产生轻微影响。

扫描威胁检测

典型的扫描攻击包括测试子网中每个 IP 地址的可访问性的主机 （通过扫描子网中的多台主机，或
者扫描主机或子网中的多个端口）。扫描威胁检测功能可以确定主机何时执行扫描。与基于流量签
名的 IPS 扫描检测不同，ASA 威胁检测扫描可以维护一个庞大的数据库，其中包含可面向扫描活动
进行分析的主机统计信息。

主机数据库跟踪可疑活动，例如无返回活动的连接、已关闭访问端口的访问、易受攻击的 TCP 行
为 （例如，非随机 IPID）和更多行为。

如果超出扫描威胁比率，则 ASA 发送系统日志消息 (733101)，并且或者避开攻击者。 ASA 跟踪两
种类型的比率：间隔期间的平均事件比率和较短爆发间隔期间的突发事件比率。突发事件比率为三
十分之一平均率间隔或 10 秒，以较大者为准。对于每个已检测到的被视为扫描攻击的一部分的事
件，ASA 检查平均和突发率限制。如果从主机发送的流量超出了其中任意一个比率，则该主机被视
为攻击者。如果主机接收的流量超出了其中任意一个比率，则该主机被视为攻击目标。
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下表列出了扫描威胁检测的默认比率限制。

注意事项 扫描威胁检测功能可以显著影响 ASA 性能和内存，同时创建和收集基于主机和子网的数据结构和
信息。

威胁检测准则

安全情景准则

除了高级威胁统计信息，仅支持单一模式的威胁检测。在多模式下，仅支持 TCP 拦截统计信息。

防火墙模式准则

在路由和透明防火墙模式下受支持。

监控的流量类型

• 仅监控通过设备的流量；流向设备的流量不包含在威胁检测中。

• ACL 拒绝的流量不触发扫描威胁检测；仅允许通过 ASA 并且创建流的流量才会受扫描威胁检
测的影响。

威胁检测的默认设置
默认情况下，启用基础威胁检测统计信息。

下表列出了默认的设置。您可以使用 Tools > Command Line Interface 中的 show running-config all 
threat-detection 命令查看所有这些默认设置。

对于高级统计信息，默认情况下，启用 ACL 统计信息。

表 17-1 扫描威胁检测的默认比率限制

平均率 突发率

在最后 600 秒内，每秒丢弃 5 次。 在最后 20 秒内，每秒丢弃 10 次。

在最后 3600 秒内，每秒丢弃 5 次。 在最后 120 秒内，每秒丢弃 10 次。

表 17-2 基础威胁检测默认设置

丢包原因

触发设置

平均率 突发率

• 检测到 DoS 攻击

• 数据包格式不对

• 超出连接限制

• 检测到可疑的 ICMP 数据包

在最后 600 秒内，每秒丢弃 
100 次。

在最后 20 秒内，每秒丢弃 
400 次。

在最后 3600 秒内，每秒丢弃 
80 次。

在最后 120 秒内，每秒丢弃 
320 次。
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配置威胁检测
默认情况下，启用基础威胁检测统计信息，而且您可能只需要威胁检测服务。如果要实施其他威胁
检测服务，请使用以下操作步骤。

操作步骤

步骤 1 第 17-5 页的配置基础威胁检测统计信息。

基础威胁检测统计信息包括可能与攻击 （例如， DoS 攻击）有关的活动。

步骤 2 第 17-5 页的配置高级威胁检测统计信息。

步骤 3 第 17-6 页的配置扫描威胁检测。

检测到扫描攻击 在最后 600 秒内，每秒丢弃 
5 次。

在最后 20 秒内，每秒丢弃 
10 次。

在最后 3600 秒内，每秒丢弃 
4 次。

在最后 120 秒内，每秒丢弃 
8 次。

检测到不完整会话，例如，检测到 
TCP SYN 攻击或未检测到数据 
UDP 会话攻击 （组合）

在最后 600 秒内，每秒丢弃 
100 次。

在最后 20 秒内，每秒丢弃 
200 次。

在最后 3600 秒内，每秒丢弃 
80 次。

在最后 120 秒内，每秒丢弃 
160 次。

被 ACL 拒绝 在最后 600 秒内，每秒丢弃 
400 次。

在最后 20 秒内，每秒丢弃 
800 次。

在最后 3600 秒内，每秒丢弃 
320 次。

在最后 120 秒内，每秒丢弃 
640 次。

• 基础防火墙检查失败

• 数据包未通过应用检测

在最后 600 秒内，每秒丢弃 
400 次。

在最后 20 秒内，每秒丢弃 
1600 次。

在最后 3600 秒内，每秒丢弃 
320 次。

在最后 120 秒内，每秒丢弃 
1280 次。

接口过载 在最后 600 秒内，每秒丢弃 
2000 次。

在最后 20 秒内，每秒丢弃 
8000 次。

在最后 3600 秒内，每秒丢弃 
1600 次。

在最后 120 秒内，每秒丢弃 
6400 次。

表 17-2 基础威胁检测默认设置 （续）

丢包原因

触发设置

平均率 突发率
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配置基础威胁检测统计信息

默认情况下，启用基础威胁检测统计信息。您可以禁用此功能，或者，如果已禁用，可以再次启用。

操作步骤

步骤 1 选择 Configuration > Firewall > Threat Detection。

步骤 2 按需选择或取消选择 Enable Basic Threat Detection。

步骤 3 点击 Apply。

配置高级威胁检测统计信息

您可以将 ASA 配置为收集大量的统计信息。默认情况下，启用 ACL 统计信息。要启用其他统计信
息，请执行以下步骤。

操作步骤

步骤 1 选择 Configuration > Firewall > Threat Detection。

步骤 2 在 Scanning Threat Statistics 区域，选择以下选项之一：

• Enable All Statistic。

• Disable All Statistics。

• Enable Only Following Statistics。

步骤 3 如果选择 Enable Only Following Statistics，则选择以下一个或多个选项：

• Hosts - 启用主机统计信息。只要主机处于活动状态并且位于扫描威胁主机数据库内，主机统计
信息就会累计。非活动时间超过 10 分钟后，将从数据库中删除主机 （并且统计信息被清除）。

• Access Rules （默认情况下启用） - 启用访问规则统计信息。

• Port - 启用 TCP 和 UDP 端口统计信息。

• Protocol - 启用非 TCP/UDP IP 协议统计信息。

• TCP-Intercept - 启用 TCP 拦截所拦截的攻击的统计信息 （请参阅第 13-7 页的配置连接设置以
启用 TCP 拦截）。

步骤 4 对于主机、端口和协议统计信息，您可以更改收集的比率间隔数量。在 Rate Intervals 区域，为每个
统计信息类型选择 1 hour、 1 and 8 hours 或 1, 8 and 24 hours。默认间隔为 1 hour，使内存使用率
保持低位。

步骤 5 对于 TCP 拦截统计信息，您可以在 TCP Intercept Threat Detection 区域设置以下选项：

• Monitoring Window Size - 设置历史监控窗口的大小，该值在 1 和 1440 分钟之间。默认值为 30 
分钟。在比率间隔内，ASA 抽取攻击数量样本 30 次，因此，在默认的 30 分钟内，每 60 秒收集
一次统计信息。

• Burst Threshold Rate - 为系统日志消息生成设置阈值，该值在 25 和 2147483647 之间。默认值
为每秒 400。超出突发率时，生成系统日志消息 733104。

• Average Threshold Rate - 为系统日志消息生成设置平均率阈值，该值在 25 和 2147483647 之
间。默认值为每秒 200。超出平均率时，生成系统日志消息 733105。
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点击 Set Default 以还原默认值。

步骤 6 点击 Apply。

配置扫描威胁检测

您可以配置扫描威胁检测，以识别攻击者，并或者避开它们。

操作步骤

步骤 1 选择 Configuration > Firewall > Threat Detection。

步骤 2 选择 Enable Scanning Threat Detection。

步骤 3 （可选）要在 ASA 将主机识别为攻击者时自动终止主机连接，请选择 Shun Hosts detected by 
scanning threat，并按需填写这些选项：

• 要使主机 IP 地址免于被避开，请在 Networks excluded from shun 字段中输入网络对象的地址或
名称。您可以输入多个地址或子网，用逗号隔开它们。要从 IP 地址对象列表中选择网络，请点
击 ... 按钮。

• 要为攻击主机设置避开持续时间，请选择 Set Shun Duration，并输入一个介于 10 和 2592000 秒
的值。默认时长为 3600 秒 （1 小时）。要还原默认值，请点击 Set Default。

步骤 4 点击 Apply。

监控威胁检测
以下主题解释如何监控威胁检测和查看流量统计信息。

• 第 17-6 页的监控基础威胁检测统计信息

• 第 17-7 页的监控高级威胁检测统计信息

监控基础威胁检测统计信息

选择 Home > Firewall Dashboard > Traffic Overview，以查看基础威胁检测统计信息。
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监控高级威胁检测统计信息

您可以使用以下控制面板监控高级威胁统计信息：

• Home > Firewall Dashboard > Top 10 Access Rules - 显示命中最多的访问规则。在此图形中不区
分允许和拒绝。您可以在 Traffic Overview > Dropped Packets Rate 图形中跟踪被拒绝的流量。

• Home > Firewall Dashboard > Top Usage Statistics - Top 10 Sources 和 Top 10 Destinations 选项
卡显示主机统计信息。由于威胁检测算法，用作组合故障转移和状态链接的接口会在前 10 台主
机中显示；这是预期行为，而且您可以在显示内容中忽略此 IP 地址。

Top 10 Services 选项卡显示端口和协议统计信息 （必须为显示内容启用两者），并且显示 
TCP/UDP 端口和 IP 协议类型的组合统计信息。TCP（协议 6）和 UDP（协议 17）不包含在 IP 
协议显示内容中；然而，TCP 和 UDP 端口包含在端口显示内容中。如果仅启用这些类型中一个
类型 （端口或协议）的统计信息，则只能查看启用的统计信息。

• Home > Firewall Dashboard > Top Ten Protected Servers under SYN Attack - 显示 TCP 拦截统
计信息。点击 Detail 按钮，以显示历史取样数据。在比率间隔内， ASA 抽取攻击数量样本 30 
次，因此，在默认的 30 分钟内，每 60 秒收集一次统计信息。

威胁检测历史

功能名称 平台版本 说明

基础和高级威胁检测统计信息、扫描威胁检测 8.0(2) 引入了基础和高级威胁检测统计信息、扫描威胁检测。

 引入了以下屏幕：Configuration > Firewall > Threat 
Detection, Home > Firewall Dashboard > Traffic Overview, 
Home > Firewall Dashboard > Top 10 Access Rules, Home > 
Firewall Dashboard > Top Usage Status, Home > Firewall 
Dashboard > Top 10 Protected Servers Under SYN Attack。

避开持续时间 8.0(4)/8.1(2) 您现在可以设置避开持续时间。

修改了以下屏幕：Configuration > Firewall > Threat 
Detection。

TCP 拦截统计信息 8.0(4)/8.1(2) 引入了 TCP 拦截统计信息。

引入或修改了以下屏幕：Configuration > Firewall > 
Threat Detection, Home > Firewall Dashboard > Top 10 
Protected Servers Under SYN Attack。

自定义主机统计信息比率间隔 8.1(2) 现在，您可以自定义收集统计信息的比率间隔数。默认比
率数已从 3 更改为 1。

修改了以下屏幕：Configuration > Firewall > Threat
Detection。

突发率间隔已更改为三十分之一平均率 8.2(1) 在早期版本中，突发率间隔为六十分之一平均率。为最大
限度利用内存，取样间隔已在平均率中减少到 30 次。

自定义端口和协议统计信息比率间隔 8.3(1) 现在，您可以自定义收集统计信息的比率间隔数。默认比
率数已从 3 更改为 1。

修改了以下屏幕：Configuration > Firewall > Threat 
Detection。

提高内存使用率 8.3(1) 提高了威胁检测的内存使用率。
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18第 章
ASA FirePOWER (SFR) 模块

本章介绍如何配置在 ASA 上运行的 ASA FirePOWER 模块。

• 第 18-1 页的 ASA FirePOWER 模块

• 第 18-5 页的 ASA FirePOWER 模块的许可要求

• 第 18-5 页的 ASA FirePOWER 的准则

• 第 18-6 页的 ASA FirePOWER 的默认设置

• 第 18-6 页的配置 ASA FirePOWER 模块

• 第 18-17 页的管理 ASA FirePOWER 模块

• 第 18-21 页的监控 ASA FirePOWER 模块

• 第 18-23 页的 ASA FirePOWER 模块的历史记录

ASA FirePOWER 模块
ASA FirePOWER 模块提供下一代防火墙服务，包括下一代 IPS (NGIPS)、应用可视性与控制 
(AVC)、 URL 过滤以及高级恶意软件防护 (AMP)。该模块既可在单情景模式或多情景模式下使用，
也可在路由模式或透明模式下使用。

该模块也称为 ASA SFR。

虽然该模块提供用于初始配置和故障排除的基本命令行界面 (CLI)，但可使用独立的应用 
FireSIGHT 管理中心配置设备上的安全策略，该应用可托管在独立的 FireSIGHT 管理中心设备上，
也可作为在 VMware 服务器上运行的虚拟设备进行托管。（FireSIGHT 管理中心也称为防御中心。）

• 第 18-2 页的 ASA FirePOWER 模块如何与 ASA 配合使用

• 第 18-3 页的 ASA FirePOWER 管理访问权限

• 第 18-4 页的与 ASA 功能的兼容性
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ASA FirePOWER 模块如何与 ASA 配合使用

ASA FirePOWER 模块从 ASA 运行独立的应用。本模块可以是一个硬件模块 （适用于 ASA 
5585-X），也可以是一个软件模块 （适用于 5512-X 至 5555-X）。作为硬件模块，设备包括独立的
管理和控制台端口，以及由 ASA 直接使用 （而非由模块本身使用）的额外数据接口。

可在被动 （“仅监控”）或内联部署中配置设备。

• 在被动部署中，流量的副本发送至设备，但不返回至 ASA。在被动模式，可在不影响网络的情
况下查看设备本来会对流量执行的操作，并对流量的内容进行评估。

• 在内联部署中，实际流量发送至设备，并且设备的策略会影响将对流量执行的操作。在丢弃不
需要的流量并执行由策略应用的任何其他操作后，流量返回至 ASA，以供进一步处理和最终
传输。

以下各节对这些模式进行了更详细地说明。

ASA FirePOWER 内联模式

在内联模式下，流量先接受防火墙检查，然后再转发至 ASA FirePOWER 模块。在确定了要在 ASA 
上接受 ASA FirePOWER 检测的流量之后，这些流量将按以下方式流经 ASA 和模块：

1. 流量进入 ASA。

2. 对传入的 VPN 流量解密。

3. 应用防火墙策略。

4. 流量发送至 ASA FirePOWER 模块。

5. ASA FirePOWER 模块向流量应用其安全策略，并执行相应的操作。

6. 有效流量发回 ASA；ASA FirePOWER 模块可能根据其安全策略阻止某些流量，被阻止的流量
将不传递下去。

7. 对传出的 VPN 流量加密。

8. 流量退出 ASA。

下图显示在内联模式下使用 ASA FirePOWER 模块时的流量流。在此示例中，模块阻止不允许某个
应用使用的流量。所有其他流量均通过 ASA 转发。

图 18-1 ASA 中的 ASA FirePOWER 模块流量流

ASA

Main System

ASA FirePOWER

Diverted Traffic

ASA FirePOWER
inspection

VPN
Decryption

Firewall
Policy

Block

inside outside
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  ASA FirePOWER 模块
注 如果在两个 ASA 接口上有一个主机间的连接，且仅为其中一个接口配置了 ASA FirePOWER 服务策
略，则这些主机间的所有流量均发送至 ASA FirePOWER 模块，包括来自非 ASA FirePOWER 接口
的流量 （因为该功能是双向的）。

ASA FirePOWER 被动（仅监控）模式

仅监控模式下的流量流与内联模式下的流量流一样。唯一的差异在于 ASA FirePOWER 模块不将流
量传回 ASA。相反，模块向流量应用安全策略，并告知您其在内联模式下运行时将会完成的操作，
例如，流量可能会在事件中被标记为 “可能已丢弃”。您可使用此信息进行流量分析并帮助您决定
是否需要内联模式。

要配置被动模式，请在将流量重定向至模块的服务策略中包括仅监控指示。

注 无法在 ASA 上同时配置仅监控模式和正常内联模式。只允许一种类型的安全策略。在多情景模式
下，无法为某些情景配置仅监控模式，并同时为其他情景配置常规内联模式。

下图显示在被动模式下运行时的流量流。

图 18-2 ASA FirePOWER 被动、仅监控模式

ASA FirePOWER 管理访问权限

有两个用于管理 ASA FirePOWER 模块的独立访问层：初始配置（以及后续故障排除）和策略管理。

• 第 18-4 页的初始配置

• 第 18-4 页的策略配置和管理
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初始配置

为了执行初始配置，必须使用 ASA FirePOWER 模块上的 CLI。有关默认管理地址的信息，请参阅
第 18-6 页的 ASA FirePOWER 的默认设置。

要访问 CLI，您可以使用以下方法：

• ASA 5585-X：

– ASA FirePOWER 控制台端口 - 模块上的控制台端口是一个独立的外部控制台端口。

– ASA FirePOWER 管理 1/0 接口（使用 SSH）- 可连接至默认 IP 地址或使用 ASDM 更改管理 
IP 地址，然后使用 SSH 进行连接。模块上的管理接口是一个独立的外部千兆以太网接口。

注 无法使用 session 命令访问 ASA 背板上的 ASA FirePOWER 硬件模块 CLI。

• ASA 5512-X 至 ASA 5555-X：

– 背板上的 ASA 的会话 - 如对 ASA 有 CLI 访问权，则可向模块发起会话并访问模块 CLI。

– ASA FirePOWER 管理 0/0 接口（使用 SSH）- 可连接至默认 IP 地址或使用 ASDM 更改管理 
IP 地址，然后使用 SSH 进行连接。这些模式将 ASA FirePOWER 模块作为软件模块运行。
ASA FirePOWER 管理接口与 ASA 共用管理 0/0 接口。 ASA 和 ASA FirePOWER  模块分别
支持不同的 MAC 地址和 IP 地址。ASA FirePOWER IP 地址的配置必须在 ASA FirePOWER 
操作系统内进行 （使用 CLI 或 ASDM）。但是，物理特性 （例如启用接口）在 ASA 上配
置。可移除 ASA 接口配置 （特别是接口名称），以便将此接口专门用作纯 ASA 
FirePOWER 接口。此接口仅用于管理。

策略配置和管理

在执行初始配置后，请使用 FireSIGHT 管理中心配置 ASA FirePOWER 安全策略。然后，使用 
ASDM 或思科安全管理器配置用于将流量发送至 ASA FirePOWER 模块的 ASA 策略。

与 ASA 功能的兼容性

ASA 提供许多高级应用检测功能，包括 HTTP 检测。但是， ASA FirePOWER 模块提供的 HTTP 检
测比 ASA 提供的更高级 检测，该模块还提供适用于其他应用的附加功能，包括监控和控制应用使
用情况。

要充分利用 ASA FirePOWER 模块功能，请参阅以下适用于发送至 ASA FirePOWER 模块的流量的
准则：

• 请勿对 HTTP 流量配置 ASA 检测。

• 请勿配置云网络安全 (ScanSafe) 检测。如果为同一流量配置 ASA FirePOWER 检测和云网络安
全检测，则 ASA 仅执行 ASA FirePOWER 检测。

• ASA 上的其他应用检测与 ASA FirePOWER 模块兼容，包括默认检测。

• 请勿启用移动用户安全 (MUS) 服务器；它不与 ASA FirePOWER 模块兼容。

• 如果启用故障转移，则当 ASA 进行故障转移时，任何现有 ASA FirePOWER 流均传输至新 
ASA。新 ASA 中的 ASA FirePOWER 模块自此开始向前检测流量；将不传输旧检测状态。
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ASA FirePOWER 模块的许可要求
ASA FirePOWER 模块和 FireSIGHT 管理中心需要附加许可证，这些许可证需要安装在模块中，而
不是安装在 ASA 情景中。 ASA 本身不需要附加许可证。

请参阅《FireSIGHT 系统用户指南》的“许可”章节或 FireSIGHT 管理中心中的在线帮助，了解详
细信息。

ASA FirePOWER 的准则

故障转移准则

不支持直接故障转移；当 ASA 进行故障转移时，任何现有 ASA FirePOWER 流均传输至新的 ASA。
新 ASA 中的 ASA FirePOWER 模块自此开始向前检测流量；将不传输旧检测状态。

您负责在高可用性 ASA 对中的 ASA FirePOWER 模块上维护一致的策略 （使用 FireSIGHT 管理中
心），以确保一致的故障转移行为。

ASA 集群准则

不支持直接集群，但可在集群中使用这些模块。您负责使用 FireSIGHT 管理中心在集群中的 ASA 
FirePOWER 模块上维护一致的策略。请勿对集群中的设备使用不同的基于 ASA 接口的区域定义。

型号准则

• 在 ASA 5585-X （作为硬件模块）和 5512-X 至 ASA 5555-X （作为软件模块）上受到支持。有
关详细信息，请参阅 《思科 ASA 兼容性矩阵》：

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

• 对于 5512-X 至 ASA 5555-X，必须安装思科固态硬盘 (SSD)。有关详细信息，请参阅 《ASA 
5500-X 硬件指南》。

附加准则和限制

• 请参阅第 18-4 页的与 ASA 功能的兼容性。

• 无法更改安装在硬件模块上的软件类型；如果购买 ASA FirePOWER 模块，则以后无法在该模
块上安装其他软件。

• 无法在 ASA 上同时配置仅监控模式和正常内联模式。只允许一种类型的安全策略。在多情景模
式下，无法为某些情景配置仅监控模式，并同时为其他情景配置常规内联模式。
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ASA FirePOWER 的默认设置
下表列出 ASA FirePOWER 模块的默认设置。

配置 ASA FirePOWER 模块
配置 ASA FirePOWER 模块这个过程包括：先在 ASA FirePOWER 模块上配置 ASA FirePOWER 安全
策略，然后配置 ASA 以发送流量至 ASA FirePOWER 模块。要配置 ASA FirePOWER 模块，请执行
以下步骤：

步骤 1 第 18-7 页的连接 ASA FirePOWER 管理接口。为 ASA FirePOWER 管理接口和或者控制台接口布线。

步骤 2 第 18-9 页的 （ASA 5512-X 至 5555-X）安装或重新映像软件模块。

步骤 3 如有必要，请参阅第 18-13 页的更改 ASA FirePOWER 管理 IP 地址。初次 SSH 访问可能要求此操作。

步骤 4 第 18-13 页的在 ASA FirePOWER CLI 配置基本 ASA FirePOWER 设置。您在 ASA FirePOWER 模块
中执行此操作。

步骤 5 第 18-14 页的向 FireSIGHT 管理中心添加 ASA FirePOWER。这将确定将管理设备的 FireSIGHT 管理
中心。

步骤 6 第 18-15 页的在 ASA FirePOWER 模块上配置安全策略。

步骤 7 第 18-16 页的向 ASA FirePOWER 模块重定向流量。

表 18-1 ASA FirePOWER 默认网络参数

参数 默认值

管理 IP 地址 • 系统软件映像：192.168.45.45/24 

• 启动映像：

– ASA 5585-X：管理 1/0 192.168.8.8/24 

– ASA 5512-X 至 ASA 5555-X：管理 0/0 192.168.1.2/24 

网关 • 系统软件映像：无 

• 启动映像：

– ASA 5585-X：192.168.8.1/24 

– ASA 5512-X 至 ASA 5555-X：192.168.1.1/24 

SSH 或会话用户名 admin

密码 • 系统软件映像：Sourcefire 

• 启动映像：Admin123 
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连接 ASA FirePOWER 管理接口

除了提供对 ASA FirePOWER 模块的管理访问权限外，ASA FirePOWER 管理接口还需要访问 HTTP 
代理服务器或 DNS 服务器和互联网，以便进行签名更新等操作。本节描述推荐的网络配置。您的
网络可能不同。

ASA 5585-X （硬件模块）

ASA FirePOWER 模块包括一个独立于 ASA 的管理接口和控制台接口。为了执行初始设置，可通过 
SSH 使用默认 IP 地址连接至 ASA FirePOWER 管理 1/0 接口。如果无法使用默认 IP 地址，则可使用
控制台端口，或使用 ASDM 来更改管理 IP 地址，以便使用 SSH。（请参阅第 18-13 页的更改 ASA 
FirePOWER 管理 IP 地址。）

如果有内部路由器

如果有内部路由器，则可在管理网络 （可能同时包括 ASA 管理 0/0 接口和 ASA FirePOWER 管理 
1/0 接口）与 ASA 内部网络之间路由，以访问互联网。另外，务必在 ASA 上添加一个路由，以便
通过内部路由器访问管理网络。

ASA 5585-X

PWR
BOOT

ALARM

ACT
VPN

PS1
HDD1

PS0
HDD0

USB
RESET

0SFP1 SFP0 101234567 MGMT

0

1

AUX CONSOLE

PWR
BOOT

ALARM

ACT
VPN

PS1
HDD1

PS0
HDD0

USB
RESET

0SFP1 SFP0 101234567 MGMT

0

1

AUX CONSOLE

ASA Management 0/0
Default IP: 192.168.1.1

ASA FirePOWER Management 1/0

SSP

ASA FirePOWER SSP

37
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46
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Internet

Management PC

Proxy or DNS Server (for example)

Router
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Outside
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Default Gateway

ASA gateway for Management
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如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独管理网络，这需要内部路由器实现网络之间的路
由。在这种情况下，可从内部接口而非管理 0/0 接口管理 ASA。由于 ASA FirePOWER 模块是独立
于 ASA 的设备，因此，可将 ASA FirePOWER 管理 1/0 地址配置为位于内部接口所在的网络上。

ASA 5512-X 至 ASA 5555-X （软件模块）

这些型号将 ASA FirePOWER 模块作为软件模块运行，并且 ASA FirePOWER 管理接口与 ASA 共用
管理 0/0 接口。为了执行初始设置，可使用 SSH 连接至 ASA FirePOWER 默认 IP 地址。如果无法使
用默认 IP 地址，则可向背板上的 ASA FirePOWER 发起会话，或使用 ASDM 来更改管理 IP 地址，
以便使用 SSH。

如果有内部路由器

如果有内部路由器，则可在管理 0/0 网络 （同时包括 ASA 和 ASA FirePOWER 管理 IP 地址）和内
部网络之间路由，以便访问互联网。另外，务必在 ASA 上添加一个路由，以便通过内部路由器访
问管理网络。

Internet

Layer 2
Switch ASA
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ASA FirePOWER Management 1/0
ASA Management 0/0 not used

Outside

FP

ASA FirePOWER Default Gateway

Management PC

Proxy or DNS Server
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如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独的管理网络。在这种情况下，可从内部接口而非管
理 0/0 接口管理 ASA。即使从管理 0/0 接口移除 ASA 配置的名称，也仍可配置该接口的 ASA 
FirePOWER IP 地址。由于 ASA FirePOWER 模块本质上是独立于 ASA 的设备，因此，可将 ASA 
FirePOWER 管理地址配置为位于内部接口所在的网络上。

注 必须为管理 0/0 接口移除 ASA 配置的名称；如果该名称是在 ASA 上配置的，则 ASA FirePOWER 地
址必须位于 ASA 所在的网络上，这其中不包括已在其他 ASA 接口上配置的任何网络。如未配置名
称，则 ASA FirePOWER 地址可位于任何网络上，例如， ASA 内部网络。

（ASA 5512-X 至 5555-X）安装或重新映像软件模块

如果购买具有 ASA FirePOWER 模块的 ASA，则模块软件和所需的固态硬盘 (SSD) 已预装好且可供
配置。如果想要将 ASA FirePOWER 软件模块添加至现有 ASA，或需要更换 SSD，则需要安装 ASA 
FirePOWER 启动软件，对 SSD 进行分区，并根据此操作步骤安装系统软件。

重新映像模块的操作步骤相同，但应首先卸载 ASA FirePOWER 模块。如果更换 SSD，需要重新映
像系统。

有关如何实际安装 SSD 的信息，请参阅 《ASA 硬件指南》。

准备工作

• 除去启动软件所 占空间外，闪存 (disk0) 上的可用空间至少应为 3GB。

• 在多情景模式下，请在系统执行空间中执行此操作步骤。

• 必须先关闭可能正在运行的任何其他软件模块；设备一次可运行一个软件模块。必须从 ASA 
CLI 执行此操作。例如，以下命令关闭并卸载 IPS 软件模块，然后重新加载 ASA；用于移除 CX 
模块的命令是一样的，除非使用 cxsc 关键字代替 ips。
hostname# sw-module module ips shutdown
hostname# sw-module module ips uninstall
hostname# reload

注 如有活动服务策略将流量重定向至 IPS 或 CX 模块，则必须移除该策略。例如，如果策
略为全局策略，则将使用 no service-policy ips_policy global。可以使用 CLI 或 ASDM 移
除策略。

• 如果重新映像模块，请使用相同关闭和卸载命令来移除旧映像。例如， sw-module module sfr 
uninstall。

• 从 Cisco.com 获取 ASA FirePOWER 启动映像和系统软件包。

Internet

Management PC

Layer 2
Switch ASA

Inside

Management 0/0
(ASA FirePOWER only)

Outside
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(for example) 37
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操作步骤

步骤 1 下载启动映像至设备。请勿传输系统软件；稍后会将其下载至 SSD。您有以下选项：

• ASDM - 首先，下载启动映像至工作站，或将其放在 FTP、 TFTP、 HTTP、 HTTPS、 SMB 或 
SCP 服务器上。然后，在 ASDM 中，选择 Tools > File Management，然后选择适当的 File 
Transfer 命令，Between Local PC and Flash 或 Between Remote Server and Flash。传输启动软
件至 ASA 上的 disk0。

• ASA CLI - 首先，将启动映像放在 TFTP、FTP、HTTP 或 HTTPS 服务器上，然后使用 copy 命令
将其下载至闪存。以下示例使用 TFTP；请使用服务器的 IP 地址或主机名替换 <TFTP Server>。

ciscoasa# copy tftp://<TFTP SERVER>/asasfr-5500x-boot-5.3.1-58.img 
disk0:/asasfr-5500x-boot-5.3.1-58.img 

步骤 2 从 Cisco.com 将 ASA FirePOWER 系统软件下载至可从 ASA FirePOWER 管理接口访问的 HTTP、
HTTPS 或 FTP 服务器。

步骤 3 通过输入以下命令在 ASA disk0 中设置 ASA FirePOWER 模块启动映像的位置：

hostname# sw-module module sfr recover configure image disk0:file_path

注 如果收到类似 “ERROR: Another service (cxsc) is running, only one service is allowed to run at 
any time,”的消息，则表明已配置了另一个软件模块。必须将其关闭并移除，以安装以上
“先决条件”一节所述的新模块。

示例：

hostname# sw-module module sfr recover configure image
disk0:asasfr-5500x-boot-5.3.1-58.img

步骤 4 通过输入以下命令加载 ASA FirePOWER 启动映像：

hostname# sw-module module sfr recover boot

步骤 5 等待约 5-15 分钟，以便 ASA FirePOWER 模块启动，然后向现在正在运行的 ASA FirePOWER 启动
映像发起控制台会话。可能需要在打开会话后按 Enter 键以进入登录提示符。默认用户名是 admin，
默认密码是 Admin123。
hostname# session sfr console
Opening console session with module sfr.
Connected to module sfr.Escape character sequence is 'CTRL-^X'.

Cisco ASA SFR Boot Image 5.3.1
asasfr login: admin
Password: Admin123

提示 如果模块启动未完成，则 session 命令将失败，并显示有关无法通过 ttyS1 连接的消息。请稍
后重试。

步骤 6 使用 setup 命令配置系统，以便安装系统软件包。

asasfr-boot> setup 

                         Welcome to SFR Setup 
                          [hit Ctrl-C to abort]
                        Default values are inside []
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系统将提示输入以下信息。请注意，管理地址和网关，以及 DNS 信息是要配置的关键设置。

• 主机名 - 最多可达 65 个字母数字字符，不能包含空格。允许使用连字符。

• 网络地址 - 可设置静态 IPv4 或 IPv6 地址，或使用 DHCP （适用于 IPv4）或 IPv6 无状态自动
配置。

• DNS 信息 - 必须至少确定一个 DNS 服务器，还可设置域名和搜索域。

• NTP 信息 - 可启用 NTP 并配置 NTP 服务器，以便设置系统时间。

步骤 7 使用 system install 命令安装系统软件映像：

system install [noconfirm] url 

如果不想回复确认消息，请在命令中添加 noconfirm 选项。使用 HTTP、HTTPS 或 FTP URL；如果
需要用户名和密码，系统将提示您提供这些信息。

安装完成后，系统将重新启动。等待 10 分钟或更长时间，以便安装应用组件及启动 ASA 
FirePOWER 服务。（show module sfr 输出应将所有进程状态显示为 Up。）

例如：

asasfr-boot> system install http://asasfr-sys-5.3.1-44.pkg 
Verifying     
Downloading     
Extracting     
Package Detail
        Description:                    Cisco ASA-FirePOWER 5.3.1-44 System Install
        Requires reboot:                Yes 

Do you want to continue with upgrade?[y]: y 
Warning: Please do not interrupt the process or turn off the system.
Doing so might leave system in unusable state.

Upgrading     
Starting upgrade process ...     
Populating new system image      

Reboot is required to complete the upgrade.Press 'Enter' to reboot the system.
(press Enter)
Broadcast message from root (ttyS1) (Mon Feb 17 19:28:38 2014):

The system is going down for reboot NOW!
Console session with module sfr terminated.

步骤 8 向 ASA FirePOWER 模块发起会话。您看到的登录提示符将有所不同，因为您登录的是功能完备的
模块。

asa3# session sfr 
Opening command session with module sfr.
Connected to module sfr.Escape character sequence is 'CTRL-^X'.

Sourcefire ASA5555 v5.3.1 (build 44)
Sourcefire3D login:

步骤 9 使用用户名 admin 和密码 Sourcefire 登录。
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步骤 10 根据提示完成系统配置。

必须先阅读并接受最终用户许可协议 (EULA)。然后根据提示依次更改管理员密码，配置管理地址
和 DNS 设置。可同时配置 IPv4 和 IPv6 管理地址。例如：

System initialization in progress.Please stand by.
You must change the password for 'admin' to continue.
Enter new password: <new password> 
Confirm new password: <repeat password> 
You must configure the network to continue.
You must configure at least one of IPv4 or IPv6.
Do you want to configure IPv4?(y/n) [y]: y 
Do you want to configure IPv6?(y/n) [n]:
Configure IPv4 via DHCP or manually?(dhcp/manual) [manual]:
Enter an IPv4 address for the management interface [192.168.45.45]: 10.86.118.3 
Enter an IPv4 netmask for the management interface [255.255.255.0]: 255.255.252.0 
Enter the IPv4 default gateway for the management interface []: 10.86.116.1 
Enter a fully qualified hostname for this system [Sourcefire3D]: asasfr.example.com 
Enter a comma-separated list of DNS servers or 'none' []: 10.100.10.15, 
10.120.10.14
Enter a comma-separated list of search domains or 'none' [example.net]: example.com 
If your networking information has changed, you will need to reconnect.
For HTTP Proxy configuration, run 'configure network http-proxy'
(Wait for the system to reconfigure itself.)

This sensor must be managed by a Defense Center.A unique alphanumeric
registration key is always required.In most cases, to register a sensor
to a Defense Center, you must provide the hostname or the IP address along
with the registration key.
'configure manager add [hostname | ip address ] [registration key ]'

However, if the sensor and the Defense Center are separated by a NAT device,
you must enter a unique NAT ID, along with the unique registration key.
'configure manager add DONTRESOLVE [registration key ] [ NAT ID ]'

Later, using the web interface on the Defense Center, you must use the same
registration key and, if necessary, the same NAT ID when you add this
sensor to the Defense Center.

步骤 11 使用 configure manager add 命令确定将管理此设备的 FireSIGHT 管理中心设备。

由您提供一个注册密钥，随后将设备添加至 FireSIGHT 管理中心目录时，您将在其中使用该注册密
钥。以下示例显示了简单情况。如果存在 NAT 边界，则命令不同；请参阅第 18-14 页的向 
FireSIGHT 管理中心添加 ASA FirePOWER。

> configure manager add 10.89.133.202 123456 
Manager successfully configured.

步骤 12 使用浏览器中的 HTTPS 连接登录 FireSIGHT 管理中心，使用以上输入的主机或地址。例如，
https://DC.example.com。

使用 Device Management (Devices > Device Management) 页面添加设备。有关详细信息，请参阅在
机帮助或 《FireSIGHT 系统用户指南》中的 “管理设备”章节。

提示 还可通过 FireSIGHT 管理中心配置 NTP 和时间设置。从 System > Local > System Policy 页
面编辑本地策略时，使用 Time Synchronization 设置。
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更改 ASA FirePOWER 管理 IP 地址

如果无法使用默认管理 IP 地址，则可从 ASA 设置管理 IP 地址。设置管理 IP 地址后，可使用 SSH 
访问 ASA FirePOWER 模块，以执行附加设置。

如在初始系统设置期间通过 ASA FirePOWER CLI 已配置管理地址，如第 18-13 页的在 ASA 
FirePOWER CLI 配置基本 ASA FirePOWER 设置中所述，则不需要通过 ASA CLI 或 ASDM 对其进
行配置。

注 对于软件模块，可通过从 ASA CLI 发起会话来访问 ASA FirePOWER CLI 以执行设置；然后，在设
置过程中，可设置 ASA FirePOWER 管理 IP 地址。对于硬件模块，可通过控制台端口完成初始设置。

要通过 ASA 更改管理 IP 地址，请执行以下操作之一。在多情景模式下，请在系统执行空间中执行
此操作步骤。

• 在 CLI 中，使用以下命令设置 ASA FirePOWER 管理 IP 地址、掩码和网关。对硬件模块使用 1，
对软件模块使用 sfr。
session {1 | sfr} do setup host ip ip_address/mask,gateway_ip

例如， session 1 do setup host ip 10.1.1.2/24,10.1.1.1。

• 在 ASDM 中，选择 Wizards > Startup Wizard，并通过向导前进至 ASA FirePOWER Basic 
Configuration，在其中可设置 IP 地址、掩码和默认网关。

在 ASA FirePOWER CLI 配置基本 ASA FirePOWER 设置

必须先在 ASA FirePOWER 模块上配置基本网络设置和其他参数，然后才能配置安全策略。此操作
步骤假设已安装完整的系统软件 （而不仅仅是启动映像），无论是在直接安装它之后，还是因为其
已经安装在硬件模块上。

提示 此操作步骤还假设您在执行初始配置。在初始配置期间，系统将提示进行这些设置。如果稍后需要
更改这些设置，请使用各种 configure network 命令来更改各项设置。有关 configure network 命令
的详细信息，请使用 ? 命令获取帮助，并参阅 《FireSIGHT 系统用户指南》或 FireSIGHT 管理中心
中的在线帮助。

操作步骤

步骤 1 执行以下操作之一：

• （所有型号）使用 SSH 连接至 ASA FirePOWER 管理 IP 地址。

• （ASA 5512-X 至 ASA 5555-X）从 ASA CLI 向模块发起会话 （请参阅一般操作配置指南中的
“入门指南”章节，以访问 ASA CLI）。在多情景模式下，从系统执行空间发起会话。

hostname# session sfr 

步骤 2 使用用户名 admin 和密码 Sourcefire 登录。

步骤 3 根据提示完成系统配置。

必须先阅读并接受最终用户许可协议 (EULA)。然后根据提示依次更改管理员密码，配置管理地址
和 DNS 设置。可同时配置 IPv4 和 IPv6 管理地址。看到表示必须通过 FireSIGHT 管理中心管理传感
器的消息时，系统已完成配置。
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例如：

System initialization in progress.Please stand by.
You must change the password for 'admin' to continue.
Enter new password: <new password> 
Confirm new password: <repeat password> 
You must configure the network to continue.
You must configure at least one of IPv4 or IPv6.
Do you want to configure IPv4?(y/n) [y]: y 
Do you want to configure IPv6?(y/n) [n]:
Configure IPv4 via DHCP or manually?(dhcp/manual) [manual]:
Enter an IPv4 address for the management interface [192.168.45.45]: 10.86.118.3 
Enter an IPv4 netmask for the management interface [255.255.255.0]: 255.255.252.0 
Enter the IPv4 default gateway for the management interface []: 10.86.116.1 
Enter a fully qualified hostname for this system [Sourcefire3D]: asasfr.example.com 
Enter a comma-separated list of DNS servers or 'none' []: 10.100.10.15, 
10.120.10.14
Enter a comma-separated list of search domains or 'none' [example.net]: example.com 
If your networking information has changed, you will need to reconnect.
For HTTP Proxy configuration, run 'configure network http-proxy'
(Wait for the system to reconfigure itself.)

This sensor must be managed by a Defense Center.A unique alphanumeric
registration key is always required.In most cases, to register a sensor
to a Defense Center, you must provide the hostname or the IP address along
with the registration key.
'configure manager add [hostname | ip address ] [registration key ]'

However, if the sensor and the Defense Center are separated by a NAT device,
you must enter a unique NAT ID, along with the unique registration key.
'configure manager add DONTRESOLVE [registration key ] [ NAT ID ]'

Later, using the web interface on the Defense Center, you must use the same
registration key and, if necessary, the same NAT ID when you add this
sensor to the Defense Center.

步骤 4 现在必须确定将管理此设备的 FireSIGHT 管理中心，如第 18-14 页的向 FireSIGHT 管理中心添加 
ASA FirePOWER中所述。

向 FireSIGHT 管理中心添加 ASA FirePOWER 
必须向 FireSIGHT 管理中心 （此应用用于在模块上配置策略）注册 ASA FirePOWER 模块。
FireSIGHT 管理中心也称为防御中心。

要注册设备，请使用 configure manager add 命令。向 FireSIGHT 管理中心注册设备始终需要一个唯
一的字母数字注册密钥。这是由您指定的简单密钥，不同于许可密钥。

在大多数情况下，必须随注册密钥一起提供 FireSIGHT 管理中心的主机名或 IP 地址，例如：

configure manager add DC.example.com my_reg_key 

然而，如果设备和 FireSIGHT 管理中心被 NAT 设备分隔，请随注册密钥一起输入一个唯一的 NAT 
ID，并指定 DONTRESOLVE 替代主机名，例如：

configure manager add DONTRESOLVE my_reg_key my_nat_id
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操作步骤

步骤 1 执行以下操作之一：

• （所有型号）使用 SSH 连接至 ASA FirePOWER 管理 IP 地址。

• （ASA 5512-X 至 ASA 5555-X）从 ASA CLI 向模块发起会话 （请参阅一般操作配置指南中的
“入门指南”章节，以访问 ASA CLI）。在多情景模式下，从系统执行空间发起会话。

hostname# session sfr 

步骤 2 使用用户名 admin 或拥有 CLI 配置 （管理员）访问级别的的另一用户名登录。

步骤 3 系统提示符下，使用 configure manager add 命令向 FireSIGHT 管理中心注册设备，该命令使用以下
语法：

configure manager add {hostname | IPv4_address | IPv6_address | DONTRESOLVE} reg_key [nat_id]

其中：

• {hostname | IPv4_address | IPv6_address | DONTRESOLVE} 指定 FireSIGHT 管理中心的完全限定
主机名或 IP 地址。如果 FireSIGHT 管理中心非直接可寻址，请使用 DONTRESOLVE。

• reg_key 是将设备注册到 FireSIGHT 管理中心所需的唯一字母数字注册密钥。

• nat_id 是在 FireSIGHT 管理中心与设备之间的注册期间使用的可选字母数字字符串。当主机名
设置为 DONTRESOLVE 时需要它。

步骤 4 使用浏览器中的 HTTPS 连接登录 FireSIGHT 管理中心，使用以上输入的主机或地址。例如，
https://DC.example.com。

使用 Device Management (Devices > Device Management) 页面添加设备。有关详细信息，请参阅在
机帮助或 《FireSIGHT 系统用户指南》中的 “管理设备”章节。

在 ASA FirePOWER 模块上配置安全策略

使用 FireSIGHT 管理中心在 ASA FirePOWER 模块上配置安全策略。安全策略控制模块提供的服
务，如下一代 IPS 过滤和应用过滤。无法通过 ASA FirePOWER CLI、ASA CLI 或 ASDM 配置策略。

要打开 FireSIGHT 管理中心，请使用网络浏览器打开以下 URL：

https://DC_address 

其中 DC_address 是在第 18-14 页的向 FireSIGHT 管理中心添加 ASA FirePOWER中定义的管理器的 
DNS 名称或 IP 地址。例如， https://dc.example.com。

有关如何配置安全策略的信息，请参阅 《FireSIGHT 系统用户指南》或 FireSIGHT 管理中心中的在
线帮助。

提示 也可从 ASDM 中的 ASA FirePOWER Status 控制面板打开 FireSIGHT 管理中心。选择 Home > ASA 
FirePOWER Status，并点击控制面板底部的链接。
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向 ASA FirePOWER 模块重定向流量

可将流量重定向至 ASA FirePOWER 模块，只需创建可确定特定流量的服务策略。

可在被动 （“仅监控”）或内联部署中配置设备。

• 在被动部署中，流量的副本发送至设备，但不返回至 ASA。在被动模式，可在不影响网络的情
况下查看设备本来会对流量执行的操作，并对流量的内容进行评估。

• 在内联部署中，实际流量发送至设备，并且设备的策略会影响将对流量执行的操作。在丢弃不
需要的流量并执行由策略应用的任何其他操作后，流量返回至 ASA，以供进一步处理和最终
传输。

注 无法在 ASA 上同时配置仅监控模式和正常内联模式。仅允许使用一种安全策略类型。在多情景模
式下，无法为某些情景配置仅监控模式，并同时为其他情景配置常规内联模式。

准备工作

• 如有活动服务策略将流量重定向至 IPS 或 CX 模块（替换为 ASA FirePOWER），则必须先移除
该策略，然后再配置 ASA FirePOWER 服务策略。

• 务必在 ASA 和 ASA FirePOWER 上配置一致的策略（通过 FireSIGHT 管理中心）。所有策略均
应反映流量的被动或内联模式。

• 在多情景模式下，请在每个安全情景中执行此操作步骤。

操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy Rules。

步骤 2 选择 Add > Add Service Policy Rule。系统将显示 Add Service Policy Rule Wizard - Service Policy 对
话框。

步骤 3 根据需要填写 Service Policy 对话框。有关这些屏幕的详细信息，请参阅 ASDM 联机帮助。

步骤 4 点击 Next。系统将显示 Add Service Policy Rule Wizard - Traffic Classification Criteria 对话框。

步骤 5 根据需要填写 Traffic Classification Criteria 对话框。请参阅 ASDM 在线帮助，了解有关这些屏幕的
详细信息。

步骤 6 点击 Next 以显示 Add Service Policy Rule Wizard - Rule Actions 对话框。

步骤 7 点击 ASA FirePOWER Inspection 选项卡。

步骤 8 选中 Enable ASA FirePOWER for this traffic flow 复选框。

步骤 9 在 If ASA FirePOWER Card Fails 区域中，点击以下选项之一：

• Permit traffic - 将 ASA 设置为在模块不可用时允许所有流量未经检查即可通过。

• Close traffic - 将 ASA 设置为在模块不可用时阻止所有流量。

步骤 10 （可选）选中 Monitor-only 以将流量的只读副本发送至模块 （被动模式）。如果选择此选项，则流
量在内联模式下发送。有关详细信息，请参阅第 18-3 页的 ASA FirePOWER 被动 （仅监控）模式。

步骤 11 点击 Finish，然后点击 Apply。

请重复此操作步骤，以根据需要配置更多流量流。
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管理 ASA FirePOWER 模块
本节包括用于管理模块的操作步骤。

• 第 18-17 页的重置密码

• 第 18-17 页的重新加载或重置模块

• 第 18-18 页的关闭模块

• 第 18-18 页的 （适用于 ASA 5512-X 至 ASA 5555-X）卸载软件模块映像

• 第 18-18 页的 （ASA 5512-X 至 ASA 5555-X）从 ASA 向模块发起会话

• 第 18-19 页的重新映像 5585-X ASA FirePOWER 硬件模块

• 第 18-21 页的升级系统软件

重置密码

如果忘记管理员用户的密码，则拥有 CLI 配置权限的另一个用户可登录并更改该密码。

如果没有拥有所需权限的其他用户，则可使用 session do 命令从 ASA 重置管理员密码。

提示 ASA hw-module 和 sw-module 命令中的 password-reset 选项不与 ASA FirePOWER 配合使用。

要将用户 admin 的模块密码重置为默认值 Sourcefire，请使用以下命令。对硬件模块使用 1，对软
件模块使用 sfr。在多情景模式下，请在系统执行空间中执行此操作步骤。

session {1 | sfr} do password-reset 

例如， session sfr do password-reset。

重新加载或重置模块

要重新加载，或重置并重新加载模块，请在 ASA CLI 处输入以下命令之一。在多情景模式下，请在
系统执行空间中执行此操作步骤。

• 硬件模块 (ASA 5585-X)：

hw-module module 1 {reload | reset} 

• 软件模块 （ASA 5512-X 至 ASA 5555-X）：

sw-module module sfr {reload | reset} 
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关闭模块

通过关闭模块软件，可让模块做好准备，在不丢失配置数据的情况下安全断电。要正确关闭模块，
请在 ASA CLI 处输入以下命令之一。在多情景模式下，请在系统执行空间中执行此操作步骤。

注 如果重新加载 ASA，模块将不自动关闭，因此，我们建议先关闭模块，再重新加载 ASA。

• 硬件模块 (ASA 5585-X)：

hw-module module 1 shutdown 

• 软件模块 （ASA 5512-X 至 ASA 5555-X）：

sw-module module sfr shutdown 

（适用于 ASA 5512-X 至 ASA 5555-X）卸载软件模块映像

可卸载软件模块映像及其关联配置。在多情景模式下，请在系统执行空间中执行此操作步骤。

操作步骤

步骤 1 卸载软件模块映像以及关联配置。

hostname# sw-module module sfr uninstall 

Module sfr will be uninstalled.This will completely remove the disk image 
associated with the sw-module including any configuration that existed within it.

Uninstall module sfr?[confirm] 

步骤 2 重新加载 ASA。必须先重新加载 ASA，然后才能安装新模块。

hostname# reload 

（ASA 5512-X 至 ASA 5555-X）从 ASA 向模块发起会话

使用 ASA FirePOWER CLI 配置基本网络设置并对模块进行故障排除。

要从 ASA 访问 ASA FirePOWER 软件模块 CLI，可从 ASA 发起会话。可向模块发起会话 （使用 
Telnet），也可创建虚拟控制台会话。如果控制面板已关闭且无法建立 Telnet 会话，则控制台会话可
能有用。在多情景模式下，从系统执行空间发起会话。

在 Telnet 或控制台会话中，会提示您输入用户名和密码。可使用 ASA FirePOWER 上配置的任何用
户名登录。最初， admin 用户名是已配置的唯一用户名 （且始终可用）。完整映像的初始默认用户
名为 Sourcefire，启动映像的初始默认用户名为 Admin123。

• Telnet 会话：

session sfr 

在 ASA FirePOWER CLI 中时，要退出并返回 ASA CLI，请输入会将您从模块注销的任何命令，
如 logout 或 exit，或按 Ctrl-Shift-6, x。
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• 控制台会话：

session sfr console 

退出控制台会话的唯一途径为同时按下 Ctrl-Shift-6, x。从模块注销后，您将回到模块登录提示
符处。

注 请勿将 session sfr console 命令与终端服务器结合使用，其中 Ctrl-Shift-6, x 是用于返回到终端服务
器提示符的转义序列。Ctrl-Shift-6, x 序列也用于对 ASA FirePOWER 控制台转义并返回至 ASA 提示
符。因此，如果在这种情况下尝试退出 ASA FirePOWER 控制台，反而会一直退回到终端服务器提
示符。如将终端服务器重新连接至 ASA， ASA FirePOWER 控制台会话仍将处于活动状态；您将永
远无法退回至 ASA 提示符。必须使用直接串行连接才能将控制台返回至 ASA 提示符。出现此情况
时，请使用 session sfr 命令，而不要使用控制台命令。

重新映像 5585-X ASA FirePOWER 硬件模块

如果出于任何原因需要重新映像 ASA 5585-X 设备中的 ASA FirePOWER 硬件模块，则需要依次安
装启动映像和系统软件包。必须安装两个软件包，系统才能正常运行。在正常情况下，不需要重新
映像系统即可安装升级软件包。

要安装启动映像，需要通过登录模块的控制台端口来从 ASA FirePOWER SSP 上的管理 0 端口对映
像执行 TFTP 启动。因为管理 0 端口位于第一个插槽的一个 SSP 上，所以，也称为管理 1/0，但是，
rommon 将其识别为管理 0 或管理 0/1。

要完成 TFTP 启动，必须执行以下操作：

• 将软件映像放在可通过 ASA FirePOWER 上的管理 1/0 接口访问的 TFTP 服务器上。

• 将管理 1/0 连接至网络。必须使用此接口对启动映像执行 TFTP 启动。

• 配置 rommon 变量。按 Esc 键中断自动启动进程，以便配置 rommon 变量。

安装启动映像后，请安装系统软件包。必须将软件包放在可从 ASA FirePOWER 访问的 HTTP、
HTTPS 或 FTP 服务器上。

以下操作步骤说明如何依次安装启动映像和系统软件包。

操作步骤

步骤 1 连接至控制台端口。借助于设置为 9600 波特、 8 数据位、无奇偶校验、 1 停止位、无流控制的终端
仿真器，使用 ASA 产品随附的控制台电缆将 PC 连接至控制台。请参阅 ASA 硬件指南，了解有关
控制台电缆的详细信息。

步骤 2 输入 system reboot 命令以重新加载系统。

步骤 3 系统提示时，按 Esc 键中断启动。如果看到引导程序开始启动系统，则表明您已等得太久。

这将让您进入 rommon 提示符。

步骤 4 在 rommon 提示符处，输入 set 并配置以下参数：

• ADDRESS - 模块的管理 IP 地址。

• SERVER - TFTP 服务器的 IP 地址。

• GATEWAY - TFTP 服务器的网关地址 如果 TFTP 服务器直接连接至管理 1/0，请使用 TFTP 服务
器的 IP 地址。如果 TFTP 服务器和管理地址位于同一子网，则请勿配置网关，否则 TFTP 启动
将失败。
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• IMAGE - TFTP 服务器上的启动映像路径和映像名称。例如，如在 TFTP 服务器上将文件放在 
tftpboot/images/filename.img 中，则 IMAGE 值为 images/filename.img。

例如：

ADDRESS=10.5.190.199 
SERVER=10.5.11.170 
GATEWAY=10.5.1.1 
IMAGE=asasfr-boot-5.3.1-26-54.img 

步骤 5 输入 sync 以保存设置。

步骤 6 输入 tftp 以启动下载和启动进程。

您将看到表示进度的 ! 标记。几分钟后启动完成时，将看到登录提示符。

步骤 7 以 admin 身份登录并使用密码 Admin123。

步骤 8 使用 setup 命令配置系统，以便安装系统软件包。

系统将提示输入以下信息。请注意，管理地址和网关，以及 DNS 信息是要配置的关键设置。

• 主机名 - 最多可达 65 个字母数字字符，不能包含空格。允许使用连字符。

• 网络地址 - 可设置静态 IPv4 或 IPv6 地址，或使用 DHCP （适用于 IPv4）或 IPv6 无状态自动
配置。

• DNS 信息 - 必须至少确定一个 DNS 服务器，还可设置域名和搜索域。

• NTP 信息 - 可启用 NTP 并配置 NTP 服务器，以便设置系统时间。

步骤 9 使用 system install 命令安装系统软件映像：

system install [noconfirm] url 

如果不想回复确认消息，请在命令中添加 noconfirm 选项。

安装完成后，系统将重新启动。等待 10 分钟或更长时间，以便安装应用组件及启动 ASA 
FirePOWER 服务。

例如：

asasfr-boot> system install http://asasfr-sys-5.3.1-54.pkg 

步骤 10 启动完成后，以 admin 身份登录，并使用密码 Sourcefire。

根据提示完成系统配置。

必须先阅读并接受最终用户许可协议 (EULA)。然后根据提示依次更改管理员密码，配置管理地址
和 DNS 设置。可同时配置 IPv4 和 IPv6 管理地址。

步骤 11 使用 configure manager add 命令确定将管理此设备的 FireSIGHT 管理中心设备。

由您提供一个注册密钥，随后将设备添加至 FireSIGHT 管理中心目录时，您将在其中使用该注册密
钥。以下示例显示了简单情况。如果存在 NAT 边界，则命令不同；请参阅第 18-14 页的向 
FireSIGHT 管理中心添加 ASA FirePOWER。

> configure manager add 10.89.133.202 123456 
Manager successfully configured.

步骤 12 使用浏览器中的 HTTPS 连接登录 FireSIGHT 管理中心，使用以上输入的主机或地址。例如，
https://DC.example.com。

使用 Device Management (Devices > Device Management) 页面添加设备。有关详细信息，请参阅
《FireSIGHT 系统用户指南》中的 “管理设备”章节或 FireSIGHT 管理中心中的在线帮助。
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升级系统软件

使用 FireSIGHT 管理中心将升级映象应用于 ASA FirePOWER 模块。在应用升级之前，请确保 ASA 
运行的是新版本所需的最低版本；可能需要先升级 ASA，然后才能升级模块。

有关应用升级的详细信息，请参阅 《FireSIGHT 系统用户指南》或 FireSIGHT 管理中心中的在线
帮助。

监控 ASA FirePOWER 模块
以下主题提供了有关监控模块的指南。有关与 ASA FirePOWER 相关的系统日志消息，请参阅系统
日志消息指南。 ASA FirePOWER 系统日志消息以消息编号 434001 开头。

选择 Tools > Command Line Interface 以使用监控命令。

• 第 18-21 页的显示模块状态

• 第 18-21 页的显示模块统计信息

• 第 18-22 页的监控模块连接

显示模块状态

从 Home 页面，可选择 ASA FirePOWER Status 选项卡以查看有关模块的信息。包括模块信息，例如
型号、序列号和软件版本，以及模块状态，例如应用程序名称和状态、数据层面状态和整体状态。
如已向 FireSIGHT 管理中心注册模块，则可点击链接以打开应用并执行进一步分析和模块配置。

显示模块统计信息

使用 show service-policy sfr 命令来显示包括 sfr 命令的每个服务策略的统计信息和状态。可以使用 
clear service-policy 命令清除计数器。

以下示例显示 ASA FirePOWER 服务策略和当前统计信息，以及模块状态：

ciscoasa# show service-policy sfr 

Global policy:
Service-policy: global_policy
    Class-map: my-sfr-class
      SFR: card status Up, mode fail-close
        packet input 2626422041, packet output 2626877967, drop 0, reset-drop 0, proxied 0

以下示例显示仅监控策略。在这种情况下，应该看到数据包输入计数器增加，但是数据包输出计数
器应保持为零，因为无流量传回至 ASA。

hostname# show service-policy sfr
Global policy:
Service-policy: global_policy
    Class-map: bypass
      SFR: card status Up, mode fail-open, monitor-only 
        packet input 2626422041, packet output 0, drop 0, reset-drop 0, proxied 0
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监控模块连接

要显示 ASA FirePOWER 模块的连接，请输入以下命令之一：

• show asp table classify domain sfr 

显示为将流量发送至 ASA FirePOWER 模块而创建的 NP 规则。

• show asp drop 

将显示丢弃的数据包。丢弃类型说明如下。

• show conn 

将显示 ‘X - inspected by service module’标记显示连接是否正在被转发到模块。

show asp drop 命令可能包括以下与 ASA FirePOWER 模块相关的丢弃原因。

丢帧：

• sfr-bad-tlv-received - 当 ASA 从 FirePOWER 收到没有 Policy ID TLV 的数据包时发生此情况。如
果此 TLV 未在操作字段中设置备用/主用位，则必须存在于非控数据包中。

• sfr-request - 此帧由 FirePOWER 根据 FirePOWER 上的一条策略请求丢弃，其中 FirePOWER 将
操作设置为 Deny Source、Deny Destination 或 Deny Pkt。如果不该丢弃该帧，请复查拒绝流的模
块上的策略。

• sfr-fail-close - 数据包已丢弃，因为卡未正常工作且配置的策略为 “fail-close”（而不是
“fail-open”，该策略即使在卡出现故障的情况下也允许数据包通过）。检查卡状态并尝试重新
启动服务或重新启动卡。

• sfr-fail - 已为现有流移除 FirePOWER 配置且无法通过将丢弃它的 FirePOWER 对其进行处理。这
种情况十分罕见。

• sfr-malformed-packet - 来自 FirePOWER 的数据包包含无效的报头。例如，报头长度可能有误。

• sfr-ha-request - 当安全设备收到 FirePOWER HA 请求数据包但无法对其进行处理，且数据包已丢
弃时，此计数器递增。

• sfr-invalid-encap - 当安全设备收到具有无效消息报头的 FirePOWER 数据包，且数据包已丢弃
时，此计数器递增。

• sfr-bad-handle-received - 在来自 FirePOWER 模块的数据包中收到错误的流句柄，因此丢弃流。
此计数器递增， FirePOWER 流的句柄在流持续时间期间已更改，因此在 ASA 上丢弃流和数
据包。

• sfr-rx-monitor-only - 当安全设备在仅监控模式下收到 FirePOWER 数据包，且数据包已丢弃时，
此计数器递增。

流量丢弃：

• sfr-request - FirePOWER 请求终止流量。设置了操作位 0。

• reset-by-sfr - FirePOWER 请求终止并重置流量。设置了操作位 1。

• sfr-fail-close - 流量已终止，因为卡出现故障且配置的策略为 “fail-close”。
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ASA FirePOWER 模块的历史记录

功能名称 平台版本 功能信息

适用于匹配 ASA FirePOWER SSP 硬件模块
的 ASA 5585-X （所有型号）支持。

适用于 ASA FirePOWER 软件模块的 ASA 
5512-X 至 ASA 5555-X 支持。

ASA 9.2(2.4)
ASA 
FirePOWER 
5.3.1

ASA FirePOWER 模块提供下一代防火墙服务，包括下一
代 IPS (NGIPS)、应用可视性与控制 (AVC)、 URL 过滤以
及高级恶意软件防护 (AMP)。该模块既可在单情景模式或
多情景模式下使用，也可在路由模式或透明模式下使用。

我们引入了以下屏幕：

Home > ASA FirePOWER Status
Wizards > Startup Wizard > ASA FirePOWER Basic 
Configuration
Configuration > Firewall > Service Policy Rules > Add 
Service Policy Rule > Rule Actions > ASA FirePOWER 
Inspection
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19第 章
ASA CX 模块

本章介绍如何配置在 ASA 上运行的 ASA CX 模块。

• 第 19-1 页的 ASA CX 模块

• 第 19-5 页的 ASA CX 模块的许可要求

• 第 19-5 页的 ASA CX 的先决条件

• 第 19-5 页的 ASA CX 的准则

• 第 19-7 页的 ASA CX 的默认设置

• 第 19-7 页的配置 ASA CX 模块

• 第 19-17 页的管理 ASA CX 模块

• 第 19-20 页的监控 ASA CX 模块

• 第 19-22 页的对身份验证代理进行故障排除

• 第 19-23 页的 ASA CX 模块的历史

ASA CX 模块
通过 ASA CX 模块，您可以根据情况的全部情景实施安全措施。情景包括用户身份 （谁）、用户要
访问的应用或网站 （什么）、尝试访问的来源 （哪里）、尝试访问的时间 （什么时候）和用于访
问的设备的属性 （如何）。通过 ASA CX 模块，您可以提取流量的全部情景并执行精细策略，例如
允许访问 Facebook，但不允许访问 Facebook 上的游戏，或允许财务人员访问敏感的企业数据库，
但不允许其他员工进行同样的访问。

• 第 19-2 页的 ASA CX 模块如何与 ASA 配合使用

• 第 19-4 页的 ASA CX 管理访问

• 第 19-4 页的用于主动活动身份验证的身份验证代理

• 第 19-5 页的与 ASA 功能的兼容性
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ASA CX 模块如何与 ASA 配合使用

ASA CX 模块从 ASA 运行单独应用。本模块可以是硬件模块 （适用于 ASA 5585-X），也可以是软
件模块 （适用于 5512-X 至 5555-X）。作为硬件模块，设备包括独立的管理和控制台端口，以及由 
ASA 直接使用 （而非由模块本身使用）的额外数据接口。

您可在正常内联模式或在仅监控模式下配置设备用于演示。

• 在内联部署中，实际流量发送至设备，并且设备的策略影响将对流量执行的操作。在丢弃不需
要的流量并执行由策略应用的任何其他操作后，流量返回至 ASA 以供进一步处理和最终传输。

• 在仅监控部署中，在被动部署中，流量副本将会被发送到设备，但不会被返回到 ASA。在仅监
控模式下，您可以看到设备在不影响网络的情况下如何对流量进行处理。您可以使用仅监控服
务策略或流量转发接口配置该模式。有关仅监控模式的准则和限制的详细信息，请参阅第 19-5 
页的 ASA CX 的准则。

以下各节对这些模式进行了更详细地说明。

ASA CX 正常内联模式

在正常内联模式下，流量在被转发到 ASA CX 模块之前会通过防火墙检查。当在 ASA 上识别流量
以进行 ASA CX 检测时，流量按以下所述顺序流经 ASA 和 ASA CX 模块：

1. 流量进入 ASA。

2. 对传入的 VPN 流量解密。

3. 应用防火墙策略。

4. 流量被发送至 ASA CX 模块。

5. ASA CX 模块将安全策略应用至流量，并采取适当的操作。

6. 有效流量将重新发送到 ASA；ASA CX 模块可能根据其安全策略阻止某些流量，这些流量将不
会被传送。

7. 对传出的 VPN 流量加密。

8. 流量退出 ASA。

下图显示在使用 ASA CX 模块时的流量。在本示例中， ASA CX 模块自动阻止了某个应用所不允许
的流量。所有其他流量均通过 ASA 转发。

图 19-1 ASA 中的 ASA CX 模块流量

ASA

Main System

ASA CX

Diverted Traffic

ASA CX inspection

VPN
Decryption

Firewall
Policy

Block

inside outside

33
34

70
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仅监控模式下的服务策略

出于测试和演示的目的，您可以配置 ASA，以将只读流量的副本数据流发送到 ASA CX 模块，这样
就可以看出模块如何在不影响 ASA 流量的情况下检查流量。在该模式下，ASA CX 模块照例检查流
量、制定策略决策并生成事件。但是，因为数据包是只读副本，因此模块操作不会影响实际流量。
相反，检测完成后模块会丢弃副本。下图显示了仅监控模式下的 ASA CX 模块。

图 19-2 ASA CX 仅监控模式

仅监控模式下的流量转发接口

或者，您可以将 ASA 接口配置为流量转发接口，接收的所有流量将直接被转发到 ASA CX 模块，
无需任何 ASA 处理。出于测试和演示的目的，流量转发消除了 ASA 处理的额外复杂情况。只有在
仅监控模式下才支持流量转发。因此， ASA CX 模块在检查流量后会丢弃该流量。下图显示了为流
量转发配置的 ASA GigabitEthernet 0/3 接口。该接口与交换机 SPAN 端口连接，因此 ASA CX 模块
可以检查所有网络流量。

图 19-3 ASA CX 流量转发
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  ASA CX 模块
ASA CX 管理访问

有两个单独的访问层用于管理 ASA CX 模块：初始配置 （及后续故障排除）和策略管理。

• 第 19-4 页的初始配置

• 第 19-4 页的策略配置和管理

初始配置

为了进行初始配置，您必须使用 ASA CX 模块上的 CLI 运行 setup 命令并配置其他可选设置。

要访问 CLI，您可以使用以下方法：

• ASA 5585-X：

– ASA CX 控制台端口- ASA CX 控制台端口是一个单独的外部控制台端口。

– 使用 SSH 的 ASA CX 管理 1/0 接口 - 您可以连接至默认的 IP 地址 (192.168.8.8)，也可以在
使用 ASDM 更改管理 IP 地址后使用 SSH 进行连接。ASA CX 管理接口是一个单独的外部千
兆位以太网接口。

注 您无法使用 session 命令来访问 ASA 背板上的 ASA CX 硬件模块 CLI。

• ASA 5512-X 至 ASA 5555-X：

– 背板上的 ASA 的会话 - 如对 ASA 有 CLI 访问权，则可向模块发起会话并访问模块 CLI。

– 使用 SSH 的 ASA CX 管理 0/0 接口 - 您可以连接至默认的 IP 地址 (192.168.1.2)，也可以在
使用 ASDM 更改管理 IP 地址后使用 SSH 进行连接。这些模式将 ASA CX 模块作为一个软
件模块运行。ASA CX 管理接口与 ASA 共用管理 0/0 接口。ASA 和 ASACX 模块支持单独
的 MAC 地址和 IP 地址。您必须在 ASA CX 操作系统内 （使用 CLI 或 ASDM）配置 ASA 
CX IP 地址。但是，物理特性 （例如启用接口）在 ASA 上配置。您可以移除 ASA 接口配
置 （具体是指接口名称），将此接口指定为一个仅 ASA CX 接口。此接口仅用于管理。

策略配置和管理

完成初始配置后，应使用思科 Prime 安全管理器 (PRSM) 配置 ASA CX 策略。PRSM（即思科 Prime 
安全管理器）既是 ASA CX 配置接口的名称，也是用于配置 ASA CX 设备的独立产品的名称。

然后配置 ASA 策略，以使用 ASDM、 ASA CLI 或 PRSM （在多设备模式下）向 ASA CX 模块发送
流量。

用于主动活动身份验证的身份验证代理

您可以在 ASA CX 上配置身份策略，以采集用户身份信息用于访问策略。系统可以主动（通过提示
输入用户名和密码凭证）或者被动（通过检索 AD 代理或 思科 Context Directory Agent、 CDA 所采
集的信息）采集用户身份。

如果要使用主动身份验证，您必须将 ASA 配置为身份验证代理。ASA CX 模块将身份验证请求重定
向至 ASA 接口 IP 地址/代理端口。默认端口为 885，但是，您也可以配置不同的端口。

如第 19-15 页的创建 ASA CX 服务策略中所述，要启用主动身份验证，您应将身份验证代理启用为
将流量重定向至 ASA CX 的服务策略的一部分。
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  ASA CX 模块的许可要求
与 ASA 功能的兼容性

ASA 提供许多高级应用检测功能，包括 HTTP 检测。但是， ASA CX 模块比 ASA 提供了更高级的 
HTTP 检测，以及适用于其他应用的附加功能，包括监控和控制应用的使用情况。

要充分利用 ASA CX 模块的功能，请按照以下准则处理发送至 ASA CX 模块的流量：

• 请勿对 HTTP 流量配置 ASA 检测。

• 请勿配置云网络安全 (ScanSafe) 检测。如果对同一流量同时配置 ASA CX 操作和云网络安全检
测， ASA 只执行 ASA CX 操作。

• ASA 的其他应用检测 （包括默认检测）与 ASA CX 模块兼容。

• 勿启用移动用户安全 (MUS) 服务器；此服务器与 ASA CX 模块不兼容。

• 请勿启用 ASA 集群；ASA 集群与 ASA CX 模块不兼容。

ASA CX 模块的许可要求
ASA CX 模块和 PRSM 需要附加许可证，此许可证需安装在模块中而非 ASA 的情景中。 ASA 本身
不需要附加许可证。有关详细信息，请参阅 ASA 文档。

ASA CX 的先决条件
要使用 PRSM 配置 ASA，您需要在 ASA 上安装证书以确保安全通信。默认情况下，ASA 会生成自
签名证书。但是，由于发布者不详，该证书会导致浏览器给出提示，要求您对证书进行验证。要避
免这些浏览器提示，您可以安装已知认证中心 (CA) 提供的证书。如果您从 CA 申请证书，应确保证
书类型同时是服务器身份验证证书和客户端身份验证证书。有关详细信息，请参阅一般操作配置
指南。

ASA CX 的准则

情景模式准则

从 ASA CX 9.1(3)开始，支持多情景模式。

但是， ASA CX 模块自身 （在 PRSM 中配置）是一台单一情景模式设备；来自 ASA 的情景特定流
量将根据通用 ASA CX 策略来检查。因此，您无法在多情景中使用相同的 IP 地址；每个情景必须
包含唯一的网络。

防火墙模式准则

在路由和透明防火墙模式下受支持。只有透明模式支持流量转发接口。

故障转移准则

不支持直接故障转移；在 ASA 进行故障转移时，所有现有 ASA CX 流量会被传输到新 ASA，但
是，允许流量在未被 ASA CX 检查的情况下通过 ASA。 ASA CX 模块只对新 ASA 接收到的新流量
起作用。

ASA 集群准则

不支持集群。
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IPv6 准则

• 支持 IPv6。

• （9.1(1) 和更早版本）不支持 NAT 64。 9.1(2) 和后期版本支持 NAT 64。

型号准则

• 仅 ASA 5585-X 和 5512-X 至 ASA 5555-X 支持。有关详细信息，请参阅 《思科 ASA 兼容性
矩阵》：

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

• 对于 5512-X 至 ASA 5555-X，必须安装思科固态硬盘 (SSD)。有关详细信息，请参阅 《ASA 
5500-X 硬件指南》。

仅监控模式准则

仅监控模式不是模块的正常运行方式，该模式严格限制于演示的目的。

• 无法在 ASA 上同时配置仅监控模式和正常内联模式。只允许一种类型的安全策略。在多情景模
式下，无法为某些情景配置仅监控模式，并同时为其他情景配置常规内联模式。

• 仅监控模式下不支持以下功能：

– 拒绝策略

– 主动身份验证

– 解密策略

• ASA CX 在仅监控模式下不执行数据包缓冲，并会以尽力而为的方式生成事件。例如，某些事
件可能会受到缓冲不足的影响，例如带有跨数据包边界的较长 URL 的事件。

• 请确保将 ASA 策略和 ASA CX 都配置为具有匹配的模式：均在仅监控模式下或均在正常内联模
式下。

流量转发接口附加准则：

• ASA 必须处于透明模式。

• 您可将多达 4 个接口配置为流量转发接口。其他 ASA 接口可用作普通接口。

• 流量转发接口必须是物理接口，而不是 VLAN 或 BVI。物理接口也不能有任何关联的 VLAN。

• 流量转发接口不能用于 ASA 流量；您无法为 ASA 功能 （包括故障转移或仅管理）对这些接口
进行命名或配置。

• 您无法为 ASA CX 流量同时配置流量转发接口和服务策略。

附加准则和限制

• 请参阅第 19-5 页的与 ASA 功能的兼容性。

• 您无法更改安装在硬件模块上的软件的类型；如果购买了 ASA CX 模块，则以后无法为其安装
其他软件。
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  ASA CX 的默认设置
ASA CX 的默认设置
下表列出了 ASA CX 模块的默认设置。

配置 ASA CX 模块
ASA CX 模块的配置过程包括在 ASA CX 模块上配置 ASA CX 安全策略，以及对 ASA 进行配置以将
流量发送到 ASA CX 模块。要配置 ASA CX 模块，请执行以下操作：

步骤 1 第 19-8 页的连接 ASA CX 管理接口。连接 ASA CX 管理接口或者控制台接口。

步骤 2 第 19-10 页的 （适用于 ASA 5512-X 至 ASA 5555-X）安装或重新映像软件模块。

步骤 3 如有必要，第 19-12 页的（适用于 ASA 5585-X）更改 ASA CX 管理 IP 地址。初次 SSH 访问可能要
求此操作。

步骤 4 第 19-13 页的配置 ASA CX 基本设置。在 ASA CX 模块上执行此操作。

步骤 5 第 19-14 页的在 ASA CX 模块上配置安全策略。

步骤 6 （可选）第 19-15 页的配置身份验证代理端口。

步骤 7 第 19-15 页的向 ASA CX 模块重定向流量。

表 19-1 默认网络参数

参数 默认值

管理 IP 地址 ASA 5585-X：管理 1/0 192.168.8.8/24

ASA 5512-X 至 ASA 5555-X：管理 0/0 192.168.1.2/24

网关 ASA 5585-X：192.168.8.1/24

ASA 5512-X 至 ASA 5555-X：192.168.1.1/24

SSH 或会话用户名 admin

密码 Admin123
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连接 ASA CX 管理接口

除提供对 ASA CX 模块的管理访问外，ASA CX 管理接口还需要访问 HTTP 代理服务器或 DNS 服务
器以及互联网，以获取签名更新和其他信息。本节描述推荐的网络配置。您的网络可能不同。

ASA 5585-X （硬件模块）

ASA CX 模块带有一个来自 ASA 的单独管理和控制台接口。对于初始设置，可以使用默认的 IP 地
址 (192.168.8.8/24)，通过 SSH 连接到 ASA CX 管理 1/0 接口。如果无法使用默认 IP 地址，则可使用
控制台端口，或使用 ASDM 来更改管理 IP 地址，以便使用 SSH。

如果有内部路由器

如果有内部路由器，您可以在管理网络（可以包括 ASA 管理 0/0 和 ASA CX 管理1/0 接口）和 ASA 
内部网络之间建立路由，以访问互联网。另外，务必在 ASA 上添加一个路由，以便通过内部路由
器访问管理网络。
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SSP
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Internet
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如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独管理网络，这需要内部路由器实现网络之间的路
由。在这种情况下，可从内部接口而非管理 0/0 接口管理 ASA。由于 ASA CX 模块是来自 ASA 的单
独设备，您可以将 ASA CX 管理 1/0 地址配置为与内部接口处于相同的网络。

ASA 5512-X 至 ASA 5555-X （软件模块）

模块在这些型号中作为一个软件模块运行，且 ASA CX 管理接口与 ASA 共用管理 0/0 接口。对于初
始设置，可以使用 SSH 连接到 ASA CX 默认的 IP 地址 (192.168.1.2/24)。如果无法使用默认的 IP 地
址，可以与背板上的 ASA CX 会话或使用 ASDM 更改管理 IP 地址，以使用 SSH。

如果有内部路由器

如果有内部路由器，您可以在管理 0/0 网络 （包括 ASA 和 ASA CX 管理 IP 地址）和内部网络之
间建立路由，以访问互联网。此外，请务必在 ASA 上添加一个路由，以通过内部路由器访问管
理网络。
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如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独的管理网络。在这种情况下，您可以从内部接口而
非管理 0/0 接口来管理 ASA。如果从管理 0/0 接口移除 ASA 配置的名称，您仍可以配置该接口的 
ASA CX IP 地址。由于 ASA CX 模块实质上是来自 ASA 的单独设备，您可以将 ASA CX 管理地址
配置为与内部接口处于相同的网络。

注 您必须移除管理 0/0 的 ASA 配置名称；如果在 ASA 已配置该名称，则 ASA CX 地址必须与 ASA 在
同一网络，并且排除所有已在其他 ASA 接口上配置的网络。如果该名称未配置，则 ASA CX 地址
可在任何网络，例如， ASA 内部网络。

（适用于 ASA 5512-X 至 ASA 5555-X）安装或重新映像软件模块

如果您购买了含有 ASA CX 模块的 ASA，则模块软件和所需的固态驱动器 (SSD) 已预先安装好并准
备就绪。如果要向现有 ASA 添加 ASA CX 或需要更换 SSD，您需要根据此操作步骤安装 ASA CX 
启动软件并对 SSD 进行分区。要物理安装 SSD，请参阅 《ASA 硬件指南》。

重新映像模块的操作步骤与此相同，不同之处在于您首先要卸载 ASA CX 模块。如果更换 SSD，需
要重新映像系统。

注 对于 ASA 5585-X 硬件模块，您必须在 ASA CX 模块内安装或升级映像。有关详细信息，请参阅 
ASA CX 模块文档。

准备工作

• 除去启动软件所 占空间外，闪存 (disk0) 上的可用空间至少应为 3GB。

• 在多情景模式下，请在系统执行空间中执行此操作步骤。

• 必须先关闭可能正在运行的任何其他软件模块；设备一次可运行一个软件模块。必须从 ASA 
CLI 执行此操作。例如，以下命令关闭并卸载 IPS 软件模块，然后重新加载 ASA。

hostname# sw-module module ips shutdown
hostname# sw-module module ips uninstall
hostname# reload

注 如果有活动服务策略将流量重定向至 IPS 模块，您必须移除该策略。例如，如果策略
为全局策略，则将使用 no service-policy ips_policy global。可以使用 CLI 或 ASDM 移
除策略。
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• 如果重新映像模块，请使用相同关闭和卸载命令来移除旧映像。例如， sw-module module cxsc 
uninstall。

• 从 Cisco.com 获取 ASA CX 启动映像和系统软件包：
http://software.cisco.com/download/type.html?mdfid=284325223&amp;flowid=34503。

操作步骤

步骤 1 下载启动映像至设备。请勿传输系统软件；稍后会将其下载至 SSD。您有以下选项：

• ASDM - 首先，下载启动映像至工作站，或将其放在 FTP、 TFTP、 HTTP、 HTTPS、 SMB 或 
SCP 服务器上。然后，在 ASDM 中，选择 Tools > File Management，然后选择适当的 File 
Transfer 命令，Between Local PC and Flash 或 Between Remote Server and Flash。传输启动软
件至 ASA 上的 disk0。

• ASA CLI - 首先，将启动映像放在 TFTP、FTP、HTTP 或 HTTPS 服务器上，然后使用 copy 命令
将其下载至闪存。以下示例使用 TFTP；请使用服务器的 IP 地址或主机名替换 <TFTP Server>。

ciscoasa# copy tftp://<TFTP SERVER>/asacx-5500x-boot-9.3.1.1-112.img 
disk0:/asacx-5500x-boot-9.3.1.1-112.img 

步骤 2 从 Cisco.com 将 ASA CX 系统软件下载到可以通过 ASA CX 管理接口访问的 HTTP、HTTPS 或 FTP 
服务器。

步骤 3 输入以下命令，在 ASA disk0 中设置 ASA CX 模块启动映像的位置：

hostname# sw-module module cxsc recover configure image disk0:file_path

注 如果收到类似“ERROR: Another service (ips) is running, only one service is allowed to run at any 
time,”的消息，表明您已经配置了不同的软件模块。必须将其关闭并移除，以安装以上
“先决条件”一节所述的新模块。

示例：

hostname# sw-module module cxsc recover configure image 
disk0:asacx-5500x-boot-9.3.1.1-112.img 

步骤 4 输入下列命令加载 ASA CX 启动映像：

hostname# sw-module module cxsc recover boot

步骤 5 等待 5 分钟左右， ASA CX 模块启动完成后，打开控制台会话至正在运行的 ASA CX 启动映像。默
认用户名是 admin，默认密码是 Admin123。
hostname# session cxsc console
Establishing console session with slot 1
Opening console session with module cxsc.
Connected to module cxsc.Escape character sequence is 'CTRL-SHIFT-6 then x'.
cxsc login: admin
Password: Admin123

提示 如果模块启动未完成，则 session 命令将失败，并显示有关无法通过 ttyS1 连接的消息。请稍
后重试。
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步骤 6 对 SSD 进行分区：

asacx-boot> partition
....
Partition Successfully Completed

步骤 7 使用 setup 命令根据第 19-13 页的配置 ASA CX 基本设置（请勿退出 ASA CX CLI），进行基本的网
络设置，然后返回该操作步骤安装软件映像。

步骤 8 使用 system install 命令安装系统软件映像：

system install [noconfirm] url 

如果不想回复确认消息，请在命令中添加 noconfirm 选项。使用 HTTP、HTTPS 或 FTP URL；如果
需要用户名和密码，系统将提示您提供这些信息。

安装完成后，系统重启，重启时控制台会话会关闭。应用组件安装以及 ASA CX 服务启动需要 
10 分钟或更长的时间。（show module cxsc 输出应将所有进程显示为 Up。）

以下命令安装 asacx-sys-9.3.1.1-112.pkg 系统软件。

asacx-boot> system install https://upgrades.example.com/packages/asacx-sys-9.3.1.1-112.pkg 

Username: buffy
Password: angelforever
Verifying
Downloading
Extracting
Package Detail
        Description:                    Cisco ASA CX 9.3.1.1-112 System Install
        Requires reboot:                Yes 

Do you want to continue with upgrade?[n]: Y
Warning: Please do not interrupt the process or turn off the system.Doing so might leave 
system in unusable state.
Upgrading
Stopping all the services ...
Starting upgrade process ...
Reboot is required to complete the upgrade.Press Enter to reboot the system.

（适用于 ASA 5585-X）更改 ASA CX 管理 IP 地址

如果无法使用默认的管理 IP 地址 (192.168.8.8)，可以从 ASA 设置管理 IP 地址。设置管理 IP 地址
后，可以使用 SSH 访问 ASA CX 模块执行初始设置。

注 对于软件模块，可以访问 ASA CX CLI，通过从 ASA 发起会话来执行设置；然后在设置过程中设置 
ASA CX 管理 IP 地址。请参阅第 19-13 页的配置 ASA CX 基本设置。

要通过 ASA 更改管理 IP 地址，请执行以下操作之一。在多情景模式下，在系统执行空间中执行此
操作步骤。

• 在 CLI 中，使用以下命令设置 ASA CX 管理 IP 地址、掩码和网关。

session 1 do setup host ip ip_address/mask,gateway_ip

例如， session 1 do setup host ip 10.1.1.2/24,10.1.1.1。
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• （仅限单一情景模式）在 ASDM 中，选择 Wizards > Startup Wizard，并向前浏览向导直至进
入 ASA CX Basic Configuration 界面，在该界面中，您可以设置 IP 地址、掩码和默认网关。如
果默认设置不适合，您还可以设置另外一个身份验证代理端口。

配置 ASA CX 基本设置

配置安全策略之前，您必须在 ASA CX 模块上模块配置基本网络设置和其他参数。您只能通过 ASA 
CX CLI 配置这些设置。

操作步骤

步骤 1 执行以下操作之一：

• （适用于所有型号）使用 SSH 连接至 ASA CX 管理 IP 地址。

• （适用于 ASA 5512-X 至 ASA 5555-X）从 ASA CLI 打开与模块的控制台会话。在多情景模式
下，从系统执行空间发起会话。

hostname# session cxsc console

步骤 2 使用用户名 admin 和密码 Admin123 登录。在此操作步骤中，您可以更改密码。

步骤 3 输入以下命令：

asacx> setup

示例：

asacx> setup
Welcome to Cisco Prime Security Manager Setup
[hit Ctrl-C to abort]
Default values are inside [ ]

按照设置向导提示操作。以下示例通过向导显示了一个典型路径；如果在提示符下输入 Y 而不是 
N，您可以配置其他的设置。此示例显示如何配置 IPv4 和 IPv6 静态地址。如果要配置 IPv6 无状态
自动配置，您可以在系统询问您是否要配置静态 IPv6 地址时回答 N。

Enter a hostname [asacx]: asa-cx-host
Do you want to configure IPv4 address on management interface?(y/n) [Y]: Y
Do you want to enable DHCP for IPv4 address assignment on management interface?(y/n)[N]: N
Enter an IPv4 address [192.168.8.8]: 10.89.31.65
Enter the netmask [255.255.255.0]: 255.255.255.0
Enter the gateway [192.168.8.1]: 10.89.31.1
Do you want to configure static IPv6 address on management interface?(y/n) [N]: Y
Enter an IPv6 address: 2001:DB8:0:CD30::1234/64
Enter the gateway: 2001:DB8:0:CD30::1
Enter the primary DNS server IP address [ ]: 10.89.47.11
Do you want to configure Secondary DNS Server?(y/n) [N]: N
Do you want to configure Local Domain Name?(y/n) [N] Y
Enter the local domain name: example.com
Do you want to configure Search domains?(y/n) [N] Y
Enter the comma separated list for search domains: example.com
Do you want to enable the NTP service?(y/n) [N]: Y
Enter the NTP servers separated by commas: 1.ntp.example.com, 2.ntp.example.com
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步骤 4 在完成最终提示后，系统将显示设置汇总。浏览摘要以确认这些值都正确，然后输入 Y 以应用更改
后的配置。输入 N 将撤消更改。

示例：

Apply the changes?(y,n) [Y]: Y
Configuration saved successfully!
Applying...
Done.
Generating self-signed certificate, the web server will be restarted after that
...
Done.
Press ENTER to continue...
asacx>

注 如果您更改了主机名，直到您注销并重新登录后才提示会显示新名称。

步骤 5 如果不使用 NTP，您应配置时间设置。默认时区为 UTC 时区。使用 show time 命令查看当前设置。
您可以使用以下命令更改时间设置：

asacx> config timezone
asacx> config time

步骤 6 输入下列命令更改管理员密码：

asacx> config passwd

示例：

asacx> config passwd
The password must be at least 8 characters long and must contain
at least one uppercase letter (A-Z), at least one lowercase letter
(a-z) and at least one digit (0-9).
Enter password: Farscape1
Confirm password: Farscape1
SUCCESS: Password changed for user admin

步骤 7 输入 exit 命令注销。

在 ASA CX 模块上配置安全策略

使用 PRSM 在 ASA CX 模块上配置安全策略。安全策略控制模块所提供的服务。您无法通过 ASA 
CX CLI、 ASA CLI 或 ASDM 配置策略。

PRSM （即思科 Prime 安全管理器）既是 ASA CX 配置接口的名称，也是用于配置 ASA CX 设备的
独立产品的名称。访问配置接口的方法与如何使用 PRSM 的方法相同。有关使用 PRSM 配置 ASA 
CX 安全策略的详细信息，请参阅 《ASA CX/PRSM 用户指南》或联机帮助。

要打开 PRSM，请使用网络浏览器打开以下 URL：

https://management_address 

其中， management_address 是 ASA CX 管理接口或 PRSM 服务器的 DNS 名称或 IP 地址。例如 
https://asacx.example.com。

在 Home > ASA CX Status 上有打开此地址的快捷方式；点击 Connect to the ASA CX application 链
接打开管理该模块的 ASA CX 或 PRSM 服务器。
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配置身份验证代理端口

如果您在 ASA CX 策略中使用活动身份验证，ASA 使用端口 885 作为身份验证代理端口。如果 885 
不能被接受，则配置另一个端口，但非默认端口编号必须大于 1024。有关身份验证代理的详细信
息，请参阅第 19-4 页的用于主动活动身份验证的身份验证代理。

在多情景模式下，应在每个安全情景内更改端口。

要更改身份验证代理端口，请选择 Configuration > Firewall > Advanced > ASA CX Auth Proxy。您
也可以在 ASDM 启动向导中设置端口。

向 ASA CX 模块重定向流量

您可以创建识别特定流量的服务策略，将流量重定向至 ASA CX 模块。仅在进行演示时，您可以为
服务策略启用仅监控模式，将流量副本转发到 ASA CX 模块，而原有流量不会受到影响。

另外，演示时您可以配置流量转发接口，而不配置仅监控模式下的服务策略。流量转发接口绕过 
ASA，将所有流量直接发送到 ASA CX 模块。

• 第 19-15 页的创建 ASA CX 服务策略

• 第 19-16 页的配置流量转发接口 （仅监控模式）

创建 ASA CX 服务策略

您可以创建识别特定流量的服务策略，将流量重定向至 ASA CX 模块。

注 ASA CX 重定向是双向的。因此，如果为一个接口配置服务策略，该接口上的主机间建立了连接且
有一个接口未配置重定向，则这些主机间的所有流量都会被发送到 ASA CX 模块，包括来自非 ASA 
CX 接口的流量。但是，由于身份验证代理仅适用于进口流量，因此 ASA 仅在应用了服务策略的接
口上执行身份验证代理。

准备工作

• 如果使用此操作步骤在 ASA 上启用身份验证代理，则应确保也为 ASA CX 模块上的身份验证配
置目录区域。有关详细信息，请参阅 《ASA CX 用户指南》。

• 如果有活动服务策略将流量重定向流量至 IPS 模块 （之前被 ASA CX 替换的模块），您必须在
在配置 ASA CX 服务策略前将该策略移除。

• 请确保将 ASA 策略和 ASA CX 都配置为具有匹配的模式：均在仅监控模式下或均在正常内联模
式下。

• 在多情景模式下，请在每个安全情景中执行此操作步骤。

• 在多设备模式下使用 PRSM 时，可以配置 ASA 策略用于将流量发送到 PRSM 内的 ASA CX 模
块，而非使用 ASDM 或如下所述的 ASA CLI。但是，配置 ASA 服务策略时， PRSM 有一些限
制；有关详细信息，请参阅 《ASA CX 用户指南》。
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操作步骤

步骤 1 选择 Configuration > Firewall > Service Policy Rules。

步骤 2 选择 Add > Add Service Policy Rule。系统将显示 Add Service Policy Rule Wizard - Service Policy 对
话框。

步骤 3 根据需要填写 Service Policy 对话框。有关这些屏幕的详细信息，请参阅 ASDM 联机帮助。

步骤 4 点击 Next。系统将显示 Add Service Policy Rule Wizard - Traffic Classification Criteria 对话框。

步骤 5 根据需要填写 Traffic Classification Criteria 对话框。有关这些屏幕的详细信息，请参阅 ASDM 联机
帮助。

步骤 6 点击 Next 以显示 Add Service Policy Rule Wizard - Rule Actions 对话框。

步骤 7 点击 ASA CX Inspection 选项卡。

步骤 8 选中 Enable ASA CX for this traffic flow 复选框。

步骤 9 在 If ASA CX Card Fails 区域，选择以下某个选项：

• Permit traffic - 将 ASA 设置为在模块不可用时允许所有流量未经检查即可通过。

• Close traffic - 将 ASA 设置为在模块不可用时阻止所有流量。

步骤 10 要启用主动身份验证所需的身份验证代理，请选中 Enable Auth Proxy 复选框。此选项在仅监控模
式下不提供。

步骤 11 （可选）仅限于演示时，选中 Monitor-only 复选框将流量的只读副本发送到 ASA CX 模块。

注 您必须将所有类和策略配置为仅监控模式或正常内联模式；您无法在同一 ASA 上同时配置
两种模式。

步骤 12 点击 Finish，然后点击 Apply。

请重复此操作步骤，以根据需要配置更多流量流。

配置流量转发接口（仅监控模式）

仅限于演示时，您可以配置流量转发接口，将所有流量直接转发到 ASA CX 模块。有关 ASA CX 正
常运行的详细信息，请参阅第 19-15 页的创建 ASA CX 服务策略。

有关详细信息，请参阅第 19-3 页的仅监控模式下的流量转发接口。有关流量转发接口的专用准则
和限制，也请参阅第 19-5 页的 ASA CX 的准则。

您只能在 CLI 配置此功能。选择 Tools > Command Line Interface，点击 Multiple Line 单选按钮，
然后输入这些命令。命令块完全时，点击 Send。

准备工作

• 确保将 ASA 策略和 ASA CX 都配置为具有匹配的模式：均在仅监控模式下。

• 在多情景模式下，请在每个安全情景中执行此操作步骤。
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操作步骤

步骤 1 为需要用于流量转发的物理接口输入接口配置模式。

interface physical_interface

示例：

hostname(config)# interface gigabitethernet 0/5

步骤 2 移除为该接口配置的所有名称。如果在任何 ASA 配置中使用了该接口，则移除该配置。您无法在
已命名的接口上配置流量转发。

no nameif 

步骤 3 启用流量转发。

traffic-forward cxsc monitor-only 

步骤 4 启用接口。

no shutdown 

为附加接口重复此操作步骤。

示例

以下示例采用 GigabitEthernet 0/5 为流量转发接口：

interface gigabitethernet 0/5
  no nameif
  traffic-forward cxsc monitor-only
  no shutdown

管理 ASA CX 模块
本节包括用于管理模块的操作步骤。

• 第 19-18 页的重置密码

• 第 19-18 页的重新加载或重置模块

• 第 19-18 页的关闭模块

• 第 19-19 页的 （ASA 5512-X 至 ASA 5555-X）卸载软件模块映像

• 第 19-19 页的 （ASA 5512-X 至 ASA 5555-X）从 ASA 向模块发起会话
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重置密码

您可以将模块密码重置为默认值。用户 admin 的默认密码为 Admin123。重置密码后，应使用模块
应用将其更改为一个唯一值。

重置模块密码将导致模块重新启动。重启模块时，服务不可用。

要将模块密码重置为默认密码，您可以采用以下方法之一。在多情景模式下，在系统执行空间中执
行此操作步骤。

• (CLI) 硬件模块 (ASA 5585-X)：

hw-module module 1 password-reset 

• （CLI）软件模块 （ASA 5512-X 至 ASA 5555-X）：

sw-module module cxsc password-reset 

• （ASDM）选择 Tools > ASA CX Password Reset。

注 如果使用新密码无法连接至 ASDM，请重新启动 ASDM 并尝试重新登录。如已定义新
密码，但 ASDM 中仍然保留了不同于新密码的现有密码，请选择 File > Clear ASDM 
Password Cache，清除密码缓存，然后重新启动 ASDM 并尝试重新登录。

重新加载或重置模块

要重新加载，或重置并重新加载模块，请在 ASA CLI 处输入以下命令之一。在多情景模式下，在系
统执行空间中执行此操作步骤。

• 硬件模块 (ASA 5585-X)：

hw-module module 1 {reload | reset} 

• 软件模块 （ASA 5512-X 至 ASA 5555-X）：

sw-module module cxsc {reload | reset。

关闭模块

通过关闭模块软件，可让模块做好准备，在不丢失配置数据的情况下安全断电。要正确关闭模块，
请在 ASA CLI 处输入以下命令之一。在多情景模式下，在系统执行空间中执行此操作步骤。

注 如果重新加载 ASA，模块将不自动关闭，因此，我们建议先关闭模块，再重新加载 ASA。

• 硬件模块 (ASA 5585-X)：

hw-module module 1 shutdown 

• 软件模块 （ASA 5512-X 至 ASA 5555-X）：

sw-module module cxsc shutdown 
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（ASA 5512-X 至 ASA 5555-X）卸载软件模块映像

可卸载软件模块映像及其关联配置。在多情景模式下，在系统执行空间中执行此操作步骤。

操作步骤

步骤 1 卸载软件模块映像以及关联配置。

hostname# sw-module module cxsc uninstall 

Module cxsc will be uninstalled.This will completely remove the disk image 
associated with the sw-module including any configuration that existed within it.

Uninstall module cxsc?[confirm] 

步骤 2 重新加载 ASA。必须先重新加载 ASA，然后才能安装新模块。

hostname# reload 

（ASA 5512-X 至 ASA 5555-X）从 ASA 向模块发起会话

使用 ASA CX CLI 配置基本网络设置并对模块进行故障排除。

要通过 ASA 访问 ASA CX 软件模块 CLI，您可以通过 ASA 进行会话。可向模块发起会话 （使用 
Telnet），也可创建虚拟控制台会话。如果控制面板已关闭且无法建立 Telnet 会话，则控制台会话可
能有用。在多情景模式下，从系统执行空间发起会话。

在 Telnet 或控制台会话中，会提示您输入用户名和密码。使用用户名 admin 及其密码 （默认密码
为 Admin123）。

• Telnet 会话：

session cxsc 

要从 ASA CX CLI 退回到 ASA CLI，请使用 exit 命令或同时按下 Ctrl-Shift-6, x。

• 控制台会话：

session cxsc console 

退出控制台会话的唯一途径为同时按下 Ctrl-Shift-6, x。从模块注销后，您将回到模块登录提示
符处。

注 请勿将 session cxsc console 命令与终端服务器结合使用，在该服务器上，Ctrl-Shift-6, x 是返回终端
服务器提示符的转义字符串。Ctrl-Shift-6, x 也是退出 ASA CX 控制台并返回 ASA 提示符的字符串。
因此，在这种情况下，如果您尝试退出 ASA CX  控制台，反而会一直退出到终端服务器提示符处。
如果将终端服务器重新连接到 ASA，ASA CX 控制台会话仍处于活动状态；您无法退出到ASA 提示
符处。必须使用直接串行连接才能将控制台返回至 ASA 提示符。当出现这种情况时，请使用 
session cxsc 命令而非控制台命令。
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监控 ASA CX 模块
以下主题提供了有关监控模块的指南。有关 ASA CX 相关系统日志消息的详细信息，请参阅系统日
志消息指南。 ASA CX 系统日志消息的编号以 429001 开始。

选择 Tools > Command Line Interface 以使用监控命令。

• 第 19-20 页的显示模块状态

• 第 19-20 页的显示模块统计信息

• 第 19-21 页的监控模块连接

显示模块状态

从主页上，您可以选择 ASA CX Status 选项卡查看有关模块的详细信息。包括模块信息，例如型
号、序列号和软件版本，以及模块状态，例如应用程序名称和状态、数据层面状态和整体状态。您
可以点击链接打开应用并进行进一步分析和模块配置。

显示模块统计信息

您可以使用 show service-policy cxsc 命令，显示包含 cxsc 命令的每个服务策略的统计信息和状态。
您可以使用 clear service-policy 命令清除计数器。

以下为 show service-policy 命令的输出示例，显示了 ASA CX 策略和当前统计信息以及身份验证代
理禁用时的模块状态：

hostname# show service-policy cxsc
Global policy:
Service-policy: global_policy
    Class-map: bypass
      CXSC: card status Up, mode fail-open, auth-proxy disabled
        packet input 2626422041, packet output 2626877967, drop 0, reset-drop 0, proxied 0

以下为 show service-policy 命令的输出示例，显示了 ASA CX 策略和当前统计信息以及身份验证代
理禁用时的模块状态；在此情况下，被代理的计数也会递增：

hostname# show service-policy cxsc
Global policy:
Service-policy: pmap
    Class-map: class-default
      Default Queueing      Set connection policy: random-sequence-number disable
        drop 0
      CXSC: card status Up, mode fail-open, auth-proxy enabled
        packet input 7724, packet output 7701, drop 0, reset-drop 0, proxied 10
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  监控 ASA CX 模块
监控模块连接

要显示通过 ASA CX 模块的连接，请输入以下某个命令：

• show asp table classify domain cxsc 

将显示为了将流量发送到 ASA CX 模块而创建的 NP 规则。

• show asp table classify domain cxsc-auth-proxy 

将显示为 ASA CX 模块的身份验证代理而创建的 NP 规则。以下为输出示例，这里显示一条规
则，目标 “port=2000”为 cxsc auth-proxy port 2000 命令配置的身份验证代理端口，而目标
“ip/id=192.168.0.100”为 ASA 接口的 IP 地址。

hostname# show asp table classify domain cxsc-auth-proxy 
Input Table
in  id=0x7ffed86cc470, priority=121, domain=cxsc-auth-proxy, deny=false

hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6
src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=192.168.0.100, mask=255.255.255.255, port=2000, dscp=0x0
input_ifc=inside, output_ifc=identity

• show asp drop 

将显示丢弃的数据包。丢弃类型说明如下。

• show asp event dp-cp cxsc-msg 

此输出显示 dp-cp 队列上有多少 ASA CX 模块消息。只有来自 ASA CX 模块的 VPN 查询会被发
送到 dp-cp。

• show conn 

将显示 ‘X - inspected by service module’标记显示连接是否正在被转发到模块。

show asp drop 命令也可包含以下与 ASA CX 模块有关的丢弃原因。

丢帧：

• cxsc-bad-tlv-received - 当 ASA 从 CXSC 收到不包含 Policy ID TLV 的数据包时，发生丢帧。如果 
actions 字段中未设置 Standby Active 位，该 TLV 必须出现在非控制数据包中。

• cxsc-request - CXSC 根据 CXSC 上的策略请求丢弃帧， CXSC 在策略中将操作设置为 Deny 
Source、 Deny Destination 或 Deny Pkt。

• cxsc-fail-close - 由于卡片未开启且所配置的策略是 “fail-close”（而非即使在卡片关闭的状态下
也允许数据包通过的 “fail-open”），因此数据包被丢弃。

• cxsc-fail - CXSC 配置已为现有流量移除，我们无法通过 CXSC 对其进行处理；因此选择丢失。
这种情况十分罕见。

• cxsc-malformed-packet - 来自 CXSC 的数据包包含无效标头。例如，报头长度可能不正确。

流量丢弃：

• cxsc-request - CXSC 要求终止流量。设置了操作位 0。

• reset-by-cxsc - CXSC 要求终止并重置流量。设置了操作位 1。

• cxsc-fail-close - 由于卡片关闭且已配置的策略是 “fail-close”，因此流量被终止。
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  对身份验证代理进行故障排除
对身份验证代理进行故障排除
如果您在使用身份验证代理功能时遇到问题，请按以下步骤对配置和连接进行故障排除。

注 如果在两个 ASA 接口上的主机间有连接，且仅为其中一个接口配置了 ASA CX 服务策略，则这些
主机间的所有流量都会被发送到 ASA CX 模块，包括来自非 ASA CX 接口的流量 （此功能是双向
的）。但是，由于该功能仅限于进口，因此 ASA 仅对应用了服务策略的接口执行身份验证代理。

操作步骤

步骤 1 检查配置。

• 在 ASA 上，检查 show asp table classify domain cxsc-auth-proxy 命令的输出，确保已安装规则
且这些规则是正确的。

• 在 PRSM 中，确保使用正确的凭证创建目录区域并测试连接，以便确保可以访问身份验证服务
器；同时确保为身份验证配置了一个或多个策略对象。

步骤 2 检查 show service-policy cxsc 命令的输出，查看是否已代理任何数据包。

步骤 3 在背板 (capture name interface asa_dataplane) 上执行数据包捕获，并检查是否正在正确的已配置端
口上重定向流量。您可以使用 show running-config cxsc 命令或 show asp table classify domain 
cxsc-auth-proxy 命令检查已配置的端口。

示例

确保始终使用了端口 2000：

1. 检查身份验证代理端口：

hostname# show running-config cxsc 
cxsc auth-proxy port 2000

2. 检查身份验证代理规则：

hostname# show asp table classify domain cxsc-auth-proxy 

Input Table
in  id=0x7ffed86cc470, priority=121, domain=cxsc-auth-proxy, deny=false

hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6
src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=192.168.0.100, mask=255.255.255.255, port=2000, dscp=0x0
input_ifc=inside, output_ifc=identity

3. 在数据包捕获中，重定向请求应该发往目标端口 2000。
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ASA CX 模块的历史

功能名称 平台版本 说明

ASA CX SSP-10 和 -20 支持带 SSP-10 和 -20 
的 ASA 5585-X

ASA 8.4(4.1)
ASA CX 9.0(1)

通过 ASA CX 模块，您可以根据情况的全部情景实施安
全措施。情景包括用户身份 （谁）、用户要访问的应用
或网站 （什么）、尝试访问的来源 （哪里）、尝试访问
的时间 （什么时候）和用于访问的设备的属性 （如
何）。通过 ASA CX 模块，您可以提取流量的全部情景并
执行精细策略，例如允许访问 Facebook，但不允许访问 
Facebook 上的游戏，或允许财务人员访问敏感的企业数
据库，但不允许其他员工进行同样的访问。

我们引入了以下屏幕：

Home > ASA CX Status
Wizards > Startup Wizard > ASA CX Basic Configuration
Configuration > Firewall > Service Policy Rules > Add 
Service Policy Rule > Rule Actions > ASA CX Inspection

ASA CX SSP 支持 ASA 5512-X 至 ASA 
5555-X

ASA 9.1(1)
ASA CX 9.1(1)

为 ASA 5512-X、 ASA 5515-X、 ASA 5525-X、 ASA 
5545-X 和 ASA 5555-X 引入了 ASA CX SSP 软件模块
支持。

我们未修改任何屏幕。

仅限于演示的仅监控模式 ASA 9.1(2)
ASA CX 9.1(2)

仅在进行演示时，您可以为服务策略启用仅监控模式，
将流量副本转发到 ASA CX 模块，而原有流量不会受到
影响。

另外，演示时您可以配置流量转发接口，而不配置仅监
控模式下的服务策略。流量转发接口绕过 ASA，将所有
流量直接发送到 ASA CX 模块。

修改了以下屏幕：Configuration > Firewall > Service Policy 
Rules > Add Service Policy Rule > Rule Actions > ASA CX 

Inspection。

仅 CLI 支持流量转发功能。

ASA CX 模块支持 NAT 64 ASA 9.1(2)
ASA CX 9.1(2)

您现在可以结合 ASA CX 模块使用 NAT 64。

我们未修改任何屏幕。

ASA CX SSP-40 和 -60 支持带 SSP-40 和 -60 
的 ASA 5585-X

ASA 9.1(3)
ASA CX 9.2(1)

ASA CX SSP-40 和 -60 模块可以与匹配级别带 SSP-40 和 
-60 的 ASA 5585-X 一起使用。

我们未修改任何屏幕。

ASA CX 模块支持多情景模式 ASA 9.1(3)
ASA CX 9.2(1)

您现在可以在 ASA 上按情景配置 ASA CX 服务策略。

注 虽然您可以配置每情景 ASA 服务策略，但是，
ASA CX 模块自身（在 PRSM 中配置）是一台单一
情景模式设备；来自 ASA 的情景特定流量将根据
通用 ASA CX 策略来检查。

我们未修改任何屏幕。
19-23
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 19 章      ASA CX 模块

  ASA CX 模块的历史
过滤在 ASA CX 背板上捕获的数据包 ASA 9.1(3)
ASA CX 9.2(1)

您现在可以使用关键字 match 或 access-list 与 capture 
interface asa_dataplane 命令来过滤在 ASA CX 背板上捕
获的数据包。

ASA CX 模块的特定控制流量不受访问列表或匹配过滤的
影响；ASA 可以捕获所有控制流量。

在多情景模式下，按情景配置数据包捕获。请注意，在
多情景模式下的所有控制流量仅流向系统执行空间。由
于无法使用访问列表或匹配来过滤控制流量，因此这些
选项在系统执行空间中不可用。

我们未修改任何 ASDM 屏幕。

功能名称 平台版本 说明
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20第 章
ASA IPS 模块

本章介绍如何配置 ASA IPS 模块。ASA IPS 模块可能是硬件模块，也可能是软件模块，取决于 ASA 
型号。有关每个 ASA 型号所支持的 ASA IPS 模块的列表，请参阅 《思科 ASA 兼容性矩阵》：

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

• 第 20-1 页的有关 ASA IPS 模块的信息

• 第 20-5 页的 ASA IPS 模块的许可要求

• 第 20-5 页的准则和限制

• 第 20-6 页的默认设置

• 第 20-6 页的配置 ASA IPS 模块

• 第 20-16 页的管理 ASA IPS 模块

• 第 20-20 页的监控 ASA IPS 模块

• 第 20-20 页的 ASA IPS 模块的功能历史记录

有关 ASA IPS 模块的信息
ASA IPS 模块运行高级 IPS 软件，该软件提供主动、全面的入侵防御服务，可在蠕虫和网络病毒等
恶意流量影响网络之前，及时对其进行拦截。

• 第 20-2 页的 ASA IPS 模块如何与 ASA 配合使用

• 第 20-3 页的操作模式

• 第 20-3 页的使用虚拟传感器

• 第 20-4 页的有关管理访问权的信息
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ASA IPS 模块如何与 ASA 配合使用

ASA IPS 模块从 ASA 运行独立应用。 ASA IPS 模块可能包含外部管理接口，以便您直接连接至 
ASA IPS 模块；如果它没有管理接口，则可通过 ASA 接口连接至 ASA IPS 模块。ASA 5585-X 上的 
ASA IPS SSP 带有数据接口；这些接口为 ASA 提供了额外的端口密度。然而， ASA 的整体吞吐量
不会增加。

流量先通过防火墙检查，然后再转发至 ASA IPS 模块。在确定要在 ASA 上接受 IPS 检测的流量之
后，这些流量将按以下方式流经 ASA 和 ASA IPS 模块。注意：此示例适用于 “内联模式”。请参
阅第 20-3 页的操作模式了解“混杂模式”的相关信息，在该模式下， ASA 仅向 ASA IPS 模块发送
流量副本。

1. 流量进入 ASA。

2. 对传入的 VPN 流量解密。

3. 应用防火墙策略。

4. 流量发送至 ASA IPS 模块。

5. ASA IPS 模块向流量应用其安全策略，并采取相应的措施。

6. 有效流量发回 ASA；ASA IPS 模块可能会根据其安全策略阻止某些流量，被阻止的流量不会传
递下去。

7. 对传出的 VPN 流量加密。

8. 流量退出 ASA。

图 20-1 展示了在内联模式下运行 ASA IPS 模块时的流量流。在此示例中，ASA IPS 模块将自动阻止
其确定为攻击的流量。所有其他流量均通过 ASA 转发。

图 20-1 ASA 中的 ASA IPS 模块流量流：内联模式
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操作模式

可使用以下任一模式将流量发送到 ASA IPS 模块：

• 内联模式 - 此模式直接将 ASA IPS 模块置于流量流中（请参阅图 20-1）。对于已确定要接受 IPS 
检测的流量，如果其未首先通过 ASA IPS 模块且由该模块进行检查，则该流量将无法继续通过 
ASA。这种模式是最安全的，因为它先对确定要检测的每个数据包进行分析，然后才允许其通
过。此外， ASA IPS 模块还可对数据包逐一实施阻止策略。不过，这种模式可能会影响吞吐
量。

• 混杂模式 - 此模式会向 ASA IPS 模块发送流量流副本。其安全性较低，但对流量吞吐量几乎无
影响。与内联模式不同的是，在混杂模式下，ASA IPS 模块只能通过指示 ASA 避开流量或重置 
ASA 上的连接来阻止流量。此外，当 ASA IPS 模块分析流量时，可能会有少量 ASA IPS 模块来
不及避开的流量通过 ASA。图 20-2 展示了混杂模式下的 ASA IPS 模块。在此示例中，ASA IPS 
模块会针对其确定为威胁的流量向 ASA 发送避开消息。

图 20-2 ASA 中的 ASA IPS 模块流量流：混杂模式

使用虚拟传感器

运行 IPS 软件 6.0 版及更高版本的 ASA IPS 模块可以运行多个虚拟传感器，这意味着可以在 ASA 
IPS 模块上配置多个安全策略。可将每个 ASA 安全情景或单模式 ASA 分配给一个或多个虚拟传感
器，也可将多个安全情景分配给同一个虚拟传感器。请参阅 IPS 文档，了解有关虚拟传感器的详细
信息，包括受支持的传感器最大数量。

图 20-3 展示了一个安全情景配备一个虚拟传感器 （内联模式），而另外两个安全情景共用同一个
虚拟传感器。
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图 20-3 安全情景和虚拟传感器

图 20-4 展示了一个单模式 ASA 配备多个虚拟传感器 （内联模式）；各个已定义的流量流转至不同
的传感器。

图 20-4 配备多个虚拟传感器的单模式 ASA

有关管理访问权的信息

可采用以下方法来管理 IPS 应用：

• 从 ASA 向模块发起会话 - 如果可以通过 CLI 访问 ASA，则可以向模块发起会话并访问模块 
CLI。请参阅第 20-9 页的从 ASA 向模块发起会话 （可能需要）。

• 使用 ASDM 或 SSH 连接至 IPS 管理接口 - 从 ASA 启动 ASDM 之后，管理站将连接至该模块管
理接口以配置 IPS 应用。对于 SSH，可在该模块管理接口上直接访问模块 CLI。（需要在模块应
用中进行额外配置才能执行 Telnet 访问）。该模块管理接口还可用于发送系统日志消息或允许
进行模块应用更新，如签名数据库更新。
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  ASA IPS 模块的许可要求
请参阅有关该管理接口的以下信息：

– ASA 5585-X - IPS 管理接口是一个独立的外部千兆以太网接口。

– ASA 5512-X、 ASA 5515-X、 ASA 5525-X、 ASA 5545-X、 ASA 5555-X - 这些型号将 ASA 
IPS 模块作为软件模块运行。 IPS 管理接口与 ASA 共用管理 0/0 接口。 ASA 和 ASA IPS 模
块分别支持不同的 MAC 地址和 IP 地址。 IPS IP 地址的配置必须在 IPS 操作系统内进行
（使用 CLI 或 ASDM）。但是，物理特性（例如启用接口）在 ASA 上配置。可移除 ASA 接
口配置 （特别是接口名称），以便将此接口专门用作纯 IPS 接口。此接口仅用于管理。

ASA IPS 模块的许可要求
下表显示此功能的许可要求：

准则和限制
此节包括该功能的指导原则和限制。

型号准则

• 请参阅 《思科 ASA 兼容性矩阵》，了解有关哪些型号支持哪些模块的信息：

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

附加准则

• ASA 与 IPS 模块的吞吐量之和小于 ASA 单独一项的吞吐量。

– ASA 5512-X 至 ASA 5555-X - 请参阅 
http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/qa_c67-700608.html

– ASA 5585-X - 请参阅 
http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/qa_c67-617018.html

• 无法更改模块上安装的软件类型；如已购买 ASA IPS 模块，则以后无法在该模块上安装其他
软件。

型号 许可证要求

ASA 5512-X、
ASA 5515-X、
ASA 5525-X、
ASA 5545-X、
ASA 5555-X

IPS 模块许可证。

注 IPS 模块许可证可用于在 ASA 上运行 IPS 软件模块。还必须另行购买 IPS 签名订用；要实现故
障转移，请为每个设备购买一个订用。要获得 IPS 签名支持，必须购买预装有 IPS 的 ASA
（部件号必须包含 “IPS”）。组合的故障转移集群许可证不允许将非 IPS 设备与 IPS 设备配
对。例如，如果购买了 ASA 5515-X 的 IPS 版本（部件号 ASA5515-IPS-K9），并试图与非 IPS 
版本（部件号 ASA5515-K9）配成故障转移对，则将无法获取 ASA5515-K9 设备的 IPS 签名更
新，即使它从其他设备继承了 IPS 模块许可证也是如此。

ASA 5585-X 基础许可证。

所有其他型号 不支持。
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第 20 章      ASA IPS 模块

  默认设置
默认设置
表 20-1 列出了 ASA IPS 模块的默认设置。

注 ASA 上的默认管理 IP 地址是 192.168.1.1/24。

配置 ASA IPS 模块
本节介绍如何配置 ASA IPS 模块。

• 第 20-6 页的 ASA IPS 模块的任务流

• 第 20-7 页的连接 ASA IPS 管理接口

• 第 20-9 页的从 ASA 向模块发起会话 （可能需要）

• 第 20-11 页的配置基本 IPS 模块网络设置

• 第 20-10 页的 （ASA 5512-X 至 ASA 5555-X）启动软件模块

• 第 20-12 页的配置 ASA IPS 模块上的安全策略

• 第 20-14 页的向安全情景分配虚拟传感器

• 第 20-15 页的将流量转移至 ASA IPS 模块

ASA IPS 模块的任务流

ASA IPS 模块的配置过程包括：在 ASA IPS 模块上配置 IPS 安全策略，然后将 ASA 配置为将流量发
送至 ASA IPS 模块。要配置 ASA IPS 模块，请执行下列步骤：

步骤 1 为 ASA IPS 管理接口布线。请参阅第 20-7 页的连接 ASA IPS 管理接口。

步骤 2 向模块发起会话。找到背板上方的 IPS CLI。对于 ASDM 用户，如果 IPS 软件未运行，可能需要向
模块发起会话以启动该软件。请参阅第 20-9 页的从 ASA 向模块发起会话 （可能需要）。

步骤 3 （ASA 5512-X 至 ASA 5555-X；可能需要）安装软件模块。请参阅第 20-10 页的 （ASA 5512-X 至 
ASA 5555-X）启动软件模块。

步骤 4 ASA为 IPS 模块配置基本网络设置。请参阅第 20-11 页的配置基本 IPS 模块网络设置。

步骤 5 在模块上配置检测和保护策略，该策略用于确定流量检查方式以及检测到入侵时应执行的操作。请
参阅第 20-12 页的配置 ASA IPS 模块上的安全策略。

表 20-1 默认网络参数

参数 默认值

管理 IP 地址 192.168.1.2/24

网关 192.168.1.1/24 （默认 ASA 管理 IP 地址）

用户名 cisco

密码 cisco
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步骤 6 （可选）在处于多情景模式的 ASA 上，指定可用于每个情景的 IPS 虚拟传感器（如果配置了虚拟传
感器）。请参阅第 20-14 页的向安全情景分配虚拟传感器。

步骤 7 在 ASA 上，确定要转移到 ASA IPS 模块的流量。请参阅第 20-15 页的将流量转移至 ASA IPS 模块。

连接 ASA IPS 管理接口

除了提供对 IPS 模块的管理访问权， IPS 管理接口还需要访问 HTTP 代理服务器或 DNS 服务器和
互联网，以便下载全局相关性、签名更新和许可证请求。本节描述推荐的网络配置。您的网络可
能不同。

• 第 20-7 页的 ASA 5585-X （硬件模块）

• 第 20-8 页的 ASA 5512-X 至 ASA 5555-X （软件模块）

ASA 5585-X （硬件模块）

IPS 模块包括一个独立于 ASA 的管理接口。

如果有内部路由器

如果有内部路由器，则可在管理网络 （可能同时包括 ASA 管理 0/0 接口和 IPS 管理 1/0 接口）与
ASA 内部网络之间路由。另外，务必在 ASA 上添加一个路由，以便通过内部路由器访问管理网络。

ASA 5585-X

PWR
BOOT

ALARM

ACT
VPN

PS1
HDD1

PS0
HDD0

USB
RESET

0SFP1 SFP0 101234567 MGMT

0

1

AUX CONSOLE

PWR
BOOT

ALARM

ACT
VPN

PS1
HDD1

PS0
HDD0

USB
RESET

0SFP1 SFP0 101234567 MGMT

0

1

AUX CONSOLE

ASA Management 0/0
Default IP: 192.168.1.1

IPS Management 1/0
Default IP: 192.168.1.2

SSP

IPS SSP

33
46

56

ASA Management 0/0

Internet

Management PC

Proxy or DNS Server (for example)

Router
ASA

IPS Management 1/0

Outside

IPS
Management

Inside
IPS Default

Gateway

ASA gateway for Management

33
46

58
20-7
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 20 章      ASA IPS 模块

  配置 ASA IPS 模块
如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独管理网络，这需要内部路由器实现网络之间的路
由。在这种情况下，可从内部接口而非管理 0/0 接口管理 ASA。由于 IPS 模块是独立于 ASA 的设
备，因此，可将 IPS 管理 1/0 地址配置为位于内部接口所在的网络上。

ASA 5512-X 至 ASA 5555-X （软件模块）

这些型号将 IPS 模块作为软件模块运行，并且 IPS 管理接口与 ASA 共用管理 0/0 接口。

如果有内部路由器

如果有内部路由器，则可在管理 0/0 网络 （同时包括 ASA 和 IPS 管理 IP 地址）与内部网络之间路
由。另外，务必在 ASA 上添加一个路由，以便通过内部路由器访问管理网络。

Internet

Layer 2
Switch ASA

Inside

IPS Management 1/0
ASA Management 0/0 not used

Outside

IPS

IPS Default Gateway

Management PC

Proxy or DNS Server
(for example) 33

46
60

ASA 5545-X IPS Management 0/0
Default IP: 192.168.1.2
ASA Management  0/0
Default IP: 192.168.1.1

33
46

65

Internet

Management PC

Proxy or DNS Server (for example)

Router
ASA

Management 0/0

Outside

IPS
Management

Inside
IPS Default

Gateway

ASA gateway for Management

33
46

67
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如果没有内部路由器

如果只有一个内部网络，您就无法拥有一个单独的管理网络。在这种情况下，可从内部接口而非管理 
0/0 接口管理 ASA。即使从管理 0/0 接口移除 ASA 配置的名称，仍可配置该接口的 IPS IP 地址。由于 
IPS 模块本质上是独立于 ASA 的设备，因此，可将 IPS 管理地址配置为位于内部接口所在的网络上。

注 必须为管理 0/0 接口移除 ASA 配置的名称；如果该名称是在 ASA 上配置的，则 IPS 地址必须位于 
ASA 所在的网络上，这其中不包括已在其他 ASA 接口上配置的任何网络。如未配置名称，则 IPS 
地址可能位于任何网络上，例如， ASA 内部网络。

后续操作

• 配置基本网络设置。请参阅第 20-11 页的配置基本 IPS 模块网络设置。

从 ASA 向模块发起会话 （可能需要）

要从 ASA 访问 IPS 模块 CLI，可从 ASA 发起会话。对于软件模块，可向模块发起会话 （使用 
Telnet），也可创建虚拟控制台会话。如果控制面板已关闭且无法建立 Telnet 会话，则控制台会话可
能有用。

如在使用多情景模式，则可能需要访问 CLI，并需要使用 CLI 设定基本网络设置或进行故障排除。

详细步骤

Internet

Management PC

Layer 2
Switch ASA

Inside

Management 0/0
(IPS only)

Outside

IPS

IPS Default Gateway

Proxy or DNS Server
(for example) 33

46
69

命令 用途

Telnet 会话。

对于硬件模块 （例如， ASA 5585-X）：

session 1

对于软件模块 （例如， ASA 5545-X）：

session ips

示例：
hostname# session 1

Opening command session with slot 1.
Connected to slot 1.Escape character 
sequence is 'CTRL-^X'.

sensor login: cisco
Password: cisco

使用 Telnet 访问模块。系统会提示输入用户名和密码。默认用户名是 
cisco，默认密码是 cisco。

注 首次登录模块时，系统将提示更改默认密码。密码长度必须至少
为八个字符，并且不能使用词典中的单词。
20-9
思科 ASA 系列防火墙 ASDM 配置指南

 



 

第 20 章      ASA IPS 模块

  配置 ASA IPS 模块
（ASA 5512-X 至 ASA 5555-X）启动软件模块

ASA 通常附带的 IPS 模块软件位于 Disk0 上。如果模块未运行，或要向现有 ASA 添加 IPS 模块，
则必须启动模块软件。如果不确定模块是否在运行，则在运行启动向导时无法看到 IPS Basic 
Configuration 屏幕 （请参阅第 20-11 页的配置基本 IPS 模块网络设置）。

详细步骤

步骤 1 执行以下操作之一：

• 预装有 IPS 的新 ASA - 要查看闪存中的 IPS 模块软件文件名，请选择 Tools > File Management。

例如，查找与 IPS-SSP_5512-K9-sys-1.1-a-7.1-4-E4.aip 类似的文件名。请记下该文件名；在后续
操作步骤中将用到该文件名。

• 新装有 IPS 的现有 ASA - 从 Cisco.com 将 IPS 软件下载至计算机。如有 Cisco.com 登录名，则可
从以下网站获取该软件：

http://www.cisco.com/cisco/software/navigator.html?mdfid=282164240

选择 Tools > File Management，然后选择 File Transfer > Between Local PC and Flash 以将新映
像上传至 disk0。请记下该文件名；在后续操作步骤中将用到该文件名。

步骤 2 选择 Tools > Command Line Interface。

步骤 3 要设置 IPS 模块软件在 disk0 中的位置，请输入以下命令，然后点击 Send：
sw-module module ips recover configure image disk0:file_path

例如，使用第 1 步的示例中的文件名，输入：

sw-module module ips recover configure image disk0:IPS-SSP_5512-K9-sys-1.1-a-7.1-4-E4.aip

步骤 4 要安装并加载 IPS 模块软件，请输入以下命令，然后点击 Send：
sw-module module ips recover boot

步骤 5 要检查映像传输和模块重启过程的进度，请输入以下命令，然后点击 Send：
show module ips details

控制台会话 （仅限软件模块）。

session ips console

示例：
hostname# session ips console

Establishing console session with slot 1
Opening console session with module ips.
Connected to module ips.Escape character 
sequence is 'CTRL-SHIFT-6 then x'.

sensor login: cisco
Password: cisco

访问模块控制台。系统会提示输入用户名和密码。默认用户名是 cisco，
默认密码是 cisco。

注 请勿将此命令与终端服务器结合使用，其中 Ctrl-Shift-6, x 是用于
返回到终端服务器提示符的转义序列。 Ctrl-Shift-6, x 序列也用于
对 IPS 控制台转义并返回至 ASA 提示符。因此，如果在此情况下
尝试退出 IPS 控制台，反而会一直退回至终端服务器提示符。如
将终端服务器重新连接至 ASA，则 IPS 控制台会话仍然会处于活
动状态；您将永远无法退回至 ASA 提示符。必须使用直接串行连
接才能将控制台返回至 ASA 提示符。

改用 session ips 命令。

命令 用途
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输出中的 Status 字段表示模块的运行状态。正在运行的模块通常显示状态 “Up”。当 ASA 向模块
传输应用映像时，输出中的 Status 字段显示 “Recover”。当 ASA 完成映像传输并重启模块时，新
传输的映像正在运行。

配置基本 IPS 模块网络设置

在单情景模式下，可使用 ASDM 中的启动向导配置基本 IPS 网络设置。这些设置将保存到 IPS 配置
而非 ASA 配置中。

在多情景模式下，从 ASA 向模块发起话，并使用 setup 命令配置基本设置。

注 （ASA 5512-X 至 ASA 5555-X）如果且在向导中看不到 IPS Basic Configuration 屏幕，则表示 IPS 模
块未运行。请参阅第 20-10 页的 （ASA 5512-X 至 ASA 5555-X）启动软件模块，然后在安装模块后
重复此操作步骤。

详细步骤 - 单模式

步骤 1 选择 Wizards > Startup Wizard。

步骤 2 点击 Next 向前浏览各个初始屏幕，直至显示 IPS Basic Configuration 屏幕。

步骤 3 在 Network Settings 区域中，配置以下选项：

• IP Address - 管理 IP 地址。默认情况下，该地址为 192.168.1.2。

• Subnet Mask - 管理 IP 地址的子网掩码。

• Gateway - 上游路由器的 IP 地址。下一跳路由器的 IP 地址。请参阅第 20-7 页的连接 ASA IPS 管
理接口了解网络要求。 ASA 管理 IP 地址的默认设置将不起作用。

• HTTP Proxy Server -（可选）HTTP 代理服务器地址。可使用代理服务器而非通过互联网下载全
局相关性更新和其他信息。

• HTTP Proxy Port - （可选） HTTP 代理服务器端口。

• DNS Primary -（可选）主 DNS 服务器地址。如在使用 DNS 服务器，则必须至少配置一个 DNS 
服务器，且该服务器必须可供访问，才能成功更新全局相关性。

为使全局相关性正常运行，必须始终配置一个 DNS 服务器或 HTTP 代理服务器。只有在访问全
局相关性更新服务器时，才支持 DNS 解析。

步骤 4 在 Management Access List 区域中，输入可访问 IPS 管理接口的任何主机的 IP 地址和子网掩码，然
后点击 Add。可添加多个 IP 地址。

步骤 5 在 Cisco Account Password 区域中，为用户名 cisco 设置密码并予以确认。用户名 cisco 以及此密码既
用于来自管理 ACL 所指定主机的 Telnet 会话，也可用于从 ASDM 访问 IPS 模块 (Configuration > 
IPS)。默认情况下，密码为 cisco。

步骤 6 在 Network Participation 区域 （用于让 IPS 模块参与 SensorBase 数据共享）中，点击 Full、 Partial 
或 Off。
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详细步骤 - 使用 CLI 的多模式

配置 ASA IPS 模块上的安全策略

本节介绍如何配置 ASA IPS 模块应用。

详细步骤

步骤 1 使用 ASA 管理 IP 地址连接至 ASDM。

步骤 2 要从 ASDM 访问 IPS 设备管理器 (IDM)，请点击 Configuration > IPS。

步骤 3 输入在第 20-11 页的配置基本 IPS 模块网络设置中设置的 IP 地址、用户名和密码，另外还要输入端
口。默认 IP 地址和端口为 192.168.1.2:443。默认用户名和密码为 cisco 和 cisco。

如果用于访问 IDM 的密码丢失，则可使用 ASDM 重置密码。有关详细信息，请参阅第 20-19 页的
重置密码。

步骤 4 要将登录信息保存至本地 PC 上，请选中 Save IPS login information on local host 复选框。

命令 用途

步骤 1 按照第 20-9 页的从 ASA 向模块发起会话 （可
能需要）向 IPS 模块发起会话。

步骤 2 设置

示例：
sensor# setup

运行设置实用程序对 ASA IPS 模块进行初始配置。系统将提示
您输入基本设置。对于默认网关，请指定上游路由器的 IP 地
址。请参阅第 20-7 页的连接 ASA IPS 管理接口了解网络要求。
ASA 管理 IP 地址的默认设置将不起作用。
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步骤 5 点击 Continue。

系统将显示 Startup Wizard 窗格。

步骤 6 点击 Launch Startup Wizard。根据提示完成屏幕设置。有关详细信息，请参阅 IDM 在线帮助。

如已配置虚拟传感器，则需将其中一个传感器确定为默认传感器。如果 ASA 系列未在其配置中指
定虚拟传感器名称，则使用默认传感器。

后续操作

• 有关多情景模式下的 ASA，请参阅第 20-14 页的向安全情景分配虚拟传感器。

• 有关单情景模式下的 ASA，请参阅第 20-15 页的将流量转移至 ASA IPS 模块。
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向安全情景分配虚拟传感器

如果 ASA 处于多情景模式，则可向每个情景分配一个或多个 IPS 虚拟传感器。然后，在将该情景配
置为将流量发送至 ASA IPS 模块时，可指定分配给该情景的传感器；不能指定未分配给该情景的传
感器。如未向某个情景分配任何传感器，则使用 ASA IPS 模块上配置的默认传感器。可将同一个传
感器分配至多个情景。

注 使用虚拟传感器并不一定要处于多情景模式；在单模式下也可将不同的传感器用于不同的流量流。

先决条件

有关配置情景的详细信息，请参阅一般操作配置指南。

详细步骤

步骤 1 在 ASDM Device List 窗格中，双击主用设备 IP 地址下的 System。

步骤 2 在 Context Management > Security Contexts 窗格中，选择要配置的情景，然后点击 Edit。

系统将显示 Edit Context 对话框。有关配置情景的详细信息，请参阅一般操作配置指南。

步骤 3 在 IPS Sensor Allocation 区域中，点击 Add。

系统将显示 IPS Sensor Selection 对话框。

步骤 4 在 Sensor Name 下拉列表中，从 ASA IPS 模块上配置的传感器名称中选择一个。

步骤 5 （可选）要向传感器分配映射名称，请在 Mapped Sensor Name 字段中输入一个值。

可在情景中使用此传感器名称，而非实际传感器名称。如未指定映射名称，则在情景中使用传感器
名称。为安全起见，您可能不想让情景管理员知道该情景所使用的传感器。或者，您可能想让情景
配置一般化。例如，如果希望所有情景都使用名为 “sensor1”和 “sensor2”的传感器，则可在情
景 A 中将 “highsec”和 “lowsec”传感器映射至 sensor1 和 sensor2，但在情景 B 中将 “medsec”
和 “lowsec”传感器映射至 sensor1 和 sensor2。

步骤 6 点击 OK 返回至 Edit Context 对话框。

步骤 7 （可选）要将某个传感器设置为此情景的默认传感器，请从 Default Sensor 下拉列表中选择一个传感
器名称。

如在情景配置中配置 IPS 时未指定传感器名称，则情景将使用此默认传感器。每个情景只能配置一
个默认传感器。如未指定传感器作为默认传感器，并且情景配置不包含传感器名称，则流量使用 
ASA IPS 模块上的默认传感器。

步骤 8 对每个安全情景重复此操作步骤。

步骤 9 切换至每个情景，以按第 20-15 页的将流量转移至 ASA IPS 模块中所述配置 IPS 安全策略。

后续操作

切换至每个情景，以按第 20-15 页的将流量转移至 ASA IPS 模块中所述配置 IPS 安全策略。
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将流量转移至 ASA IPS 模块

本节确定要从 ASA 转移至 ASA IPS 模块的流量。

先决条件

在多情景模式下，在每个情景执行空间中执行以下步骤。要切换至某个情景，双击主用设备 IP 地
址下的情景名称。

详细步骤

步骤 1 选择 Configuration > Firewall > Service Policy Rules。

步骤 2 选择 Add > Add Service Policy Rule。系统将显示 Add Service Policy Rule Wizard - Service Policy 对
话框。

步骤 3 根据需要填写 Service Policy 对话框。有关这些屏幕的详细信息，请参阅 ASDM 联机帮助。

步骤 4 点击 Next。系统将显示 Add Service Policy Rule Wizard - Traffic Classification Criteria 对话框。

步骤 5 根据需要填写 Traffic Classification Criteria 对话框。有关这些屏幕的详细信息，请参阅 ASDM 在线
帮助。

步骤 6 点击 Next 以显示 Add Service Policy Rule Wizard - Rule Actions 对话框。
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步骤 7 点击 Intrusion Prevention 选项卡。

步骤 8 选中 Enable IPS for this traffic flow 复选框。

步骤 9 在 Mode 区域中，点击 Inline Mode 或 Promiscuous Mode。有关详细信息，请参阅第 20-3 页的操作
模式。

步骤 10 在 If IPS Card Fails 区域中，点击 Permit traffic 或 Close traffic。Close traffic 选项将 ASA 设置为在 
ASA IPS 模块不可用时阻止所有流量。Permit traffic 选项将 ASA 设置为在 ASA IPS 模块不可用时允
许所有流量在未经检查的情况下通过。有关 IPS Sensor Selection 区域的信息，请参阅 ASDM 在线
帮助。

步骤 11 （ASA 5512-X 及更高版本）从 IPS Sensor to use 下拉列表中，选择一个虚拟传感器名称。

如果使用虚拟传感器，则可使用此选项指定传感器名称。如果在 ASA 上使用多情景模式，则只能
指定已分配给该情景的传感器 （请参阅第 20-14 页的向安全情景分配虚拟传感器）。如未指定传感
器名称，则流量将使用默认传感器。在多情景模式下，可为情景指定默认传感器。在单模式下，或
者，如在多模式下未指定默认传感器，则流量将使用 ASA IPS 模块上设置的默认传感器。

步骤 12 依次点击 OK 和 Apply。

步骤 13 请重复此操作步骤，以根据需要配置更多流量流。

管理 ASA IPS 模块
本节包括的操作步骤有助于恢复模块或排除模块的故障。

• 第 20-17 页的安装并启动模块上的映像

• 第 20-18 页的关闭模块

• 第 20-19 页的卸载软件模块映像

• 第 20-19 页的重置密码

• 第 20-20 页的重新加载或重置模块
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安装并启动模块上的映像

如果模块出现故障，并且模块应用映像无法运行，则可从 TFTP 服务器 （针对硬件模块）或本地磁
盘 （软件模块）在模块上重新安装新映像。

注 请勿在模块软件中使用 upgrade 命令来安装映像。

先决条件

• 硬件模块 - 确保所指定的 TFTP 服务器可传输最大 60 MB 的文件。

注 此过程可能约需 15 分钟左右才能完成，具体取决于网络和映像大小。

• 软件模块 - 先将映像复制至 ASA 内部闪存 (disk0)，然后再完成此操作步骤。

注 在将 IPS 软件下载至 disk0 之前，请确保至少有 50% 的可用闪存。安装 IPS 时，IPS 会为
其文件系统保留 50% 的内部闪存。

详细步骤

命令 用途

步骤 1 对于硬件模块 （例如， ASA 5585-X）：

hw-module module 1 recover configure

对于软件模块 （例如， ASA 5545-X）：

sw-module module ips recover configure 
image disk0:file_path

示例：
hostname# hw-module module 1 recover 
configure
Image URL [tftp://127.0.0.1/myimage]: 
tftp://10.1.1.1/ids-newimg
Port IP Address [127.0.0.2]: 10.1.2.10
Port Mask [255.255.255.254]: 255.255.255.0
Gateway IP Address [1.1.2.10]: 10.1.2.254
VLAN ID [0]: 100

指定新映像的位置。

对于硬件模块 - 此命令将提示您输入 TFTP 服务器的 URL、管
理接口 IP 地址和子网掩码以及网关地址。这些网络参数将在 
ROMMON 中配置；模块应用配置中配置的网络参数不可用于 
ROMMON，因此，必须在此处单独设置。

对于软件模块 - 指定映像在本地磁盘上的位置。

可使用 show module {1 | ips} recover 命令查看恢复配置。

在多情景模式下，在系统执行空间中输入此命令。

步骤 2 对于硬件模块：

hw-module module 1 recover boot

对于软件模块：

sw-module module ips recover boot

示例：
hostname# hw-module module 1 recover boot

安装并启动 IPS 模块软件。
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关闭模块

通过关闭模块软件，可让模块做好准备，在不丢失配置数据的情况下安全断电。注意：如果重新加
载 ASA，模块不会自动关闭，因此，建议在重新加载 ASA 之前，先关闭模块。要正常关闭模块，
请在 ASA CLI 处执行下列步骤。

详细步骤

步骤 3 对于硬件模块：

show module 1 details

对于软件模块：

show module ips details

示例：
hostname# show module 1 details

检查映像传输和模块重启进程的进度。

输出中的 Status 字段表示模块的运行状态。正在运行的模块通
常显示状态 “Up”。当 ASA 向模块传输应用映像时，输出中
的 Status 字段显示 “Recover”。当 ASA 完成映像传输并重启
模块时，新传输的映像正在运行。

命令 用途

命令 用途

对于硬件模块 （例如， ASA 5585-X）：

hw-module module 1 shutdown

对于软件模块 （例如， ASA 5545-X）：

sw-module module ips shutdown

示例：
hostname# hw-module module 1 shutdown

关闭模块。
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卸载软件模块映像

要卸载软件模块映像和关联配置，请执行下列步骤。

详细步骤

重置密码

可将模块密码重置为默认值。对于用户 cisco，默认密码为 cisco。重置密码后，应使用模块应用将
其更改为一个唯一值。

重置模块密码将导致模块重新启动。重启模块时，服务不可用。

如果使用新密码无法连接至 ASDM，请重新启动 ASDM 并尝试重新登录。如已定义新密码，但 
ASDM 中仍然保留了不同于新密码的现有密码，请选择 File > Clear ASDM Password Cache，清除
密码缓存，然后重新启动 ASDM 并尝试重新登录。

要将模块密码重置为默认值 cisco，请执行下列步骤。

详细步骤

步骤 1 从 ASDM 菜单栏，选择 Tools > module Password Reset。

系统将显示 Password Reset 确认对话框。

步骤 2 点击 OK 将密码重置为默认值。

系统将显示一个对话框，指示密码重置是成功还是失败。

步骤 3 点击 Close 以关闭对话框。

命令 用途

步骤 1 sw-module module ips uninstall

示例：
hostname# sw-module module ips uninstall
Module ips will be uninstalled.This will 
completely remove the
disk image associated with the sw-module 
including any configuration
that existed within it.

Uninstall module <id>?[confirm]

永久卸载软件模块映像及关联配置。

步骤 2 reload

示例：
hostname# reload

重新加载 ASA。必须先重新加载 ASA，然后才能安装新模块
类型。
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重新加载或重置模块

要重新加载或重置模块，请在 ASA CLI 处输入以下任一命令。

详细步骤

监控 ASA IPS 模块
查看一般操作配置指南中的 Intrusion Prevention 选项卡。

ASA IPS 模块的功能历史记录
表 20-2 列出了各项功能变更以及实施了该变更的平台版本。 ASDM 可向后兼容多个平台版本，因
此，此处未列出添加了支持的具体 ASDM 版本。

命令 用途

对于硬件模块 （例如， ASA 5585-X）：

hw-module module 1 reload

对于软件模块 （例如， ASA 5545-X）：

sw-module module ips reload

示例：
hostname# hw-module module 1 reload

重新加载模块软件。

对于硬件模块：

hw-module module 1 reset

对于软件模块：

sw-module module ips reset

示例：
hostname# hw-module module 1 reset

执行重置，然后重新加载模块。

表 20-2 ASA IPS 模块的功能历史记录

功能名称 平台版本 功能信息

AIP SSM 7.0(1) 我们为 ASA 5510、5520 和 5540 引入了对 AIP SSM 的支持。

引入了以下屏幕：Configuration > Firewall > Service Policy 
Rules > Add/Edit Service Policy Rule > Intrusion Prevention。
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虚拟传感器 （ASA 5510 及更高版本） 8.0(2) 引入了虚拟传感器支持。借助于虚拟传感器，可在 ASA IPS 
模块上配置多个安全策略。

修改了以下屏幕：Context Management > Security Contexts > 
Edit Context。

适用于ASA 5505 的 AIP SSC 8.2(1) 我们为 ASA 5505 引入了对 AIP SSC 的支持。

引入了以下屏幕：Configuration > Device Setup > SSC Setup。

对适用于 ASA 5585-X 的 ASA IPS SSP-10、 -20、 -40 
和 -60 的支持

8.2(5)/
8.4(2)

我们为 ASA 5585-X 引入了对 ASA IPS SSP-10、-20、-40 和 
-60 的支持。只能安装带有匹配级别 SSP 的 ASA IPS SSP；
例如， SSP-10 和 ASA IPS SSP-10。

注 8.3 版本不支持 ASA 5585-X。

对适用于 SSP-40 和 SSP-60 的双 SSP 的支持 8.4(2) 对于 SSP-40 和 SSP-60，可在同一机箱中使用两个相同级别
的 SSP。不支持级别混合的 SSP （例如，不支持混合使用 
SSP-40 和 SSP-60）。每个 SSP 均可充当具有独立配置并进
行独立管理的独立设备。如果需要，可使用两个 SSP 作为故
障转移对。

注 在机箱中使用两个 SSP 时，VPN 不受支持；然而，请
注意，尚未禁用 VPN。

我们未修改任何屏幕。

对适用于 ASA 5512-X 至 ASA 5555-X 的 ASA 
IPS SSP 的支持

8.6(1) 我们为 ASA 5512-X、 ASA 5515-X、 ASA 5525-X、 ASA 
5545-X 和 ASA 5555-X 引入了对 ASA IPS SSP 软件模块的
支持。

我们未修改任何屏幕。

表 20-2 ASA IPS 模块的功能历史记录（续）

功能名称 平台版本 功能信息
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